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What is vRealize Automation 
Cloud Assembly 1
You use vRealize Automation Cloud Assembly to connect to your public and private cloud 
providers so that you can deploy machines, applications, and services that you create to those 
resources. You and your teams develop blueprints-as-code in an environment that supports an 
iterative workflow, from development to testing to production. At provisioning time, you can 
deploy across a range of cloud vendors. The service is a managed VMware SaaS and NaaS-based 
framework.

An overview of vRealize Automation Cloud Assembly includes the following basic functions.

n The Infrastructure tab is where you add and organize your cloud vendor resources and users. 
This tab also provides information about deployed blueprints.

n The Marketplace tab provides VMware Solution Exchange blueprints and images that help you 
build your blueprint library and access supporting OVA or OVFs.

n The Design tab is your development home. You use the canvas and the YAML editor to 
develop and then deploy your machines and applications.

n The Deployments tab shows the current status of your provisioned resources. You can access 
details and history that you use to manage your deployments.
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This chapter includes the following topics:

n How does vRealize Automation Cloud Assembly work

How does vRealize Automation Cloud Assembly work

vRealize Automation Cloud Assembly is a blueprint development and deployment service. You 
and your teams use the service to deploy machines, applications, and services to your cloud 
vendor resources.

As a Cloud Assembly administrator, generally referred to as a cloud administrator, you set up the 
provisioning infrastructure and create the projects that group users and resources.

n Add your cloud vendor accounts. See Adding cloud accounts to vRealize Automation Cloud 
Assembly.

n Determine which regions or datastores are the cloud zones that you want your developers 
deploying to. See Learn more about vRealize Automation Cloud Assembly cloud zones.

n Create policies that define the cloud zones. See Chapter 4 Building your vRealize Automation 
Cloud Assembly resource infrastructure.

Using and Managing vRealize Automation Cloud Assembly
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n Create projects that group the developers with the cloud zones. See Using vRealize 
Automation Cloud Assembly project tags and custom properties .

As a blueprint developer, you are a member of one or more projects. You create and deploy 
blueprints to the cloud zones associated with one of your projects.

n Develop blueprints for projects using the canvas. Your project administrator can use the 
marketplace to download blueprints and supporting images from the VMware Solution 
Exchange. See Chapter 6 Designing your vRealize Automation Cloud Assembly deployments 
and How to use the vRealize Automation Cloud Assembly Marketplace .

n Deploy your blueprints to project cloud zones based on policies and constraints.

n Manage your deployments, including deleting unused applications. See Chapter 7 Managing 
vRealize Automation Cloud Assembly deployments.

Welcome to vRealize Automation Cloud Assembly. If you want an example of how to define the 
infrastructure, and then create an deploy a blueprint, see The WordPress use case.

Using and Managing vRealize Automation Cloud Assembly
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Setting up vRealize Automation 
Cloud Assembly for your 
organization

2
As a Cloud Assembly administrator, you must understand the user roles and set up connections 
with your cloud account vendor and integration applications.

When you configure the cloud accounts and integrations, you are configuring the communication 
between Cloud Assembly and those target systems.

This chapter includes the following topics:

n What are the vRealize Automation Cloud Assembly user roles

n Adding cloud accounts to vRealize Automation Cloud Assembly

n Integrating vRealize Automation with other applications

n What are onboarding plans in vRealize Automation Cloud Assembly

n Advanced configuration for vRealize Automation Cloud Assembly environment

What are the vRealize Automation Cloud Assembly user 
roles

User roles determine what you can see and do in vRealize Automation Cloud Assembly. Some 
roles are defined at the organization level, and some are specific to vRealize Automation Cloud 
Assembly.

User Roles

User roles are defined for the organization in the vRealize Automation console by an organization 
owner. There are two types of roles, organization roles and service roles.

The organization roles are global and apply to all services in the organization. The organization-
level roles are Organization owner or Organization Member role.

For more information about the organization roles, see Administering vRealize Automation.

The vRealize Automation Cloud Assembly service roles, which are service-specific permissions, are 
also assigned at the organization level in the console.
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Cloud Assembly Service Roles

The vRealize Automation Cloud Assembly service roles determine what you can see and do 
in vRealize Automation Cloud Assembly. These service roles are defined in the console by an 
organization owner.

Table 2-1. vRealize Automation Cloud Assembly Service Role Descriptions

Role Description

Cloud Assembly Administrator Must have read and write access to the entire user 
interface and API resources. This is the only user role that 
can see and do everything, including add cloud accounts, 
create new projects, and assign a project administrator.

Cloud Assembly User A user who does not have the Cloud Assembly 
Administrator role.

In a vRealize Automation Cloud Assembly project, the 
administrator adds users to projects as project members. 
The administrator can also add a project administrator. 
The permission for these two roles are defined below.

Cloud Assembly Viewer A user who can see information but cannot create, update, 
or delete values. This is a read-only role.

Users with the viewer role can see the blueprints 
and deployments for all projects regardless of project 
membership or whether the project deployments are 
shared.

In addition to the service roles, vRealize Automation Cloud Assembly has project roles.

The project roles are defined in vRealize Automation Cloud Assembly and can vary between 
projects.

In the following tables, which tells you what the different service and project roles can see and do, 
remember that the service administrators have full permission on all areas of the user interface.

The descriptions of project roles will help you decide what permissions to give your users.

n Project administrators leverage the infrastructure that is created by the service administrator 
to ensure that their project members have the resources they need for their development 
work.

n Project members work within their projects to design and deploy blueprints.

n Project viewers are restricted to read-only access, except in a few cases where they can do 
non-destructive things like download blueprints.

Using and Managing vRealize Automation Cloud Assembly
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Table 2-2. vRealize Automation Cloud Assembly service roles and project roles

UI Context Task

Cloud 
Assembly 
Administrator

Cloud 
Assembly 
Viewer

Cloud Assembly User

User must be a project administrator or 
member to see and do project-related 
tasks.

Project 
Administrator

Project 
Member

Project 
Viewer

Access Cloud 
Assembly

Console In the vRA console, 
you can see 
and open Cloud 
Assembly

Yes Yes Yes Yes Yes

Infrastructure

See and open the 
Infrastructure tab

Yes Yes Yes Yes Yes

Configure - 
Projects

Create projects Yes

Update, or delete 
values from 
project summary, 
users, provisioning, 
Kubernetes, 
integrations, and 
test project 
configurations.

Yes Yes. Your 
projects

Add users and assign 
roles in projects.

Yes Yes. Your 
projects.

View projects Yes Yes Yes. Your 
projects

Yes. Your 
projects

Yes. Your 
projects

Configure - 
Cloud Zones

Create, update, or 
delete cloud zones

Yes

View cloud zones Yes Yes

Configure - 
Kubernetes 
Zones

Create, update, or 
delete Kubernetes 
zones

Yes

View Kubernetes 
zones

Yes Yes

Configure - 
Flavors

Create, update, or 
delete flavors

Yes

View flavors Yes Yes

Configure - 
Image 
Mappings

Create, update, 
or delete image 
mappings

Yes

Using and Managing vRealize Automation Cloud Assembly
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Table 2-2. vRealize Automation Cloud Assembly service roles and project roles (continued)

UI Context Task

Cloud 
Assembly 
Administrator

Cloud 
Assembly 
Viewer

Cloud Assembly User

User must be a project administrator or 
member to see and do project-related 
tasks.

Project 
Administrator

Project 
Member

Project 
Viewer

View image 
mappings

Yes Yes

Configure - 
Network 
Profiles

Create, update, 
or delete network 
profiles

Yes

View image network 
profiles

Yes Yes

Configure - 
Storage Profiles

Create, update, 
or delete storage 
profiles

Yes

View image storage 
profiles

Yes Yes

Configure - 
Pricing Cards

Create, update, or 
delete pricing cards

Yes

View the pricing 
cards

Yes Yes

Configure - 
Tags

Create, update, or 
delete tags

Yes

View tags Yes Yes

Resources - 
Compute

Add tags to 
discovered compute 
resources

Yes

View discovered 
compute resources

Yes Yes

Resources - 
Networks

Modify network tags, 
IP ranges, IP 
addresses

Yes

View discovered 
network resources

Yes Yes

Resources - 
Security

Add tags to 
discovered security 
groups

Yes

View discovered 
security groups

Yes Yes

Resources - 
Storage

Add tags to 
discovered storage

Yes

View storage Yes Yes

Using and Managing vRealize Automation Cloud Assembly
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Table 2-2. vRealize Automation Cloud Assembly service roles and project roles (continued)

UI Context Task

Cloud 
Assembly 
Administrator

Cloud 
Assembly 
Viewer

Cloud Assembly User

User must be a project administrator or 
member to see and do project-related 
tasks.

Project 
Administrator

Project 
Member

Project 
Viewer

Resources - 
Machines

Add and delete 
machines

Yes

View machines Yes Yes Yes. Your 
projects

Yes. Your 
projects

Yes. Your 
projects

Resources - 
Volumes

Delete discovered 
storage volumes

Yes

View discovered 
storage volumes

Yes Yes Yes. Your 
projects

Yes. Your 
projects

Yes. Your 
projects.

Resources - 
Kubernetes

Deploy or add 
Kubernetes clusters, 
and create or add 
namespaces

Yes

View Kubernetes 
clusters and 
namespaces

Yes Yes Yes. Your 
projects

Yes. Your 
projects

Yes. Your 
projects

Activity - 
Requests

Delete deployment 
request records

Yes

View deployment 
request records

Yes Yes Yes. Your 
projects

Yes. Your 
projects

Yes. Your 
projects

Activity - Event 
Logs

View event logs Yes Yes Yes. Your 
projects

Yes. Your 
projects

Yes. Your 
projects

Connections - 
Cloud Accounts

Create, update, 
or delete cloud 
accounts

Yes

View cloud accounts Yes Yes

Connections - 
Integrations

Create, update, or 
delete integrations

Yes

View integrations Yes Yes

Onboarding Create, update, or 
delete onboarding 
plans

Yes

View onboarding 
plans

Yes Yes Yes. Your 
projects

Marketplace

See and open the 
Marketplace tab

Yes Yes

Using and Managing vRealize Automation Cloud Assembly
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Table 2-2. vRealize Automation Cloud Assembly service roles and project roles (continued)

UI Context Task

Cloud 
Assembly 
Administrator

Cloud 
Assembly 
Viewer

Cloud Assembly User

User must be a project administrator or 
member to see and do project-related 
tasks.

Project 
Administrator

Project 
Member

Project 
Viewer

Use the downloaded 
blueprints on the 
Design tab

Yes Yes. If 
associated with 
your projects.

Yes. If 
associated 
with your 
projects.

Marketplace - 
Blueprints

Download a blueprint Yes

View the blueprints Yes Yes

Marketplace - 
Images

Download images Yes

View images Yes Yes

Marketplace - 
Downloads

View the log of all 
downloaded items

Yes Yes

Extensibility

See and open the 
Extensibility tab

Yes Yes Yes

Events View extensibility 
events

Yes Yes

Subscriptions Create, update, or 
delete extensibility 
subscriptions

Yes

Disable subscriptions Yes

View subscriptions Yes Yes

Library - Event 
topics

View event topics Yes Yes

Library - 
Actions

Create, update, or 
delete extensibility 
actions

Yes

View extensibility 
actions

Yes Yes

Library - 
Workflows

View extensibility 
workflows

Yes Yes

Activity - Action 
Runs

Cancel or delete 
extensibility action 
runs

Yes

View extensibility 
action runs

Yes Yes Yes. Your 
projects

Using and Managing vRealize Automation Cloud Assembly

VMware, Inc. 16



Table 2-2. vRealize Automation Cloud Assembly service roles and project roles (continued)

UI Context Task

Cloud 
Assembly 
Administrator

Cloud 
Assembly 
Viewer

Cloud Assembly User

User must be a project administrator or 
member to see and do project-related 
tasks.

Project 
Administrator

Project 
Member

Project 
Viewer

Activity - 
Workflow Runs

View extensibility 
workflow runs

Yes Yes

Design

Design Open the Design tab 
and see a list of 
blueprints

Yes Yes Yes. Your 
projects

Yes. Your 
projects

Yes. Your 
projects

Blueprints Create, update, and 
delete blueprints

Yes Yes. Your 
projects

Yes. Your 
projects

View blueprints Yes Yes Yes. Your 
projects

Yes. Your 
projects

Yes. Your 
projects

Download blueprints Yes Yes Yes. Your 
projects

Yes. Your 
projects

Yes. Your 
projects

Upload blueprints Yes Yes. Your 
projects

Yes. Your 
projects

Deploy blueprints Yes Yes. Your 
projects

Yes. Your 
projects

Version and restore 
blueprints

Yes Yes. Your 
projects

Yes. Your 
projects

Release blueprints to 
the catalog

Yes Yes. Your 
projects

Yes. Your 
projects

Custom 
Resources

Create, update 
or delete custom 
resources

Yes

View custom 
resources

Yes Yes Yes. Your 
projects

Yes. Your 
projects

Yes. Your 
projects

Custom Actions Create, update, 
or delete custom 
actions

Yes

View custom actions Yes Yes Yes. Your 
projects

Yes. Your 
projects

Yes. Your 
projects

Deployments

See and open the 
Deployments tab

Yes Yes Yes Yes Yes

Using and Managing vRealize Automation Cloud Assembly
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Table 2-2. vRealize Automation Cloud Assembly service roles and project roles (continued)

UI Context Task

Cloud 
Assembly 
Administrator

Cloud 
Assembly 
Viewer

Cloud Assembly User

User must be a project administrator or 
member to see and do project-related 
tasks.

Project 
Administrator

Project 
Member

Project 
Viewer

View deployments, 
including deployment 
details, deployment 
history, and 
troubleshooting 
information.

Yes Yes Yes. Your 
projects

Yes. Your 
projects

Yes. Your 
projects

Run day 2 actions on 
deployments based 
on policies

Yes Yes. Your 
projects

Yes. Your 
projects

Adding cloud accounts to vRealize Automation Cloud 
Assembly

Cloud accounts are the configured permissions that vRealize Automation Cloud Assembly uses to 
collect data from the regions or data centers, and to deploy blueprints to those regions.

The collected data includes the regions that you later associate with cloud zones.

When you later configure cloud zones, mappings, and profiles, you select the cloud account to 
which they are associated.

As a cloud administrator, you create cloud accounts for the projects in which team members 
work. Resource information such as network and security, compute, storage, and tags content is 
data-collected from your cloud accounts.

Note   If the cloud account has associated machines that have already been deployed in the 
region, you can bring those machines into vRealize Automation Cloud Assembly management 
by using an onboarding plan. See What are onboarding plans in vRealize Automation Cloud 
Assembly.

If you remove a cloud account that is used in a deployment, resources that are part of that 
deployment become unmanaged.

Credentials required for working with cloud accounts in vRealize 
Automation

To configure and work with cloud accounts in vRealize Automation, verify that you have the 
following credentials.

Using and Managing vRealize Automation Cloud Assembly
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Required cloud account credentials

To... You need...

Sign up 
for and 
log in to 
vRealize 
Automatio
n Cloud 
Assembly

A VMware ID.

n Set up a My VMware account by using your corporate email address.

Connect 
to 
vRealize 
Automatio
n services

HTTPS port 443 open to outgoing traffic with access through the firewall to:

n *.vmwareidentity.com

n gaz.csp-vidm-prod.com

n *.vmware.com

For more information about ports and protocols, see VMware Ports and Protocols.

For related information about required ports and protocols, see:

n Ports and Protocols in the Installation help

n Port Requirements in the Reference Architecture help

Using and Managing vRealize Automation Cloud Assembly
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To... You need...

Add an 
Amazon 
Web 
Services 
(AWS) 
cloud 
account

Provide a power user account with read and write privileges. The user account must be a member of the 
power access policy (PowerUserAccess) in the AWS Identity and Access Management (IAM) system.

n 20-digit Access Key ID and corresponding Secret Access Key

If you are using an external HTTP Internet proxy, it must be configured for IPv4.

vRealize Automation actions-based extensibility (ABX) and external IPAM integration may require 
additional permissions.

The following AWS permissions are suggested to allow autoscaling functions:

n Autoscaling actions:

n autoscaling:DescribeAutoScalingInstances

n autoscaling:AttachInstances

n autoscaling:DeleteLaunchConfiguration

n autoscaling:DescribeAutoScalingGroups

n autoscaling:CreateAutoScalingGroup

n autoscaling:UpdateAutoScalingGroup

n autoscaling:DeleteAutoScalingGroup

n autoscaling:DescribeLoadBalancers

n Autoscaling resources:

n *

Provide all autoscaling resource permissions.

The following permissions are required to allow AWS Security Token Service (AWS STS) functions to 
support temporary, limited-privilege credentials for AWS identity and access:

n AWS STS resources:

n *

Provide all STS resource permissions.

The following AWS permissions are required to allow EC2 functions:

n EC2 actions:

n ec2:AttachVolume

n ec2:AuthorizeSecurityGroupIngress

n ec2:DeleteSubnet

n ec2:DeleteSnapshot

n ec2:DescribeInstances

n ec2:DeleteTags

n ec2:DescribeRegions

n ec2:DescribeVolumesModifications

n ec2:CreateVpc

n ec2:DescribeSnapshots

n ec2:DescribeInternetGateways

n ec2:DeleteVolume

n ec2:DescribeNetworkInterfaces

n ec2:StartInstances

n ec2:DescribeAvailabilityZones

n ec2:CreateInternetGateway

n ec2:CreateSecurityGroup

n ec2:DescribeVolumes

Using and Managing vRealize Automation Cloud Assembly
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To... You need...

n ec2:CreateSnapshot

n ec2:ModifyInstanceAttribute

n ec2:DescribeRouteTables

n ec2:DescribeInstanceStatus

n ec2:DetachVolume

n ec2:RebootInstances

n ec2:AuthorizeSecurityGroupEgress

n ec2:ModifyVolume

n ec2:TerminateInstances

n ec2:DescribeSpotFleetRequestHistory

n ec2:DescribeTags

n ec2:CreateTags

n ec2:RunInstances

n ec2:DescribeNatGateways

n ec2:StopInstances

n ec2:DescribeSecurityGroups

n ec2:CreateVolume

n ec2:DescribeSpotFleetRequests

n ec2:DescribeImages

n ec2:DescribeVpcs

n ec2:DeleteSecurityGroup

n ec2:DeleteVpc

n ec2:CreateSubnet

n ec2:DescribeSubnets

n ec2:RequestSpotFleet

Note   The SpotFleet request permission is not required for vRealize Automation actions-based 
extensibility (ABX) or external IPAM integrations.

n EC2 resources:

n *

Provide all EC2 resource permissions.

The following AWS permissions are required to allow elastic load balancing functions:

n Load balancer actions:

n elasticloadbalancing:DeleteLoadBalancer

n elasticloadbalancing:DescribeLoadBalancers

n elasticloadbalancing:RemoveTags

n elasticloadbalancing:CreateLoadBalancer

n elasticloadbalancing:DescribeTags

n elasticloadbalancing:ConfigureHealthCheck

n elasticloadbalancing:AddTags

n elasticloadbalancing:CreateTargetGroup

n elasticloadbalancing:DeleteLoadBalancerListeners

n elasticloadbalancing:DeregisterInstancesFromLoadBalancer

n elasticloadbalancing:RegisterInstancesWithLoadBalancer

n elasticloadbalancing:CreateLoadBalancerListeners

Using and Managing vRealize Automation Cloud Assembly
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To... You need...

n Load balancer resources:

n *

Provide all load balancer resource permissions.

The following AWS Identity and Access Management (IAM) permissions can be enabled, however they are 
not required:

n iam:SimulateCustomPolicy

n iam:GetUser

n iam:ListUserPolicies

n iam:GetUserPolicy

n iam:ListAttachedUserPolicies

n iam:GetPolicyVersion

n iam:ListGroupsForUser

n iam:ListGroupPolicies

n iam:GetGroupPolicy

n iam:ListAttachedGroupPolicies

n iam:ListPolicyVersions

Using and Managing vRealize Automation Cloud Assembly
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To... You need...

Add a 
Microsoft 
Azure 
cloud 
account

Configure a Microsoft Azure instance and obtain a valid Microsoft Azure subscription from which you can 
use the subscription ID.

Create an Active Directory application as described in How to: Use the portal to create an Azure AD 
application and service principal that can access resources in Microsoft Azure product documentation.

If you are using an external HTTP Internet proxy, it must be configured for IPv4.

Make note of the following information:

n Subscription ID

Allows you to access to your Microsoft Azure subscriptions.

n Tenant ID

The authorization endpoint for the Active Directory applications you create in your Microsoft Azure 
account.

n Client application ID

Provides access to Microsoft Active Directory in your Microsoft Azure individual account.

n Client application secret key

The unique secret key generated to pair with your client application ID.

The following permissions are needed for creating and validating Microsoft Azure cloud accounts:

n Microsoft Compute

n Microsoft.Compute/virtualMachines/extensions/write

n Microsoft.Compute/virtualMachines/extensions/read

n Microsoft.Compute/virtualMachines/extensions/delete

n Microsoft.Compute/virtualMachines/deallocate/action

n Microsoft.Compute/virtualMachines/delete

n Microsoft.Compute/virtualMachines/powerOff/action

n Microsoft.Compute/virtualMachines/read

n Microsoft.Compute/virtualMachines/restart/action

n Microsoft.Compute/virtualMachines/start/action

n Microsoft.Compute/virtualMachines/write

n Microsoft.Compute/availabilitySets/write

n Microsoft.Compute/availabilitySets/read

n Microsoft.Compute/availabilitySets/delete

n Microsoft.Compute/disks/delete

n Microsoft.Compute/disks/read

n Microsoft.Compute/disks/write

n Microsoft Network

n Microsoft.Network/loadBalancers/backendAddressPools/join/action

n Microsoft.Network/loadBalancers/delete

n Microsoft.Network/loadBalancers/read

n Microsoft.Network/loadBalancers/write

n Microsoft.Network/networkInterfaces/join/action

n Microsoft.Network/networkInterfaces/read

n Microsoft.Network/networkInterfaces/write

n Microsoft.Network/networkInterfaces/delete

n Microsoft.Network/networkSecurityGroups/join/action

n Microsoft.Network/networkSecurityGroups/read
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To... You need...

n Microsoft.Network/networkSecurityGroups/write

n Microsoft.Network/networkSecurityGroups/delete

n Microsoft.Network/publicIPAddresses/delete

n Microsoft.Network/publicIPAddresses/join/action

n Microsoft.Network/publicIPAddresses/read

n Microsoft.Network/publicIPAddresses/write

n Microsoft.Network/virtualNetworks/read

n Microsoft.Network/virtualNetworks/subnets/delete

n Microsoft.Network/virtualNetworks/subnets/join/action

n Microsoft.Network/virtualNetworks/subnets/read

n Microsoft.Network/virtualNetworks/subnets/write

n Microsoft.Network/virtualNetworks/write

n Microsoft Resources

n Microsoft.Resources/subscriptions/resourcegroups/delete

n Microsoft.Resources/subscriptions/resourcegroups/read

n Microsoft.Resources/subscriptions/resourcegroups/write

n Microsoft Storage

n Microsoft.Storage/storageAccounts/delete

n Microsoft.Storage/storageAccounts/listKeys/action

n Microsoft.Storage/storageAccounts/read

n Microsoft.Storage/storageAccounts/write

n Microsoft Web

n Microsoft.Web/sites/read

n Microsoft.Web/sites/write

n Microsoft.Web/sites/delete

n Microsoft.Web/sites/config/read

n Microsoft.Web/sites/config/write

n Microsoft.Web/sites/config/list/action

n Microsoft.Web/sites/publishxml/action

n Microsoft.Web/serverfarms/write

n Microsoft.Web/serverfarms/delete

n Microsoft.Web/sites/hostruntime/functions/keys/read

n Microsoft.Web/sites/hostruntime/host/read

n Microsoft.web/sites/functions/masterkey/read

If you are using Microsoft Azure with action-based extensibility, the following permissions are required, in 
addition to the minimal permissions:

n Microsoft.Web/sites/read

n Microsoft.Web/sites/write

n Microsoft.Web/sites/delete

n Microsoft.Web/sites/config/read

n Microsoft.Web/sites/config/write

n Microsoft.Web/sites/config/list/action

n Microsoft.Web/sites/publishxml/action

n Microsoft.Web/serverfarms/write

n Microsoft.Web/serverfarms/delete
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To... You need...

n Microsoft.Web/sites/hostruntime/functions/keys/read

n Microsoft.Web/sites/hostruntime/host/read

n Microsoft.Web/sites/functions/masterkey/read

If you are using Microsoft Azure with action-based extensibility with extensions, the following permissions 
are also needed:

n Microsoft.Compute/virtualMachines/extensions/write

n Microsoft.Compute/virtualMachines/extensions/read

n Microsoft.Compute/virtualMachines/extensions/delete
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To... You need...

Add a 
Google 
Cloud 
Platform 
(GCP) 
cloud 
account

The Google Cloud Platform cloud account interacts with the Google Cloud Platform compute engine.

The Project Admin and Owner credentials are required for creating and validating Google Cloud Platform 
cloud accounts.

If you are using an external HTTP Internet proxy, it must be configured for IPv4.

The compute engine service must be enabled. When creating the cloud account in vRealize Automation, 
use the service account that was created when the compute engine was initialized.

The following compute engine permissions are also needed, depending on the actions that the user can 
take:

n roles/compute.admin

Provides full control of all compute engine resources.

n roles/iam.serviceAccountUser

Provides access to users who manage virtual machine instances that are configured to run as a service 
account. Grant access to the following resources and services:

n compute.*

n resourcemanager.projects.get

n resourcemanager.projects.list

n serviceusage.quotas.get

n serviceusage.services.get

n serviceusage.services.list

n roles/compute.imageUser

Provides permission to list and read images without having other permissions on the image. Granting 
the compute.imageUser role at the project level gives users the ability to list all images in the project. 
It also allows users to create resources, such as instances and persistent disks, based on images in the 
project.

n compute.images.get

n compute.images.getFromFamily

n compute.images.list

n compute.images.useReadOnly

n resourcemanager.projects.get

n resourcemanager.projects.list

n serviceusage.quotas.get

n serviceusage.services.get

n serviceusage.services.list

n roles/compute.instanceAdmin

Provides permissions to create, modify, and delete virtual machine instances. This includes permissions 
to create, modify, and delete disks, and also to configure shielded VMBETA settings.

For users that manage virtual machine instances (but not network or security settings or instances 
that run as service accounts), grant this role to the organization, folder, or project that contains the 
instances, or to the individual instances.

Users that manage virtual machine instances that are configured to run as a service account also need 
the roles/iam.serviceAccountUser role.

n compute.acceleratorTypes

n compute.addresses.get

n compute.addresses.list

n compute.addresses.use
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To... You need...

n compute.autoscalers

n compute.diskTypes

n compute.disks.create

n compute.disks.createSnapshot

n compute.disks.delete

n compute.disks.get

n compute.disks.list

n compute.disks.resize

n compute.disks.setLabels

n compute.disks.update

n compute.disks.use

n compute.disks.useReadOnly

n compute.globalAddresses.get

n compute.globalAddresses.list

n compute.globalAddresses.use

n compute.globalOperations.get

n compute.globalOperations.list

n compute.images.get

n compute.images.getFromFamily

n compute.images.list

n compute.images.useReadOnly

n compute.instanceGroupManagers

n compute.instanceGroups

n compute.instanceTemplates

n compute.instances

n compute.licenses.get

n compute.licenses.list

n compute.machineTypes

n compute.networkEndpointGroups

n compute.networks.get

n compute.networks.list

n compute.networks.use

n compute.networks.useExternalIp

n compute.projects.get

n compute.regionOperations.get

n compute.regionOperations.list

n compute.regions

n compute.reservations.get

n compute.reservations.list

n compute.subnetworks.get

n compute.subnetworks.list

n compute.subnetworks.use

n compute.subnetworks.useExternalIp

n compute.targetPools.get

n compute.targetPools.list
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n compute.zoneOperations.get

n compute.zoneOperations.list

n compute.zones

n resourcemanager.projects.get

n resourcemanager.projects.list

n serviceusage.quotas.get

n serviceusage.services.get

n serviceusage.services.list

n roles/compute.instanceAdmin.v1

Provides full control of compute engine instances, instance groups, disks, snapshots, and images. Also 
provides read access to all compute engine networking resources.

Note   If you grant a user this role at the instance level, that user cannot create new instances.

n compute.acceleratorTypes

n compute.addresses.get

n compute.addresses.list

n compute.addresses.use

n compute.autoscalers

n compute.backendBuckets.get

n compute.backendBuckets.list

n compute.backendServices.get

n compute.backendServices.list

n compute.diskTypes

n compute.disks

n compute.firewalls.get

n compute.firewalls.list

n compute.forwardingRules.get

n compute.forwardingRules.list

n compute.globalAddresses.get

n compute.globalAddresses.list

n compute.globalAddresses.use

n compute.globalForwardingRules.get

n compute.globalForwardingRules.list

n compute.globalOperations.get

n compute.globalOperations.list

n compute.healthChecks.get

n compute.healthChecks.list

n compute.httpHealthChecks.get

n compute.httpHealthChecks.list

n compute.httpsHealthChecks.get

n compute.httpsHealthChecks.list

n compute.images

n compute.instanceGroupManagers

n compute.instanceGroups

n compute.instanceTemplates

Using and Managing vRealize Automation Cloud Assembly

VMware, Inc. 28



To... You need...

n compute.instances

n compute.interconnectAttachments.get

n compute.interconnectAttachments.list

n compute.interconnectLocations

n compute.interconnects.get

n compute.interconnects.list

n compute.licenseCodes

n compute.licenses

n compute.machineTypes

n compute.networkEndpointGroups

n compute.networks.get

n compute.networks.list

n compute.networks.use

n compute.networks.useExternalIp

n compute.projects.get

n compute.projects.setCommonInstanceMetadata

n compute.regionBackendServices.get

n compute.regionBackendServices.list

n compute.regionOperations.get

n compute.regionOperations.list

n compute.regions

n compute.reservations.get

n compute.reservations.list

n compute.resourcePolicies

n compute.routers.get

n compute.routers.list

n compute.routes.get

n compute.routes.list

n compute.snapshots

n compute.sslCertificates.get

n compute.sslCertificates.list

n compute.sslPolicies.get

n compute.sslPolicies.list

n compute.sslPolicies.listAvailableFeatures

n compute.subnetworks.get

n compute.subnetworks.list

n compute.subnetworks.use

n compute.subnetworks.useExternalIp

n compute.targetHttpProxies.get

n compute.targetHttpProxies.list

n compute.targetHttpsProxies.get

n compute.targetHttpsProxies.list

n compute.targetInstances.get

n compute.targetInstances.list

n compute.targetPools.get
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n compute.targetPools.list

n compute.targetSslProxies.get

n compute.targetSslProxies.list

n compute.targetTcpProxies.get

n compute.targetTcpProxies.list

n compute.targetVpnGateways.get

n compute.targetVpnGateways.list

n compute.urlMaps.get

n compute.urlMaps.list

n compute.vpnTunnels.get

n compute.vpnTunnels.list

n compute.zoneOperations.get

n compute.zoneOperations.list

n compute.zones

n resourcemanager.projects.get

n resourcemanager.projects.list

n serviceusage.quotas.get

n serviceusage.services.get

n serviceusage.services.list

Add an 
NSX-T 
cloud 
account

Provide an account with the following read and write privileges:

n NSX-T Enterprise Administrator role and access credentials

n NSX-T IP address or FQDN

Administrators also require access to the vCenter Server as described in the following vSphere agent 
requirements for vCenter-based cloud accounts section on this page.

Add an 
NSX-V 
cloud 
account

Provide an account with the following read and write privileges:

n NSX-V Enterprise Administrator role and access credentials

n NSX-V IP address or FQDN

Administrators also require access to the vCenter Server as described in the following vSphere agent 
requirements for vCenter-based cloud accounts section on this page.
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Add a 
vCenter 
cloud 
account

Provide an account with the following read and write privileges:

n vCenter IP address or FQDN

Administrators also require access to the vCenter Server as described in the following vSphere agent 
requirements for vCenter-based cloud accounts section on this page.

Add a 
VMware 
Cloud on 
AWS 
(VMC) 
cloud 
account

Provide an account with the following read and write privileges:

n The cloudadmin@vmc.local account or any user account in the CloudAdmin group

n NSX Enterprise Administrator role and access credentials

n NSX Cloud Admin access to your organization's VMware Cloud on AWS SDDC environment

n Administrator access to your organization's VMware Cloud on AWS SDDC environment

n The VMware Cloud on AWS API token for your VMware Cloud on AWS environment in your 
organization's VMware Cloud on AWS service

n vCenter IP address or FQDN

Administrators also require access to the vCenter that is used by your target VMware Cloud on AWS SDDC 
that has all the permissions listed in the following vSphere agent requirements for vCenter-based cloud 
accounts section on this page.

For more information about the permissions needed to create and use VMware Cloud on AWS cloud 
accounts, see Managing the VMware Cloud on AWS Data Center in VMware Cloud on AWS product 
documentation.

vSphere agent requirements for vCenter-based cloud accounts

The following table lists the permissions needed to manage VMware Cloud on AWS and vCenter 
cloud accounts. The permissions must be enabled for all clusters in the vCenter Server, not just 
clusters that host endpoints.

For all vCenter Server-based cloud accounts - including NSX-V, NSX-T, vCenter, and VMware 
Cloud on AWS - the administrator must have vSphere endpoint credentials, or the credentials 
under which the agent service runs in vCenter, that provide administrative access to the host 
vCenter Server.

For more information about vSphere agent requirements, see VMware vSphere product 
documentation.

Table 2-3. Permissions Required for vSphere Agent to Manage vCenter Server Instance

Attribute Value Permission

Datastore n Allocate space

n Browse datastore

n Low level file operations

Datastore Cluster Configure a datastore cluster

Folder n Create folder

n Delete folder

Global n Manage custom attributes

n Set custom attribute

Network Assign network
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Table 2-3. Permissions Required for vSphere Agent to Manage vCenter Server Instance 
(continued)

Attribute Value Permission

Permissions Modify permission

Resource n Assign VM to Res Pool

n Migrate powered off virtual machine

n Migrate powered on virtual machine

Content Library To assign a permission on a content library, an administrator 
must grant the permission to the user as a global permission. For 
related information, see Hierarchical Inheritance of Permissions 
for Content Libraries in vSphere Virtual Machine Administration 
at VMware vSphere Documentation.

n Add library item

n Create local library

n Create subscribed library

n Delete library item

n Delete local library

n Delete subscribed library

n Download files

n Evict library item

n Evict subscribed library

n Probe subscription information

n Read storage

n Sync library item

n Sync subscribed library

n Type introspection

n Update configuration settings

n Update files

n Update library

n Update library item

n Update local library

n Update subscribed library

n View configuration settings

Tags n Assign or unassign vSphere tag

n Create a vSphere tag

n Create a vSphere tag category

n Delete vSphere tag

n Delete vSphere tag category

n Edit vSphere tag

n Edit vSphere tag category

n Modify UsedBy field for category

n Modify UsedBy field for tag
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Table 2-3. Permissions Required for vSphere Agent to Manage vCenter Server Instance 
(continued)

Attribute Value Permission

vApp n Import

n vApp application configuration

The vApp.Import application configuration is required for OVF 

templates and to provision VMs from the content library.

The vApp.vApp application configuration is required when using 

cloud-init for cloud configuration scripting. This setting allows for 
modification of a vApp's internal structure, such as its product 
information and properties.

Virtual Machine - Inventory n Create from existing

n Create new

n Move

n Remove

Virtual Machine - Interaction n Configure CD media

n Console interaction

n Device connection

n Power off

n Power on

n Reset

n Suspend

n Tools install

Virtual Machine - Configuration n Add existing disk

n Add new disk

n Remove disk

n Advanced

n Change CPU count

n Change resource

n Extend virtual disk

n Disk change tracking

n Memory

n Modify device settings

n Rename

n Set annotation

n Settings

n Swapfile placement

Virtual Machine - Provisioning n Customize

n Clone template

n Clone virtual machine

n Deploy template

n Read customization specs

Virtual Machine - State n Create snapshot

n Remove snapshot

n Revert to snapshot
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Configure Microsoft Azure for use with vRealize Automation Cloud Assembly

You must gather some information and perform some configuration in order to create a Microsoft 
Azure cloud account in vRealize Automation Cloud Assembly.

Procedure

1 Locate and record your Microsoft Azure subscription and tenant IDs.

n Subscription ID - Click the Subscriptions icon on the left toolbar in your Azure portal to 
view the subscription ID.

n Tenant ID - Click the Help icon and select Show Diagnostics in your Azure portal. Search 
for tenant and record the ID when you have located it.

2 You can create a new storage account and a resource group to get started. Alternatively, you 
can create these in blueprints later.

n Storage Account - Use the following procedure to configure an account.

1 In your Azure portal, locate the Storage Accounts icon on the sidebar. Make sure the 
correct subscription is selected and click Add. You can also, search for storage account 
in the Azure search field.

2 Enter the required information for the storage account. You will need your subscription 
ID.

3 Select whether to use an existing resource group or create a new one. Make note of 
your resource group name, as you will need it later.

Note   Save the location of your storage account as you will need it later.

3 Create a virtual network. Alternatively, if you have a suitable existing network, you can select 
that one.

If you are creating a network, you must select Use an Existing Resource Group and specify the 
group that you created in the preceding step. Also, select the same location that you specified 
previously. Microsoft Azure will not deploy virtual machines or other objects if the location 
doesn't match between all applicable components that the object will consume.

a Locate the Virtual Network icon on the left panel and click it or search for virtual network. 
Make sure to select the correct subscription and click Add.

b Enter a unique name for your new virtual network and record it for later.

c Enter the appropriate IP address for your virtual network in the Address space field.

d Ensure that the correct subscription is selected and click Add.

e Enter the remaining basic configuration information.

f You can modify the other options as necessary, but for most configurations, you can leave 
the defaults.

g Click Create.
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4 Set up an Azure Active Directory application so that vRA can authenticate.

a Locate the Active Directory icon on the Azure left menu and click it.

b Click App Registrations and select Add.

c Type a name for your application that complies with Azure name validation.

d Leave Web app/API as the Application Type.

e The Sign-on URL can be anything that is appropriate for your usage.

f Click Create.

5 Create a secret key to authenticate the application in Cloud Assembly.

a Click the name of your application in Azure.

Make note of your Application ID for later use.

b Click All Settings in the next pane and select Keys from the settings list.

c Enter a description for the new key and choose a duration.

d Click Save and make sure to copy the key value to a safe location as you will be unable to 
retrieve it later.

e On the left menu, select API Permissions for the application and click Add a Permission to 
create a new permission.

f Select Azure Service Management on the Select an API page.

g Click Delegated Permissions.

h Under Select permissions select user_impersonation and then click Add Permissions.

6 Authorize your Active Directory application to connect to your Azure subscription so that you 
can deploy and manage virtual machines.

a In the left menu, click the Subscriptions icon, and select your new subscription.

You may need to click on the text of the name to get the panel to slide over.

b Select the Access control (IAM) option to see the permissions to your subscription.

c Click Add under the Add a Role Assignment heading.

d Choose Contributor from the Role drop down.

e Leave the default selection in the Assign Access to drop down.

f Type the name of your application in the Select box.

g Click Save.

h Add additional roles so that your new application has Owner, Contributor, and Reader 
roles.

i Click the Save.
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What to do next

You must install the Microsoft Azure command line interface tools. These tools are freely available 
for both Windows and Mac operating systems. See the Microsoft documentation for more 
information about downloading and installing these tools.

When you have the command line interface installed, you must authenticate to your new 
subscription.

1 Open a terminal window and type your Microsoft Azure login. You will receive a URL and a 
shortcode that will allow you to authenticate.

2 In a browser, enter the code that you received from the application on your device.

3 Enter your Auth Code and click Continue.

4 Select your Azure account and login.

If you have multiple subscriptions, ensure that the correct one is selected using the azure 
account set <subscription-name> command.

5 Before you proceed, you must register the Microsoft.Compute provider to your new Azure 
subscription using the azure provider register microsoft.compute command.

If the command times out and generates an error the first time your run it, run it again.

When you have completed configuration, you can use the azure vm image list command to 

retrieve available virtual machine image names. You can choose the desired image and record the 
URN provided for it and later use it in blueprints.

Create a Microsoft Azure cloud account in vRealize Automation

As a cloud administrator, you can create a Microsoft Azure cloud account for account regions to 
which your team will deploy vRealize Automation blueprints.

To view an example use case of how Microsoft Azure cloud account works in vRealize Automation 
see The WordPress use case.

Prerequisites

n Verify that you have the required administrator credentials and have enabled HTTPS access on 
port 443. See Credentials required for working with cloud accounts in vRealize Automation.

n Verify that you have the required user role. See What are the vRealize Automation Cloud 
Assembly user roles.

n Configure a Microsoft Azure account for use with vRealize Automation. See Configure 
Microsoft Azure for use with vRealize Automation Cloud Assembly.

n If you do not have external Internet access, configure an Internet server proxy. See How do I 
configure an Internet proxy server for vRealize Automation.

Procedure

1 Select Infrastructure > Connections > Cloud Accounts and click Add Cloud Account.
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2 Select the Microsoft Azure account type and enter credentials and other values.

3 Click Validate.

The account regions associated with the account are collected.

4 Select the regions to which you want to provision this resource.

5 For efficiency, click Create a Cloud zone for the selected regions.

6 If you need to add tags to support a tagging strategy, enter capability tags. See How do I 
use tags to manage vRealize Automation Cloud Assembly resources and deployments and 
Creating a Tagging Strategy.

7 Click Save.

Results

The account is added to vRealize Automation, and the selected regions are available for the 
specified cloud zone.

What to do next

Create infrastructure resources for this cloud account.

Create an Amazon Web Services cloud account in vRealize 
Automation

As a cloud administrator, you can create an Amazon Web Services (AWS) cloud account for 
account regions to which your team will deploy vRealize Automation blueprints.

For authorized users, AWS cloud accounts support access to the AWS GovCloud configuration. 
This configuration supports most of the standard vRealize Automation cloud account functionality 
with regard to project configuration, tags, and infrastructure. In blueprints, it does support use of 
AWS Platform as a Service (PaaS) properties.

The following procedure describes how to configure an AWS cloud account.

Prerequisites

n Verify that you have the required administrator credentials and have enabled HTTPS access on 
port 443. See Credentials required for working with cloud accounts in vRealize Automation.

n Verify that you have the required user role. See What are the vRealize Automation Cloud 
Assembly user roles.

n Verify that you have required AWS administrator credentials.

n If you do not have external Internet access, configure an Internet server proxy. See How do I 
configure an Internet proxy server for vRealize Automation.

Procedure

1 Select Infrastructure > Connections > Cloud Accounts and click Add Cloud Account.
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2 Select the AWS account type, and enter credentials and other values.

3 Click Validate.

The account regions associated with the account are collected.

4 Select the regions to which you want to provision this resource.

5 For efficiency, click Create a Cloud zone for the selected regions.

6 If you need to add tags to support a tagging strategy, enter capability tags. See How do I 
use tags to manage vRealize Automation Cloud Assembly resources and deployments and 
Creating a Tagging Strategy.

7 Click Add.

Results

The account is added to vRealize Automation, and the selected regions are available for the 
specified cloud zone.

What to do next

Configure infrastructure resources for this cloud account.

Create a Google Cloud Platform cloud account in vRealize 
Automation

As a cloud administrator, you can create a Google Cloud Platform (GCP) cloud account for account 
regions to which your team will deploy vRealize Automation blueprints.

Prerequisites

n Verify that you have the required administrator credentials and have enabled HTTPS access on 
port 443. See Credentials required for working with cloud accounts in vRealize Automation.

n Verify that you have the required user role. See What are the vRealize Automation Cloud 
Assembly user roles.

n Verify that you have access to the Google Cloud Platform JSON security key.

n Verify that you have required security information for your Google Cloud Platform instance. 
You can obtain most of this information from your instance or from the Google documentation.

n If you do not have external Internet access, configure an Internet server proxy. See How do I 
configure an Internet proxy server for vRealize Automation.

Procedure

1 Select Infrastructure > Connections > Cloud Accounts and click Add Cloud Account.
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2 Select the Google Cloud Platform account type and enter the appropriate credentials and 
related information. Use the service account that was created when the source GCP account 
compute engine was initialized.

As noted in the Prerequisites section above, credential requirements are available at 
Credentials required for working with cloud accounts in vRealize Automation. To successfully 
create the cloud account in vRealize Automation, the source GCP account must have the 
compute engine service enabled.

In vRealize Automation, the project ID is part of the Google Cloud Platform endpoint. You 
specify it when you create the cloud account. During data collection of project-specific private 
images, the vRealize Automation GCP adapter queries the Google Cloud Platform API.

3 Click Validate.

The account regions associated with the account are collected.

4 Select the regions to which you want to provision this resource.

5 For efficiency, click Create a Cloud zone for the selected regions.

6 If you need tags to support a tagging strategy, enter capability tags. See How do I use tags 
to manage vRealize Automation Cloud Assembly resources and deployments and Creating a 
Tagging Strategy.

7 Click Add.

Results

The account is added to vRealize Automation, and the selected regions are available for the 
specified cloud zone.

What to do next

Create infrastructure resources for this cloud account.

Create a vCenter cloud account in vRealize Automation

You add a vCenter cloud account for the account regions that you want to deploy vRealize 
Automation blueprints to.

For network and security purposes, you can associate an NSX-T or NSX-V cloud account with the 
vCenter cloud account.

Prerequisites

n Verify that you have the required administrator credentials and have enabled HTTPS access on 
port 443. See Credentials required for working with cloud accounts in vRealize Automation.

n Verify that you have the cloud administrator user role. See What are the vRealize Automation 
Cloud Assembly user roles.
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n Verify that you have properly configured your ports and protocols to support the cloud 
account. See the Ports and Protocols for vRealize Automation topic in Installing vRealize 
Automation with vRealize Easy Installer and the Port Requirements topic in vRealize 
Automation Reference Architecture Guide in the vRealize Automation product documentation.

Procedure

1 Select Infrastructure > Connections > Cloud Accounts and click Add Cloud Account.

2 Select the vCenter account type and enter the vCenter Server host IP address.

3 Enter your vCenter Server administrator credentials and click Validate.

All data centers that are associated with the account are data-collected. The following 
elements are data-collected, as are all vSphere tags for the following elements:

n Machines

n Clusters and hosts

n Port groups

n Data stores

4 Select at least one of the available data centers on the specified vCenter Server to allow 
provisioning for this cloud account.

5 For efficiency, create a cloud zone for provisioning to the selected data centers.

You can also create cloud zones as a separate step according to your organization's cloud 
strategy.

For information about cloud zones, see Learn more about vRealize Automation Cloud 
Assembly cloud zones.

6 Select an existing NSX cloud account.

You can select the NSX account now, or later when you edit the cloud account.

For information about NSX-V cloud accounts, see Create an NSX-V cloud account in vRealize 
Automation Cloud Assembly.

For information about NSX-T cloud accounts, see Create an NSX-T cloud account in vRealize 
Automation Cloud Assembly.

7 If you want to add tags to support a tagging strategy, enter capability tags.

You can add tags now, or later when you edit the cloud account. For information about 
tagging, see How do I use tags to manage vRealize Automation Cloud Assembly resources and 
deployments.

8 Click Save.
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Results

The cloud account is added and the selected data centers are available for the specified cloud 
zone. Collected data such as machines, networks, storage, and volumes is listed in the Resources 
section of the Infrastructure tab.

What to do next

Configure remaining infrastructure resources for this cloud account. See Chapter 4 Building your 
vRealize Automation Cloud Assembly resource infrastructure.

Create an NSX-V cloud account in vRealize Automation Cloud 
Assembly

For network and security purposes, you can create and associate an NSX-V cloud account with a 
vCenter cloud account.

Prerequisites

n Verify that you have the required administrator credentials and have enabled HTTPS access on 
port 443. See Credentials required for working with cloud accounts in vRealize Automation.

n Verify that you have the cloud administrator user role. See What are the vRealize Automation 
Cloud Assembly user roles.

n Verify that you have a vCenter cloud account to use with this NSX cloud account. See Create a 
vCenter cloud account in vRealize Automation.

n Verify that you have properly configured your ports and protocols to support the cloud 
account. See the Ports and Protocols for vRealize Automation topic in Installing vRealize 
Automation with vRealize Easy Installer and the Port Requirements topic in vRealize 
Automation Reference Architecture Guide in the vRealize Automation product documentation.

Procedure

1 Select Infrastructure > Connections > Cloud Accounts and click Add Cloud Account.

2 Select the NSX-V account type and enter the NSX-V host IP address.

3 Enter your NSX administrator credentials and click Validate.

The assets associated with the account are collected.

If the NSX host IP address is not available, validation fails.

4 If available, select the vCenter endpoint that represents the vCenter cloud account that you are 
associating with this NSX-V account.

5 If you want to add tags to support a tagging strategy, enter capability tags.

You can add or remove capability tags later. See How do I use tags to manage vRealize 
Automation Cloud Assembly resources and deployments.

6 Click Save.
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What to do next

You can create or edit a vCenter cloud account and associate it with this NSX cloud account. See 
Create a vCenter cloud account in vRealize Automation.

Create and configure one or more cloud zones for use with the data centers that are used by this 
cloud account. See Learn more about vRealize Automation Cloud Assembly cloud zones.

Configure infrastructure resources for this cloud account. See Chapter 4 Building your vRealize 
Automation Cloud Assembly resource infrastructure.

Create an NSX-T cloud account in vRealize Automation Cloud 
Assembly

For network and security purposes, you can create and associate an NSX-T cloud account with a 
vCenter cloud account.

To facilitate fault tolerance and high availability in deployments, each NSX-T data center endpoint 
represents a cluster of three NSX managers.

n vRealize Automation can point to one of the NSX managers. With this option, one NSX 
manager receives the API calls from vRealize Automation.

n vRealize Automation can point to the Virtual IP of the cluster. With this option, one NSX 
manager assumes control of the VIP. That manager receives the API calls from vRealize 
Automation. In case of failure, another node in the cluster assumes control of the VIP and 
receives the API calls from vRealize Automation.

For more information about VIP configuration, see Configure a Virtual IP (VIP) Address 
for a Cluster in the NSX-T Data Center Installation Guide at VMware NSX-T Data Center 
Documentation.

n vRealize Automation can point to a load balancer VIP to load-balance the calls to the three 
NSX managers. Using this option, all three NSX managers receive API calls from vRealize 
Automation.

You can configure the VIP on a third-party load balancer or on an NSX-T load balancer.

For large scale environments, consider using this option to split the vRealize Automation API 
calls among the three NSX managers.

Prerequisites

n Verify that you have the required administrator credentials and have enabled HTTPS access on 
port 443. See Credentials required for working with cloud accounts in vRealize Automation.

n Verify that you have the cloud administrator user role. See What are the vRealize Automation 
Cloud Assembly user roles.

n Verify that you have a vCenter cloud account to use with this NSX cloud account. See Create a 
vCenter cloud account in vRealize Automation.
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n Verify that you have properly configured your ports and protocols to support the cloud 
account. See the Ports and Protocols for vRealize Automation topic in Installing vRealize 
Automation with vRealize Easy Installer and the Port Requirements topic in vRealize 
Automation Reference Architecture Guide in the vRealize Automation product documentation.

Procedure

1 Select Infrastructure > Connections > Cloud Accounts and click Add Cloud Account.

2 Select the NSX-T account type and enter the host IP address for the NSX-T endpoint manager 
instance or VIP (see above).

3 Enter your NSX administrator credentials and click Validate.

The assets associated with the account are collected.

If the NSX host IP address is not available, validation fails.

4 If available, select the vCenter endpoint that represents the vCenter cloud account that you are 
associating with this NSX-T cloud account.

5 If you want to add tags to support a tagging strategy, enter capability tags.

You can add or remove capability tags later. See How do I use tags to manage vRealize 
Automation Cloud Assembly resources and deployments.

6 Click Save.

What to do next

You can create or edit a vCenter cloud account to associate with this NSX cloud account. See 
Create a vCenter cloud account in vRealize Automation.

Create and configure one or more cloud zones for use with the data centers that are used by this 
cloud account. See Learn more about vRealize Automation Cloud Assembly cloud zones.

Configure infrastructure resources for this cloud account. See Chapter 4 Building your vRealize 
Automation Cloud Assembly resource infrastructure.

Create a VMware Cloud on AWS cloud account in vRealize 
Automation

As a cloud administrator, you can create a VMware Cloud on AWS cloud account for account 
regions to which your team will deploy vRealize Automation blueprints.

VMware Cloud on AWS requires some unique configuration procedures in vRealize Automation. 
To properly configure vRealize Automation for VMware Cloud on AWS, including setting an API 
token values for the cloud account and setting gateway firewall rules for its cloud proxy, see the 
VMware Cloud on AWS use case workflow.
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Prerequisites

n Verify that you have the required VMware Cloud on AWS administrator credentials, including 
VMware Cloud on AWS CloudAdmin credentials for the target SDDC in vCenter and that you 
have enabled HTTPS access on port 443. See Credentials required for working with cloud 
accounts in vRealize Automation.

n Verify that you have the cloud administrator user role. See What are the vRealize Automation 
Cloud Assembly user roles.

n If you do not have external Internet access, configure an Internet server proxy. See How do I 
configure an Internet proxy server for vRealize Automation.

n Verify that you have configured needed access and firewall rules in the SDDC. See Prepare 
your VMware Cloud on AWS SDDC to connect with VMware Cloud on AWS cloud accounts in 
vRealize Automation.

Procedure

1 Select Infrastructure > Connections > Cloud Accounts, click Add Cloud Account and select 
the VMware Cloud on AWS account type.

2 Add the VMC API token for your organization to access the available SDDCs.

You can create a new token or use an existing token for your organization on the linked API 
Tokens page. For details, see Create a VMware Cloud on AWS cloud account in vRealize 
Automation within a sample workflow.

3 Select the SDDC to be available for deployments.

NSX-V SDDCs are not supported and do not appear in the list.

The vCenter and NSX-T Manager IP address/FQDN values are automatically populated based 
on the SDDC.

4 Enter your vCenter user name and password for the specified SDDC if other than the default 
value of cloudadmin@vmc.local.

5 Click Validate to confirm your access rights to the specified vCenter and check that the 
vCenter is running.

The data centers associated with the account are collected.

6 For efficiency, create a cloud zone for provisioning to the selected SDDC.

You can also create cloud zones as a separate step according to your organization's cloud 
strategy.

7 If you need to add tags to support a tagging strategy, enter capability tags.

You can add or remove capability tags later. See How do I use tags to manage vRealize 
Automation Cloud Assembly resources and deployments.

8 Click Save.
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Results

The cloud account is added and the selected SDDC is available for the specified cloud zone.

What to do next

To properly configure vRealize Automation for VMware Cloud on AWS, see VMware Cloud on 
AWS use case .

For related information about VMware Cloud on AWS outside of vRealize Automation, see 
VMware Cloud on AWS documentation.

Integrating vRealize Automation with other applications

Integrations enable you to add external systems to vRealize Automation.

Integrations include vRealize Orchestrator, configuration management and other external systems 
such as GitHub, Ansible, Puppet, and external IPAM providers such as Infoblox.

Note   If you do not have external Internet access and your integration requires it, you can 
configure an Internet server proxy. See How do I configure an Internet proxy server for vRealize 
Automation.

How do I use Git integration in vRealize Automation Cloud Assembly

vRealize Automation Cloud Assembly supports integration with GitLab, GitHub, and BitBucket 
repositories so that you can manage blueprints and action scripts under source control. This 
functionality facilitates auditing and accountability of processes around deployment.

vRealize Automation Cloud Assembly offers three different flavors of Git integration: GitLab, 
GitHub, and BitBucket. Each of these options is a separate integration.

You must have an appropriate local Git repository configured with access for all designated users 
in order to set up Git integration with vRealize Automation Cloud Assembly. Also, you must save 
your blueprints in a specific structure in order for them to be detected by Git. To create an 
integration with GitLab or GitHub, select Infrastructure > Connections > Integrations in vRealize 
Automation Cloud Assembly and then make the appropriate selection. You will need the url and 
token for the target repository.

When Git integration is configured with an existing repository, all blueprints associated with 
selected projects become available to qualified users. You can use these blueprints with an 
existing deployment or as the basis of a new deployment. When you add a project, you must 
select some properties regarding where and how it is stored in Git.
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You can save actions to a Git repository directly from vRealize Automation Cloud Assembly. You 
can version action scripts either directly to Git, or you can create versions in vRealize Automation 
Cloud Assembly. If you create a version of an action in vRealize Automation Cloud Assembly, then 
it is automatically saved to Git as a version. Blueprints are a bit more complicated, because you 
cannot directly add them to a Git integration from vRealize Automation Cloud Assembly. You must 
save them directly to a Git instance, and then you can retrieve them from Git when working with 
the blueprint management page in vRealize Automation Cloud Assembly.

Before you Begin

You must create and save your blueprints in a specific structure in order for them to be detected 
by GitLab or GitHub.

n Configure and store Blueprints to be integrated with GitLab correctly. Only valid blueprint are 
imported into GitLab.

n Create one or more designated folders for the blueprints.

n All blueprints must be stored within blueprint.yaml files.

n Ensure that the top of your blueprints include the name: and version: properties.

n Extract an API key for the applicable repository. In your Git account, select your login in the 
upper right corner, and navigate to the Settings menu. Select Access Tokens, then name your 
token, set an expiration date. Then, select API and create the token. Copy the resulting value 
and save it.

The following guidelines must be observed for all blueprints used with Git integration.

n Each blueprint must reside in a separate folder.

n All blueprints must be named blueprint.yaml.

n All blueprint YAML files must use name and version fields.

n Only valid blueprint are imported.

n If you update a draft blueprint imported from Git, and its content differs from that in the top 
version, the draft will not be updated in subsequent syncs and a new version is created. If you 
want to update a blueprint and also allow further sync's from Git, then you must create a new 
version after final changes.

n Configure GitLab blueprint integration in vRealize Automation Cloud Assembly

This procedure demonstrates configuring GitLab integration in vRealize Automation Cloud 
Assembly so that you can work with blueprints in the repository and automatically download 
saved blueprints that are associated with designated projects. To use blueprints with GitLab, 
you must create a connection to an appropriate GitLab instance, and then save the desired 
blueprints to that instance.

n Configure GitHub integration in vRealize Automation Cloud Assembly

You can integrate the GitHub cloud-based repository hosting service in vRealize Automation 
Cloud Assembly
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Configure GitLab blueprint integration in vRealize Automation Cloud Assembly

This procedure demonstrates configuring GitLab integration in vRealize Automation Cloud 
Assembly so that you can work with blueprints in the repository and automatically download saved 
blueprints that are associated with designated projects. To use blueprints with GitLab, you must 
create a connection to an appropriate GitLab instance, and then save the desired blueprints to that 
instance.

When GitLab integration is configured with an existing repository, all blueprints associated with 
selected projects become available to qualified users. You can use these blueprints with an 
existing deployment or as the basis of a new deployment. When you add a project, you must 
select some properties regarding where and how it is stored in GitLab.

Note   You cannot push new or updated blueprints to the Git repository from vRealize 
Automation Cloud Assembly. Also, you cannot push new blueprints to the repository from 
vRealize Automation Cloud Assembly. To add blueprints to a repository, developers must use 
the Git interface.

If you update a draft blueprint imported from Git, and its content differs from that in the top 
version, the draft will not be updated in subsequent syncs and a new version is created. If you 
want to update a blueprint and also allow further sync's from Git, then you must create a new 
version after final changes.

After you set up your blueprints for use with GitLab and collect required information, you must 
set up integration with your GitLab instance. Then, you can import the designated blueprints 
into GitLab. You can view a video demonstration of this procedure at https://www.youtube.com/
watch?v=h0vqo63Sdgg.

Prerequisites

n Extract an API key for the applicable repository. In your GitLab account, select your login in 
the upper right corner, and navigate to the Settings menu. Select Access Tokens, then name 
your token, set an expiration date. Then, select API and create the token. Copy the resulting 
value and save it.

You must have an appropriate local Git repository configured with access for all designated users 
in order to set up Git integration with vRealize Automation Cloud Assembly. Also, you must create 
and save your blueprints in a specific structure in order for them to be detected by GitLab.

n Configure and store Blueprints to be integrated with GitLab correctly. Only valid blueprint 
are imported into GitLab. See How do I use Git integration in vRealize Automation Cloud 
Assembly.

Procedure

1 Set up integration with your GitLab environment in vRealize Automation Cloud Assembly.

a Select Infrastructure > Integrations > Add New and choose GitLab.

b Enter the URL for your GitLab instance. For a software as a service GitLab instance, in 
most cases, it will be gitlab.com.
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c Enter the Token, also known as an API key, for the specified GitLab instance. See the 
prerequisites above for information about extracting the token from your GitLab instance.

d Add an appropriate Name and Description.

e Click Validate to verify the connection.

f Add capability tags if desired. See Using capability tags in vRealize Automation Cloud 
Assembly for more information.

g Click Add.

2 Configure the GitLab connection to accept blueprints in an appropriate repository.

a Select Infrastructure > Integrations and choose the appropriate GitLab integration.

b Select Projects.

c Select New Project and create a name for the project.

d Enter the Repository path within GitLab. Typically, this is the user name of the main 
account appended to the repository name.

e Enter the appropriate GitLab Branch that you want to use.

f If applicable, enter a Folder name. If left blank, all folders are available.

g Enter an appropriate Type. If applicable, enter a folder name. If left blank, all folders are 
available.

h Click Next to finish adding the repository.

When you click Next, an automated synchronization task is initiated that imports blueprints 
into the platform.

When the synchronization tasks are complete, a message indicates that the blueprints 
have been imported.

Results

You can now retrieve blueprints from GitLab.

Configure GitHub integration in vRealize Automation Cloud Assembly

You can integrate the GitHub cloud-based repository hosting service in vRealize Automation 
Cloud Assembly

You need a valid GitHub token to configure GitHub integration in vRealize Automation Cloud 
Assembly See the GitHub documentation for information about creating and locating your token.

Prerequisites

n You must have access to GitHub.

n Configure and store Blueprints to be integrated with GitHub correctly. Only valid blueprint 
are imported into GitHub. See How do I use Git integration in vRealize Automation Cloud 
Assembly.
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Procedure

1 Select Infrastructure > Connections > Integrations and click Add Integration.

2 Select GitHub.

3 Enter the required information on the GitHub configuration page.

4 Click Validate to check the integration.

5 If you need to add tags to support a tagging strategy, enter capability tags. See How do I 
use tags to manage vRealize Automation Cloud Assembly resources and deployments and 
Creating a Tagging Strategy.

6 Click Add.

7 Configure the GitLab connection to accept blueprints in an appropriate repository.

a Select Infrastructure > Integrations and choose the appropriate GitHub integration.

b Select Projects.

c Select New Project and create a name for the project.

d Enter the Repository path within GitHub. Typically, this is the user name of the main 
account appended to the repository name.

e Enter the appropriate GitHub Branch that you want to use.

f If applicable, enter a Folder name. If left blank, all folders are available.

g Enter an appropriate Type.

h Click Next to finish adding the repository.

An automated synchronization task is initiated that imports blueprints into the platform.

When the synchronization tasks are complete, a message indicates that the blueprints 
have been imported.

Results

GitHub is available for use in vRealize Automation Cloud Assembly blueprints.

What to do next

You can now retrieve blueprints from GitHub.

Configure an external IPAM integration point in vRealize Automation

You can create a provider-specific external IPAM integration point to manage the IP addresses 
used in your blueprint deployments. When using an external IPAM integration point, IP addresses 
are obtained from, and managed by, the designated IPAM provider rather than from vRealize 
Automation.

You can create a provider-specific IPAM integration point to manage IP addresses and DNS 
settings for blueprint deployments and VMs in vRealize Automation.
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For information about how to configure the prerequisites, and an example of how to create a 
provider-specific external IPAM integration point within the context of a sample workflow, see Add 
an external IPAM integration point in vRealize Automation .

For information about how to create the needed assets to enable external IPAM partners and 
vendors to integrate their IPAM solution with vRealize Automation, see How do I use the IPAM 
SDK to create a provider-specific external IPAM integration package for vRealize Automation.

Prerequisites

n Verify that you have cloud administrator credentials. See Credentials required for working with 
cloud accounts in vRealize Automation.

n Verify that you have the cloud administrator user role. See What are the vRealize Automation 
Cloud Assembly user roles.

n Verify that you have an account with the external IPAM provider, for example Infoblox or 
Bluecat, and that you have the correct access credentials to your organization's account with 
the IPAM provider.

n Verify that you have access to a deployed integration package for the IPAM provider, such as 
Infoblox or BlueCat. The deployed package is initially obtained as a .zip download from your 
IPAM provider or from the vRealize Automation Marketplace and then deployed to vRealize 
Automation.

n Verify that you have access to a configured running environment for the IPAM provider.

n If you are using an actions-based extensibility (ABX) On-Prem Embedded running 
environment, verify that you have an HTTP proxy server in the vRealize Automation 
network that is able to pass outgoing traffic to external sites such as gcr.io and 
storage.googleapis.com. For details, see Pulling Docker images behind proxy in vRealize 
Automation 8.x (75180).

Procedure

1 Select Infrastructure > Connections > Integrations and click Add Integration.

2 Click IPAM.

3 In the Provider drop-down, select a configured IPAM provider package from the list.

If the list is empty, click Import Provider Package, navigate to an existing provider 
package .zip file, and select it. If you do not have the .zip file, you can obtain it from your 
provider's web site or from the vRealize Automation Marketplace tab.

4 Enter your administrator user name and password credentials for your account with the 
external IPAM provider, along with all other (if any) mandatory fields, such as the host name of 
your provider.

Using and Managing vRealize Automation Cloud Assembly

VMware, Inc. 50

https://www.infoblox.com
https://www.bluecatnetworks.com
http://kb.vmware.com/s/article/75180
http://kb.vmware.com/s/article/75180


5 In the Running Environment drop-down list, select an existing running environment, such as 
on-premises actions-based extensibility integration point.

The running environment supports communication between vRealize Automation and the 
IPAM provider.

The IPAM framework only supports an actions-based extensibility (ABX) On-Prem Embedded 
running environment.

Note   If you use an Amazon Web Services or Microsoft Azure cloud account as the integration 
running environment, be sure that the IPAM provider appliance is accessible from the Internet 
and is not behind a NAT or firewall and that it has a publicly resolvable DNS name. If the IPAM 
provider is not accessible, the Amazon Web Services Lambda or Microsoft Azure Functions 
cannot connect to it and the integration will fail.

6 Click Validate.

7 When prompted to trust the self-signed certificate from the external IPAM provider, click 
Accept.

After you accept the self-signed certificate, the validation action can continue to completion.

8 Enter a name for this IPAM integration point and click Add to save the new IPAM integration 
point.

A data collection action is imitated. Networks and IP addresses are data-collected from the 
external IPAM provider.

How do I upgrade to a newer IPAM integration package in vRealize 
Automation

You can upgrade an existing external IPAM integration point to source a more recent version of 
the vendor-specific IPAM integration package.

An external IPAM provider or VMware may upgrade a source IPAM integration package for a 
particular vendor. For example, the external IPAM integration package for Infoblox has been 
upgraded several times. To preserve any existingvRealize Automation infrastructure settings that 
use a named IPAM integration point, you can edit an IPAM integration point to source the updated 
IPAM integration package, rather than create a new IPAM integration point.

Prerequisites

This procedure assumes that you have already created an external IPAM integration point and 
want to upgrade that integration point to use a more recent version of the vendor's IPAM 
integration package.

For information about how to create an external IPAM integration point, see Add an external IPAM 
integration point in vRealize Automation .

n Verify that you have cloud administrator credentials. See Credentials required for working with 
cloud accounts in vRealize Automation.
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n Verify that you have the cloud administrator user role. See What are the vRealize Automation 
Cloud Assembly user roles.

n Verify that you have an account with the external IPAM provider and that you have the correct 
access credentials to your organization's account with that IPAM provider.

n Verify that you have access to a deployed integration package for your IPAM provider. The 
deployed package is initially obtained as a .zip download from your IPAM provider website or 
from the vRealize Automation Marketplace and then deployed to vRealize Automation.

For information about how to download and deploy the provider package .zip file and make 
it available as a Provider value on the IPAM Integration page, see Download and deploy an 
external IPAM provider package for use in vRealize Automation.

n Verify that you have access to a configured running environment for the IPAM provider. The 
running environment is typically an actions-based extensibility (ABX) On-Prem Embedded 
integration point.

For information about running environment characteristics, see Create a running environment 
for an IPAM integration point in vRealize Automation.

Procedure

1 Select Infrastructure > Connections > Integrations IPAM and open the existing IPAM 
integration point.

2 Click Manage Providers.

3 Navigate to and import the updated IPAM integration package.

4 Click Validate and click Save.

Configure MyVMware Integration in vRealize Automation Cloud 
Assembly

You can integrate MyVMware with vRealize Automation Cloud Assembly to support VMware 
related actions and capabilities, such as accessing the VMware Marketplace for blueprints.

You can create only one My VMware integration for each organization.

Prerequisites

You must have a user account with the appropriate permissions for MyVMware.

n For information about inviting a user to a MyVMware account, see KB 2070555.

n For information about assigning user permissions in a My VMware account, see KB 2006977.

Procedure

1 Select Infrastructure > Connections > Integrations and click Add Integration.

2 Select My VMware.

3 Enter the required information on the MyVMware configuration page.
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4 If you require tags to support a tagging strategy, enter capability tags. See How do I use tags 
to manage vRealize Automation Cloud Assembly resources and deployments and Creating a 
Tagging Strategy.

5 Click Add.

Results

My VMware is available for use with blueprints.

What to do next

Add a My VMware component to the desired blueprints.

Configure vRealize Orchestrator integration in Cloud Assembly

You can configure one or more vRealize Orchestrator integrations, so that you can use workflows 
as part of extensibility.

vRealize Automation includes a preconfigured vRealize Orchestrator instance that can be used for 
extensibility subscriptions. You can also access the client of the embedded vRealize Orchestrator 
from the vRealize Automation Cloud Services Console.

With the vRealize Orchestrator integration to vRealize Automation Cloud Assembly, you can add 
an external vRealize Orchestrator instance and use the included workflow library in extensibility 
subscriptions. For more information, see Extensibility workflow subscriptions.

Prerequisites

n Verify that you have cloud administrator credentials. For more information, see What are the 
vRealize Automation Cloud Assembly user roles.

n Upgrade or migrate to vRealize Orchestrator 8.1. See Upgrading and Migrating VMware 
vRealize Orchestrator.

Procedure

1 Select Infrastructure > Connections > Integrations.

2 Click Add integration.

3 Select vRealize Orchestrator.

4 In vRealize Automation Cloud Assembly, enter the URL of the vRealize Orchestrator instance.

5 To validate the integration, click Validate.

6 Enter a name for the vRealize Orchestrator integration.

7 (Optional) Enter a description for the vRealize Orchestrator integration.
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8 (Optional) Add capability tags. For more information on capability tags, see Using capability 
tags in vRealize Automation Cloud Assembly.

Note   Capability tags can be used to manage multiple vRealize Orchestrator integrations. See 
Managing multiple vRealize Orchestrator integrations with project constraints.

9 Click Add.

The vRealize Orchestrator integration is saved.

What to do next

To verify that the integration is configured and that the workflows are added, select Extensibility > 
Library > Workflows.

Managing multiple vRealize Orchestrator integrations with project constraints

You can use project constraints to manage what vRealize Orchestrator integrations are used in 
workflow subscriptions.

vRealize Automation Cloud Assembly supports the integration of multiple vRealize Orchestrator 
servers that can be used in workflow subscriptions. You can manage what vRealize Orchestrator 
integrations are used in blueprints provisioned by your project with soft or hard project 
constraints. For more information on project constraints, see Using vRealize Automation Cloud 
Assembly project tags and custom properties .

Prerequisites

n Verify that you have cloud administrator credentials. For more information, see What are the 
vRealize Automation Cloud Assembly user roles.

n Configure two or more vRealize Orchestrator integrations in vRealize Automation Cloud 
Assembly. For more information, see Configure vRealize Orchestrator integration in Cloud 
Assembly.

n Add capability tags to your vRealize Orchestrator integrations. For more information on 
capability tags, see Using capability tags in vRealize Automation Cloud Assembly.

Procedure

1 Navigate to Infrastructure > Configure > Projects and select your project.

2 Select the Provisioning tab.

3 Enter the capability tags of your vRealize Orchestrator integrations in the Extensibility 
constraints text box and set them as soft or hard project constraints.

4 Click Save.

Results

When you deploy a blueprint, vRealize Automation Cloud Assembly uses the project constraints to 
manage what vRealize Orchestrator integrations are used in workflow subscriptions.
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What to do next

Alternatively, you can use capability tags to manage multiple vRealize Orchestrator integrations 
on a cloud account level. For more information, see Managing multiple vRealize Orchestrator 
integrations with cloud account capability tags.

Managing multiple vRealize Orchestrator integrations with cloud account 
capability tags

You can use capability tags to manage what vRealize Orchestrator integrations are used in 
workflow subscriptions.

vRealize Automation Cloud Assembly supports the integration of multiple vRealize Orchestrator 
servers that can be used in workflow subscriptions. You can manage what vRealize Orchestrator 
integrations are used in workflow subscriptions by adding capability tags to your cloud account.

Prerequisites

n Verify that you have cloud administrator credentials. For more information, see What are the 
vRealize Automation Cloud Assembly user roles.

n Configure two or more vRealize Orchestrator integrations in vRealize Automation Cloud 
Assembly. For more information, see Configure vRealize Orchestrator integration in Cloud 
Assembly.

n Add capability tags to your vRealize Orchestrator integrations. For more information on 
capability tags, see Using capability tags in vRealize Automation Cloud Assembly.

Procedure

1 Navigate to Infrastructure > Connections > Cloud Accounts.

2 Select your cloud account.

3 Enter the capability tags of the vRealize Orchestrator integrations you want to use.

The capability tags are automatically converted into soft constraints. To use hard constraints 
in managing your integrations, you must use project constraints. For more information, see 
Managing multiple vRealize Orchestrator integrations with project constraints.

4 Click Save.

Results

When you deploy a blueprint, vRealize Automation Cloud Assembly uses the tagging in the 
associated cloud account to manage what vRealize Orchestrator integrations are used in workflow 
subscriptions.

How do I work with Kubernetes in vRealize Automation Cloud 
Assembly

vRealize Automation Cloud Assembly offers several options for managing and deploying 
Kubernetes resources.
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There are two primary options to working with Kubernetes resources in vRealize Automation 
Cloud Assembly. You can integrate Pivotal Container Service (PKS) or Red Hat OpenShift with 
vRealize Automation Cloud Assembly to configure, manage and deploy Kubernetes resources. 
With the second option, you can leverage a vCenter cloud account to access supervisor 
namespaces to work with vSphere Project Pacific Kubernetes-based functionality.You can also 
integrate external Kubernetes resources in vRealize Automation Cloud Assembly.

Working with PKS or Openshift Integrations

For PKS, external clusters, or Openshift configurations, vRealize Automation Cloud Assembly 
provides a Kubeconfig that enables users to access applicable Kubernetes clusters.

After you create a PKS or OpenShift integration, applicable Kubernetes clusters become available 
in vRealize Automation Cloud Assembly and you can add and create Kubernetes components 
to vRealize Automation Cloud Assembly to support management of cluster and container 
applications. These applications form the basis of self-service deployments that are available from 
the Service Broker catalog.

Working with vSphere Project Pacific Kubernetes Clusters

Project Pacific is a vSphere enhancement that uses Kubernetes as its control plane. It enables you 
to manage both virtual machines and containers from one interface. vRealize Automation Cloud 
Assembly enables users to leverage the Pacific Kubernetes capabilities that have been embedded 
within vSphere. You can access Pacific functionality by creating an integration with a vCenter 
deployment with a vSphere implementation that contains supervisor clusters. Pacific enables you 
to manage both conventional virtual machines and Kubernetes clusters from vCenter.

For Pacific-based supervisor namespaces, users must have access to an applicable vSphere SSO 
so that they can log in to a provided link to the supervisor namespace details. Then, they can 
download a customized Kubectl with vSphere authentication so they can use their supervisor 
namespace.

To use this functionality, you must have a vCenter with vSphere cloud account that has supervisor 
namespaces configured. After a users has logged in they can begin working with applicable 
namespaces.

n Configure PKS Integration in vRealize Automation Cloud Assembly

You can configure a PKS resource connection on premises and in the cloud to 
support Kubernetes integration and management capabilities in vRealize Automation Cloud 
Assembly.

n Configure Red Hat OpenShift Integration in vRealize Automation Cloud Assembly

You can configure a Red Hat OpenShift resource connection on premises and in the cloud 
to support enterprise-level Kubernetes integration and management capabilities in vRealize 
Automation Cloud Assembly.
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n Configure a Kubernetes Zone in vRealize Automation Cloud Assembly

Kubernetes zones enable cloud administrators to define policy-based placement of 
Kubernetes clusters and namespaces used in vRealize Automation Cloud Assembly 
deployments. An administrator can use this page to specify what clusters are available for 
provisioning of Kubernetes namespaces and what properties are acceptable for clusters.

n Use Pacific supervisor clusters and namespaces with vRealize Automation Cloud Assembly 

You can select supervisor clusters from an existing vSphere integration and create or add 
namespaces to provide selective access to Kubernetes resources within existing vRealize 
Automation Cloud Assembly projects.

n Working with Kubernetes clusters and namespaces in vRealize Automation Cloud Assembly

You can add, view, and manage the configuration of Kubernetes clusters and namespaces 
which serve as the basis of Kubernetes deployments in vRealize Automation Cloud Assembly.

n Adding Kubernetes components to blueprints in vRealize Automation Cloud Assembly

When adding Kubernetes components to a vRealize Automation Cloud Assembly blueprint, 
you can choose to add clusters or enable users to create namespaces in various 
configurations. Typically, this choice depends on your access control requirements, how you 
have configured your Kubernetes components, and your deployment requirements.

n Using vRealize Automation Cloud Assembly Extensibility with Kubernetes

vRealize Automation Cloud Assembly provides a standard set of event topics that correspond 
to typical actions related to Kubernetes cluster deployment. Users can subscribe to these 
topics as desired, and they receive notification when the event related to the subscribed topic 
occurs. You can also configure vRO workflows to run based on event notifications.

Configure PKS Integration in vRealize Automation Cloud Assembly

You can configure a PKS resource connection on premises and in the cloud to support Kubernetes 
integration and management capabilities in vRealize Automation Cloud Assembly.

PKS integrations enable you to manage PKS instances on premises and in the cloud and 
Kubernetes clusters provisioned on PKS and external clusters. You must create a Kubernetes 
profile and associate it with a project to support policy-based placement of resources.

Prerequisites

n You must have an appropriately configured Pivotal Container Service (PKS) server set up with 
UAA authentication.

n Verify that you have cloud administrator credentials. For more information, see What are the 
vRealize Automation Cloud Assembly user roles.

Procedure

1 Select Infrastructure > Connections > Integrations and click Add Integration.

2 Select VMware Enterprise PKS.
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3 Enter the IP address or FQDN, and PKS address for the PKS cloud account you are creating.

n The IP address is the FQDN or IP address of the PKS user authentication server.

n The PKS address is the FQDN or IP address for the main PKS server.

4 Select whether this PKS server is local or located in the public cloud or on a private cloud.

5 Enter an appropriate Username and Password for the PKS server and other related 
information..

6 If you use tags to support a tagging strategy, enter capability tags. See How do I use tags 
to manage vRealize Automation Cloud Assembly resources and deployments and Creating a 
Tagging Strategy.

7 Click Add.

Results

You can create Kubernetes zones and assign them to a project, or you can discover external 
Kubernetes clusters and assign those clusters to projects. In addition, you can add or create 
Kubernetes namespaces that facilitate management of clusters among large groups and 
organizations.

What to do next

Create or select the appropriate Kubernetes zones, then select one or more clusters or 
namespaces, and assign them to a project. After that, you can create and publish blueprints to 
enable users to generate self-service deployments that use Kubernetes.

Configure Red Hat OpenShift Integration in vRealize Automation Cloud 
Assembly

You can configure a Red Hat OpenShift resource connection on premises and in the cloud 
to support enterprise-level Kubernetes integration and management capabilities in vRealize 
Automation Cloud Assembly.

vRealize Automation Cloud Assembly supports integration with OpenShift versions 3.x.

Prerequisites

n You must have an appropriately configured Red Hat OpenShift implementation.

n Verify that you have cloud administrator credentials. For more information, see What are the 
vRealize Automation Cloud Assembly user roles.

n VMware supplies resources you can use to create an OpenShift cluster with a blueprint at 
the following location: https://flings.vmware.com/enterprise-openshift-as-a-service-on-cloud-
automation-services. You can use clusters created with these resources as global clusters in 
the Kubernetes zones to create self-service namespaces.

Procedure

1 Select Infrastructure > Connections > Integrations and click Add Integration.
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2 Select Red Hat OpenShift.

3 Enter the Address and Location for the OpenShift server.

4 Select the appropriate Credential Type and enter the approriate credentials.

OpenShift integration supports either OAuth username/password, public key, or bearer token 
authentication.

5 Enter an appropriate Name and Description for the OpenShift integration.

6 If you use tags to support a tagging strategy, enter the appropriate capability tags. See How 
do I use tags to manage vRealize Automation Cloud Assembly resources and deployments and 
Creating a Tagging Strategy.

7 Click Add.

Results

When an integration is created, new Kubernetes clusters appear in the relevant section of the 
Kubernetes page. You can create Kubernetes zones and assign them to a project. In addition, you 
can configure Kubernetes namespaces that facilitate management of clusters among large groups 
and organizations.

What to do next

Create or select the appropriate Kubernetes zones, then select one or more clusters or 
namespaces, and assign them to a project. After that, you can create and publish blueprints to 
enable users to generate self-service deployments that use Kubernetes.

Configure a Kubernetes Zone in vRealize Automation Cloud Assembly

Kubernetes zones enable cloud administrators to define policy-based placement of Kubernetes 
clusters and namespaces used in vRealize Automation Cloud Assembly deployments. An 
administrator can use this page to specify what clusters are available for provisioning of 
Kubernetes namespaces and what properties are acceptable for clusters.

Cloud administrators can associate Kubernetes zones with PKS cloud accounts configured for 
Cloud Assembly or with external Kubernetes clusters that are not associated with a project.

When you create a Kubernetes zone, you can assign multiple provider-specific resources to the 
zone, and these resources will dictate what properties can be set for the newly provisioned 
clusters in terms of the number of workers, masters, available CPU, memory, and other 
configuration settings. For PKS providers, these correspond to PKS plans. An administrator can 
also assign multiple clusters to a Kubernetes zone that will be used for placement of newly 
provisioned Kubernetes namespaces. The administrator can only assign clusters that are not 
onboarded, or not managed by CMX, and are provisioned via the preselected cluster provider. 
The administrator can assign multiple Kubernetes zones to a single project, thus making them all 
available for placement operations that happen within this project.

A cloud administrator can assign priorities on multiple levels.

n Kubernetes zone priority within a project.
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n Resource priority within a Kubernetes zone.

n Cluster priority within a Kubernetes zone.

The cloud administrator can also assign tags on multiple levels:

n Capability tags per Kubernetes zone.

n Tags per resource assignment.

n Tags per cluster assignment.

Service Broker contains a version of the Kubernetes Zone page to enable Service Broker 
administrators to access existing Kubernetes zones so they can create placement policies for 
Kubernetes namespaces and clusters provisioned from the catalog.

Prerequisites

Configure integration with a suitable PKS deployment. See Configure PKS Integration in vRealize 
Automation Cloud Assembly

Procedure

1 Select Infrastructure > Configure > Kubernetes Zone and click New Kubernetes Zone.

2 Enter the PKS integration Account name to which you want this zone to apply.

3 Add a Name and Description for the Kubernetes Zone.

4 Add capability tags if appropriate. See Using capability tags in vRealize Automation Cloud 
Assembly for more information.

5 Click Save.

6 Click the On-demand tab and add PKS plans as appropriate for the zone to use for cluster 
provisioning.

You can select one or more plans and assign priorities to them. Lower numbers equal higher 
priority. Priority assignments are secondary to tag based selection.

7 Click the Cluster tab and then click the Add button to add Kubernetes clusters to the zone. If 
you are working with an external cluster, it is automatically onboarded to vRealize Automation 
Cloud Assembly when you select it.

You can add Kubernetes namespaces to the cluster on the Kubernetes Clusters page in 
vRealize Automation Cloud Assembly.

Results

Kubernetes zones are configured for use with vRealize Automation Cloud Assembly deployments.

What to do next

Assign the Kubernetes zone to a project.

1 Select Infrastructure > Configure > Projects and then select the project that you want to 
associate with your Kubernetes zone.
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2 Click the Kubernetes Provisioning tab on the Project page.

3 Click Add Kubernetes Zone and add the zone that you just created. You can multiple zones if 
appliacable, and you also set the priority on the zones.

4 Click Save.

After you assign a zone to a project, you can use the Blueprints page to provision a deployment 
based on the Kubernetes zone and project configuration.

Use Pacific supervisor clusters and namespaces with vRealize Automation Cloud 
Assembly

You can select supervisor clusters from an existing vSphere integration and create or add 
namespaces to provide selective access to Kubernetes resources within existing vRealize 
Automation Cloud Assembly projects.

This task describes how to add supervisor clusters with vRealize Automation Cloud Assembly for 
use in deployments and how to create or add namespaces that define what vRealize Automation 
Cloud Assembly projects and users can access particular Kubernetes resources. Supervisor 
clusters are customized Kubernetes clusters associated with vSphere. They expose Kubernetes 
APIs to end users, and they use ESXI as a platform for worker nodes rather than Linux. 
Supervisor namespaces facilitate access control to Kubernetes resources, because it is typically 
easier to apply policies to namespaces than to individual virtual machines. You can create multiple 
namespaces for each supervisor cluster.

vRealize Automation Cloud Assembly users designated as project viewers have view only access 
to namespaces, while project members can edit them.

Prerequisites

n To use Pacific namespaces with vRealize Automation Cloud Assembly, you must have a 
vSphere endpoint configured. vSphere is installed as part of a vCenter cloud account. See 
Create a vCenter cloud account in vRealize Automation.

n Project Pacific must be enabled on the vSphere cloud account, and it must contain appropriate 
supervisor namespaces.

Procedure

1 Select Infrastructure > Resources > Kubernetes in vRealize Automation Cloud Assembly.

This page shows managed clusters that are available for use, and enables you to add 
additional clusters. You can click on any of the clusters to view their details.

2 Select Add Supervisor Cluster.

3 Specify the Account details for the target vSphere cloud account.

4 Click the Search icon in the Supervisor cluster text box to either view all supervisor clusters or 
search for a cluster by name.

5 Select the desired cluster and click Add.
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6 Select the Supervisor Namespaces tab and click the New Supervisor Namespace button to 
add a new namespace.

If you want to add an existing namespace, click Add Supervisor Namespace and select the 
desired namespace.

a If you are creating a new namespace, add a Name and Description.

b Select the appropriate cloud Account to associate with the namespace.

c Select the Supervisor cluster to associate with this namespace.

d Select the Project to associate with the namespace.

e Click Create.

7 Review the relevant details for the new namespace.

Users and groups that currently have access to the namespace in vSphere are listed on the 
Users tab. If new users or groups are added to the project, click the Update Users button on 
this tab to update the list. The list is not updated automatically, so you must use the button to 
update.

Note   Synchronization of users makes sense only if vRealize Automation Cloud Assembly and 
vCenter are configured with a common Active Directory/LDAP service.

What to do next

After a namespace is configured, the Infrastructure > Resources > Kubernetes page in vRealize 
Automation Cloud Assembly for applicable users displays the namespace. Users can click the 
Address link on the Summary tab to open the vSphere Kubernetes CLI Tools to manage the 
namespace. Users must be a cloud administrator or a member of the namespace for the 
designated project to access a link to the Supervisor namespace details. Also users can download 
a customized Kubectl to use the Supervisor namespace. Users can log in to the supervisor 
namespace and use it as they would any other namespace, and then create blueprints and deploy 
applications.

Working with Kubernetes clusters and namespaces in vRealize Automation 
Cloud Assembly

You can add, view, and manage the configuration of Kubernetes clusters and namespaces which 
serve as the basis of Kubernetes deployments in vRealize Automation Cloud Assembly.
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You can view, add, and manage Kubernetes clusters and namespaces to which you are entitled 
access on the Infrastructure > Resources > Kubernetes page. Most typically, this page facilitates 
management of deployed clusters and namespaces.

n Cluster: A cluster is a group of Kubernetes nodes distributed across one or more physical 
machines. This page shows provisioned and undeployed clusters that have been configured 
for use on your vRealize Automation Cloud Assembly instance. You can click on a cluster 
to view information about its current status. When you deploy a cluster, it includes a link 
to a Kubconfig file that is accessible only for cloud administrators. This file grants full admin 
privileges over the cluster including a list of namespaces.

n Namespaces: Namespaces are virtual clusters that provide administrators with a way to 
segregate cluster resources. They facilitate management of resources among large groups 
of users and organizations. As a form of role-based access control, a cloud administrator 
can enable users to add namespaces to a project when they request a deployment and then 
later manage those namespaces from the Kubernetes Clusters page. When you deploy a 
namespace, it includes a link to a kubeconfig file that enables valid users, such as developers, 
to view and manage some aspects of that namespace.

If you are configuring new or existing cluster, you must select whether to connect with a master IP 
address or a master hostname.

Working with Kubernetes Clusters in vRealize Automation Cloud Assembly

You can add new, existing, or external clusters to vRealize Automation Cloud Assembly using the 
options on this page.

1 Select Infrastructure > Resources > Kubernetes and confirm that the Clusters tab is active.

If there are any clusters currently configured for your vRealize Automation Cloud Assembly 
instance, they appear on this page.

2 If you are adding a new or existing cluster, or deploying a cluster, select the appropriate 
option according to the following table.

Option Description Details

Deploy Add new clusters to vRealize 
Automation Cloud Assembly

You must specify the PKS cloud account that to which this cluster 
will be deployed as well as the desired plan and the number of 
nodes.

Add 
Existing

Configure an existing cluster 
to work with your project.

You must specify the PKS cloud account, the cluster to use, and the 
appropriate project for the targeted developer. Also, you need to 
specify the sharing scope. If you want to share globally, you must 
configure your Kubernetes zones and namespaces appropriately.

Add 
External

Add a vanilla Kubernetes 
cluster, that might not be 
associated with PKS, to 
vRealize Automation Cloud 
Assembly.

You must designate a project to which the custer is associated, 
enter the IP address for the desired cluster and select a cloud 
proxy and certificate information required to connect to this 
cluster.

3 Click Add to make the cluster available within vRealize Automation Cloud Assembly.
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Working with Kubernetes Namespaces in vRealize Automation Cloud Assembly

If you are a cloud administrator, namespaces help you group and manage Kubernetes cluster 
resources. If you are a user, namespaces are the area in Kubernetes clusters for your 
deployments. Administrators and users can access namespaces using the Namespaces tab located 
on the Infrastructure > Resources > Kubernetes page.

There are several ways to add Kubernetes namespaces to resources in vRealize Automation Cloud 
Assembly. The following procedure outlines one typical method.

1 Select Infrastructure > Resources > Kubernetes and click the Namespaces tab.

2 To add a new namespace, click New Namespace. To add an existing namespace click Add 
Namespace.

3 Enter a Name and Description for the namespace.

At this point you have added a namespace for use with Kubernetes resources, but it is not 
associated with anything in particular.

4 Specify the Cluster that you want to associate with this namespace.

5 Click Create to add the namespace to vRealize Automation Cloud Assembly.

Adding Kubernetes components to blueprints in vRealize Automation Cloud 
Assembly

When adding Kubernetes components to a vRealize Automation Cloud Assembly blueprint, you 
can choose to add clusters or enable users to create namespaces in various configurations. 
Typically, this choice depends on your access control requirements, how you have configured 
your Kubernetes components, and your deployment requirements.

To add a Kubernetes component to a blueprint in vRealize Automation Cloud Assembly, click 
Blueprints, select New, and then locate and expand the Kubernetes option on the left menu. Then, 
make the desired selection, either Cluster or KBS Namespace by dragging it to the canvas.

Adding a Kubernetes cluster that is associated with a project to a blueprint is the most 
straightforward method of making Kubernetes resources available to valid users. You can use 
tags on clusters to control where they are deplyed just as you do with other Cloud Assembly 
resources. You can use tags to select a zone and a PKS plan during the allocation phase of cluster 
deployment.

Once you add a cluster in this way, it is automatically available to all valid users.
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Blueprint Examples

The first blueprint example shows a blueprint for a simple Kubernetes deployment that is 
controlled by tagging. A Kubernetes zone was created with two deployment plans, configured on 
the New Kubernetes Zone page In this case, a tag called placement:tag was added as a capability 

on the zone, and it was used to match the analogous constraint on the blueprint. If there were 
more than one zone configured with the tag, the one with the lowest priority number would be 
selected.

formatVersion: 1
inputs: {}
resources:
  Cluster_provisioned_from_tag:
    type: Cloud.K8S.Cluster
    properties:
      hostname: 109.129.209.125
      constraints:
    -tag: 'placement tag'
      port: 7003
      workers: 1
      connectBy: hostname 

The second blueprint examples shows how to set up a blueprint with a variable called $
(input.hostname) so that users can input the desired cluster hostname when requesting a 
deployment. Tags can also be used to select a zone and a PKS plan durring the resource allocation 
phase of cluster deployment.

formatVersion: 1
inputs:
  hostname:
    type: string
    title: Cluster hostname
resources:
  Cloud_K8S_Cluster_1:
    type: Cloud.K8S.Cluster
    properties:
      hostname: ${input.hostname}
      port: 8443
      connectBy: hostname
      workers: 1

If you want to use namespaces to mange cluster usage, you can set up a variable in the blueprint 
called name: ${input.name} to substitute for the namespace name which a user enters when 
requesting a deployment. For this sort of deployment, you would create a blueprint something like 
the following example:

1 formatVersion: 1
2 inputs:
3 name:
4    type: string
5    title: "Namespace name"
6 resources:
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7    Cloud_KBS_Namespace_1:
8        type: Cloud.KBS.Namespace
9        properties:
10            name: ${input.name}

Users can manage deployed clusters via kubeconfig files that are accessible from the 
Infrastructure > Resources > Kubernetes Clusters page. Locate the card on the page for the 
desired cluster and click Kubeconfig.

Using vRealize Automation Cloud Assembly Extensibility with Kubernetes

vRealize Automation Cloud Assembly provides a standard set of event topics that correspond to 
typical actions related to Kubernetes cluster deployment. Users can subscribe to these topics as 
desired, and they receive notification when the event related to the subscribed topic occurs. You 
can also configure vRO workflows to run based on event notifications.

The following topics are available for subscription on the Extensibility > Libaray > Event Topics 
page in vRealize Automation Cloud Assembly. To view these topics, search for Kubernetes in the 
Event Topics Search text box.

n Kubernetes cluster allocation

n Kubernetes cluster post provision

n Kubernetes cluster post removal

n Kubernetes cluster provision

n Kubernetes cluster removal

Click one of the topics to view the schema for that topic which shows all the information that 
is collected and transmitted. You can use any of this schema information to set up various 
notifications and management and reporting tasks.

You can set up action scripts for CMX-related actions on the Extensibility > Library > Actions 
page. Action scripts can be used for various purposes: for example, to create a DNS record of 
Kubernetes cluster provisioning. If you are creating a DNS record, you can use the masternodeips 
field from the Kubernetes cluster post provision topic with a REST command in an Action script to 
create a DNS record.

The Subscriptions page defines the relationship between the event topics and action scripts. You 
can view and manage these components on the Subscriptions page in vRealize Automation Cloud 
Assembly

What Is configuration management in vRealize Automation Cloud 
Assembly

vRealize Automation Cloud Assembly supports integration with Puppet Enterprise, Ansible Open 
Source, and Ansible Tower so that you can manage deployments for configuration and drift.
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Puppet Integration

To integrate Puppet-based configuration management, you must have a valid instance of Puppet 
Enterprise installed on a public or private cloud with a vSphere workload. You must establish a 
connection between this external system and your vRealize Automation Cloud Assembly instance. 
Then you can make Puppet configuration management available to vRealize Automation Cloud 
Assembly by adding it to appropriate blueprints.

The vRealize Automation Cloud Assembly blueprint service Puppet provider installs, configures, 
and runs the Puppet agent on a deployed compute resource. The Puppet provider supports both 
SSH and WinRM connections with the following prerequisites:

n SSH connections:

n The user name must be either a super user or a user with sudo permissions to run 
commands with NOPASSWD.

n Disable requiretty for the given user.

n cURL must be available on the deployment compute resource.

n WinRM connections:

n PowerShell 2.0 must be available on the deployment compute resource.

n Configure the Windows template as described in the vRealize Orchestrator documentation.

The DevOps administrator is responsible for managing the connections to a Puppet master 
and for applying Puppets roles, or configuration rules, to specific deployments. Following 
deployment, virtual machines configured to support configuration management are registered 
with the designated Puppet Master.

When virtual machines are deployed, users can add or delete a Puppet Master as an 
external system or update projects assigned to the Puppet Master. Finally, appropriate users 
can de-register deployed virtual machines from the Puppet Master when the machines are 
decommissioned.

Ansible Open Source Integration

When setting up an Ansible integration, install Ansible Open Source in accordance with the 
Ansible installation instructions. See the Ansible documentation for more information about 
installation.

Ansible enables host key checking by default. If a host is reinstalled with a different key in the 
known_hosts file, an error message appear. If a host is not listed in the known_hosts file, you 

must supply the key on start-up. You can disable host key checking with the following setting in 
the /etc/ansible/ansible.cfg or ~/.ansible.cfg file:

[defaults]
host_key_checking = False
localhost_warning = False
 
[paramiko_connection]

Using and Managing vRealize Automation Cloud Assembly

VMware, Inc. 67



record_host_keys = False
 
[ssh_connection]
#ssh_args = -C -o ControlMaster=auto -o ControlPersist=60s
ssh_args = -o UserKnownHostsFile=/dev/null

To avoid the host key checking errors, set host_key_checking and record_host_keys to False 

including adding an extra option UserKnownHostsFile=/dev/null set in ssh_args.In addition, if the 

inventory is empty initially, Ansible warns that the host list is empty. This causes the playbook 
syntax check to fail.

Ansible vault enables you to store sensitive information, such as passwords or keys, in encrypted 
files rather than as plain text. Vault is encrypted with a password. In vRealize Automation Cloud 
Assembly, Ansible uses Vault to encrypt data such as ssh passwords for host machines. It assumes 
that the path to the Vault password has been set.

You can modify the ansible.cfg file to specify the location of the password file using the 

following format.

vault_password_file = /path to/file.txt

You can also set the ANSIBLE_VAULT_PASSWORD_FILE environment variable 

so that Ansible automatically searches for the password. For example, 
ANSIBLE_VAULT_PASSWORD_FILE=~/.vault_pass.txt

vRealize Automation Cloud Assembly manages the Ansible inventory file, so you must ensure that 
the vRealize Automation Cloud Assembly user has rwx access on the inventory file.

cat ~/var/tmp/vmware/provider/user_defined_script/$(ls -t ~/var/tmp/vmware/provider/
user_defined_script/ | head -1)/log.txt

If you want to use a non-root user with vRealize Automation Cloud Assembly open-source 
integration, the users require a set of permissions to run the commands used by the vRealize 
Automation Cloud Assembly open-source provider. The following commands must be set in the 
user's sudoers file.

Defaults:myuser !requiretty

If the user is not part of an admin group that has no askpass application specified, set the following 
command in the user's sudoers file.

myuser ALL=(ALL) NOPASSWD: ALL

If you encounter errors or other problems when setting up Ansible integration, refer 
to the log.txt file at 'cat~/var/tmp/vmware/provider/user_defined_script/$(ls -t 
~/var/tmp/vmware/provider/user_defined_script/ | head -1)/' on the Ansible Control 

Machine.
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Ansible Tower Integration

Supported Operating System Types

n Red Hat Enterprise Linux 8.0 or later 64-bit (x86), supports only Ansible Tower 3.5 and 
greater.

n Red Hat Enterprise Linux 7.4 or later 64-bit (x86).

n CentOS 7.4 or later 64-bit (x86).

The following is a sample inventory file, which is generated during an Ansible Tower installation. 
You may need to modify it for vRealize Automation Cloud Assembly integration uses.

[root@cava-env8-dev-001359 ansible-tower-setup-bundle-3.5.2-1.el8]# pwd
 
/root/ansible-tower-install/ansible-tower-setup-bundle-3.5.2-1.el8
 
[root@cava-env8-dev-001359 ansible-tower-setup-bundle-3.5.2-1.el8]# cat inventory
 
[tower]
 
localhost ansible_connection=local
 
 
 
 
[database]
 
 
 
 
[all:vars]
 
admin_password='VMware1!'
 
 
 
 
pg_host=''
 
pg_port=''
 
 
 
 
pg_database='awx'
 
pg_username='awx'
 
pg_password='VMware1!'
 
 
 
 
rabbitmq_port=5672
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rabbitmq_vhost=tower
 
rabbitmq_username=tower
 
rabbitmq_password='VMware1!'
 
rabbitmq_cookie=cookiemonster
 
 
 
 
# Needs to be true for fqdns and ip addresses
 
rabbitmq_use_long_name=false
 
 
 
 
# Isolated Tower nodes automatically generate an RSA key for authentication;
 
# To disable this behavior, set this value to false
 
# isolated_key_generation=true

Configure Puppet Enterprise integration in vRealize Automation Cloud Assembly

vRealize Automation Cloud Assembly supports integration with Puppet Enterprise configuration 
management.

When you add Puppet Enterprise to Cloud Assembly as an external system, by default it is 
available on all projects. You can restrict it to specific projects.

To add a Puppet Enterprise integration, you must have the Puppet master name and the 
hostname or IP address of the master.

You can find Puppet logs at the following location in case you need to check them for errors or 
information purposes.

Description Log Location

Log for create and 
install related events

Logs are on the deployed machine at `~/var/tmp/vmware/provider/
user_defined_script/$(ls -t ~/var/tmp/vmware/provider/user_defined_script/ 
| head -1)/`.

Refer to the log.txt file for full logs. For detailed Puppet agent logs, refer to https://
puppet.com/docs/puppet/4.8/services_agent_unix.html#logging

Log for Puppet delete 
and run related tasks

Logs are on the PE at `~/var/tmp/vmware/provider/user_defined_script/$(ls -t 
~/var/tmp/vmware/provider/user_defined_script/ | head -1)/`. Refer to the 

log.txt file for full logs.
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Procedure

1 Select Infrastructure > Connections > Integrations and click Add Integration.

2 Select Puppet.

3 Enter the required information on the Puppet configuration page.

4 Click Validate to check the integration.

5 Click Add.

Results

Puppet is available for use with blueprints.

What to do next

Add Puppet components to the desired blueprints.

1 Select Puppet under the Content Management heading on the blueprint menu and drag the 
Puppet component to the canvas.

2 Enter Puppet Properties on the pane to the right.

Property Description

Master Enter the name of the Puppet primary machine to be 
used with this blueprint.

Environment Select the environment for the Puppet primary machine.

Role Select the Puppet role to be used with this blueprint.

Agent Run Interval The frequency at which you want the Puppet agent 
to poll the Puppet primary machine for configuration 
details to be applied to deployed virtual machines 
related to this blueprint.

3 Click the Code tab on the right pane to view the YAML code for the Puppet configuration 
properties.

Configure Ansible Open Source integration in vRealize Automation Cloud 
Assembly

vRealize Automation Cloud Assembly supports integration with Ansible Open Source configuration 
management. After configuring integration, you can add Ansible components to new or existing 
deployments.

When you integrate Ansible Open Source with vRealize Automation Cloud Assembly, you can 
configure it to run one or more Ansible playbooks in a given order when a new machine is 
provisioned to automate configuration management. You specify the desired playbooks in the 
blueprint for a deployment.
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When setting up an Ansible integration, you must specify the Ansible Open Source host machine 
as well as the inventory file path that defines information for managing resources. In addition, you 
must provide a name and password to access the Ansible Open Source instance. Later, when you 
add an Ansible component to a deployment, you can update the connection to use key-based 
authentication.

By default, Ansible uses ssh to connect to the physical machines. If you are using Windows 
machines as specified in the blueprint with the osType Windows property, the connection_type 
variable is automatically set to winm.

Initially, Ansible integration uses the user/password or user/key credentials provided in the 
integration to connect to the Ansible Control Machine. Once the connection is successful, the 
provided playbooks in the blueprint are validated for syntax.

If the validation is successful, then an execution folder is created on the Ansible Control 
Machine at ~/var/tmp/vmware/provider/user_defined_script/. This is the location from 

which scripts run to add the host to the inventory, create the host vars files including setting up 
the authentication mode to connect to the host, and finally run the playbooks. At this point, the 
credentials provided in the blueprint are used to connect to the host from the Ansible Control 
Machine.

Ansible integration supports physical machines that do no use an IP address. For machines 
provisioned on public clouds such as AWS, Azure, and GCP, the address property in the created 
resource is populated with the machine's public IP address only when the machine is connected 
to a public network. For machines not connected to a public network, the Ansible integration 
looks for the IP address from the network attached to the machine. If there are multiple networks 
attached, Ansible integration looks for the network with the least deviceIndex; that is, the index 
of the Network Interface Card (NIC) attached to the machine. If the deviceIndex property is not 
specified in the blueprint, the integration uses the first network attached.

See What Is configuration management in vRealize Automation Cloud Assembly for more details 
on configuring Ansible Open Source for integration in vRealize Automation Cloud Assembly.

Prerequisites

n The Ansible control machine must use Ansible version 2.6.0 or later.

n The user must have read/write access to the directory where the Ansible inventory file is 
located. In addition, the user must have read/write access to the inventory file, if it exists 
already.

n If you are using a non-root user with the sudo option, ensure that the following is set in the 
sudoers file:

Defaults:user_name !requiretty

and

username ALL=(ALL) NOPASSD: ALL
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n Ensure that host key checking is disabled by setting host_key_checking = False at /etc/
ansible/ansible.cfg or ~/.ansible.cfg.

n Ensure that the vault password is set by adding the following line to the /etc/ansible/
ansible.cfg or ~/.ansible.cfg file:

vault password_file = /path/to/password_file

The vault password file contains the password in plain text and is used only when blueprints or 
deployments provide the username and password combination to use between ACM and the 
node as show in the following example.

echo 'myStr0ng9@88w0rd' > ~/.ansible_vault_password.txt
echo 'ANSIBLE_VAULT_PASSWORD_FILE=~/.ansible_vault_password.txt' > ~/.profile        
# Instead of this way, you can also set it setting 
'vault_password_file=~/.ansible_vault_password.txt' in either /etc/ansible/ansible.cfg or 
~/.ansible.cfg

n To avoid host key failures while trying to run playbooks, it is recommended that you include 
the following settings in /etc/ansible/ansible config.

[paramiko_connection]
record_host_keys = False
 
[ssh_connection]
#ssh_args = -C -o ControlMaster=auto -o ControlPersist=60s
ssh_args = -o UserKnownHostsFile=/dev/null                  # If you already have any 
options set for ssh_args, just add the additional option shown here at the end.

Procedure

1 Select Infrastructure > Connections > Integrations and click Add Integration.

2 Click Ansible.

The Ansible configuration page appears.

3 Enter the Hostname, Inventory File Path and other required information for the Ansible Open 
Source instance.

4 Click Validate to check the integration.

5 Click Add.

Results

Ansible is available for use with blueprints.

What to do next

Add Ansible components to the desired blueprints.

1 On the blueprint canvas page, select Ansible under the Configuration Management heading on 
the blueprint options menu and drag the Ansible component to the canvas.
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2 Use the panel on the right to configure the appropriate Ansible properties such as specifying 
the playbooks to run.

In Ansible, users can assign a variable to a single host, and then use it later in playbooks. 
Ansible Open Source integration enables you to specify these host variable in blueprints. The 
hostVariables property must be in proper YAML format, as expected by the Ansible control 
machine, and this content will be placed at the following location:

parent_directory_of_inventory_file/host_vars/host_ip_address/vra_user_host_vars.yml

The default location of the Ansible inventory file is defined in the Ansible account as added on 
the Integrations page in Cloud Assembly. The Ansible integration will not validate the hostVariable 
YAML syntax in the blueprint, but the Ansible Control Machine will throw an when you run a 
playbook in the case of incorrect format or syntax.

The following blueprint YAML snippet shows an example useage of the hostVariables property.

Cloud_Ansible_1:
    type: Cloud.Ansible
    properties:
      host: '${resource.AnsibleLinuxVM.*}'
      osType: linux
      account: ansible-CAVA
      username: ${input.username}
      password: ${input.password}
      maxConnectionRetries: 20
      groups:
        - linux_vms
      playbooks:
        provision:
          - /root/ansible-playbooks/install_web_server.yml
      hostVariables: |
        message: Hello ${env.requestedBy}
        project: ${env.projectName}

Ansible integrations expect authentication credentials to be present in a blueprint in one of the 
following ways:

n User name and password in the Ansible resource.

n User name and privateKeyFile in the Ansible resource.

n Username in Ansible resource and privatekey in the compute resource by specifying 
remoteAccess to generatedPublicPrivateKey.

Configure Ansible Tower Integration in vRealize Automation Cloud Assembly

You can integrate Ansible Tower with vRealize Automation Cloud Assembly to support 
configuration management of deployed resources. After configuring integration, you can add 
Ansible components to new or existing deployments from the blueprint editor.

vRealize Automation Cloud Assembly supports integration with Ansible Tower versions 3.5 and 
3.6.
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Prerequisites

n You must configure the appropriate credentials and templates in Ansible Tower for use with 
your deployments. Templates define the inventory and playbook for use with a deployment. 
There is a 1:1 mapping between a job template and a playbook. Playbooks use a YAML-like 
syntax to define tasks that are associated with the template. For most typical deployments, use 
machine credentials for authentication.

a Log in the the Ansible Tower and navigate to the Job Templates section.

b Select Adding a new job template.

n Select the Credential that you already created. These are the Credentials of the 
machine to be managed by Ansible Tower. For each job template, there can be one 
credential object.

n For the Limit selection, select Prompt on Launch. This ensures that the job template 
runs against the node being provisioned or de-provisioned from vRealize Automation 
Cloud Assembly. If this option is not selected, a Limit is not set error will appear when 
the blueprint that contains the job template is deployed.

n You can view the execution of the Job templates invoked from vRealize Automation Cloud 
Assembly on the Ansible Tower Jobs tab .

Procedure

1 Select Infrastructure > Connections > Integrations and click Add Integration.

2 Click Ansible Tower.

The Ansible configuration page appears.

3 Enter the Hostname, which can be an IP address, and other required information for the 
Ansible Tower instance.

4 Enter the UI-based authentication Username and Password for the applicable Ansible Tower 
instance.

5 Click Validate to verify the integration.

6 Type an appropriate Name and Description for the integration.

7 Click Add.

Results

Ansible Tower is available for use in blueprints.

What to do next

Add Ansible Tower components to the desired blueprints.

1 On the blueprint canvas page, select Ansible under the Configuration Management heading on 
the blueprint options menu and drag the Ansible Tower component to the canvas.
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2 Use the panel on the right to configure the appropriate Ansible properties such as job 
templates.

How do I create an Active Directory integration in vRealize 
Automation Cloud Assembly

vRealize Automation Cloud Assembly supports integration with Active Directory servers to provide 
out of the box creation of computer accounts in a specified Organizational Unit (OU) within an 
Active Directory server prior to provisioning a virtual machine. Active Directory supports an LDAP 
connection to the Active Directory server.

An Active Directory policy that is associated with a project is applied to all virtual machines 
provisioned within the scope of that project. Users can specify one or more tags that are used 
to selectively apply the policy to virtual machines that are provisioned to the cloud zones with 
matching capability tags.

For on-premises deployments, Active Directory integration enables you to set up a health check 
feature that shows the status of the integration and the underlying ABX integration on which 
it relies, including the required extensibility cloud proxy. Prior to applying an Active Directory 
policy, vRealize Automation Cloud Assembly checks the status of the underlying integrations. 
If the integration is healthy, vRealize Automation Cloud Assembly proceeds with creating the 
deployed computer objects in the specified Active Directory. If the integration is unhealthy, the 
deploy skips the Active Directory phase during provisioning.

Prerequisites

n Active Directory integration requires an LDAP connection to the Active Directory server.

n If you are configuring an Active Directory integration with vCenter on-premises, you must 
configure an ABX integration with an extensibility cloud proxy. Select Extensibility > Activity > 
Integrations and choose Extensibility Actions On Prem.

n If you are configuring an integration with Active Directory in the cloud, you must have a 
Microsoft Azure or Amazon Web Services account.

n You must have a project configured with appropriate cloud zones, and image and flavor 
mappings to use with the Active Directory integration.

n The desired OU on your Active Directory must be pre-created before you associated your 
Active Directory integration with a project.

Procedure

1 Select Infrastructure > Connections > Integrations and then New Integration.

2 Click Active Directory.

3 On the Summary tab, enter the appropriate LDAP host and environment names.

4 Enter the name and password for the LDAP server.
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5 Enter the appropriate Base DN for the desired users and groups in your Active Directory.

Note   You can specify only one DN per Active Directory integration.

6 Click Validate to ensure that the integration is functional.

7 Enter a Name and Description of this integration.

8 Click Save.

9 Click the Project tab to add a project to the Active Directory integration.

On the Add Projects dialog, you must select a project name and a relative DN, which is a DN 
that exists within the Base DN specified on the Summary tab.

10 Click Save.

Results

You can now associate the project with Active Directory integration to a blueprint. When a 
machine is previsioned using this blueprint, it will be pre-staged in the specified Active Directory 
and Organizational Unit.

You can also implement a tag-based health check for on- premises Active Directory integrations 
as follows.

1 Create an Active Directory integration as described in the preceding steps.

2 Click the Project tab to add a project to the Active Directory integration.

3 Select a project name and a relative DN on the Add Projects dialog. The relative DN must exist 
within the specified base DN.

4 Add appropriate tags. These tags are applicable to the cloud zone to which the Active 
Directory policy may apply.

5 Click Save.

The Status of the Active Directory integration is displayed for each integration on theInfrastructure 
> Connections > Integrations page in vRealize Automation Cloud Assembly.

You can associate the project with Active Directory integration with a blueprint. When a machine is 
provisioned using this blueprint, it is pre-staged in the specified Active Directory and OU.

Integrating with vRealize Operations Manager

vRealize Automation can work with vRealize Operations Manager to perform advanced workload 
placement, provide deployment health and virtual machine metrics, and display pricing.

Integration between the two products must be on-premises to on-premises, not a mix of on-
premises and cloud.
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To integrate with vRealize Operations Manager, look under Infrastructure > Connections > 
Integrations. To add the integration, you need the vRealize Operations Manager URL and its login 
username and password. In addition, vRealize Automation and vRealize Operations Manager need 
to manage the same endpoint.

See the following sections for details. For pricing information, see What are Pricing Cards.

Advanced workload placement using vRealize Operations Manager

vRealize Automation and vRealize Operations Manager can work together to optimally place 
deployment workloads.

You enable workload placement at the vSphere based cloud zone level. Only Distributed Resource 
Scheduler (DRS) enabled clusters of a cloud zone are eligible for advanced placement using 
vRealize Operations Manager.

n vRealize Automation placement—The vRealize Automation placement engine is application 
intent based. It considers tag-based constraints, project membership and the associated cloud 
zones, and affinity filters related to network, storage, and compute. Resource placement 
depends on all of these factors plus the presence of other, related target resources in the 
same deployment.

n vRealize Operations Manager placement—vRealize Operations Manager considers operational 
intent for optimal placement. Operational intent can take past workloads and future, what-if 
predictions into account.

When using advanced workload placement, you must apply vRealize Automation tagging 
in order to implement business intent decisions, instead of using the vRealize Operations 
Manager business intent options.

When integrating with vRealize Operations Manager, vRealize Automation continues to follow 
its application intent model and its related constraints to filter for target placement. Then, from 
within those results, it uses the vRealize Operations Manager recommendation to further refine 
placement.

In the absence of a recommendation

If you enable advanced workload placement, and vRealize Operations Manager analysis returns no 
recommendations, you may configure vRealize Automation to fall back to its default, application 
intent placement.

Limitations on workload placement

Certain limitations apply when using vRealize Operations Manager to place workloads.

n vRealize Operations Manager does not support workload placement on resource pools in 
vCenter Server.

n If vRealize Operations Manager is down, the timeout used for workload placement to call 
vRealize Operations Manager might expire.
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n Placement doesn't cross multiple cloud zones. vRealize Automation sends one cloud zone to 
vRealize Operations Manager for placement recommendations within that single cloud zone.

How to enable workload placement

To enable workload placement, there are steps to take for vSphere, vRealize Operations Manager, 
and vRealize Automation.

1 In vRealize Automation Cloud Assembly, connect to your vCenter Server cloud account.

The options are under Infrastructure > Connections > Cloud Accounts.

2 In vCenter Server, verify that DRS enabled clusters exist and are set to fully automated.

3 In vRealize Operations Manager, verify that the same vCenter Server is being managed.

You need vRealize Operations Manager 8 or later.

4 In vRealize Automation Cloud Assembly, add the vRealize Operations Manager integration.

The options are under Infrastructure > Connections > Integrations.

To add the integration, you need the vRealize Operations Manager primary node URL below, 
plus the login username and password.

https://operations-manager-IP-address-or-FQDN/suite-api

After entering the values, click VALIDATE.

5 Synchronize the integration to the vCenter Server by clicking SYNC.

Also synchronize any time that vRealize Automation Cloud Assembly and vRealize Operations 
Manager begin managing a new vCenter Server.

6 In vRealize Automation Cloud Assembly, create a cloud zone for the vCenter Server account.

The options are under Infrastructure > Configure > Cloud Zones.

7 Under the cloud zone Summary tab, set the Placement Policy to ADVANCED.

8 Under the Placement Policy, select whether to have vRealize Automation fall back to its default 
placement if vRealize Operations Manager returns no recommendations.

Troubleshooting workload placement

If vRealize Operations Manager isn't recommending workload placements the way that you 
expect, review the deployment request details in vRealize Automation Cloud Assembly or vRealize 
Automation Service Broker.

1 Go to Infrastructure > Activity > Requests, and click the request.

2 In Request Details, look at the allocation phases.

Look for targets that were successfully or unsuccessfully identified.

3 In Request Details, at the upper right, enable Dev Mode.

4 Follow the request path to locate filter blocks.
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5 Click a filter block, and review the following section.

filterName: ComputePlacementPolicyAffinityHostFilter
  ˅ computeLinksBefore
  ˅ computeLinksAfter
  ˅ filteredOutHostsReasons

Entry Description

computeLinksBefore List of potential placement hosts based on vRealize Automation algorithms.

computeLinksAfter Selected placement host.

filteredOutHostsReasons Messages describing why a host was selected or rejected.

When vRealize Operations Manager selects the host, the following message appears.

advance policy filter: Filtered hosts based on recommendation from vROPS.

Continuous optimization using vRealize Operations Manager

When you add the vRealize Automation adapter in vRealize Operations Manager, vRealize 
Operations Manager automatically creates a new custom datacenter (CDC) for vRealize 
Automation based workloads.

With continuous optimization, you take advantage of workload rebalancing and relocation, and 
use vRealize Automation with vRealize Operations Manager beyond initial workload placement. 
As virtualization resources move or come under heavier or lighter load, vRealize Automation 
provisioned workloads can move as needed.

n Continuous optimization automatically creates a new CDC in vRealize Operations Manager.

There is one new CDC for each vRealize Automation vSphere cloud zone.

n The newly created CDC contains every vRealize Automation managed cluster associated with 
the cloud zone.

Note   Do not manually create a mixed CDC of vRealize Automation and non-vRealize 
Automation clusters.

n You use vRealize Operations Manager to run continuous optimization for the newly created 
vRealize Automation based CDC.

n Workloads can only be rebalanced or relocated within the same cloud zone or CDC.

n Optimization never creates a new vRealize Automation or vRealize Operations Manager 
placement violation.

n If you have existing placement violations, optimization can fix vRealize Operations Manager 
operational intent issues.

n If you have existing placement violations, optimization cannot fix vRealize Operations 
Manager business intent issues.
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For example, if you used vRealize Operations Manager to manually move a virtual machine 
to a cluster that doesn't support your constraints, vRealize Operations Manager doesn't 
detect a violation nor try to resolve it.

n This release obeys operational intent at the CDC level. All member vRealize Automation 
clusters are optimized to the same settings.

To set a different operational intent for clusters, you must configure them in separate vRealize 
Automation CDCs, associated with separate vSphere cloud zones. Having different test and 
production clusters might be one example situation.

n vRealize Automation application intent and the constraints defined in vRealize Automation are 
honored during any optimization rebalance or relocation operations.

n vRealize Operations Manager placement tags cannot be applied to vRealize Automation 
provisioned workloads.

In addition, scheduled optimization involving multiple machines is supported. Regularly scheduled 
optimizations are not all-or-nothing processes. If conditions interrupt machine movement, 
successfully relocated machines stay relocated, and the next vRealize Operations Manager cycle 
attempts to relocate the remainder as is usual for vRealize Operations Manager. Such a partially 
completed optimization causes no negative effect in vRealize Automation.
How to enable continuous optimization
When you add the vRealize Automation adapter in vRealize Operations Manager, vRealize 
Operations Manager automatically creates a new, dedicated datacenter for vRealize Automation 
based workloads.

Other than adding the integration within vRealize Automation Cloud Assembly, there are no 
separate installation steps for continuous optimization. You may begin configuring and using 
vRealize Operations Manager for workload relocation in the new datacenter. See the Continuous 
optimization example .
Continuous optimization example
The following example shows a rebalancing workflow for vRealize Automation continuous 
optimization with vRealize Operations Manager.

1 From the vRealize Operations Manager home page, click Workload Optimization.

2 Select the automatically created vRealize Automation datacenter.

3 Under Operational Intent, click Edit, and select Balance.

You cannot select or edit Business Intent, which is disabled when the datacenter is for vRealize 
Automation optimization.
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4 Under Optimization Recommendation, click Optimize Now.

vRealize Operations Manager displays a before-and-after diagram of the proposed operation.

5 Click Next.

6 Click Begin Action.

7 In vRealize Automation, monitor the operation in progress by clicking Deployments and 
looking at event status.

When rebalancing finishes, vRealize Automation refreshes. The Compute Resources page shows 
that machines have moved.

In vRealize Operations Manager, the next data collection refreshes the display to show that 
optimization is complete.
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In vRealize Operations Manager, you can review the operation by clicking Administration > 
History > Recent Tasks.
Locate vRealize Automation managed datacenters
You can use vRealize Operations Manager to display only the vRealize Automation managed 
datacenters.

Procedure

1 From the vRealize Operations Manager home page, click Workload Optimization.

2 Near the top right, click the View drop-down.

3 Select only the vRealize Automation managed datacenters.

Deployment monitoring based on vRealize Operations Manager

vRealize Automation can show vRealize Operations Manager data about your deployments.

Reviewing the filtered set of metrics directly in vRealize Automation saves you the task of 
accessing or searching vRealize Operations Manager. Although you cannot launch in context 
to vRealize Operations Manager, you are of course free to log in and use vRealize Operations 
Manager for additional data as needed.

Enable vRealize Operations Manager data

For vRealize Automation to show vRealize Operations Manager data, you add the vRealize 
Operations Manager integration.

Procedure

1 In vRealize Operations Manager, go to Administration > Solutions.

2 Under Configured Adapter Instances, verify that you have a vCenter Adapter for the vSphere 
cloud zone that vRealize Automation provisions to and that it is receiving data.

3 In vRealize Automation Cloud Assembly, go to Infrastructure > Connections > Integrations.

4 Enter the vRealize Operations Manager primary node URL, plus the vRealize Operations 
Manager login username and password.

https://operations-manager-IP-address-or-FQDN/suite-api

5 Click Deployments, select a deployment, and verify that the Monitor tab appears.

Using and Managing vRealize Automation Cloud Assembly

VMware, Inc. 83

https://docs.vmware.com/en/vRealize-Operations-Manager/6.7/com.vmware.vcom.core.doc/GUID-19DAD6AF-7262-4655-B69F-6C665E33B52F.html


Metrics provided by vRealize Operations Manager

When monitoring is enabled, vRealize Automation retrieves vRealize Operations Manager metrics 
about your deployments.

To access monitoring, click a deployment and select the Monitor tab. If the tab is missing, see 
Enable vRealize Operations Manager data.

To see metrics, expand the component tree on the left, and highlight a virtual machine.

n Metrics are not cached. They come directly from vRealize Operations Manager and might take 
a few moments to load.

n Only virtual machine metrics appear. Metrics from other components such as vCloud Director, 
Software, or XaaS are not supported.

n Only vSphere virtual machine metrics appear. Other cloud providers such as AWS or Azure are 
not supported.

Metrics appear as timeline graphs that show highs and lows for the following measures.

n CPU

n Memory

n Storage IOPS

n Network MBPS

To reveal the specific metric name, click the blue information icon at the upper left corner of the 
timeline.

Acting on data provided by vRealize Operations Manager

When metrics provided by vRealize Operations Manager expose a problem, you can identify 
trouble areas directly in vRealize Automation.

To see metrics provided by vRealize Operations Manager, click a deployment and select the 
Monitor tab. If the tab is missing, see Enable vRealize Operations Manager data.
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Metrics for the past day, week, or month are available. To zoom in on an area of concern, select a 
small area in the lower, shaded part under any metric timeline:

What are onboarding plans in vRealize Automation Cloud 
Assembly

You use a workload onboarding plan to identify machines that have been data-collected from a 
cloud account type in a target region or data center but that are not yet managed by a vRealize 
Automation Cloud Assembly project.

When you add a cloud account that contains machines that were deployed outside of vRealize 
Automation Cloud Assembly, the machines are not managed by Cloud Assembly until you 
onboard them. Use an onboarding plan to bring unmanaged machines into vRealize Automation 
Cloud Assembly management. You create a plan, populate it with machines, and then run the plan 
to import the machines. Using the onboarding plan, you can create a blueprint and can also create 
one or many deployments.

You can onboard one or many unmanaged machines in a single plan. You can select machines 
manually or by using a filtering rule. Filtering rules select machines for onboarding based on 
criteria such as machine name, status, IP address, and tags.

n You can onboard up to 3,500 unmanaged machines within a single onboarding plan per hour.

n You can onboard up to 17,000 unmanaged machines concurrently within multiple onboarding 
plans per hour.

Machines that are available for workload onboarding are listed on the Resources > Machines page 
relative to a specific cloud account type and region and labeled as Discovered in the Origin 

column. Only machines that have been data-collected are listed. After you onboard the machines, 
they appear in the Origin column as Deployed.

The person who runs the workload onboarding plan is automatically assigned as the machine 
owner.

Onboarding examples

For examples of onboarding techniques, see Example: Onboard selected machines as a single 
deployment in vRealize Automation Cloud Assembly and Example: Onboard rule-filtered machines 
as separate deployments in vRealize Automation Cloud Assembly.
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Onboarding event subscriptions

A Deployment Onboarded event is created when you run the plan. Using Extensibility tab 

options, you can subscribe to these deployment events and perform actions on them.

Example: Onboard selected machines as a single deployment in 
vRealize Automation Cloud Assembly

In this example, you onboard two unmanaged machines as a single vRealize Automation Cloud 
Assembly deployment and create a single blueprint for all machines in the plan.

When you create a cloud account, all machines that are associated to it are data-collected 
and then displayed on the Infrastructure > Resources > Machines page. If the cloud account 
has machines that were deployed outside of vRealize Automation Cloud Assembly, you can 
use an onboarding plan to allow vRealize Automation Cloud Assembly to manage the machine 
deployments.

Prerequisites

n Verify that you have the required user role. See What are the vRealize Automation Cloud 
Assembly user roles.

n Review What are onboarding plans in vRealize Automation Cloud Assembly.

n Create and prepare a vRealize Automation Cloud Assembly project.

This procedure involves some of the steps from the basic Wordpress use case. See The 
WordPress use case.

n Create a project, add users, and assign user roles in the project. See WordPress use case: 
create a project.

n Create an Amazon Web Services cloud account for the project. See WordPress use case: 
add cloud accounts .

The Amazon Web Services cloud account in this procedure contains machines that were 
deployed before the cloud account was added to vRealize Automation Cloud Assembly 
and by an application other than vRealize Automation Cloud Assembly.

n Verify that the Machines page contains machines to onboard. See Machine resources.

Procedure

1 Go to Infrastructure > Onboarding.

2 Click New Onboarding Plan and enter sample values.

Setting Sample Value

Plan name VC-sqa-deployments

Description Sample onboarding plan for AWS machine for OurCo-
AWS cloud account
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Setting Sample Value

Cloud account OurCo-AWS

Default project WordPress

3 Click Create.

4 On the plan's Deployments tab, click Select Machines, choose one or more machines, and 
click OK.

5 Select Create one deployment that contains all the machines and click Create.

6 Click the check box next to the new deployment name and click Blueprint....

7 Click Create blueprint in Cloud Assembly format.
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8 Enter a blueprint name and click Save.

Note   When your onboarding plan uses a vSphere machine, you must edit the blueprint after 
the onboarding process is complete. The onboarding process cannot link the source vSphere 
machine and its machine template, and the resultant blueprint will contain the imageRef: "no 
image available" entry in the blueprint code. The blueprint cannot be deployed until you 

specify the correct template name in the imageRef: field. To make it easier to locate and 

update the blueprint after the onboarding process is complete, use the Blueprint name option 
on the deployment's Blueprint Configuration page. Record the auto-generated blueprint 
name or enter and record a blueprint name of your choice. When onboarding is complete, 
locate and open the blueprint and replace the "no image available" entry in the imageRef: 
field with the correct template name.

9 Click the deployment name check box, click Run, and then click Run again on the Run Plan 
page.

The selected Amazon Web Services machines are onboarded as a single deployment, with an 
accompanying blueprint.

10 Open and examine the blueprint by clicking the Blueprints tab and then clicking the blueprint 
name.

11 Open and examine the deployment by clicking the Deployments tab and then clicking the 
deployment name.

Example: Onboard rule-filtered machines as separate deployments in 
vRealize Automation Cloud Assembly

In this example, you use a filtering rule to onboard machines whose state is On and whose name 
begins with the letters BG. You also create a separate vRealize Automation Cloud Assembly 
blueprint and deployment for each machine in the plan.
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When you create a cloud account, all machines that are associated to it are data-collected 
and then displayed on the Infrastructure > Resources > Machines page. If the cloud account 
has machines that were deployed outside of vRealize Automation Cloud Assembly, you can 
use an onboarding plan to allow vRealize Automation Cloud Assembly to manage the machine 
deployments.

Prerequisites

n Verify that you have the required user role. See What are the vRealize Automation Cloud 
Assembly user roles.

n Review What are onboarding plans in vRealize Automation Cloud Assembly.

n Create and prepare a vRealize Automation Cloud Assembly project and populate it with one or 
more cloud accounts.

This involves some of the basic steps in your guided setup procedure.

n Create a project, add users, and assign user roles in the project. See WordPress use case: 
create a project.

n Create one or more cloud accounts in designated regions for the project. See WordPress 
use case: add cloud accounts .

n Verify that the Machines page contains machines to onboard. See Machine resources.

Procedure

1 Go to Infrastructure > Onboarding.

2 Click New Onboarding Plan and enter values.

Setting Sample Value

Plan name ob_rules_1

Description Machine onboarding with rules1

Cloud account rs-aws

Default project rs-project
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3 Click Create.

4 Click the Rules tab and then click Add Rule.

You can create one or more rules to select a group of machines for onboarding based on 
specific machine characteristics.
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5 Enter a rule name, such as ob_rules_1.

6 Build the rule by adding filters.

For this example, use the Status and Name filters on the Filter drop-down menu to specify all 
the machine whose name contains BG* and whose status is On.

 

7 Click Save.

Although you can make additional rules, this example uses a single rule.
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8 Click the Machines tab. In this example, 4 machines are selected, 3 that begin with the letters 
BG and one that contains the letters BG.

9 Remove the machine whose name does not begin with BG by selecting its check box and then 

clicking Exclude.

10 Click the Deployments tab.

The 3 machines that begin with the letters BG and that are powered On are ready to be 

deployed. By default, a separate blueprint and deployment is created for each machine.
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11 Click the check box next to the three deployment names, click Blueprints, click Create 
blueprint in Cloud Assembly format, and click Save.

Note   When your onboarding plan uses a vSphere machine, you must edit the blueprint after 
the onboarding process is complete. The onboarding process cannot link the source vSphere 
machine and its machine template, and the resultant blueprint will contain the imageRef: "no 
image available" entry in the blueprint code. The blueprint cannot be deployed until you 

specify the correct template name in the imageRef: field. To make it easier to locate and 

update the blueprint after the onboarding process is complete, use the Blueprint name option 
on the deployment's Blueprint Configuration page. Record the auto-generated blueprint 
name or enter and record a blueprint name of your choice. When onboarding is complete, 
locate and open the blueprint and replace the "no image available" entry in the imageRef: 
field with the correct template name.
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12 On the Deployments page, click the check box next to the three deployment names, and click 
Run.

13 When prompted to confirm, click Run to onboard the machines.

The plan is run and the machines are brought into vRealize Automation Cloud Assembly 
management. A separate blueprint and deployment is created for each machine.

Advanced configuration for vRealize Automation Cloud 
Assembly environment

You can configure your vRealize Automation Cloud Assembly environment to further support 
project configuration, integration, and deployment.

For related and additional information about administration methods, such as using working with 
users and logs, and joining or leaving the Customer Experience program, see the Administering 
vRealize Automation help.
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How do I configure an Internet proxy server for vRealize Automation

For vRealize Automation 8.0.1 forward installations on isolated networks with no direct Internet 
access, you can use an Internet proxy server to allow Internet by proxy functionality. The Internet 
proxy server supports HTTP and HTTPS.

To configure and use public cloud providers such as Amazon Web Services (AWS), Microsoft 
Azure, and Google Cloud Platform (GCP) as well as external integration points such as IPAM, 
Ansible, and Puppet, with vRealize Automation, you must configure an Internet proxy server to 
access the internal vRealize Automation Internet proxy server.

vRealize Automation contains an internal proxy server that communicates with your Internet 
proxy server. This server communicates with your proxy server if it has been configured with 
the vracli proxy set ... command. If you have not configured an Internet proxy server for your 

organization, then the vRealize Automation internal proxy server attempts to connect directly to 
the Internet.

You can set up vRealize Automation to use an Internet proxy server by using the supplied vracli 
command line utility. Information about how to use the vracli API is available by using the 

--help argument in the vracli command line, for examplevracli proxy –-help.

Access to the Internet proxy server requires use of the actions-based extensibility (ABX) On-Prem 
Embedded controls that are built into vRealize Automation.

Note   Access to Workspace ONE Access (previously named VMware Identify Manager) is not 
supported by way of the Internet proxy. You cannot use the vracli set vidm command to access 

Workspace ONE Access through the Internet proxy server. 

The internal proxy server requires IPv4 as its default IP format. It doesn't require Internet protocol 
restrictions, authentication or man-in-the-middle actions on TLS (HTTPS) certificate traffic.

Prerequisites

n Verify that you have an existing HTTP or HTTPS server, that you can use as the Internet proxy 
server, in the vRealize Automation network that is able to pass outgoing traffic to external 
sites. The connection must be configured for IPv4.

n Verify that the target Internet proxy server is configured to support IPv4 as its default IP 
format and not IPv6.

n If the Internet proxy server uses TLS and requires an HTTPS connection with its clients, you 
must import the server certificate by using one of the following commands, prior to setting the 
proxy configuration.

n vracli certificate proxy --set path_to_proxy_certificate.pem 

n vracli certificate proxy --set stdin

Use the stdin parameter for interactive input.
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Procedure

1 Create a proxy configuration for the pods or containers that are used by Kubernetes. In this 
example, the proxy server is accessed by using the HTTP scheme.

vracli proxy set --host http://proxy.vmware.com:3128

2 Show the proxy configuration.

vracli proxy show

The result will be similar to:

{
    "enabled": true,
    "host": "10.244.4.51",
    "java-proxy-exclude": "*.local|*.localdomain|localhost|10.244.*|
192.168.*|172.16.*|kubernetes|sc2-rdops-vm06-dhcp-198-120.eng.vmware.com|10.192.204.9|
*.eng.vmware.com|sc2-rdops-vm06-dhcp-204-9.eng.vmware.com|10.192.213.146|sc2-rdops-vm06-
dhcp-213-146.eng.vmware.com|10.192.213.151|sc2-rdops-vm06-dhcp-213-151.eng.vmware.com",
    "java-user": null,
    "password": null,
    "port": 3128,
    "proxy-
exclude": ".local,.localdomain,localhost,10.244.,192.168.,172.16.,kubernetes,sc2-
rdops-vm06-dhcp-198-120.eng.vmware.com,10.192.204.9,.eng.vmware.com,sc2-
rdops-vm06-dhcp-204-9.eng.vmware.com,10.192.213.146,sc2-rdops-vm06-
dhcp-213-146.eng.vmware.com,10.192.213.151,sc2-rdops-vm06-dhcp-213-151.eng.vmware.com",
    "scheme": "http",
    "upstream_proxy_host": null,
    "upstream_proxy_password_encoded": "",
    "upstream_proxy_port": null,
    "upstream_proxy_user_encoded": "",
    "user": null,
    "internal.proxy.config": "dns_v4_first on \nhttp_port 
0.0.0.0:3128\nlogformat squid %ts.%03tu %6tr %>a %Ss/%03>Hs 
%<st %rm %ru %[un %Sh/%<a %mt\naccess_log stdio:/tmp/logger squid\ncoredump_dir /\ncache 
deny all \nappend_domain .prelude.svc.cluster.local\nacl mylan src 10.0.0.0/8\nacl mylan 
src 127.0.0.0/8\nacl mylan src 192.168.3.0/24\nacl proxy-exclude dstdomain .local\nacl 
proxy-exclude dstdomain .localdomain\nacl proxy-exclude dstdomain localhost\nacl 
proxy-exclude dstdomain 10.244.\nacl proxy-exclude dstdomain 192.168.\nacl proxy-exclude 
dstdomain 172.16.\nacl proxy-exclude dstdomain kubernetes\nacl proxy-exclude dstdomain 
10.192.204.9\nacl proxy-exclude dstdomain .eng.vmware.com\nacl proxy-exclude dstdomain 
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10.192.213.146\nacl proxy-exclude dstdomain 10.192.213.151\nalways_direct allow proxy-
exclude\nhttp_access allow mylan\nhttp_access deny all\n# End autogen configuration\n",
    "internal.proxy.config.type": "default"
}

Note   If you have configured an Internet proxy server for your organization, then 
"internal.proxy.config.type": "non-default" appears in the above example instead of 

'default'. For security, the password is not shown.

Note   If you use the -proxy-exclude parameter, you must edit the default values. For 

example, if you want to add acme.com as a domain that cannot be accessed by using the 

Internet proxy server, use the following steps:

a Enter vracli proxy default-no-proxy to obtain the default proxy-exclude settings. This is 

a list of automatically generated domains and networks.

b Edit the value to add .acme.com.

c Enter vracli proxy set .... --proxy-exclude ... to update the configuration settings.

d Run the /opt/scripts/deploy.sh command to redeploy the environment.

3 (Optional) Exclude DNS domains, FQDNs, and IP addresses from being accessed by the 
Internet proxy server.

Always modify the default values of the proxy-exclude variable using parameter --proxy-
exclude. To add the domain exclude.vmware.com, first use the vrali proxy show command, 

then copy the proxy-exclude variable, and add the domain value using the vracli proxy 
set ... command as below:

vracli proxy set --host http://
proxy.vmware.com:3128 --proxy-exclude "exclude.vmware.com,docker-
registry.prelude.svc.cluster.local,localhost,.local,.cluster.local,10.244.,192.,172.16.,sc-
rdops-vm11-dhcp-75-38.eng.vmware.com,10.161.75.38,.eng.vmware.com"

Note   Add elements to proxy-exclude instead of replacing values. If you delete proxy-
exclude default values, vRealize Automation does not function properly. If this happens, 

delete the proxy configuration and start over.

4 After you set the Internet proxy server with vracli proxy set ... command, you can use the 

vracli proxy apply command to update the Internet proxy server configuration and make the 

latest proxy settings active.

5 If you have not already done so, activate the script changes by running the following 
command:

/opt/scripts/deploy.sh
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6 (Optional) If needed, configure the proxy server to support external access on port 22.

To support integrations such as Puppet and Ansible, the proxy server must allow port 22 to 
access the relevant hosts.

Example: Sample Squid configuration

Relative to step 1, if you are setting up a Squid proxy, you can tune your configuration in /etc/
squid/squid.conf by adapting it to the following sample:

acl localnet src 192.168.11.0/24

acl SSL_ports port 443

acl Safe_ports port 80 # http
acl Safe_ports port 21 # ftp
acl Safe_ports port 443 # https
acl Safe_ports port 70 # gopher
acl Safe_ports port 210 # wais
acl Safe_ports port 1025-65535 # unregistered ports
acl Safe_ports port 280 # http-mgmt
acl Safe_ports port 488 # gss-http
acl Safe_ports port 591 # filemaker
acl Safe_ports port 777 # multiling http
acl CONNECT method CONNECT

http_access allow !Safe_ports
http_access allow CONNECT !SSL_ports
http_access allow localnet

http_port 0.0.0.0:3128

maximum_object_size 5 GB
cache_dir ufs /var/spool/squid 20000 16 256
coredump_dir /var/spool/squid
refresh_pattern ^ftp: 1440 20% 10080
refresh_pattern ^gopher: 1440 0% 1440
refresh_pattern -i (/cgi-bin/|\?) 0 0% 0
refresh_pattern (Release|Packages(.gz)*)$ 0 20% 2880
refresh_pattern . 0 20% 4320

client_persistent_connections on
server_persistent_connections on

How do I use the IPAM SDK to create a provider-specific external 
IPAM integration package for vRealize Automation

External IPAM vendors and partners can download and use the IPAM SDK to create an IPAM 
integration package that enables vRealize Automation to support their provider-specific IPAM 
solution.
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The process for building and deploying a custom IPAM integration package for vRealize 
Automation by using the supplied IPAM SDK is described in the Creating and Deploying a 
Provider-specific IPAM Integration Package for VMware Cloud Assembly document. As described 
in the document, you can download the most recent VMware vRealize Automation Third-Party 
IPAM SDK from the VMware code site. The following IPAM SDK packages are available:

n VMware vRealize Automation Third-Party IPAM SDK 1.1.0

n VMware vRealize Automation Third-Party IPAM SDK 1.0.0

Before taking the time to create a vendor-specific IPAM integration package by using the IPAM 
SDK, check to see if one already exists for vRealize Automation. You can check for a provider-
specific IPAM integration package on the IPAM provider's website, in the VMware Marketplace 
and from the vRealize Automation Marketplace tab.

While the Use case: How do I configure a provider-specific external IPAM integration for vRealize 
Automation example is vendor-specific, it also contains helpful reference information.
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vRealize Automation Cloud 
Assembly use cases 3
These use cases show examples that create resource infrastructure in vRealize Automation Cloud 
Assembly and then design and deploy applications onto that infrastructure.

The uses cases present example values only. Your own environment structure and naming 
conventions will vary.

This chapter includes the following topics:

n The WordPress use case

n VMware Cloud on AWS use case 

n Use case: How do I configure a provider-specific external IPAM integration for vRealize 
Automation 

The WordPress use case

This end-to-end vRealize Automation Cloud Assembly use case shows an example of creating 
infrastructure and deploying a WordPress site onto that infrastructure.

Look at the sequential setup to understand the process that brings a WordPress site to 
completion.

Remember that the values you see are only use case examples. You won't be able to use them 
letter-by-letter in your environment.

Think about where you would make your own substitutions, or extrapolate from the example 
values, in order to fit your own cloud infrastructure and deployment needs.

Procedure

1 WordPress use case: create the infrastructure

As a cloud administrator, you first need to configure the resources where engineering can 
later develop, test, and put a WordPress site into production.

2 WordPress use case: create a project

A project enables the users who can provision, and configures how much provisioning is 
possible.
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3 WordPress use case: create and expand a blueprint

As a developer, you define the WordPress site in the form of a generic vRealize Automation 
Cloud Assembly blueprint that can be deployed to any cloud vendor.

WordPress use case: create the infrastructure

As a cloud administrator, you first need to configure the resources where engineering can later 
develop, test, and put a WordPress site into production.

The infrastructure includes cloud targets, and definitions around the machines, networks, and 
storage that the WordPress site will need.

Procedure

1 WordPress use case: add cloud accounts 

In this step, the cloud administrator adds two cloud accounts. The project expects to do 
development and testing work on AWS, and go to production on Azure.

2 WordPress use case: add cloud zones

In this step, the cloud administrator adds three cloud zones, one each for development, 
testing, and production.

3 WordPress use case: add flavor mappings

In this step, the cloud administrator adds flavor mappings to account for capacity needs that 
might vary depending on deployment.

4 WordPress use case: add image mappings

In this step, the cloud administrator adds an image mapping for Ubuntu, the host for the 
WordPress server and its MySQL database server.

5 WordPress use case: add network profiles

In this step, the cloud administrator adds a network profile to each cloud zone.

6 WordPress use case: add storage profiles

In this step, the cloud administrator adds a storage profile to each cloud zone.

WordPress use case: add cloud accounts

In this step, the cloud administrator adds two cloud accounts. The project expects to do 
development and testing work on AWS, and go to production on Azure.

Procedure

1 Go to Infrastructure > Connections > Cloud Accounts.
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2 Click Add Cloud Account, select Amazon Web Services, and enter values.

Setting Sample Value

Access key ID R5SDR3PXVV2ZW8B7YNSM

Secret access key SZXAINXU4UHNAQ1E156S

Name OurCo-AWS

Description WordPress

Capabilities cloud:aws

Remember that all values are only use case samples. Your account specifics will vary.

3 To verify credentials, click Validate.

4 Click Add.

5 Edit the newly added account Configuration, and allow provisioning to us-east-1 and us-
west-2 regions.

6 Click Add Cloud Account, select Microsoft Azure, and enter values.

Setting Sample Value

Subscription ID ef2avpf-dfdv-zxlugui1i-g4h0-i8ep2jwp4c9arbfe

Tenant ID dso9wv3-4zgc-5nrcy5h3m-4skf-nnovp40wfxsro22r

Client application ID bg224oq-3ptp-mbhi6aa05-q511-uf1yjr2sttyik6bs

Client application secret key 7uqxi57-0wtn-kymgf9wcj-t2l7-e52e4nu5fig4pmdd

Name OurCo-Azure

Description WordPress

Capabilities cloud:az

7 To verify credentials, click Validate.

8 Click Add.

9 Edit the newly added account Configuration, and allow provisioning to the East US region.

What to do next

Add cloud zones where the project will deploy the WordPress site. See WordPress use case: add 
cloud zones.

WordPress use case: add cloud zones

In this step, the cloud administrator adds three cloud zones, one each for development, testing, 
and production.
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Cloud zones are the resources onto which the project will deploy the machines, networks, and 
storage to support the WordPress site.

Prerequisites

Add cloud accounts. See WordPress use case: add cloud accounts .

Procedure

1 Go to Infrastructure > Configure > Cloud Zones.

2 Click New Cloud Zone, and enter values for the development environment.

Cloud Zone Setting Sample Value

Account / region OurCo-AWS/us-east-1

Name OurCo-AWS-US-East

Description WordPress

Placement policy Default

Capability tags env:dev

Remember that all values are only use case samples. Your zone specifics will vary.

3 Click Compute, and verify that the zones you expect are there.

4 Click Create.

5 Repeat the process twice, with values for the test and production environments.

Cloud Zone Setting Sample Value

Account / region OurCo-AWS/us-west-2

Name OurCo-AWS-US-West

Description WordPress

Placement policy Default

Capability tags env:test

Cloud Zone Setting Sample Value

Account / region OurCo-Azure/East US

Name OurCo-Azure-East-US

Description WordPress

Placement policy Default

Capability tags env:prod
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What to do next

Account for different size machine deployments by adding flavor mappings. See WordPress use 
case: add flavor mappings.

WordPress use case: add flavor mappings

In this step, the cloud administrator adds flavor mappings to account for capacity needs that might 
vary depending on deployment.

Flavor mapping is informally referred to as T-shirt sizing.

Prerequisites

Add cloud zones. See WordPress use case: add cloud zones.

Procedure

1 Go to Infrastructure > Configure > Flavor Mappings. Each cloud zone needs to allow for 
small, medium, and large flavors.

2 Click New Flavor Mapping, and enter values for the development cloud zone.

Setting Sample Value

Flavor name small

Account/region

Value

OurCo-AWS/us-east-1

t2.micro

Account/region

Value

OurCo-AWS/us-west-2

t2.micro

Account/region

Value

OurCo-Azure/East US

Standard_A0

Remember that all values are only use case samples. Your flavors will vary.

3 Click Create.

4 Repeat the process twice, with values for medium and large flavors.

Setting Sample Value

Flavor name medium

Account/region

Value

OurCo-AWS/us-east-1

t2.medium

Account/region

Value

OurCo-AWS/us-west-2

t2.medium

Account/region

Value

OurCo-Azure/East US

Standard_A3
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Setting Sample Value

Flavor name large

Account/region

Value

OurCo-AWS/us-east-1

t2.large

Account/region

Value

OurCo-AWS/us-west-2

t2.large

Account/region

Value

OurCo-Azure/East US

Standard_A7

What to do next

Plan for the operating system by adding image mappings. See WordPress use case: add image 
mappings.

WordPress use case: add image mappings

In this step, the cloud administrator adds an image mapping for Ubuntu, the host for the 
WordPress server and its MySQL database server.

Each cloud zone needs a Ubuntu image mapping.

Prerequisites

Add cloud zones. See WordPress use case: add cloud zones.

Procedure

1 Go to Infrastructure > Configure > Image Mappings.

2 Click New Image Mapping, and enter values for Ubuntu servers.

Setting Sample Value

Image name ubuntu-16

Account/region

Value

OurCo-AWS/us-east-1

ubuntu-16.04-server-cloudimg-amd64

Account/region

Value

OurCo-AWS/us-west-2

ubuntu-16.04-server-cloudimg-amd64

Account/region

Value

OurCo-Azure/East US

azul-zulu-ubuntu-1604-923eng

Remember that all values are only use case samples. Your images will vary.

3 Click Create.

What to do next

Add networks. See WordPress use case: add network profiles.
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WordPress use case: add network profiles

In this step, the cloud administrator adds a network profile to each cloud zone.

In each profile, the administrator adds a network for the WordPress machines, and a second 
network that will sit on the other side of an eventual load balancer. The second network will be the 
one that users eventually connect over.

Prerequisites

Add cloud zones. See WordPress use case: add cloud zones.

Procedure

1 Go to Infrastructure > Configure > Network Profiles.

2 Click New Network Profile, and create a profile for the development cloud zone.

Network Profile Setting Sample Value

Account / region OurCo-AWS/us-east-1

Name devnets

Description WordPress

Capability tags env:dev

3 Click Networks, and click Add Network.

4 Select wpnet, appnet-public, and click Add.

Remember that all values are only use case samples. Your network names will vary.

5 Click Create.

This Wordpress example does not require that you specify network policy or network security 
settings.

6 Repeat the process twice, to create a network profile for the Wordpress example test and 
production cloud zones. In each case, add the wpnet and appnet-public networks.

Network Profile Setting Sample Value

Account / region OurCo-AWS/us-west-2

Name testnets

Description WordPress

Capability tags env:test
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Network Profile Setting Value

Account / region OurCo-Azure/East US

Name prodnets

Description WordPress

Capability tags env:prod

What to do next

Add storage. See WordPress use case: add storage profiles.

WordPress use case: add storage profiles

In this step, the cloud administrator adds a storage profile to each cloud zone.

The administrator places fast storage at the production zone and general storage at development 
and test.

Prerequisites

Add cloud zones. See WordPress use case: add cloud zones.

Procedure

1 Go to Infrastructure > Configure > Storage Profiles.

2 Click New Storage Profile, and create a profile for the development cloud zone.

Additional fields appear after you select the account/region.

Storage Profile Setting Sample Value

Account / region OurCo-AWS/us-east-1

Name OurCo-AWS-US-East-Disk

Description WordPress

Device type EBS

Volume type General Purpose SSD

Capability tags usage:general

Remember that all values are only use case samples.

3 Click Create.
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4 Repeat the process to create a profile for the test cloud zone.

Storage Profile Setting Sample Value

Account / region OurCo-AWS/us-west-2

Name OurCo-AWS-US-West-Disk

Description WordPress

Device type EBS

Volume type General Purpose SSD

Capability tags usage:general

5 Repeat the process to create a profile for the production cloud zone, which has different 
settings because it is an Azure zone.

Storage Profile Setting Sample Value

Account / region OurCo-Azure/East US

Name OurCo-Azure-East-US-Disk

Description WordPress

Storage type Managed disks

Disk type Premium LRS

OS disk caching Read only

Data disk caching Read only

Capability tags usage:fast

What to do next

Create a project to identify users, and to define provisioning settings. See WordPress use case: 
create a project.

WordPress use case: create a project

A project enables the users who can provision, and configures how much provisioning is possible.

Projects define the user and provisioning settings.

n Users and their role level of permission

n Priority for deployments as they are being provisioned to a cloud zone

n Maximum number of deployment instances per cloud zone
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Prerequisites

Add cloud zones. See WordPress use case: add cloud zones.

Procedure

1 Go to Infrastructure > Administration > Projects.

2 Click New Project, and enter the name WordPress.

3 Click Users, and click Add Users.

4 Add email addresses and roles for the users.

To successfully add a user, a VMware Cloud Services administrator must have enabled access 
to vRealize Automation Cloud Assembly for the user.

Remember that addresses shown here are only use case samples.

n chris.ladd@ourco.com, Member

n kerry.mott@ourco.com, Member

n pat.tubb@ourco.com, Administrator

5 Click Provisioning, and click Add Cloud Zone.

6 Add the cloud zones that the users can deploy to.

Project Cloud Zone Setting Sample Value

Cloud zone

Provisioning priority

Instances limit

OurCo-AWS-US-East

1

5

Cloud zone

Provisioning priority

Instances limit

OurCo-AWS-US-West

1

5

Cloud zone

Provisioning priority

Instances limit

OurCo-Azure-East-US

0

1

7 Click Create.

8 Go to Infrastructure > Configure > Cloud Zones, and open a zone that was created in 
WordPress use case: add cloud zones.

9 Click Projects, and verify that WordPress is a project that is allowed to provision to the zone.

10 Check the other zones created in WordPress use case: add cloud zones.

What to do next

Create a basic blueprint.
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WordPress use case: create and expand a blueprint

As a developer, you define the WordPress site in the form of a generic vRealize Automation Cloud 
Assembly blueprint that can be deployed to any cloud vendor.

The use case blueprint consists of a WordPress application server, MySQL database server, and 
supporting resources that are deployable to AWS, Azure, or vSphere-based clouds. The blueprint 
starts with a few resources, and then grows as you modify existing resources and add more 
resources.

The examples from WordPress use case: create the infrastructure included infrastructure that was 
set by a cloud administrator:

n Two cloud accounts, AWS and Azure.

n Three cloud zone environments:

n Development—OurCo-AWS-US-East

n Test—OurCo-AWS-US-West

n Production—OurCo-Azure-East-US

n Flavor mappings with small, medium, and large compute resources for each zone.

n Image mappings for Ubuntu 16 configured in each zone.

n Network profiles with internal and external subnets for each zone: devnets, testnets, prodnets.

n Storage to support an archive disk, general storage for development and test, with fast 
storage for production.

n The WordPress project includes all three cloud zone environments plus users who can try the 
use case.

Prerequisites

Be familiar with your infrastructure values. For example, the use case example uses AWS for 
development and test, and Azure for production. When creating your own blueprint, substitute 
your own values, typically set by your cloud administrator.

Procedure

1 WordPress use case: create a basic blueprint

As a developer, you start with a vRealize Automation Cloud Assembly blueprint that contains 
only minimal WordPress resources, such as having only one application server.

2 WordPress use case: test a basic blueprint

During development, you are typically building a vRealize Automation Cloud Assembly 
blueprint by starting with the essentials, then deploying and testing as the blueprint grows.
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3 WordPress use case: expand a blueprint

After you create and test a basic vRealize Automation Cloud Assembly blueprint, you expand 
it into a multiple tier application that is deployable to development, test, and eventually 
production.

WordPress use case: create a basic blueprint

As a developer, you start with a vRealize Automation Cloud Assembly blueprint that contains only 
minimal WordPress resources, such as having only one application server.

vRealize Automation Cloud Assembly is an infrastructure-as-code tool. You drag resources to the 
design canvas to get started. Then, you complete the details using the code editor to the right of 
the canvas.

The code editor allows you to type, cut, and paste code directly. If you're uncomfortable editing 
code, you can select a resource in the canvas, click the code editor Properties tab, and enter 
values there. Values that you enter appear in the code as if you had typed them directly.

Prerequisites

Be familiar with your infrastructure. The examples shown here use the infrastructure values from 
WordPress use case: create the infrastructure, but you would substitute your own.

Procedure

1 Go to Design, and click New.

2 Name the blueprint Wordpress-BP.

3 Select the WordPress project, and click Create.

4 From the resources on the left of the blueprint design page, drag two cloud agnostic machines 
onto the canvas.

The machines serve as WordPress application server (WebTier) and MySQL database server 
(DBTier).

5 On the right, edit the machine YAML code to add names, images, flavors, and constraint tags:

resources:
  DBTier:    
    type: Cloud.Machine    
    properties:      
        name: mysql      
        image: 'ubuntu-16'      
        flavor: 'small'      
        constraints:        
            -   tag: env:dev
  WebTier:
    type: Cloud.Machine    
    properties:     
        name: wordpress      
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        image: 'ubuntu-16'      
        flavor: 'small'      
        constraints:        
            - tag: env:dev

6 Drag a cloud agnostic network to the canvas, and edit its code:

 WP-Network-Private:
    type: Cloud.Network
    properties:
        name: WP-Network-Private
        networkType: existing
        constraints:
            - tag: 'type:isolated-net'
            - tag: 'env:dev'

7 Connect the machines to the network:

Click and hold where the line touches the network block, drag to a machine block, and release.

In the editor, notice that the network code gets added to the two machines:

resources:
  DBTier:    
    type: Cloud.Machine    
    properties:      
        name: mysql      
        image: 'ubuntu-16'      
        flavor: 'small'      
        constraints:        
            -   tag: env:dev
        networks:
            - network: '${resource["WP-Network-Private"].id}'
  WebTier:
    type: Cloud.Machine    
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    properties:     
        name: wordpress      
        image: 'ubuntu-16'      
        flavor: 'small'      
        constraints:        
            - tag: env:dev
        networks:
            - network: '${resource["WP-Network-Private"].id}'
  

8 Add user input prompting.

In some places, the use case infrastructure was set up for multiple options. For example:

n Cloud zone environments for development, test, and production

n Flavor mappings for small, medium, and large machines

n Storage disk speeds for general and fast usage
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You might set a specific option directly in the blueprint, but a better approach is to let the user 
select the option at blueprint deployment time. Prompting for user input lets you create one 
blueprint that can be deployed many ways, instead of having many hard-coded blueprints.

a Create an inputs section in the code so that users can select machine size and target 

environment at deployment time. Define the selectable values:

inputs:
  env:
    type: string
    enum:
      - 'env:dev'
      - 'env:prod'
      - 'env:test'
    default: 'env:dev'
    title: Environment
    description: Target Environment
  size:
    type: string
    enum:
      - small
      - medium
      - large
    description: Size of Nodes
    title: Tier Machine Size

b In the resources section of the code, add ${input.input-name} code to prompt for the 

user selection:

resources:
  DBTier:    
    type: Cloud.Machine    
    properties:      
        name: mysql      
        image: 'ubuntu-16'      
        flavor: '${input.size}'      
        constraints:        
            -   tag: '${input.env}'
        networks:
            - network: '${resource["WP-Network-Private"].id}'
  WebTier:
    type: Cloud.Machine    
    properties:     
        name: wordpress      
        image: 'ubuntu-16'      
        flavor: '${input.size}'      
        constraints:        
            - tag: '${input.env}'
        networks:
            - network: '${resource["WP-Network-Private"].id}'
  WP-Network-Private:
    type: Cloud.Network
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    properties:
        name: WP-Network-Private
        networkType: existing
        constraints:
            - tag: 'type:isolated-net'
            - tag: '${input.env}'

9 Finally, enhance the WebTier and DBTier code using the following examples. The WP-Network-
Private code does not need additional changes.

Note that the enhancements include login access to the database server, a database disk, and 
deployment-time cloudConfig initialization scripts.
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Component Example

Additional 
DBTier Inputs   username:

    type: string
    minLength: 4
    maxLength: 20
    pattern: '[a-z]+'
    title: Database Username
    description: Database Username
  userpassword:
    type: string
    pattern: '[a-z0-9A-Z@#$]+'
    encrypted: true
    title: Database Password
    description: Database Password
  databaseDiskSize:
    type: number
    default: 4
    maximum: 10
    title: MySQL Data Disk Size
    description: Database Disk Size

DBTier 
Resource   DBTier:

    type: Cloud.Machine
    properties:
      name: mysql
      image: ubuntu-16
      flavor: '${input.size}'
      constraints:
        - tag: '${input.env}'
      networks:
        - network: '${resource["WP-Network-Private"].id}'
          assignPublicIpAddress: true
      remoteAccess:
        authentication: usernamePassword
        username: '${input.username}'
        password: '${input.userpassword}'
      cloudConfig: |
        #cloud-config
        repo_update: true
        repo_upgrade: all

        packages:
         - mysql-server

        runcmd:
         - sed -e '/bind-address/ s/^#*/#/' -i /etc/mysql/mysql.conf.d/
mysqld.cnf
         - service mysql restart
         - mysql -e "GRANT ALL PRIVILEGES ON *.* TO 'root'@'%' IDENTIFIED 
BY 'mysqlpassword';"
         - mysql -e "FLUSH PRIVILEGES;"
      attachedDisks: []

WebTier 
Resource   WebTier:

    type: Cloud.Machine
    properties:
      name: wordpress
      flavor: '${input.size}'
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Component Example

      image: ubuntu-16
      constraints:
        - tag: '${input.env}'
      networks:
        - network: '${resource["WP-Network-Private"].id}'
          assignPublicIpAddress: true
      cloudConfig: |
        #cloud-config
        repo_update: true
        repo_upgrade: all

        packages:
         - apache2
         - php
         - php-mysql
         - libapache2-mod-php
         - php-mcrypt
         - mysql-client

        runcmd:
         - mkdir -p /var/www/html/mywordpresssite && cd /var/www/html 
&& wget https://wordpress.org/latest.tar.gz && tar -xzf /var/www/html/
latest.tar.gz -C /var/www/html/mywordpresssite --strip-components 1
         - i=0; while [ $i -le 5 ]; do mysql --connect-timeout=3 -h $
{DBTier.networks[0].address} -u root -pmysqlpassword -e "SHOW STATUS;" && 
break || sleep 15; i=$((i+1)); done
         - mysql -u root -pmysqlpassword -h ${DBTier.networks[0].address} 
-e "create database wordpress_blog;"
         - mv /var/www/html/mywordpresssite/wp-config-sample.php /var/www/
html/mywordpresssite/wp-config.php
         - sed -i -e 
s/"define( 'DB_NAME', 'database_name_here' );"/"define( 'DB_NAME', 
'wordpress_blog' );"/ /var/www/html/mywordpresssite/wp-config.php && sed 
-i -e s/"define( 'DB_USER', 'username_here' );"/"define( 'DB_USER', 
'root' );"/ /var/www/html/mywordpresssite/wp-config.php && sed -i 
-e s/"define( 'DB_PASSWORD', 'password_here' );"/"define( 'DB_PASSWORD', 
'mysqlpassword' );"/ /var/www/html/mywordpresssite/wp-config.php && sed 
-i -e s/"define( 'DB_HOST', 'localhost' );"/"define( 'DB_HOST', 
'${DBTier.networks[0].address}' );"/ /var/www/html/mywordpresssite/wp-
config.php
         - service apache2 reload

Example: Completed Basic Blueprint Code Example

inputs:
  env:
    type: string
    enum:
      - 'env:dev'
      - 'env:prod'
      - 'env:test'
    default: 'env:dev'
    title: Environment
    description: Target Environment
  size:
    type: string
    enum:
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      - small
      - medium
      - large
    description: Size of Nodes
    title: Tier Machine Size
  username:
    type: string
    minLength: 4
    maxLength: 20
    pattern: '[a-z]+'
    title: Database Username
    description: Database Username
  userpassword:
    type: string
    pattern: '[a-z0-9A-Z@#$]+'
    encrypted: true
    title: Database Password
    description: Database Password
  databaseDiskSize:
    type: number
    default: 4
    maximum: 10
    title: MySQL Data Disk Size
    description: Database Disk Size
resources:
  DBTier:
    type: Cloud.Machine
    properties:
      name: mysql
      image: ubuntu-16
      flavor: '${input.size}'
      constraints:
        - tag: '${input.env}'
      networks:
        - network: '${resource["WP-Network-Private"].id}'
          assignPublicIpAddress: true
      remoteAccess:
        authentication: usernamePassword
        username: '${input.username}'
        password: '${input.userpassword}'
      cloudConfig: |
        #cloud-config
        repo_update: true
        repo_upgrade: all

        packages:
         - mysql-server

        runcmd:
         - sed -e '/bind-address/ s/^#*/#/' -i /etc/mysql/mysql.conf.d/mysqld.cnf
         - service mysql restart
         - mysql -e "GRANT ALL PRIVILEGES ON *.* TO 'root'@'%' IDENTIFIED BY 'mysqlpassword';"
         - mysql -e "FLUSH PRIVILEGES;"
      attachedDisks: []
  WebTier:
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    type: Cloud.Machine
    properties:
      name: wordpress
      flavor: '${input.size}'
      image: ubuntu-16
      constraints:
        - tag: '${input.env}'
      networks:
        - network: '${resource["WP-Network-Private"].id}'
          assignPublicIpAddress: true
      cloudConfig: |
        #cloud-config
        repo_update: true
        repo_upgrade: all

        packages:
         - apache2
         - php
         - php-mysql
         - libapache2-mod-php
         - php-mcrypt
         - mysql-client

        runcmd:
         - mkdir -p /var/www/html/mywordpresssite && cd /var/www/html && wget 
https://wordpress.org/latest.tar.gz && tar -xzf /var/www/html/latest.tar.gz -C /var/www/html/
mywordpresssite --strip-components 1
         - i=0; while [ $i -le 5 ]; do mysql --connect-timeout=3 -h $
{DBTier.networks[0].address} -u root -pmysqlpassword -e "SHOW STATUS;" && break || sleep 15; 
i=$((i+1)); done
         - mysql -u root -pmysqlpassword -h ${DBTier.networks[0].address} -e "create database 
wordpress_blog;"
         - mv /var/www/html/mywordpresssite/wp-config-sample.php /var/www/html/
mywordpresssite/wp-config.php
         - sed -i -e s/"define( 'DB_NAME', 'database_name_here' );"/"define( 'DB_NAME', 
'wordpress_blog' );"/ /var/www/html/mywordpresssite/wp-config.php && sed 
-i -e s/"define( 'DB_USER', 'username_here' );"/"define( 'DB_USER', 
'root' );"/ /var/www/html/mywordpresssite/wp-config.php && sed -i 
-e s/"define( 'DB_PASSWORD', 'password_here' );"/"define( 'DB_PASSWORD', 
'mysqlpassword' );"/ /var/www/html/mywordpresssite/wp-config.php && sed 
-i -e s/"define( 'DB_HOST', 'localhost' );"/"define( 'DB_HOST', '$
{DBTier.networks[0].address}' );"/ /var/www/html/mywordpresssite/wp-config.php
         - service apache2 reload
  WP-Network-Private:
    type: Cloud.Network
    properties:
      name: WP-Network-Private
      networkType: existing
      constraints:
        - tag: 'type:isolated-net'
        - tag: '${input.env}'

What to do next

Test the blueprint by checking the syntax and deploying it.
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WordPress use case: test a basic blueprint

During development, you are typically building a vRealize Automation Cloud Assembly blueprint 
by starting with the essentials, then deploying and testing as the blueprint grows.

To be certain that a deployment works the way that you want, you might test and deploy the 
blueprint several times. Gradually, you add more resources, retest, and redeploy along the way.

Prerequisites

Create the basic blueprint. See WordPress use case: create a basic blueprint.

Procedure

1 Click Blueprints, and open the WordPress-BP blueprint.

The basic blueprint appears, in the design canvas and code editor.

2 To check blueprint syntax, placement, and basic validity, click Test at the lower left.

3 Enter input values, and click Test.

The test is only a simulation and does not actually deploy virtual machines or other resources. 
The simulation exposes potential issues, such as not having any resource capabilities defined 
that match hard constraints in the blueprint.

The test includes a link to a Provisioning Diagram, where you can inspect the simulated 
deployment flow and see any errors that occurred.
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A successful simulation doesn't guarantee that you can deploy the blueprint without errors.

4 After the blueprint passes the simulation, click Deploy at the lower left.

5 Select Create a new deployment.

6 Name the deployment WordPress for OurCo and click Next.

7 Enter input values, and click Deploy.

8 To verify that the blueprint successfully deployed, look under Deployments.

If a deployment fails, click its name, and click the History tab to see messages that can help 
you troubleshoot.

Some history entries might have the Provisioning Diagram link at the far right. The diagram 
is similar to the simulated one, where you inspect the flow chart of vRealize Automation Cloud 
Assembly decision points in the provisioning process.

Using and Managing vRealize Automation Cloud Assembly

VMware, Inc. 121



More flow charts are available under Infrastructure > Activity > Requests.

9 To verify that the application is working, open the WordPress start page in a browser.

a Wait for the WordPress servers to be fully created and initialized.

It might take 30 minutes or more for initialization, depending on the environment.

b To locate the site FQDN or IP address, go to Deployments > Topology.

c On the canvas, click the WebTier, and find the IP address in the panel on the right.

d Enter the IP address as part of the full URL to the WordPress start page.

In this use case, the full URL is:

http://{IP-address}/mywordpresssite

or

http://{IP-address}/mywordpresssite/wp-admin/install.php

10 After inspecting WordPress in a browser, if the application needs more work, make blueprint 
changes and redeploy using the Update an existing deployment option.

11 Consider versioning the blueprint. You can revert to a working version if a change causes 
deployment to fail.

a On the blueprint design page, click Version.

b On the Creating Version page, enter WP-1.0.

Do not enter spaces in version names.

c Click Create.

To review or revert to a version, on the design page, click the Version History tab.

12 With a basic deployment now possible, try your first deployment-time enhancement by 
increasing CPU and memory on the application and database servers.

Update to a medium node size for both. Using the same blueprint, select medium at 

deployment time, redeploy, and verify the application again.

What to do next

Expand the blueprint into a production-worthy application by adding more resources.

WordPress use case: expand a blueprint

After you create and test a basic vRealize Automation Cloud Assembly blueprint, you expand it 
into a multiple tier application that is deployable to development, test, and eventually production.

To expand the blueprint, you add the following enhancements.

n An option to cluster application servers for increased capacity

n A public-facing network and load balancer in front of the application servers
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n A backup server with archive storage

Prerequisites

Create the basic blueprint and test it. See WordPress use case: create a basic blueprint and 
WordPress use case: test a basic blueprint.

Procedure

1 Click Blueprints, and open the WordPress-BP blueprint.

The basic blueprint appears, in the design canvas and code editor.

2 Make additions and changes, using the code example and figure for guidance.

You use the GUI to drag new resources to the canvas, such as the load balancer, and then 
finish the configuration in the code editor.

a Add a count input prompt to make the WordPress application server into a cluster.

b Add a cloud agnostic load balancer.

c Connect the load balancer to the WordPress application server cluster.

d Add a cloud agnostic backup machine.

e Connect the backup machine to the private/internal network.

f Add a cloud agnostic public/external network.

g Connect the load balander to the public network.

h Add a cloud agnostic storage volume for use as an archive disk.

i Connect the archive disk to the backup machine.

j Add an archiveusage input prompt for the storage disk speed.

k Add an archiveDiskSize input prompt for the storage disk size.

3 Deploy, test, and make changes in the same way that you did for the basic blueprint.

You can update existing deployments, or even deploy new instances so that you can compare 
deployments.

The goal is to reach a solid, repeatable blueprint that can be used for production deployments.
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Example: Completed Expanded Blueprint Code Example

inputs:
  env:
    type: string
    enum:
      - 'env:dev'
      - 'env:prod'
      - 'env:test'
    default: 'env:dev'
    title: Environment
    description: Target Environment
  size:
    type: string
    enum:
      - small
      - medium
      - large
    description: Size of Nodes
    title: Tier Machine Size
  username:
    type: string
    minLength: 4
    maxLength: 20
    pattern: '[a-z]+'
    title: Database Username
    description: Database Username
  userpassword:
    type: string
    pattern: '[a-z0-9A-Z@#$]+'
    encrypted: true
    title: Database Password
    description: Database Password
  databaseDiskSize:
    type: number
    default: 4
    maximum: 10
    title: MySQL Data Disk Size
    description: Database Disk Size
  count:
    type: integer
    default: 2
    maximum: 5
    minimum: 2
    title: WordPress Cluster Size
    description: WordPress Cluster Size (Number of Nodes)
  archiveDiskSize:
    type: number
    default: 4
    maximum: 10
    title: WordPress Archive Disk Size
    description: Archive Storage Disk Speed
  archiveusage:
    type: string
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    enum:
      - 'usage:general'
      - 'usage:fast'
    description: Archive Storage Disk Speed
    title: Archive Disk Speed
resources:
  DBTier:
    type: Cloud.Machine
    properties:
      name: mysql
      image: ubuntu-16
      flavor: '${input.size}'
      constraints:
        - tag: '${input.env}'
      networks:
        - network: '${resource["WP-Network-Private"].id}'
          assignPublicIpAddress: true
      remoteAccess:
        authentication: usernamePassword
        username: '${input.username}'
        password: '${input.userpassword}'
      cloudConfig: |
        #cloud-config
        repo_update: true
        repo_upgrade: all

        packages:
         - mysql-server

        runcmd:
         - sed -e '/bind-address/ s/^#*/#/' -i /etc/mysql/mysql.conf.d/mysqld.cnf
         - service mysql restart
         - mysql -e "GRANT ALL PRIVILEGES ON *.* TO 'root'@'%' IDENTIFIED BY 'mysqlpassword';"
         - mysql -e "FLUSH PRIVILEGES;"
      attachedDisks: []
  WebTier:
    type: Cloud.Machine
    properties:
      name: wordpress
      flavor: '${input.size}'
      image: 'ubuntu-16'
      count: '${input.count}'
      constraints:
        - tag: '${input.env}'
      networks:
        - network: '${resource["WP-Network-Private"].id}'
          assignPublicIpAddress: true
      storage:
        disks:
          - capacityGb: '${input.archiveDiskSize}'
            name: ArchiveDisk
      cloudConfig: |
        #cloud-config
        repo_update: true
        repo_upgrade: all
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        packages:
         - apache2
         - php
         - php-mysql
         - libapache2-mod-php
         - php-mcrypt
         - mysql-client

        runcmd:
         - mkdir -p /var/www/html/mywordpresssite && cd /var/www/html && wget 
https://wordpress.org/latest.tar.gz && tar -xzf /var/www/html/latest.tar.gz -C /var/www/html/
mywordpresssite --strip-components 1
         - i=0; while [ $i -le 10 ]; do mysql --connect-timeout=3 -h $
{DBTier.networks[0].address} -u root -pmysqlpassword -e "SHOW STATUS;" && break || sleep 15; 
i=$((i+1)); done
         - mysql -u root -pmysqlpassword -h ${DBTier.networks[0].address} -e "create database 
wordpress_blog;"
         - mv /var/www/html/mywordpresssite/wp-config-sample.php /var/www/html/
mywordpresssite/wp-config.php
         - sed -i -e s/"define( 'DB_NAME', 'database_name_here' );"/"define( 'DB_NAME', 
'wordpress_blog' );"/ /var/www/html/mywordpresssite/wp-config.php && sed 
-i -e s/"define( 'DB_USER', 'username_here' );"/"define( 'DB_USER', 
'root' );"/ /var/www/html/mywordpresssite/wp-config.php && sed -i 
-e s/"define( 'DB_PASSWORD', 'password_here' );"/"define( 'DB_PASSWORD', 
'mysqlpassword' );"/ /var/www/html/mywordpresssite/wp-config.php && sed 
-i -e s/"define( 'DB_HOST', 'localhost' );"/"define( 'DB_HOST', '$
{DBTier.networks[0].address}' );"/ /var/www/html/mywordpresssite/wp-config.php && 
sed -i -e s/"define('DB_HOST', 'localhost');"/"define('DB_HOST', '$
{DBTier.networks[0].address}');"/ /var/www/html/mywordpresssite/wp-config.php
         - service apache2 reload
  LoadBalancer:
    type: Cloud.LoadBalancer
    properties:
      name: myapp-lb
      network: '${resource["WP-Network-Public"].id}'
      instances:
        - '${WebTier.id}'
      routes:
        - protocol: HTTP
          port: '80'
          instanceProtocol: HTTP
          instancePort: '80'
          healthCheckConfiguration:
            protocol: HTTP
            port: '80'
            urlPath: /mywordpresssite/wp-admin/install.php
            intervalSeconds: 6
            timeoutSeconds: 5
            unhealthyThreshold: 2
            healthyThreshold: 2
      internetFacing: true
  WP-Network-Private:
    type: Cloud.Network
    properties:
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      name: WP-Network-Private
      networkType: existing
      constraints:
        - tag: 'type:isolated-net'
        - tag: '${input.env}'
  WP-Network-Public:
    type: Cloud.Network
    properties:
      name: WP-Network-Public
      networkType: public
      constraints:
        - tag: 'type:public-net'
        - tag: '${input.env}'
  backup:
    type: Cloud.Machine
    properties:
      name: backup
      flavor: '${input.size}'
      image: 'ubuntu-16'
      networks:
        - network: '${resource["WP-Network-Private"].id}'
      constraints:
        - tag: '${input.env}'
      attachedDisks:
        - source: '${ArchiveDisk.id}'
  ArchiveDisk:
    type: Cloud.Volume
    properties:
      name: ArchiveDisk
      capacityGb: 5
      constraints:
        - tag: '${input.archiveusage}'
        - tag: '${input.env}'

What to do next

Define your own infrastructure and create your own blueprints.

See Chapter 4 Building your vRealize Automation Cloud Assembly resource infrastructure and 
Chapter 6 Designing your vRealize Automation Cloud Assembly deployments.

VMware Cloud on AWS use case

This vRealize Automation Cloud Assembly use case shows the process of defining resource 
infrastructure and blueprint settings for deployment to a VMware Cloud on AWS environment.

The procedure requires that a cloud administrator has already configured your organization’s 
VMware Cloud on AWS SDDC data center as described in Deploying and Managing a Software-
Defined Data Center in the VMware Cloud on AWS Getting Started documentation.
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Look at the sequential setup to understand the process for configuring your environment for 
VMware Cloud on AWS. Remember that the values you see are only use case examples. Think 
about where you would make your own substitutions, or extrapolate from the example values, in 
order to fit your own cloud infrastructure and deployment needs.

A detailed video of a similar workflow is available from VMware Cloud Management Technical 
Marketing at How to Configure VMware Cloud on AWS for Cloud Assembly.

Procedure

1 Configure a basic VMware Cloud on AWS workflow in vRealize Automation

This use case shows the process of defining resource infrastructure and a corresponding 
cloud template for deployment to a VMware Cloud on AWS environment.

2 Configure an isolated network in VMware Cloud on AWS workflow in vRealize Automation 
Cloud Assembly

In this procedure, you add an isolated network for your VMware Cloud on AWS deployment 
in vRealize Automation Cloud Assembly.

Configure a basic VMware Cloud on AWS workflow in vRealize 
Automation

This use case shows the process of defining resource infrastructure and a corresponding cloud 
template for deployment to a VMware Cloud on AWS environment.

In this procedure, you configure infrastructure that supports cloud template deployment to 
resources in your existing VMware Cloud on AWS environment.

Prerequisites

n Before you can create and configure a VMware Cloud on AWS cloud account in vRealize 
Automation Cloud Assembly, you must be part of an organization in an existing VMware Cloud 
on AWS SDDC environment. For information about configuring the VMware Cloud on AWS 
service, see VMware Cloud on AWS Documentation.

n To facilitate the needed connection between your existing VMware Cloud on AWS host 
SDDC in vCenter and a VMware Cloud on AWS cloud account in vRealize Automation Cloud 
Assembly, you must provide a network connection, and add firewall rules, by using a VPN or 
similar networking means. See Prepare your VMware Cloud on AWS SDDC to connect with 
VMware Cloud on AWS cloud accounts in vRealize Automation.

Procedure

1 Prepare your VMware Cloud on AWS SDDC to connect with VMware Cloud on AWS cloud 
accounts in vRealize Automation

When using VMware Cloud on AWS cloud accounts in your vRealize Automation Cloud 
Assembly on-premises environment, you must create a network connection to support 
communication between your SDDC in vCenter and any VMware Cloud on AWS cloud 
accounts in vRealize Automation.
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2 Create a VMware Cloud on AWS cloud account in vRealize Automation within a sample 
workflow

In this step, you create a VMware Cloud on AWS cloud account in vRealize Automation.

3 Create a cloud zone for VMware Cloud on AWS deployments in vRealize Automation Cloud 
Assembly

In this step, you create a cloud zone to specify a compute resource that the CloudAdmin 
user can access when working with VMware Cloud on AWS in vRealize Automation Cloud 
Assembly.

4 Configure network and storage profiles for VMware Cloud on AWS deployments in vRealize 
Automation Cloud Assembly

In this step, you configure a network profile and a storage profile to specify resources that 
are available to a VMware Cloud on AWS CloudAdmin user in vRealize Automation Cloud 
Assembly.

5 Create a project to support VMware Cloud on AWS deployments in vRealize Automation 
Cloud Assembly

In this step, you define a vRealize Automation Cloud Assembly project that can be used to 
control which resources are available for VMware Cloud on AWS deployments.

6 Define a vCenter machine resource in a blueprint design to support VMware Cloud on AWS 
deployment in vRealize Automation Cloud Assembly

In this step, you drag a vCenter machine resource onto the design canvas and add settings 
for a VMware Cloud on AWS deployment.

Prepare your VMware Cloud on AWS SDDC to connect with VMware Cloud on 
AWS cloud accounts in vRealize Automation

When using VMware Cloud on AWS cloud accounts in your vRealize Automation Cloud Assembly 
on-premises environment, you must create a network connection to support communication 
between your SDDC in vCenter and any VMware Cloud on AWS cloud accounts in vRealize 
Automation.

To facilitate the needed connection between your existing VMware Cloud on AWS host SDDC in 
vCenter and a VMware Cloud on AWS cloud account in vRealize Automation, you must provide a 
network connection between the two elements by using a VPN or similar networking means.

Procedure

1 Configure a VPN connection over the public Internet or AWS Direct connect.

See VMware Cloud on AWS Networking and Security at VMware Cloud on AWS 
Documentation.

2 Verify that the vCenter Server FQDN is resolvable at a private IP address on the management 
network.

See VMware Cloud on AWS Networking and Security at VMware Cloud on AWS 
Documentation.
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3 Configure needed firewall rules.

You must configure management gateway firewall rules in the SDDC's VMware Cloud on AWS 
console to support communication. The rules must be in the Management Gateway firewall 
rules section. Create the firewall rules by using options on the Networking & Security tab in 
the SDDC console.

n Limit network traffic to ESXi for HTTPS (TCP 443) services to the discovered IP address of 
the vRealize Automation appliance/server or vRealize Automation load balancer VIP.

n Limit network traffic to vCenter for ICMP (All ICMP), SSO (TCP 7444), and HTTPS (TCP 
443) services to the discovered IP address of the vRealize Automation appliance/server or 
vRealize Automation load balancer VIP.

n Limit network traffic to the NSX-T Manager for HTTPS (TCP 443) services to the discovered 
IP address of the vRealize Automation appliance/server or vRealize Automation load 
balancer VIP.

The required firewall rules are summarized in the following table.

Table 3-1. Required Management Gateway Firewall Rules Summary

Name Source Destination Service

vCenter CIDR block of on-premises 
data center

vCenter Any (All Traffic)

vCenter ping Any vCenter ICMP (All ICMP)

NSX Manager CIDR block of on-premises 
data center

NSX Manager Any (All Traffic)

On pemises to ESXi ping CIDR block of on-premises 
data center

ESXi Management Only ICMP (All ICMP)

On Premises to ESXi 
remote console and 
provisioning

CIDR block of on-premises 
data center

ESXi Management Only TCP 902

On-premises to SDDC VM CIDR block of on-premises 
data center

CIDR block of SDDC 
logical network

Any (All Traffic)

SDDC VM to on premises CIDR block of SDDC 
logical network

CIDR block of on-premises 
data center

Any (All Traffic)

For related information, see VMware Cloud on AWS Networking and Security and VMware 
Cloud on AWS Operations Guide at VMware Cloud on AWS Documentation.

Results

After you have configured required gateway access and firewall rules, you can continue with the 
process of creating a VMware Cloud on AWS cloud account.

Create a VMware Cloud on AWS cloud account in vRealize Automation within a 
sample workflow

In this step, you create a VMware Cloud on AWS cloud account in vRealize Automation.
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For related information, see VMware Cloud on AWS documentation.

Unless otherwise indicated, the step values that you enter in this procedure are for this example 
workflow only.

Prerequisites

n This procedure assumes that you have the required administrator credentials, including 
VMware Cloud on AWS CloudAdmin credentials for the target SDDC in vCenter and that you 
have enabled HTTPS access on port 443. See Credentials required for working with cloud 
accounts in vRealize Automation.

n This procedure assumes that you have the cloud administrator user role. See What are the 
vRealize Automation Cloud Assembly user roles.

n To facilitate the needed connection between your existing VMware Cloud on AWS host SDDC 
in vCenter and a VMware Cloud on AWS cloud account in vRealize Automation, you must 
provide a network connection, and firewall rules, by using a VPN or similar networking means. 
See Prepare your VMware Cloud on AWS SDDC to connect with VMware Cloud on AWS cloud 
accounts in vRealize Automation. If you are using an external HTTP Internet proxy, it must be 
configured for IPv4.

n If you do not have external Internet access, configure an Internet server proxy. See How do I 
configure an Internet proxy server for vRealize Automation.

Procedure

1 Select Infrastructure > Connections > Cloud Accounts.

2 Click Add Cloud Account, select VMware Cloud on AWS, and enter values.

Sample values and supporting information are provided in the following table.
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Setting Sample Value and Instruction Description

VMC API Token 1 Click the i help icon at the end of 
the VMC API token line and click API 
Tokens page in the help text box to 
open the API Tokens tab on your 
organization's My Account page.

2 Click Generate Token to display the 
Generate a New API Token options.

3 Enter a new token name, for example 
myinitials_mytoken.

4 Set the Token TTL to never expire.

If you create a token that is set 
to expire, then the VMware Cloud 
on AWS operations from vRealize 
Automation will stop working when 
the token expires and continue to 
not work until you update the cloud 
account with a new token.

5 In the Define Scopes section, select 
All Roles.

6 Click Generate.

7 In the generated token page, click 
Copy and click Continue.

8 Return to the New Cloud Account 
page, paste the copied token into the 
VMC API token row, and click Apply 
API token.

You can create a new token or use an existing 
token for your organization on the linked API 
Tokens page.

In the Define Scopes section, the minimum 
required roles for the API token are:

n Organizational Roles

n Organization Member

n Organization Owner

n Service Roles - VMware Cloud on AWS

n Administrator

n NSX Cloud Administrator

n NSX Cloud Auditor

Note   Copy, download, or print the generated 
token. Once you leave this page you cannot 
retrieve the generated token.

Apply the generated or supplied token to 
connect to the available SDDC environment 
in your organization's VMware Cloud on AWS 
subscription and populate the list of SDDC 
names.

If the vRealize Automation and VMware Cloud 
on AWS services are in different organizations, 
you should switch to the VMware Cloud on 
AWS organization and then generate the 
token.

For more information about API tokens, see 
Generate API Tokens.

SDDC name For this example, select 
Datacenter:Datacenter-abz.

The valid SDDC name auto-populates the 
vCenter and NSX-T FQDN entries. If a 
cloud proxy was already deployed to the 
SDDC, the cloud proxy value also auto-
populates.

Select from the list of available SDDCs from 
your VMware Cloud on AWS subscription. The 
list of SDDCs is based on the VMware Cloud on 
AWS API token.

NSX-V SDDCs are not supported with vRealize 
Automation and do not appear in the list of 
available SDDCs.
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Setting Sample Value and Instruction Description

vCenter IP address/
FQDN

The address auto-populates based on 
your SDDC selection.

Enter the IP address or FQDN of the vCenter 
Server in the specified SDDC.

The IP address defaults to the private IP 
address. Based on the type of network 
connectivity used to access your SDDC, the 
default address might be different than the 
IP address of the NSX Manager Server in the 
specified SDDC.

NSX Manager IP 
address/FQDN

The address auto-populates based on 
your SDDC selection.

Specifies the IP address or FQDN of the NSX 
Manager in the specified SDDC.

The IP address defaults to the private IP 
address. Based on the type of network 
connectivity used to access your SDDC, the 
default address might be different than the 
IP address of the NSX Manager Server in the 
specified SDDC.

VMware Cloud on AWS cloud accounts 
support NSX-T.

vCenter user name 
and password

The user name auto-populates as 
cloudadmin@vmc.local.

Enter your vCenter user name for the specified 
SDDC if it's different than the default.

The specified user requires CloudAdmin 
credentials. The user does not require 
CloudGlobalAdmin credentials.

Enter the user password.

Validate Click Validate. Validate confirms your access rights to the 
specified vCenter and checks that the vCenter 
is running.

Name and 
Description

Enter OurCo-VMC for the cloud account 

name.

Enter Sample deployment for VMC for 

the cloud account description.

Allow provisioning 
to these data 
centers

This information is read-only. Lists available data centers in your specified 
VMware Cloud on AWS SDDC environment.

Create a cloud zone De-select the check-box. For this 
example, you will create a cloud zone later 
in the workflow.

See Learn more about vRealize Automation 
Cloud Assembly cloud zones.

Capability tags Leave this empty. This workflow does not 
use capability tags.

Use tags according to your organization's 
tag strategy. See How do I use tags to 
manage vRealize Automation Cloud Assembly 
resources and deployments and Creating a 
Tagging Strategy.

3 Click Add.
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Results

Resources such as machines and volumes are data-collected from the VMware Cloud on AWS 
SDDC data center and listed in the Resources section of the vRealize Automation Infrastructure 
tab.

What to do next

Create a cloud zone for VMware Cloud on AWS deployments in vRealize Automation Cloud 
Assembly.

Create a cloud zone for VMware Cloud on AWS deployments in vRealize 
Automation Cloud Assembly

In this step, you create a cloud zone to specify a compute resource that the CloudAdmin user can 
access when working with VMware Cloud on AWS in vRealize Automation Cloud Assembly.

In VMware Cloud on AWS, the two primary administrator credentials are CloudGlobalAdmin and 
CloudAdmin. vRealize Automation Cloud Assembly is designed to support the CloudAdmin user. 
Deploy to resources that are available to a VMware Cloud on AWS CloudAdmin user. Do not 
deploy to resources that require VMware Cloud on AWS CloudGlobalAdmin credentials.

Cloud zones identify the compute resources onto which a project blueprint deploys machines, 
networks, and storage. See Learn more about vRealize Automation Cloud Assembly cloud zones.

Unless otherwise indicated, the step values that you enter in this procedure are for this example 
workflow only.

Prerequisites

n Complete the Create a VMware Cloud on AWS cloud account in vRealize Automation within a 
sample workflow procedure.

n This procedure assumes that you have the required administrator credentials, including 
VMware Cloud on AWS CloudAdmin credentials for the target SDDC in vCenter. See 
Credentials required for working with cloud accounts in vRealize Automation.

n This procedure assumes that you have the cloud administrator user role. See What are the 
vRealize Automation Cloud Assembly user roles.

Procedure

1 Select Infrastructure > Configure > Cloud Zones.
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2 Click New Cloud Zone, and enter values for the VMware Cloud on AWS environment.

Setting Sample Value

Account / region OurCo-VMC / Datacenter:Datacenter-abz

This is the cloud account and associated region that you 
defined in the previous step, Create a VMware Cloud 
on AWS cloud account in vRealize Automation within a 
sample workflow.

Name VMC_cloud_zone-1

Description VMware Cloud on AWS resources only

Placement policy Default

Capability tags Leave this empty. This workflow does not use capability 
tags.

3 Click the Compute tab.

4 As shown in area 1 below, find and select a compute resource that is available to the 
CloudAdmin user. For this example, use the resource named Cluster 1/ Compute-
ResourcePool.

Cluster 1/ Compute-ResourcePool is the default compute resource for VMware Cloud on 

AWS.

5 As shown in area 2 above, add the tag name vmc_placements_abz.

6 Filter the compute resources that are used in this cloud zone by entering vmc_placements_abz 
in the Filter tags section.
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7 Click Save.

For this example, only the compute resource named Cluster 1/ Compute-ResourcePool is 

available to the CloudAdmin user.

What to do next

Configure network and storage profiles for VMware Cloud on AWS deployments in vRealize 
Automation Cloud Assembly.

Configure network and storage profiles for VMware Cloud on AWS deployments 
in vRealize Automation Cloud Assembly

In this step, you configure a network profile and a storage profile to specify resources that are 
available to a VMware Cloud on AWS CloudAdmin user in vRealize Automation Cloud Assembly.

While an image and a flavor value are also needed, there is nothing unique about them specific to 
VMware Cloud on AWS user credentials. For this example, you'll use a flavor value of small and 

an image value of ubuntu-16 when you define the blueprint.

For general information about mappings and profiles, see Chapter 4 Building your vRealize 
Automation Cloud Assembly resource infrastructure.

Unless otherwise indicated, the step values that you enter in this procedure are for this example 
workflow only.

Prerequisites

n Create a cloud zone. See Create a cloud zone for VMware Cloud on AWS deployments in 
vRealize Automation Cloud Assembly.

n This procedure assumes that you have the required administrator credentials, including 
VMware Cloud on AWS CloudAdmin credentials for the target SDDC in vCenter. See 
Credentials required for working with cloud accounts in vRealize Automation.

n This procedure assumes that you have the cloud administrator user role. See What are the 
vRealize Automation Cloud Assembly user roles.
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Procedure

1 Define a network profile for VMware Cloud on AWS deployments.

a Select Infrastructure > Configure > Network Profiles and click New Network Profile.

Setting Sample value

Account / region OurCo-VMC / Datacenter:Datacenter-abz

Note   Select the VMware Cloud on AWS cloud account, and its 
matched SDDC data center, that you created in Create a VMware 
Cloud on AWS cloud account in vRealize Automation within a 
sample workflow.

Name vmc-network1

Description Contains networks that can be accessed by blueprint 
administrators who have VMware Cloud on AWS CloudAdmin 
credentials.

b Click the Network tab and click Add Network.

c Select a network that a VMware Cloud on AWS user with CloudAdmin credentials can 
deploy to, for example sddc-cgw-network-1.

2 Save the network profile.
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3 Define a storage profile for VMware Cloud on AWS deployments.

Configure a storage profile that targets a datastore/cluster that is accessible to the 
CloudAdmin user.

a Select Infrastructure > Configure > Storage Profiles and click new New Storage Profile.

Setting Sample Value

Account / region OurCo-VMC / Datacenter:Datacenter-abz

Select the VMware Cloud on AWS cloud account, and its matched 
SDDC data center, that you created in Create a VMware Cloud on 
AWS cloud account in vRealize Automation within a sample workflow.

Name vmc-storage1

Description Contains the datastore cluster that can be deployed to by blueprint 
administrators who have VMware Cloud on AWS CloudAdmin 
credentials.

b From the Datastore / Cluster drop-down menu, select the WorkloadDatastore datastore.

For VMware Cloud on AWS in vRealize Automation Cloud Assembly, the storage 
policy must use the WorkloadDatastore datastore to support VMware Cloud on AWS 
deployment.

4 Save the storage profile.

What to do next

Create a project to support VMware Cloud on AWS deployments in vRealize Automation Cloud 
Assembly.

Create a project to support VMware Cloud on AWS deployments in vRealize 
Automation Cloud Assembly

In this step, you define a vRealize Automation Cloud Assembly project that can be used to control 
which resources are available for VMware Cloud on AWS deployments.

For information about projects, see How do vRealize Automation Cloud Assembly projects work at 
deployment time.

Unless otherwise indicated, the step values that you enter in this procedure are for this example 
workflow only.
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Prerequisites

n Complete the Configure network and storage profiles for VMware Cloud on AWS deployments 
in vRealize Automation Cloud Assembly procedure.

n This procedure assumes that you have the required administrator credentials, including 
VMware Cloud on AWS CloudAdmin credentials for the target SDDC in vCenter. See 
Credentials required for working with cloud accounts in vRealize Automation.

n This procedure assumes that you have the cloud administrator user role. See What are the 
vRealize Automation Cloud Assembly user roles.

Procedure

1 Select Infrastructure > Configure > Projects.

2 Click New Project and enter the project name VMC_proj-1_abz.

3 Click Users and click Add Users.

The users need CloudAdmin credentials to their organization's VMware Cloud on AWS 
subscription.

n chris.gray@ourco.com, Administrator

n kerry.white@ourco.com, Member

4 Click Provisioning and then click Add Cloud Zone.

5 Add the cloud zone that you configured in the earlier step.

Setting Sample Value

Cloud zone VMC_cloud_zone-1

You created this cloud zone in the earlier step, Create a 
cloud zone for VMware Cloud on AWS deployments in 
vRealize Automation Cloud Assembly.

Provisioning priority 1

Instances limit 3

6 For this example, ignore the other options.

What to do next

Create a blueprint to deploy in your VMware Cloud on AWS environment. See Define a vCenter 
machine resource in a blueprint design to support VMware Cloud on AWS deployment in vRealize 
Automation Cloud Assembly.

Define a vCenter machine resource in a blueprint design to support VMware 
Cloud on AWS deployment in vRealize Automation Cloud Assembly

In this step, you drag a vCenter machine resource onto the design canvas and add settings for a 
VMware Cloud on AWS deployment.
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Create a blueprint design that you can deploy to available VMware Cloud on AWS resources.

Unless otherwise indicated, the step values that you enter in this procedure are for this example 
workflow only.

Prerequisites

n This procedure assumes that you have blueprint designer credentials. See What are the 
vRealize Automation Cloud Assembly user roles.

n This procedure assumes that you have VMware Cloud on AWS CloudAdmin credentials for 

the target SDDC in vCenter (Datacenter:Datacenter-abz). See Credentials required for working 
with cloud accounts in vRealize Automation.

n Configure the resource infrastructure and project as described in the preceding sections.

Procedure

1 Click the Design tab and then click New.

Setting Sample Value

Name vmc-bp_abz

Description 1

Project VMC_proj-1_abz

This is the project that you created earlier, which 
supports the cloud zone that you also created earlier. 
The project is now associated with the cloud zone, which 
in turn is associated with the VMware Cloud on AWS 
cloud account/region that you created earlier.

2 Slide a vSphere machine resource onto the canvas.

3 Edit the following (bold) blueprint resource code in the machine resource.

formatVersion: 1
inputs: {}
resources:
  Cloud_vSphere_Machine_1:
    type: Cloud.vSphere.Machine
    properties:
      image: ubuntu-1604
      cpuCount: 1
      totalMemoryMB: 1024
      folderName: Workloads

The image can be any value that is appropriate to your deployment needs.

You must add the folderName: Workloads statement to the blueprint design code to support 

VMware Cloud on AWS deployment. The folderName: Workloads setting supports the 

CloudAdmin credentials in the VMware Cloud on AWS SDDC environment and is required.
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Note: While the folderName: Workloads setting shown in the above code sample is required, 

you can add it directly in the blueprint design code as shown above or you can add it in the 
associated cloud zone or project. If the setting is specified in more than one of these three 
places, the precedence is as follows:

n Project setting overrides the blueprint design setting and the cloud zone setting.

n Blueprint design setting overrides the cloud zone setting.

Note: You can optionally replace the cpuCount and totalMemoryMB settings with a flavor 
(sizing) entry, as shown below:

formatVersion: 1
inputs: {}
resources:
  Cloud_vSphere_Machine_1:
    type: Cloud.vSphere.Machine
    properties:
      image: ubuntu-1604
      flavor: small
      folderName: Workloads

If the cloud zone has the folder value set to Workloads, you do not need to set the folderName 
property in the blueprint design, unless you want to override the cloud zone folder value.

What to do next

Expand on this basic VMware Cloud on AWS workflow by adding network isolation. See Configure 
an isolated network in VMware Cloud on AWS workflow in vRealize Automation Cloud Assembly.

Configure an isolated network in VMware Cloud on AWS workflow in 
vRealize Automation Cloud Assembly

In this procedure, you add an isolated network for your VMware Cloud on AWS deployment in 
vRealize Automation Cloud Assembly.

When you define your VMware Cloud on AWS cloud account, NSX-T settings configured in your 
VMware Cloud on AWS service are available. For information about configuring NSX-T settings in 
your VMware Cloud on AWS service, see VMware Cloud on AWS product documentation.

vRealize Automation Cloud Assembly supports VMware Cloud on AWS with NSX-T. It does not 
support VMware Cloud on AWS with NSX-V.

vRealize Automation Cloud Assembly supports network isolation for VMware Cloud on AWS 
deployments. It does not support other network methods for VMware Cloud on AWS.

This extension of the basic VMware Cloud on AWS workflow describes the following methods of 
creating an isolated network for use in your vRealize Automation Cloud Assembly blueprint:

n Configure on-demand network-based isolation.

n Configure on-demand security group-based isolation.
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Prerequisites

This procedure expands on the basic VMware Cloud on AWS workflow. It uses the same cloud 
account and region, cloud zone, project, and network profile that you configured in the VMware 
Cloud on AWS use case workflow.

Procedure

1 Define an isolated network for a VMware Cloud on AWS deployment in vRealize Automation 
Cloud Assembly

You can configure network isolation for a VMware Cloud on AWS deployment by using either 
of the following procedures:

2 Define a network component in a blueprint to support network isolation for VMware Cloud on 
AWS in vRealize Automation Cloud Assembly

In this step, you drag a network machine component onto a vRealize Automation Cloud 
Assembly blueprint canvas and add settings for an isolated network deployment to your 
target VMware Cloud on AWS environment.

Define an isolated network for a VMware Cloud on AWS deployment in vRealize 
Automation Cloud Assembly

You can configure network isolation for a VMware Cloud on AWS deployment by using either of 
the following procedures:

n Configure on-demand network-based isolation in vRealize Automation Cloud Assembly

n Configure on-demand security group-based isolation in vRealize Automation Cloud Assembly

Configure on-demand network-based isolation in vRealize Automation Cloud Assembly

You can configure network isolation for your VMware Cloud on AWS deployment needs by 
specifying and using on-demand network settings in a vRealize Automation Cloud Assembly 
network profile.

You can specify an isolated network by using a security group or by using on-demand network 
settings. In this example, you configure network isolation by specifying on-demand network 
settings in the network profile. Later, you access the network in a blueprint and use the blueprint 
in a VMware Cloud on AWS deployment.

Unless otherwise indicated, the step values that you enter in this procedure are for this example 
workflow only.

Prerequisites

n Complete the Configure a basic VMware Cloud on AWS workflow in vRealize Automation 
workflow.

n Review Configure an isolated network in VMware Cloud on AWS workflow in vRealize 
Automation Cloud Assembly.
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n This procedure assumes that you have the required administrator credentials, including 
VMware Cloud on AWS CloudAdmin credentials for the target SDDC in vCenter. See 
Credentials required for working with cloud accounts in vRealize Automation.

n This procedure assumes that you have the cloud administrator user role. See What are the 
vRealize Automation Cloud Assembly user roles.

Procedure

1 Open the network profile that you used in the basic VMware Cloud on AWS workflow, for 
example vmc-network1. See Configure network and storage profiles for VMware Cloud on 

AWS deployments in vRealize Automation Cloud Assembly.

2 You do not need to make any selections on the Networks tab.

3 Click the Network Policies tab.

4 Select the Create an on-demand network option and select the default cgw network domain. 

Specify an appropriate CIDR and subnet size.

5 Click Save.

When you use this network profile, machines are deployed to a network in the default network 
domain. The network is isolated from other networks by using private or outbound network 
access.

What to do next

Configure a network component in your blueprint. See Define a network component in a blueprint 
to support network isolation for VMware Cloud on AWS in vRealize Automation Cloud Assembly

Configure on-demand security group-based isolation in vRealize Automation Cloud Assembly

You can configure network isolation for your VMware Cloud on AWS deployment needs by 
specifying and using an on-demand security group in a vRealize Automation Cloud Assembly 
network profile.

You can specify an isolated network by using a security group or by using on-demand network 
settings. In this example, you configure network isolation by specifying an on-demand security 
group in the network profile. Later, you specify the network in a blueprint and use the blueprint in 
a VMware Cloud on AWS deployment.

Unless otherwise indicated, the step values that you enter in this procedure are for this example 
workflow only.

Prerequisites

n Complete the Configure a basic VMware Cloud on AWS workflow in vRealize Automation 
workflow.

n Review Configure an isolated network in VMware Cloud on AWS workflow in vRealize 
Automation Cloud Assembly.
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n This procedure assumes that you have the required administrator credentials, including 
VMware Cloud on AWS CloudAdmin credentials for the target SDDC in vCenter. See 
Credentials required for working with cloud accounts in vRealize Automation.

n This procedure assumes that you have the cloud administrator user role. See What are the 
vRealize Automation Cloud Assembly user roles.

Procedure

1 Open the network profile that you used in the basic VMware Cloud on AWS workflow, for 
example vmc-network1. See Configure network and storage profiles for VMware Cloud on 

AWS deployments in vRealize Automation Cloud Assembly .

2 Select the existing network that you used in the basic VMware Cloud on AWS workflow, 
for example sddc-cgw-network-1. See Configure network and storage profiles for VMware 

Cloud on AWS deployments in vRealize Automation Cloud Assembly.

3 Click the Network Policies tab.

4 Select the Create an on-demand security group option.

5 Click Save.

When you use this network profile, machines are deployed to the selected network and are 
isolated by a new security group policy. The new security policy allows private or outbound 
network access.

What to do next

Configure a network component in your blueprint. See Define a network component in a blueprint 
to support network isolation for VMware Cloud on AWS in vRealize Automation Cloud Assembly

Define a network component in a blueprint to support network isolation for 
VMware Cloud on AWS in vRealize Automation Cloud Assembly

In this step, you drag a network machine component onto a vRealize Automation Cloud Assembly 
blueprint canvas and add settings for an isolated network deployment to your target VMware 
Cloud on AWS environment.
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Add network isolation to the blueprint that you created earlier. The blueprint is already associated 
with a project and cloud zone that support deployment to your VMware Cloud on AWS 
environment, as well as the network profile and network that you configured for isolation.

Unless otherwise indicated, the step values that you enter in this procedure are for this example 
workflow only.

Prerequisites

n Complete the Configure on-demand security group-based isolation in vRealize Automation 
Cloud Assembly or Configure on-demand network-based isolation in vRealize Automation 
Cloud Assembly procedure.

n This procedure assumes that you have blueprint designer credentials. See What are the 
vRealize Automation Cloud Assembly user roles.

n This procedure assumes that you have VMware Cloud on AWS CloudAdmin credentials for the 
target SDDC in vCenter. See Credentials required for working with cloud accounts in vRealize 
Automation.

Procedure

1 Open the blueprint that you created in the previous workflow. See Define a vCenter machine 
resource in a blueprint design to support VMware Cloud on AWS deployment in vRealize 
Automation Cloud Assembly.

2 From the components on the left of the blueprint design page, drag a network component 
onto the canvas.

3 Edit the network component YAML code to specify a network type of either private or 

outbound, as shown in bold.

resources:  Cloud_Network_1:    
            type: Cloud.Network
            properties:
              name: vmc_isolated      
              networkType: private      

OR

resources:  Cloud_Network_1:
            type: Cloud.Network
            properties:
              name: vmc_isolated      
              networkType: outbound      

What to do next

You are ready to deploy or close the blueprint.
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Use case: How do I configure a provider-specific external 
IPAM integration for vRealize Automation

You can use an external IPAM provider to manage IP address assignments for your blueprint 
deployments. This example describes how to configure external IPAM integration in vRealize 
Automation using Infoblox as the external IPAM provider.

In this procedure, you use an existing IPAM provider package, in this case an Infoblox package, 
and an existing running environment to build a provider-specific IPAM integration point. You 
configure an existing network and create a network profile to support IP address allocation from 
the external IPAM provider. Finally, you create a blueprint that is matched to the network and 
network profile and deploy networked machines using IP values obtained from the external IPAM 
provider.

Information about how to obtain and configure the IPAM provider package, and how to configure 
a running environment that accesses a cloud extensibility proxy to support the IPAM provider 
integration, is included as reference.

Remember that the values you see are example values. You won't be able to use them letter-
by-letter in your environment. Think about where you would make your own substitutions, or 
extrapolate from the example values, to fit your organization's needs.

 To reference a similar vRealize Automation scenario that illustrates an Infoblox IPAM 
integration workflow in video form, see Infoblox IPAM Plug-in 1.1 Integration with vRealize 
Automation 8.1 / vRealize Automation Cloud.

Procedure

1 Add required extensible attributes in the Infoblox application for integration with vRealize 
Automation

Before you can download and deploy the Infoblox provider package (infoblox.zip) for 

integration with vRealize Automation from either the Infoblox website or from the VMware 
Marketplace, you must add required extensibility attributes in Infoblox.

2 Download and deploy an external IPAM provider package for use in vRealize Automation

Before you can define an external IPAM integration point in vRealize Automation, you need a 
configured IPAM provider package.

3 Create a running environment for an IPAM integration point in vRealize Automation

Before you can define a external IPAM integration point in vRealize Automation, you need to 
create or access an existing running environment to serve as an intermediary between the 
IPAM provider and vRealize Automation. The running environment is commonly an Amazon 
Web Services or Microsoft Azure cloud account or an on-premises actions-based extensibility 
integration point that is associated to a cloud extensibility proxy.
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4 Add an external IPAM integration point in vRealize Automation 

vRealize Automation supports integration with an external IPAM providers. You can use a 
provider-specific IPAM integration point to obtain and manage IP addresses and related 
network characteristics for blueprint deployments.

5 Configure a network and network profile to use external IPAM for an existing network in 
vRealize Automation 

You can define an existing network to use IP address values that are obtained from, and 
managed by, an external IPAM provider rather than internally from vRealize Automation.

6 Define and deploy a vRealize Automation Cloud Assembly blueprint that uses IPAM provider 
range assignment

You can define a blueprint to obtain and manage IP addresses assignments from your 
external IPAM provider.

7 Using Infloblox-specific properties and extensible attributes for IPAM integrations in vRealize 
Automation

You can use Infloblox-specific properties for vRealize Automation projects that contain 
external IPAM integrations for Infoblox.

Add required extensible attributes in the Infoblox application for 
integration with vRealize Automation

Before you can download and deploy the Infoblox provider package (infoblox.zip) for 

integration with vRealize Automation from either the Infoblox website or from the VMware 
Marketplace, you must add required extensibility attributes in Infoblox.

This procedure is applicable if you are creating an external IPAM integration point for Infoblox 
integration with vRealize Automation Cloud Assembly.

Before you can use the infoblox.zip download, you must log in to your Infoblox account, 

using your organization account administrator credentials, and pre-create the following Infoblox 
extensible attributes:

n VMware NIC index

n VMware resource ID

Prerequisites

n Verify that you have an account with Infoblox and that you have the correct access credentials 
to your organization's Infoblox account.

n Confirm that the Infoblox WAPI version is supported. IPAM integration with Infoblox depends 
on Infoblox WAPI version v2.7. All Infoblox appliances that support WAPI v2.7 are supported.

n Review Using Infloblox-specific properties and extensible attributes for IPAM integrations in 
vRealize Automation.
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Procedure

1 Log in to your Infoblox account using administrator credentials.

These are the same administrator user name and password credentials that you specify when 
you create an external IPAM integration point in vRealize Automation Cloud Assembly using 
the Infrastructure > Connections > Integrations > menu sequence.

2 Use the procedure described in the Infoblox documentation to create the following required 
extensible attributes in your Infoblox application.

n VMware NIC index - type Integer

n VMware resource ID - type String

The procedure is described in the Adding Extensible Attributes section of the Infoblox 
documentation topic About Extensible Attributes. Also see Managing Extensible Attributes.

What to do next

After you add the required attributes, you can resume the process of downloading and deploying 
the Infloblox package as described in Download and deploy an external IPAM provider package 
for use in vRealize Automation.

Download and deploy an external IPAM provider package for use in 
vRealize Automation

Before you can define an external IPAM integration point in vRealize Automation, you need a 
configured IPAM provider package.

You can download a provider-specific integration package from your IPAM provider's website, 
from the VMware solutions exchange marketplace or, if available, from the vRealize Automation 
Marketplace tab.

Note   This example uses the VMware-supplied Infoblox package Infoblox.zip, which is available 

for download from VMware Marketplace as follows:

n vRA Cloud Infoblox plugin version 1.2 - Compatible with vRealize Automation 8.1.x and 8.2.x

n vRA Cloud Infoblox plugin version 1.1 - Compatible with vRealize Automation 8.1.x

n vRA Cloud Infoblox plugin version 1.0 - Compatible with vRealize Automation 8.0.1.x with or 
without an internet connection to the global network.

n vRA Cloud Infoblox plugin version 0.4 - Compatible with vRealize Automation 8.0.0.x and 
8.0.1.x when there is an internet connection with the global network.

IPAM integration with Infoblox depends on Infoblox WAPI version v2.7. All Infoblox appliances 
that support WAPI v2.7 are supported.

For information about how to create an IPAM integration package for other IPAM providers, if 
one does not already exist in the Marketplace, see How do I use the IPAM SDK to create a 
provider-specific external IPAM integration package for vRealize Automation.
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The IPAM provider package contains scripts that are packaged with metadata and other 
configurations. The scripts contain the source code used for the operations that vRealize 
Automation performs in coordination with the external IPAM provider. Example operations include 
Allocate an IP address for a virtual machine, Fetch a list of IP ranges from 
the provider, and Update the MAC address of a host record in the provider.

Prerequisites

n Verify that you have cloud administrator credentials. See Credentials required for working with 
cloud accounts in vRealize Automation.

n Verify that you have the cloud administrator user role. See What are the vRealize Automation 
Cloud Assembly user roles.

n Verify that you have an account with the external IPAM provider, for example Infoblox or 
Bluecat, and that you have the correct access credentials to your organization's account with 
the IPAM provider.

n If you are using Infobox as your external IPAM provider, verify that you have added the 
required extensible attributes to your Infoblox account before continuing. See Add required 
extensible attributes in the Infoblox application for integration with vRealize Automation.

Note   A certificate chain issue exists that is derived from how the Python element in the 
Infoblox plug-in handles SSL handshakes. For information about the issue and its required actions, 
see Knowledge Base Article vRA Cloud Infoblox Plugin throws a certificate chain error during 
authentication process (88057). 

Procedure

1 Navigate to the vRA Cloud Infoblox plugin version 1.1 package page at VMware Marketplace.

2 Log in and download the plug-in package.

3 If you have not already done so, add the required extensible attributes in Infoblox. See 
Add required extensible attributes in the Infoblox application for integration with vRealize 
Automation.

Results

The package is now available for you to deploy by using the Integrations > Add Integration > 
IPAM > Manage Providers > Import package menu sequence as described in Add an external 
IPAM integration point in vRealize Automation .

Create a running environment for an IPAM integration point in 
vRealize Automation

Before you can define a external IPAM integration point in vRealize Automation, you need to 
create or access an existing running environment to serve as an intermediary between the 
IPAM provider and vRealize Automation. The running environment is commonly an Amazon 
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Web Services or Microsoft Azure cloud account or an on-premises actions-based extensibility 
integration point that is associated to a cloud extensibility proxy.

External IPAM integration requires a running environment. When you define the IPAM integration 
point, you create a connection between vRealize Automation Cloud Assembly and your IPAM 
provider by specifying an available running environment.

IPAM integration uses a set of downloaded provider-specific scripts or plug-ins in a running 
environment that is facilitated by a Feature-as-a-Services (FaaS) provider such as Amazon Web 
Services Lambda, Microsoft Azure Functions, or an actions-based extensibility (ABX) On-Prem 
Embedded integration point. The running environment is used to connect to the external IPAM 
provider, for example Infoblox.

Note   An Infoblox IPAM integration point requires an actions-based extensibility (ABX) On-Prem 
Embedded integration point.

Each type of runtime environment has advantages and disadvantages:

n Actions-based extensibility (ABX) integration point

n free, no additional vendor usage costs

n can connect to IPAM vendor appliances that reside in an on-premises data center behind a 
NAT/firewall that is not publicly accessible, for example Infoblox

n slower and slightly less reliable performance than commercial cloud vendors

n Amazon Web Services

n has associated vendor FaaS connection/usage costs

n cannot connect to IPAM vendor appliances that reside in an on-premises data center 
behind a NAT/firewall that is not publicly accessible

n has fast and highly reliable performance

n Microsoft Azure

n has associated vendor FaaS connection/usage costs

n cannot connect to IPAM vendor appliances that reside in an on-premises data center 
behind a NAT/firewall that is not publicly accessible

n has fast and highly reliable performance

Prerequisites

n Verify that you have cloud administrator credentials. See Credentials required for working with 
cloud accounts in vRealize Automation.

n Verify that you have the cloud administrator user role. See What are the vRealize Automation 
Cloud Assembly user roles.
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n Verify that you have an account with the external IPAM provider, for example Infoblox or 
Bluecat, and that you have the correct access credentials to your organization's account with 
the IPAM provider.

n Verify that you have access to a deployed integration package for your IPAM provider, such 
as Infoblox or BlueCat. The deployed package is initially obtained as a .zip download from 
your IPAM provider website or from the vRealize Automation Cloud Assembly Marketplace 
and then deployed in vRealize Automation Cloud Assembly.

For information about how to deploy the provider package .zip file and make it available as 
a Provider value on the IPAM Integration page, see Download and deploy an external IPAM 
provider package for use in vRealize Automation.

Procedure

1 To create an On-Prem FaaS-based extensibility action to use as an IPAM integration running 
environment, select Extensibility > Library > Actions.

2 Click New Action, enter an action name and description, and specify a project.

3 In the FaaS provider drop-down menu, select On Prem.

4 Complete the form to define the extensibility action.

 For related information about the running environment, see this Infoblox IPAM Plug-in 
1.1 Integration blog video at approximately 24 minutes into the video.

Add an external IPAM integration point in vRealize Automation

vRealize Automation supports integration with an external IPAM providers. You can use a 
provider-specific IPAM integration point to obtain and manage IP addresses and related network 
characteristics for blueprint deployments.

In this example, you create an external IPAM integration point to support access to your 
organization's account with an external IPAM provider. In this example workflow, the IPAM 
provider is Infoblox and the provider-specific integration package already exists. While these 
instructions are specific to an Infoblox integration, they can be used as reference if creating an 
IPAM integration for a different external IPAM provider.

You can obtain a provider-specific integration package from your IPAM provider's website, from 
the VMware solutions exchange marketplace or, if available, from the vRealize Automation Cloud 
Assembly Marketplace tab.

This example uses the VMware-supplied Infoblox package Infoblox.zip, which is available for 

download from the VMware solutions exchange marketplace as follows:

n vRA Cloud Infoblox plugin version 1.1 - supports vRealize Automation 8.1

n vRA Cloud Infoblox plugin version 1.0 - supports vRealize Automation 8.0.1

n vRA Cloud Infoblox plugin version 0.1 - supports vRealize Automation 8.0
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Prerequisites

n Verify that you have cloud administrator credentials. See Credentials required for working with 
cloud accounts in vRealize Automation.

n Verify that you have the cloud administrator user role. See What are the vRealize Automation 
Cloud Assembly user roles.

n Verify that you have an account with external IPAM provider and that you have the correct 
access credentials to your organization's account with the IPAM provider.

n Verify that you have access to a deployed integration package for your IPAM provider. The 
deployed package is initially obtained as a .zip download from your IPAM provider website, or 
from the VMware solutions exchange marketplace, and then deployed to vRealize Automation.

For information about how to download and deploy the provider package .zip file and make 
it available as a Provider value on the IPAM Integration page, see Download and deploy an 
external IPAM provider package for use in vRealize Automation.

n Verify that you have access to a configured running environment for the IPAM provider. The 
running environment is typically an actions-based extensibility (ABX) On-Prem Embedded 
integration point.

For information about running environment characteristics, see Create a running environment 
for an IPAM integration point in vRealize Automation.

n Enable required extensible attributes in your Infoblox application. See Add required extensible 
attributes in the Infoblox application for integration with vRealize Automation.

n If you do not have external Internet access, you can configure an Internet server proxy. See 
How do I configure an Internet proxy server for vRealize Automation.

Procedure

1 Select Infrastructure > Connections > Integrations and click Add Integration.

2 Click IPAM.

3 In the Provider drop-down, select a configured IPAM provider package from the list, for 
example Infoblox_hrg.

If the list is empty, click Import Provider Package, navigate to an existing provider 
package .zip file, and select it. If you do not have the provider .zip file, you can obtain it from 
your IPAM provider's web site or from the vRealize Automation Cloud Assembly Marketplace 
tab.

For information about how to deploy the provider package .zip file in vCenter and make it 
available as a Provider value on the Integration page, see Download and deploy an external 
IPAM provider package for use in vRealize Automation.

For information about how to upgrade an existing IPAM integration to use a more recent 
version of a vendor's IPAM integration package, see How do I upgrade to a newer IPAM 
integration package in vRealize Automation .
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4 Enter your administrator user name and password credentials for your account with the 
external IPAM provider, along with all other (if any) mandatory fields, such as the host name of 
your provider.

In this example, you obtain the host name of your Infoblox IPAM provider using the following 
steps:

a In a separate browser tab, log in to your IPAM provider account using your Infoblox 
administrator credentials.

b Copy your host name URL.

c Paste your host name URL in the Hostname field on the IPAM Integration page.

5 In the Running Environment drop-down list, select an existing on-premises actions-based 
extensibility integration point, for example Infoblox_abx_intg.

The running environment supports communication between vRealize Automation and the 
external IPAM provider.

Note   If you use an Amazon Web Services or Microsoft Azure cloud account as the integration 
running environment, be sure that the IPAM provider appliance is accessible from the Internet 
and is not behind a NAT or firewall and that it has a publicly resolvable DNS name. If the IPAM 
provider is not accessible, the Amazon Web Services Lambda or Microsoft Azure Functions 
cannot connect to it and the integration will fail. For related information, see Create a running 
environment for an IPAM integration point in vRealize Automation.

The IPAM framework only supports an actions-based extensibility (ABX) On-Prem Embedded 
running environment.

Note   An Infoblox IPAM integration point requires an actions-based extensibility (ABX) On-
Prem Embedded integration point.

The configured cloud account or integration point allows communication between vRealize 
Automation and the IPAM provider, in this example Infoblox, through an associated cloud 
extensibility proxy. You can select a provider that has already been created or you can create 
one.

For information about how to create a running environment, see Create a running environment 
for an IPAM integration point in vRealize Automation.

6 Click Validate.

Because this example uses the on-premises actions-based extensibility integration for the 
running environment, you can view the validation action.

a Click the Extensibility tab.

b Click Activity > Action Runs and select either All Runs or Integration runs from the filter to 
note that an endpoint validation action is initiated and running.
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7 When prompted to trust the self-signed certificate from the IPAM provider, click Accept.

After you accept the self-signed certificate, the validation action can continue to completion.

8 Enter a Name for this IPAM integration point, such as Infloblox_Integration, and a 
Description, such as Infoblox IPAM with ABX integration for team HRG.

9 Click Add to save the new external IPAM integration point.

A data collection action is imitated. Networks and IP ranges are data-collected from the IPAM 
provider. You can view the data collection action as follows:

a Click the Extensibility tab.

b Click Activity > Action Runs and note that a data collection action is initiated and running. 
You can open and view the action run content.

Results

The provider-specific external IPAM integration is now available for use with networks and 
network profiles.

Configure a network and network profile to use external IPAM for an 
existing network in vRealize Automation

You can define an existing network to use IP address values that are obtained from, and managed 
by, an external IPAM provider rather than internally from vRealize Automation.

You can define a network to access existing IP settings that you have defined in your 
organization's external IPAM provider account. This step expands on the Infoblox provider 
integration that you created in the previous step.

In this example, you configure a network profile with existing networks that were data-collected 
from vCenter. You then configure these networks to obtain IP information from an external IPAM 
provider, in this case Infoblox. Virtual machines that you provision from vRealize Automation that 
can be matched with this network profile obtain their IP and other TCP/IP related settings from the 
external IPAM provider.

For more information about networks, see Network resources. For more information about 
network profiles, see How to add vRealize Automation Cloud Assembly network profiles and Learn 
more about network profiles in vRealize Automation.

For related information, see How do I configure a network profile to support an on-demand 
network for an external IPAM integration in vRealize Automation.

Prerequisites

This sequence of steps is shown in the context of an IPAM provider integration workflow. See Use 
case: How do I configure a provider-specific external IPAM integration for vRealize Automation .

n Verify that you have cloud administrator credentials. See Credentials required for working with 
cloud accounts in vRealize Automation.
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n Verify that you have the cloud administrator user role. See What are the vRealize Automation 
Cloud Assembly user roles.

n Verify that you have an account with the external IPAM provider, for example Infoblox or 
Bluecat, and that you have the correct access credentials to your organization's account with 
the IPAM provider. In this example workflow, the IPAM provider is Infoblox.

n Verify that you have an IPAM integration point for the IPAM provider. See Add an external 
IPAM integration point in vRealize Automation .

Procedure

1 To configure a network, click Infrastructure > Resources > Networks.

2 On the Networks tab, select an existing network to use with the IPAM provider integration 
point. In this example, the network name is net.23.117-only-IPAM.

Listed networks have been data-collected by vRealize Automation from a vCenter in your 
organization.

3 To obtain values from the external IPAM provider, verify that except for the Account/region, 
Name, and Network domain, all other network settings are empty, including the following:

n Domain (See Note in step 8)

n CIDR

n Default gateway

n DNS servers

n DNS search domains

4 Click the IP Ranges tab and click Add IPAM IP Range.

5 From the Network menu, select the network that you just configured, for example net.23.117-
only-IPAM.

6 From the Provider menu, select the Infloblox_Integration IPAM integration point that you 
created earlier in the workflow

7 From the now-visible Address Space drop-down menu, select one of the listed network views.

An address space in Infoblox is referred to as a network view.

The network views are obtained from your IPAM provider account. This example uses 
the network subnet that you just configured, for example net.23.117-only-IPAM, the 
Infloblox_Integration integration point that you created earlier in the workflow, and an address 
space named default.

Listed address space values are obtained from the external IPAM provider.
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8 From the list of displayed networks that are available for the selected address space, select 
one or more networks, for example select 10.23.117.0/24.

For this example, the Domains and DNS Servers column values for the selected network 
contain values from Infoblox.

Note   If you select a network in Step 3 that had a Domain specified for vRealize Automation, 
and then select a network from the external IPAM provider address space that contains a 
Domain value, the Domain value in the external IPAM provider network takes precedence 
over the Domain specified in vRealize Automation. If the IPAM IP range setting doesn't have 
a Domain value, specified in either Cloud Assembly or in the external IPAM provider as 
described above, provisioning fails.

For Infoblox, you can use the blueprint property Infoblox.IPAM.Network.dnsSuffix at the 

machine level to overwrite the Domain value. For related information, see Using Infloblox-
specific properties and extensible attributes for IPAM integrations in vRealize Automation.

9 Click Add to save the IPAM IP range for the network.

The range is visible in the IP Ranges table.

10 Click the IP Addresses tab.

After you provision a machine by using the new address range from the external IPAM 
provider, a new record will be visible in the IP Addresses table.

11 To configure a network profile to use the network, click Infrastructure > Configure > Network 
Profiles.

12 Name the network profile, for example Infoblox-NP, and add the following sample settings.

n Summary tab

n Specify a vSphere cloud account/region.

n Add a capability tag for the network profile, for example named infoblox_abx.

Make note of the capability tag, as you must also use it as a cloud template constraint 
tag to make the provisioning association in the cloud template.

n Networks tab

n Add the network that you created earlier, for example net.23.117-only-IPAM.

13 Click Save to save the network profile with these settings.

Results

The network and network profile setting are now configured for an existing network type to be 
used for the Infoblox IPAM integration in a cloud template design.
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Define and deploy a vRealize Automation Cloud Assembly blueprint 
that uses IPAM provider range assignment

You can define a blueprint to obtain and manage IP addresses assignments from your external 
IPAM provider.

In this final step in the external IPAM integration workflow, you define and deploy a blueprint 
that connects your previously defined network and network profile to your organization's Infoblox 
account to obtain and manage IP address assignments for deployed VMs from the external IPAM 
provider rather than from vRealize Automation Cloud Assembly.

The workflow uses Infoblox as the external IPAM provider and in some steps, the example values 
are unique to Infoblox, although the intent is that the procedure can be applied to other external 
IPAM integrations.

 The Infoblox Automate IPAM and DNS for VMs using VMware vRealize Automation and 
Infoblox DDI blog and video provide related information.

After you deploy the blueprint and the VM is started, the IP address used for each VM in the 
deployment appears as a network entry in the Resources > Networks page, as a new host record 
in the IPAM provider network in your IPAM provider's account, and in the vSphere Web Client 
record for each deployed VM in the host vCenter.

Prerequisites

This sequence of steps is shown in the context of an external IPAM provider integration workflow. 
See Use case: How do I configure a provider-specific external IPAM integration for vRealize 
Automation .

n Verify that you have cloud administrator credentials. See Credentials required for working with 
cloud accounts in vRealize Automation.

n Verify that you have the cloud administrator user role. See What are the vRealize Automation 
Cloud Assembly user roles.

n Verify that you have an account with the external IPAM provider, for example Infoblox or 
BlueCat, and that you have the correct access credentials to your organization's account with 
the IPAM provider.

n Verify that you have administrator access to the host account and any role requirements 
needed to display status records in the vSphere web client record for your deployed VMs in 
the host vCenter.

n Verify that you have an IPAM integration point for the external IPAM provider. See Add an 
external IPAM integration point in vRealize Automation .

n Verify that you have configured a vRealize Automation Cloud Assembly network and network 
profile that support external IPAM integration for your intended IPAM integration point. See 
Configure a network and network profile to use external IPAM for an existing network in 
vRealize Automation .
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n Verify that your project and cloud zone are tagged to match tags in the IPAM integration point 
and network or network profile. Optionally configure the project to support custom resource 
naming.

For more information than provided about the role of a project and cloud zone, as well as 
the role of other infrastructure elements in your blueprint, see The WordPress use case. For 
more information about tagging, see How do I use tags to manage vRealize Automation Cloud 
Assembly resources and deployments.

For information about custom naming VMs by using settings in your project, see How to 
customize the names of deployed resources using vRealize Automation Cloud Assembly.

Procedure

1 Click Blueprints > New, enter the following information in the New Blueprint page, and click 
Create.

n Name = ipam-bpa

n Description = Blueprint that uses Infoblox IPAM integration

n Project = 123VC

2 For this example, add a cloud agnostic machine component and a cloud agnostic network 
component to the blueprint canvas and connect the two components.

3 Edit the blueprint code to add a constraint tag to the network component that matches 
the capability tag that you added to the network profile. For this example, that tag value is 
infoblox_abx.

4 Edit the blueprint code to specify that the network assignment type is static.

When using an external IPAM provider, the assignment: static setting is required.

For this example, the specified IP address 10.23.117.4 is known to be currently available in 
the external IPAM address space that we selected for the network in the associated network 
profile. While the assignment: static setting is required, the address: valuesetting is not. 

You can choose to begin external IP address selection at a particular address value, but doing 
so is not required. If you do not specify an address: value setting, the external IPAM provider 

selects the next available address in the external IPAM network.

5 Verify the blueprint code against the following example.

formatVersion: 1
inputs: {}
resources:
  Cloud_Network_1:
    type: Cloud.Network
    properties:
      networkType: existing
      name: ipam
      constraints: 
        - tag: infoblox_abx
  Cloud_Machine_1:
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    type: Cloud.Machine
    properties:
      image: ubuntu
      flavor: small
      networks:
        - network: '${resource.Cloud_Network_1.id}'
          assignment: static
          address: 10.23.117.4
          name: '${resource.Cloud_Network_1.name}'

For examples of Infoblox properties that are available for specifying DNS and DHCP settings 
in blueprints, see Using Infloblox-specific properties and extensible attributes for IPAM 
integrations in vRealize Automation.

6 Click Deploy on the blueprint page, name the deployment Infoblox-1, and click Deploy on the 
Deployment Type page.

7 As the blueprint is being deployed, click the Extensibility tab and select Activity > Action 
Runs to see the Infoblox_AllocateIP_n extensibility action running.

After the extensibility action is completed and the machine is provisioned, the 
Infloblox_Update_n action propagates the MAC address to Infoblox.

8 You can log in to and open your Infoblox account to see the new host record for the IPAM 
address in the associated 10.23.117.0/24 network. You can also open the DNS tab in Infoblox to 
see the new DNS host record.

9 To verify that the VM is being provisioned, log in to your host vCenter and vSphere Web Client 
to locate the provisioned machine and view the DNS name and IP address.

After the provisioned VM is started, the MAC address is propagated to Infoblox by an 
Infoblox_AllocateIP extensibility action.

10 To view the new network record in vRealize Automation Cloud Assembly, select Infrastructure 
> Resources > Networks and click to open the IP Addresses tab.

11 If you delete the deployment, the IPAM address of VMs in the deployment are released 
and the IP addresses are again available to the external IPAM provider for other 
allocations. The extensibility action for this event in vRealize Automation Cloud Assembly is 
Infoblox_Deallocate.

Using Infloblox-specific properties and extensible attributes for IPAM 
integrations in vRealize Automation

You can use Infloblox-specific properties for vRealize Automation projects that contain external 
IPAM integrations for Infoblox.

The following Infloblox properties are available for use with your Infoblox IPAM integrations. You 
can use them in vRealize Automation to further control IP address allocation during blueprint 
deployment. Use of these properties is optional.
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While all of the following Infloblox properties are available for use with the vRA Cloud Infoblox 
plugin version 0.1 package for vRealize Automation 8.0, the Infoblox.IPAM.Network.dnsView 
property is only available for use with the vRA Cloud Infoblox plugin version 1.0 for vRealize 
Automation 8.0.1 and vRA Cloud Infoblox plugin version 1.1 for vRealize Automation 8.1 and later 
packages.

Note   Use of these properties is not included in the Use case: How do I configure a provider-
specific external IPAM integration for vRealize Automation sample workflow.

n Infoblox.IPAM.createFixedAddress

This property enables you to create a fixed address record inside Infoblox. Possible values are 
True and False. By default, a host record is created. The default value is False.

n Infoblox.IPAM.Network.dnsView

This property enables you to use a DNS view when creating a host record inside Infoblox.

n Infoblox.IPAM.Network.enableDns

When allocating an IP in Infoblox, this property enables you to also create a DNS record. 
Possible values are True and False, the default is True.

n Infoblox.IPAM.Network.enableDhcp

You can set this option to True to enable the DHCP configuration for the host address.

n Infoblox.IPAM.Network.dnsSuffix

This property enables you to overwrite the domain DHCP option of an Infoblox network with 
a new one. This capability is useful if the Infoblox network does not have the domain DHCP 
option set or if the the domain DHCP option must be overwritten. The default value is null 
(empty string).

Infoblox.IPAM.Network.dnsSuffix is only applicable if 

Infoblox.IPAM.Network.enableDns is set to True.

You can specify an Infoblox property using one of the following methods in vRealize 
Automation Cloud Assembly:

n You can specify properties in a project by using the Custom Properties section on 
your Infrastructure > Administration > Projects page. Using this method, the specified 
properties are applied to all machines that are provisioned in the scope of this project.

n You can specify properties on each machine component in a blueprint. Sample blueprint 
code illustrating use of the Infoblox.IPAM.Network.dnsView property is shown below:

formatVersion: 1
inputs: {}
resources:
  Cloud_vSphere_Machine_1:
    type: Cloud.vSphere.Machine
    properties:
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      Infoblox.IPAM.Network.dnsView: default
      image: ubuntu
      cpuCount: 1
      totalMemoryMB: 1024
      networks:
        - network: '${resource.Cloud_Network_1.id}'
  Cloud_Network_1:
    type: Cloud.Network
    properties:
      networkType: existing
      constraints: 
        - tag: mk-ipam-demo

n You can specify properties by using an extensibility subscription.

For related information about Infoblox extensible attributes relative to this use case, see 
Add required extensible attributes in the Infoblox application for integration with vRealize 
Automation.

Using Infoblox properties in blueprints

The following Infoblox properties can have a different value for each machine NIC in the blueprint:

n Infoblox.IPAM.Network.enableDhcp

n Infoblox.IPAM.Network.dnsView

n Infoblox.IPAM.Network.enableDns

For example, to use a different Infoblox.IPAM.Network.dnsView value for each NIC, use a 

Infoblox.IPAM.Network<nicIndex>.dnsView entry for each NIC. The following sample shows 

different values Infoblox.IPAM.Network.dnsView for two NICs.

formatVersion: 1
inputs: {}
resources:
  Cloud_Machine_1:
    type: Cloud.Machine
    properties:
      Infoblox.IPAM.Network0.dnsView: default
      Infoblox.IPAM.Network1.dnsView: my-net
      image: ubuntu
      flavor: small
      networks:
        - network: '${resource.Cloud_Network_1.id}'
          deviceIndex: 0
        - network: '${resource.Cloud_Network_2.id}'
          deviceIndex: 1
  Cloud_Network_1:
    type: Cloud.Network
    properties:
      networkType: existing
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  Cloud_Network_2:
    type: Cloud.Network
    properties:
      networkType: existing

By default, the Infoblox integration creates a DNS host record in the default DNS view in Infoblox. 
If your Infoblox administrator has created custom DNS views, you can overwrite the default 
integration behavior and specify a named view by using the Infoblox.IPAM.Network.dnsView 
property in the machine component. For example, you can add the following property to the 
Cloud_Machine_1 component to specify a named DNS view in Infoblox.

  Cloud_Machine_1:
    type: Cloud.Machine
    properties:
      image: ubuntu
      flavor: small
      Infoblox.IPAM.Network.dnsView:<dns-view-name> 

For information about configuring and using DNS views, see DNS Views in Infoblox product 
documentation. For examples in the Infoblox integration workflow, see Define and deploy a 
vRealize Automation Cloud Assembly blueprint that uses IPAM provider range assignment.
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Building your vRealize Automation 
Cloud Assembly resource 
infrastructure

4
vRealize Automation Cloud Assembly resource infrastructure is where you define cloud account 
regions as zones into which blueprints and their workloads can be deployed.

In addition, resource infrastructure involves creation of common mappings of images and machine 
sizes, and profiles that define network and storage capabilities across cloud account regions or 
data centers.

This chapter includes the following topics:

n How to add cloud zones that define vRealize Automation Cloud Assembly target placement 
regions or data centers 

n How to add vRealize Automation Cloud Assembly flavor mappings to create common machine 
sizes in vRealize Automation Cloud Assembly

n How to add vRealize Automation Cloud Assembly image mapping to create common 
operating systems

n How to add vRealize Automation Cloud Assembly network profiles

n How to add vRealize Automation Cloud Assembly storage profiles that account for different 
requirements 

n How do I use tags to manage vRealize Automation Cloud Assembly resources and 
deployments

n How to work with resources in vRealize Automation Cloud Assembly

How to add cloud zones that define vRealize Automation 
Cloud Assembly target placement regions or data centers

A vRealize Automation Cloud Assembly cloud zone is a set of resources within a cloud account 
type such as AWS or vSphere.

Cloud zones in a specific account region are where your blueprints deploy workloads. Each cloud 
zone is associated with a vRealize Automation Cloud Assembly project.

Select Infrastructure > Configure > Cloud Zones and click Add New Zone.
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Learn more about vRealize Automation Cloud Assembly cloud zones

vRealize Automation Cloud Assembly cloud zones are sections of compute resources that are 
specific to your cloud account type such as AWS or vSphere.

Cloud zones are specific to a region, you must assign them to a project. There is a many to many 
relationship between cloud zones and projects. vRealize Automation Cloud Assembly supports 
deployment to the most popular public clouds including Azure, AWS and GCP as well as to 
vSphere. See Adding cloud accounts to vRealize Automation Cloud Assembly.

Additional placement controls include placement policy options, capability tags, and compute 
tags.

n Placement policy

Placement policy drives host selection for deployments within the specified cloud zone.

n default - Distributes compute resources across clusters and hosts randomly. This 
option works at an individual machine level. For example, all machines in a particular 
deployment are distributed randomly across the available clusters and hosts that satisfy 
the requirements.

n binpack - Places compute resources on the most loaded host that has enough available 
resources to run the given compute.

n spread - Provisions compute resources, at a deployment level, to the cluster or host with 
the least number of virtual machines. For vSphere, Distributed Resource Scheduler (DRS) 
distributes the virtual machines across the hosts. For example, all requested machines in a 
deployment are placed on the same cluster, but the next deployment may choose another 
vSphere cluster depending on the current load.

For example, let's assume you have the following configuration:

n DRS cluster 1 with 5 virtual machines

n DRS cluster 2 with 9 virtual machines

n DRS cluster 3 with 6 virtual machines

If you request a cluster of 3 virtual machines and you select a Spread policy, they should 
all be placed on cluster 1. The updated loads become 8 virtual machines for cluster 1, while 
the loads for clusters 2 and 3 remain the same at 9 and 6.

Then, if you request an additional 2 virtual machines, they are placed on DRS cluster 3, 
which will now have 8 virtual machines. The load for clusters 1 and 3 remain the same at 8 
and 9.

If two cloud zones both match all the criterias needed for provisioning, then the placement 
logic selects the one with higher priority.

n Capability tags
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Blueprints contain constraint tags to help determine deployment placement. During 
deployment, blueprint constraint tags are mapped to matching capability tags in cloud zones 
to determine which cloud zones are available for compute resource placement.

n Computes

You can view and manage the compute resources that are available to provision workloads, 
such as AWS availability zones and vCenter clusters, to this cloud zone.

If a vCenter compute cluster is DRS-enabled, the cloud zone only displays the cluster in the 
list of computes and it does not display the child hosts. If a vCenter compute cluster is not 
DRS-enabled, the cloud zone only displays standalone ESXi hosts, if present.

Compute tags help to further control placement. You can use tags to filter available compute 
resources to only those that match one or more tags, as shown in the following examples.

n Computes contain no tags and no filtering is used.

n Two computes contain the same tag but no filtering is used.
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n Two computes contain the same tag and the tag filter matches the tag used on the two 
computes.

n Projects

You can view which projects have been configured to support workload provisioning to this 
cloud zone.

After you create a cloud zone, you can validate its configuration.

How to add vRealize Automation Cloud Assembly flavor 
mappings to create common machine sizes in vRealize 
Automation Cloud Assembly

A vRealize Automation Cloud Assembly flavor map is where you use natural language to define 
target deployment sizes for a specific cloud account/region.
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Flavor maps express the deployment sizes that make sense for your environment. One example 
might be small for 1 CPU and 2 GB memory and large for 2 CPUs and 8 GB memory for a vCenter 
account in a named data center and t2.nano for an Amazon Web Services account in a named 
region.

Select Infrastructure > Configure > Flavor Mappings and click New Flavor Mapping.

Learn more about flavor mappings in vRealize Automation Cloud 
Assembly

A flavor mapping groups a set of target deployment sizings for a specific cloud account/region in 
vRealize Automation Cloud Assembly using natural language naming.

Flavor mapping lets you create a named mapping that contains similar flavor sizings across your 
account regions. For example, a flavor map named standard_small might contain a similar flavor 

sizing (such as 1 CPU, 2 GB RAM) for some or all available account/regions in your project. When 
you build a blueprint, you pick an available flavor that fits your needs.

Organize flavor mappings for your project by deployment intent.

To simplify blueprint creation, you can select a pre-configuration option when you add a new 
cloud account. When you select the pre-configuration option, your organization's most popular 
flavor mapping and image mapping for the specified region are selected.

With regard to image mapping in blueprints that contain vSphere resources, if there are no 
flavor mappings defined for a vSphere cloud zone, you can configure unlimited memory and CPU 
by using vSphere-specific settings in the blueprint. If there are flavor mappings defined for a 
vSphere cloud zone, the flavor mapping serves as a limit for vSphere-specific configurations in the 
blueprint.

For a basic flavor mapping example, see WordPress use case: add flavor mappings.

How to add vRealize Automation Cloud Assembly image 
mapping to create common operating systems

A vRealize Automation Cloud Assembly image map is where you use natural language to define 
target deployment operating systems for a specific cloud account/region.

Select Infrastructure > Configure > Image Mappings and click New Image Mapping.

Learn more about image mappings in vRealize Automation

An image mapping groups a set of predefined target operating system specifications for a specific 
cloud account/region in vRealize Automation by using natural language naming.

Cloud vendor accounts such as Microsoft Azure and Amazon Web Services use images to group 
a set of target deployment conditions together, including OS and related configuration settings. 
vCenter and NSX-based environments, including VMware Cloud on AWS, use a similar grouping 
mechanism to define a set of OS deployment conditions. When you build and eventually deploy 
and iterate a cloud template, you pick an available image that best fits your needs.
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Organize image mappings for a project by similar operating system settings, tagging strategy, and 
functional deployment intent.

To simplify cloud template creation, you can select a pre-configuration option when you add 
a new cloud account. When you select the pre-configuration option, your organization's most 
popular flavor mapping and image mapping for the specified region are selected.

When you add image information to a cloud template, you use either the image or imageRef entry 

in the properties section of a machine component. For example, if you want to clone from a 

snapshot, use the imageRef property.

For examples of image and imageRef entries in cloud template code, see Chapter 6 Designing your 

vRealize Automation Cloud Assembly deployments.

To assign a permission on a content library, an administrator must grant the permission to the user 
as a global permission. For related information, see Hierarchical Inheritance of Permissions for 
Content Libraries in vSphere Virtual Machine Administration at VMware vSphere Documentation.

Synchronizing images for the cloud account/region

You can run image synchronization to ensure that the images you are adding or removing for a 
given cloud account/region on the Infrastructure > Configure > Image Mapping page are current.

1 Open the associated Cloud Account/Region by selecting Infrastructure > Connections > 
Cloud accounts. Select the existing cloud account/region.

2 Click the Sync Images button and let the action complete.

3 When the action is complete, click Infrastructure > Configure > Image Mapping. Define a new 
or edit an existing image mapping and select the cloud account/region from step 1.

4 Click the image synchronization icon on the Image Mapping page.

5 Configure image mappings settings for the specified cloud account/region on the Image 
Mapping page.
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Viewing OVF details

You can include OVF specifications in vRealize Automation Cloud Assembly cloud template 
objects, such as vCenter machine components and image maps. If your image contains an OVF 
file, you can discover its content without opening the file. Hover over the OVF to display OVF 
details, including its name and location.

Using shared and latest images from a Microsoft Azure image gallery

When creating image mappings for Microsoft Azure, you can select images from a shared Azure 
image gallery in the subscription. The images in the drop-down menu are data-collected and 
made available based on your selected region.

While shared image galleries can be used across multiple subscriptions, they cannot be listed 
in the image mapping drop-down menu across subscriptions. Only the images of a particular 
subscription are data-collected and listed in the image mappings list. To use an image from an 
image gallery in a different subscription, provide the image ID in the image mapping and use that 
image mapping in the cloud template.

Using constraints and tags to refine image selection

To further refine image selection in a cloud template, you can add one or more constraints 
to specify tag-based restrictions on the type of image that can be deployed. The supplied 
Constraints example that is displayed when you are creating or editing an image mapping 
configuration is !license:none:hard. The example illustrates a tag-based restriction where the 

image can only be used if the license:none tag is not present in the cloud template. If you 

add tags such as license:88 and license:92, the specified image can be used only if the 

license:88 and the license:92 tags are present in the cloud template.

Using a cloud configuration script to control deployment

You can use a cloud configuration script in an image map, cloud template, or both to define 
custom OS characteristics to be used in a vRealize Automation Cloud Assembly deployment. For 
example, based on whether you are deploying a cloud template to a public or private cloud, you 
can apply specific user permissions, OS permissions, or other conditions to the image. A cloud 
configuration script adheres to a cloud-init format for Linux-based images or a cloudbase-init 
format for Windows-based images. vRealize Automation Cloud Assembly supports the cloud-init 
tool for Linux systems and the cloudbase-init tool for Windows.
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For Windows machines, you can use any cloud configuration script format that is supported by 
cloudbase-init.

The machine resource in the following sample cloud template code uses an image that contains a 
cloud configuration script, the content of which is seen in the image entry.

resources:
  demo-machine:
    type: Cloud.vSphere.Machine
    properties:
      flavor: small
      image: MyUbuntu16 
        https://cloud-images.ubuntu.com/releases/16.04/release-20170307/ami-
ubuntu-16.04-1.10.3-00-15269239.ova
      cloudConfig: |
        ssh_pwauth: yes
        chpasswd:
          list: |
            ${input.username}:${input.password}
          expire: false
        users:
          - default
          - name: ${input.username}
            lock_passwd: false
            sudo: ['ALL=(ALL) NOPASSWD:ALL']
            groups: [wheel, sudo, admin]
            shell: '/bin/bash'
        runcmd:
          - echo "Defaults:${input.username}  !requiretty" >> /etc/sudoers.d/${input.username}

What happens when an image mapping and a cloud template contain a cloud 
configuration script

When a cloud template that contains a cloud configuration script uses an image mapping that 
contains a cloud configuration script, both scripts are combined. The merge action processes the 
contents of the image mapping script first and the contents of the cloud template script second, 
with consideration being given to whether the scripts are in #cloud-config format or not.

n For scripts that are in the #cloud-config format, the merge combines the contents of each 

module (for example runcmd, users, and write_files) as follows:

n For modules where the contents are a list, the lists of commands from the image mapping 
and from the cloud template are merged, excluding commands that are identical in both 
lists.

n For modules where the contents are a dictionary, the commands are merged and the 
result is a combination of both dictionaries. If the same key exists in both dictionaries, the 
key from the image mapping script dictionary is preserved and the key from the cloud 
template script dictionary is ignored.

n For modules where the contents are a string, the content values from the image mapping 
script are kept and the content values from the cloud template script are ignored.
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n For scripts that are in a format other than #cloud-config or when one script is in #cloud-
config format and the other is not, both scripts are combined in a way that the image 

mapping script is run first and the cloud template script is run when the image mapping script 
is finished.

Add an image from a vCenter content library

When a local or publisher content library resides in a vCenter that is managed by your vRealize 
Automation organization, content library template images appear in the image drop-down menu. 
The images listed include OVF and VM template images in local or publisher vCenter content 
libraries. Images in subscriber content libraries do not appear in the drop-down menu. The 
template from which a VM has been cloned is shown in the machine details section of the machine 
deployments user interface.

Note   If the publisher content library vCenter is managed by vRealize Automation, then 
publisher information is displayed in the image mapping selection grid in the following format: 
publisher_content_library_name / content_item_name

To assign a permission on a content library, an administrator must grant the permission to the user 
as a global permission. For related information, see Hierarchical Inheritance of Permissions for 
Content Libraries in vSphere Virtual Machine Administration at VMware vSphere Documentation.

If the publisher content library vCenter is not managed by vRealize Automation, then 
subscriber information is displayed in the image mapping selection grid in the following format: 
subscriber_content_library_name / content_item_name

When you deploy a cloud template that contains a VM template image mapping, vRealize 
Automation attempts to access the mapped image in the content library that is closest to the 
datastore, and then closest to the host, of the machine to be provisioned. This can include a local 
content library as well as a publisher or subscriber content library.

When you deploy a cloud template that contains an OVF template image mapping, OVF images 
are accessed as specified in the image mapping row if the image is in a local content library or a 
local subscriber of a specified remote publisher content library.

More information about configuring and using cloud configuration scripts

For more information about working with cloud configuration scripts in cloud templates, see How 
to automatically initialize a machine in a vRealize Automation Cloud Assembly blueprint .

How to add vRealize Automation Cloud Assembly network 
profiles

A vRealize Automation Cloud Assembly network profile describes the behavior of the network to 
be deployed.
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For example, a network might need to be Internet facing versus internal only. Networks and their 
profiles are cloud-specific.

Select Infrastructure > Configure > Network Profiles and click New Network Profile.

Learn more about network profiles in vRealize Automation

A network profile defines a group of networks and network settings that are available for a cloud 
account in a particular region or data center in vRealize Automation.

You typically define network profiles to support a target deployment environment, for example 
a small test environment where an existing network has outbound access only or a large load-
balanced production environment that needs a set of security policies. Think of a network profile 
as a collection of workload-specific network characteristics.

What's in a network profile

A network profile contains specific information for a named cloud account type and region in 
vRealize Automation, including the following settings:

n Named cloud account/region and optional capability tags for the network profile.

n Named existing networks and their settings.

n Network policies that define on-demand and other aspects of the network profile.

n Optional inclusion of existing load balancers.

n Optional inclusion of existing security groups.

You determine the network IP management functionality based on the network profile.

Network profile capability tags are matched with constraint tags in blueprints to help control 
network selection. Further, all tags that are assigned to the networks that are collected by the 
network profile are also matched with tags in the blueprint to help control network selection when 
the blueprint is deployed.

Capability tags are optional. Capability tags are applied to all networks in the network profile, 
but only when the networks are used as part of that network profile. For network profiles that 
do not contain capability tags, tag matching occurs on the network tags only. The network and 
security settings that are defined in the matched network profile are applied when the blueprint is 
deployed.

When using static IP, the address range is managed by vRealize Automation. For DHCP, the 
IP start and end addresses are managed by the independent DHCP server, not by vRealize 
Automation. When using DHCP or mixed network address allocation, the network utilization 
value is set to zero. An on-demand network allocated range is based on the CIDR and subnet 
size specified in the network profile. To support both static and dynamic assignment in the 
deployment, the allocated range is divided into two ranges - one for static allocation and another 
for dynamic allocation.
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Networks

Networks, also referred to as subnets, are logical subdivisions of an IP network. A network groups 
a cloud account, IP address or range, and network tags to control how and where to provision a 
blueprint deployment. Network parameters in the profile define how machines in the deployment 
can communicate with one another over IP layer 3. Networks can have tags.

You can add networks to the network profile, edit aspects of networks that are used by the 
network profile, and remove networks from the network profile.

n Network domain or Transport zone

A network domain or transport zone is the distributed virtual switch (dvSwitch) for the vSphere 
vNetwork Distributed PortGroups (dvPortGroup). A transport zone is an existing NSX concept 
that is similar to terms like dvSwitch or dvPortGroup.

When using an NSX cloud account, the element name on the page is Transport zone, 
otherwise it is Network domain.

For standard switches, the network domain or transport zone is the same as the switch itself. 
The network domain or transport zone defines the boundaries of the subnets within vCenter.

A transport zone controls which hosts an NSX logical switch can reach to. It can span one or 
more vSphere clusters. Transport zones control which clusters and which virtual machines can 
participate in the use of a particular network. Subnets that belong to the same NSX transport 
zone can be used for the same machine hosts.

n Domain

Represents the vCenter Single Sign-On domain for a target virtual machine. Domains are 
configured by a vCenter administrator during vSphere configuration. The domain determines 
the local authentication space in vCenter.

n IPv4 CIDR and IPv4 default gateway

vSphere cloud accounts, and vSphere machine components in the blueprint, support dual 
IPv6 and IPv4 internet protocol methods. For example, 192.168.100.14/24 represents the IPv4 
address 192.168.100.14 and its associated routing prefix 192.168.100.0, or equivalently, its 
subnet mask 255.255.255.0, which has 24 leading 1-bits. The IPv4 block 192.168.100.0/22 
represents the 1024 IP addresses from 192.168.100.0 to 192.168.103.255.

n IPv6 CIDR and IPv6 default gateway

vSphere cloud accounts, and vSphere machine components in the blueprint, support dual IPv6 
and IPv4 internet protocol methods. For example, 2001:db8::/48 represents the block of IPv6 
addresses from 2001:db8:0:0:0:0:0:0 to 2001:db8:0:ffff:ffff:ffff:ffff:ffff.

The IPv6 format is not supported for on-demand networks.

n DNS servers and DNS search domains

n Support public IP
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Select this option to flag the network as public. Network components in a blueprint that have a 
network type: public property are matched to networks that are flagged as public. Further 

matching occurs during blueprint deployment to determine network selection.

n Default for zone

Select this option to flag the network as a default for the cloud zone. During blueprint 
deployment, default networks are preferred over other networks.

n Origin

Identifies the network source.

n Tags

Specifies one or more tags assigned to the network. Tags are optional. Tag matching affect 
which networks are available for your blueprint deployments.

Network tags exist on the network item itself, irrespective of the network profile. Network 
tags apply to every occurrence of the network they have been added to and to all network 
profiles that contain that network. Networks can be instanced into any number of network 
profiles. Regardless of network profile residency, a network tag is associated with that network 
wherever the network is used.

When you deploy a blueprint, constraint tags in a blueprint's network components are 
matched to network tags, including network profile capability tags. For network profiles that 
contain capability tags, the capability tags are applied to all the networks that are available 
for that network profile. The network and security settings that are defined in the matched 
network profile are applied when the blueprint is deployed.

Network Policies

By using network profiles, you can define subnets for existing network domains that contain static, 
DHCP, or a mixture of static and DHCP IP address settings. You can define subnets and specify IP 
address settings by using the Network Policies tab.

Depending on the associated cloud account, you can use network policies to define settings for 
the outbound, private, and routed network types and for on-demand security groups. You can 

also use network policies to control existing networks when there is a load balancer associated 

with that network.

Options for the following on-demand selections are described in the Network Profiles on-screen 
help and summarized below.

n Do not create an on-demand network or on-demand security group

You can use this option when specifying an existing or public network type. Blueprints that 

require an outbound, private, or routed network are not matched to this profile.

n Create an on-demand network

You can use this option when specifying an outbound, private, or routed network type.
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Amazon Web Services, Microsoft Azure, NSX, vSphere, and VMware Cloud on AWS support 
this option.

n Create an on-demand security group

You can use this option when specifying an outbound or private network type.

A new security group is created for matched blueprints if the network type is outbound or 

private.

Amazon Web Services, Microsoft Azure, NSX, and VMware Cloud on AWS support this option.

Network policy settings can be cloud account type-specific. These settings are described in the 
on-screen signpost help and summarized below:

n Network domain or Transport zone

A network domain or transport zone is the distributed virtual switch (dvSwitch) for the vSphere 
vNetwork Distributed PortGroups (dvPortGroup). A transport zone is an existing NSX concept 
that is similar to terms like dvSwitch or dvPortGroup.

When using an NSX cloud account, the element name on the page is Transport zone, 
otherwise it is Network domain.

For standard switches, the network domain or transport zone is the same as the switch itself. 
The network domain or transport zone defines the boundaries of the subnets within vCenter.

A transport zone controls which hosts an NSX logical switch can reach to. It can span one or 
more vSphere clusters. Transport zones control which clusters and which virtual machines can 
participate in the use of a particular network. Subnets that belong to the same NSX transport 
zone can be used for the same machine hosts.

n External subnet

An on-demand network with outbound access requires an external subnet that has outbound 
access. The external subnet is used to provide outbound access if requested in the blueprint 
- it does not control network placement. For example, the external subnet does not affect the 
placing of a private network.

n CIDR

CIDR notation is a compact representation of an IP address and its associated routing prefix. 
The CIDR value specifies the network address range to be used during provisioning to create 
subnets. This CIDR setting on the Network Policies tab accepts IPv4 notation ending in /nn 
and containing values between 0 - 32.

n Subnet size 

This option specifies the size of the on-demand network, using IPv4 notation, to create for 
each isolated network in a deployment that uses this network profile. The subnet size setting is 
available for internal or external IP address management.

The IPv6 format is not supported for on-demand networks.

n Distributed logical router
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For an on-demand routed network, you must specify a distributed logical network when using 
an NSX-V cloud account.

A distributed logical router (DLR) is used to route east/west traffic between on-demand routed 
networks on NSX-V. This option is only visible if the account/region value for the network 
profile is associated to an NSX-V cloud account.

n IP range assignment

The option is available for cloud accounts that support NSX or VMware Cloud on AWS, 
including vSphere.

The IP range setting is available when using an existing network with an external IPAM 
integration point.

You can select one of the following three options to specify an IP range assignment type for 
the deployment network:

n Static and DHCP

Default and recommended. This mixed option uses the allocated CIDR and Subnet range 
settings to configure the DHCP server pool to support half of the address space allocation 
using the DHCP (dynamic) method and half of the IP address space allocation using the 
Static method. Use this option when some of the machines that are connected to an 
on-demand network require assigned static IP addresses and some require dynamic IP 
addresses. Two IP ranges are created.

This option is most effective in deployments with machines that are connected to an on-
demand network, where some of the machines are assigned static IPs and other machines 
have IPs dynamically assigned by an NSX DHCP server and deployments where the load 
balancer VIP is static.

n DHCP (dynamic)

This option uses the allocated CIDR to configure an IP pool on a DHCP server. All the IP 
addresses for this network are dynamically assigned. A single IP range is created for each 
allocated CIDR.

n Static

This option uses the allocated CIDR to statically allocate IP addresses. Use this option 
when a DHCP server is not required to be configured for this network. A single IP range is 
created for each allocated CIDR.

n IP blocks

The IP blocks setting is available when using an on-demand network with an external IPAM 
integration point.

Using the IP block setting, you can add a named IP block, or range, to the network profile 
from your integrated external IPAM provider. You can also remove an added IP block from the 
network profile. For information about how to create an external IPAM integration, see Add an 
external IPAM integration point in vRealize Automation .
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External IPAM is available for the following cloud account/region types:

n vSphere

n vSphere with NSX-T

n vSphere with NSX-V

n Network Resources - External network

External networks are also referred to as existing networks. These networks are data-collected 
and made available for selection.

n Network Resources - Tier-0 logical router

NSX-T uses the tier-0 logical router as a gateway to networks that are external to the NSX 
deployment. The tier-0 logical router configures outbound access for on-demand networks.

n Network Resources - Edge cluster

The specified edge cluster provides routing services. The edge cluster is used to configure 
outbound access for on-demand networks and load balancers. It identifies the edge cluster, or 
resource pool, where the edge appliance is to be deployed.

n Network Resources - Edge datastore

The specified edge datastore is used to provision the edge appliance. This setting applies to 
NSX-V only.

Load Balancers

You can add load balancers to the network profile. Listed load balancers are available based on 
information that is data-collected from the source cloud account.

If a tag on any of the load balancers in the network profile matches a tag used in a load balancer 
component in the blueprint, the load balancer is considered during deployment. Load balancers in 
a matched network profile are used when a blueprint is deployed.

For more information, see Using load balancer settings in network profiles in vRealize Automation 
Cloud Assembly and Network, security, and load balancer design samples in vRealize Automation 
blueprints.

Security Groups

When a blueprint is deployed, the security groups in its network profile are applied to the 
machines NICs that are provisioned. For an Amazon Web Services-specific network profile, the 
security groups in the network profile are available in the same network domain (VPC) as the 
networks that are listed on the Networks tab. If the network profile has no networks listed on its 
Networks tab, all available security groups are displayed.

You can use a security group to further define the isolation settings for an on-demand private or 

outbound network. Security groups are also applied to existing networks.
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Security groups are applied to all the machines in the deployment that are connected to the 
network that matches the network profile. As there might be multiple networks in a blueprint, each 
matching a different network profile, you can use different security groups for different networks.

Adding a tag to an existing security group allows you to use the security group in a blueprint 
Cloud.SecurityGroup component. A security group must have at least one tag or it cannot be 

used in a blueprint. For more information, see Security resources and Network, security, and load 
balancer design samples in vRealize Automation blueprints.

More information about network profiles, networks, blueprints, and tags

For more information about network profiles, see other topics in this section of the help as well as 
WordPress use case: add network profiles.

For more information about networks, see Network resources.

For examples of sample network component code in a blueprint, see Network, security, and load 
balancer design samples in vRealize Automation blueprints.

For sample network automation workflows, see Network Automation with Cloud Assembly and 
NSX.

For more information about tags and tag strategy, see How do I use tags to manage vRealize 
Automation Cloud Assembly resources and deployments.

Using network settings in network profiles and blueprints in vRealize 
Automation

You use networks and network profiles in vRealize Automation to help define the behavior of 
network provisioning for your deployments.

In vRealize Automation, you can define cloud-specific network profiles. See Learn more about 
network profiles in vRealize Automation.

Using network and network profile settings, you can control how network IP addresses are used in 
vRealize Automation blueprints and deployments.

IPv4 and IPv6 support in vRealize Automation networks

vRealize Automation networks support pure IPv4 or dual stack IPv4 and IPv6. Pure IPv6 is not 
currently supported.

While pure IPv4 is supported for all cloud account and integration types, dual stack IPv4 and IPv6 
is supported only for vSphere cloud accounts and their endpoints.

IPv6 is currently not supported for use with load balancers, NSX on-demand networks, or external 
third-party IPAM providers.
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External IPAM provider support

In addition to the supplied internal IPAM support, you can use an external IPAM provider to 
dynamically or statically allocate IP address for networks - as IP ranges for existing networks in 
your blueprint designs and deployments and IP blocks for on-demand networks in your blueprint 
designs and deployments.

Support for external IPAM providers, such as Infoblox, is available for vendor-specific IPAM 
integration points that you create by using the Infrastructure > Connections > Add Integration 
> IPAM menu sequence.

Options for defining external IPAM provider address information is available by using the Add 
IPAM IP Range option on the Network Policies > Add IPAM IP Range page.

For information about how to create an external IPAM integration point, see Configure an external 
IPAM integration point in vRealize Automation . For an example of how to create an IPAM 
integration point for a specific IPAM vendor, see Use case: How do I configure a provider-specific 
external IPAM integration for vRealize Automation .

Network types

A network component in a blueprint is defined as one of the following networkType types.

Network type Definition

existing Selects an existing network that is configured on the 
underlying cloud provider, such as vCenter, Amazon Web 
Services, and Microsoft Azure. An existing network is 
required by the outbound on-demand network.

You can define a range of static IP addresses on an 
existing network.

public Machines on a public network are accessible from the 
Internet. An IT administrator defines these networks. The 
definition of a public network is identical to that of an 

existing network for networks that allow network traffic 

to occur along public networks.

private An on-demand network type.

Limits network traffic to occur only between resources on 
the deployed network. It prevents inbound and outbound 
traffic. In NSX, it can be equated to on-demand NAT one-
to-many.
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Network type Definition

outbound An on-demand network type.

Limits network traffic to occur between the compute 
resources in the deployment but also allows one-way 
outbound network traffic. In NSX, it can be equated to 
on-demand NAT one-to-many with external IP.

routed An on-demand network type.

Routed networks contain a routable IP space divided 
across available subnets that are linked together. 
The virtual machines that are provisioned with routed 
networks, and that have the same routed network profile, 
can communicate with each other and with an existing 
network.

Routed networks are an on-demand network type that is 
available for NSX-V and NSX-T networks. Microsoft Azure 
and Amazon Web Services provides this connectivity by 
default.

A routed network is only available for blueprint 

specification in a Cloud.NSX.Network network component.

For examples of populated blueprints that contain network component data, see Network, 
security, and load balancer design samples in vRealize Automation blueprints.

Networking scenarios

You can expect the following behavior when you deploy a blueprint that uses the following 
network profile configuration.
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Network type or scenario
No network profiles available for 
cloud zone

Network profiles available for cloud 
zone

No network If no network is specified in the 
blueprint, a random network is 
selected from the same provisioning 
region as the compute.

Preference is given to networks that 
are labeled as default.

If no networks exist in an available 
provisioning region, provisioning fails.

A network is selected from a matched 
network profile.

Preference is given to networks that 
are labeled as default.

If none of the network profiles meet 
the criteria, provisioning fails.

Existing network If the network component in the 
blueprint contains constraint tags, 
those constraints are used to filter the 
list of available networks. Constraint 
tags in the blueprint's network 
component are matched to network 
tags and, if available, network profile 
constraint tags.

From the filtered list of networks, 
a single network is selected from 
the same provisioning region as the 
compute.

Preference is given to networks that 
are labeled as default.

If after filtering based on constraints 
there are no networks in the 
provisioning region, provisioning fails.

A network is selected from a matching 
network profile.

Preference is given to networks that 
are labeled as default.

If none of the network profiles meet 
the criteria, provisioning fails.

Network constraints can be used to 
filter existing networks in the profile 
based on their pre-assigned tags.

Public network If the network has constraints, those 
constraints are used to filter the list 
of available networks that have the 
supports public IP attribute set.

From the filtered list of networks, 
a random network is selected from 
the same provisioning region as the 
compute.

Preference is given to networks that 
are labeled as default.

If after filtering based on constraints 
there are no public networks in the 
provisioning region, provisioning fails.

A network with the supports public 
IP attribute is selected from a 

matching network profile.

Preference is given to networks that 
are labeled as default.

Network constraints can be used to 
filter existing public networks in the 
profile based on their pre-assigned 
tags.

Private network Provisioning fails because private 
networks require information from a 
network profile.

A new network or new security group 
is created based on settings in the 
matched network profile.

Network constraint tags can be 
used to filter network profiles and 
networks.
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Network type or scenario
No network profiles available for 
cloud zone

Network profiles available for cloud 
zone

Outbound network Provisioning fails because outbound 
networks require information from a 
network profile.

A new network or new security group 
is created based on settings in the 
matched network profile.

Network constraint tags can be 
used to filter network profiles and 
networks.

On-demand routed network Provisioning fails because routed 
networks require information from a 
network profile.

For NSX-V we need DLR (Distributed 
Logical Router) selection.

For NSX-T and VMware Cloud on 
AWS, we require similar on-demand 
settings as private and outbound.

Example Wordpress use case with 
existing or public networks

Provisioning occurs as described for 
an existing network or public network.

See above descriptions for existing 
network and public network behavior.

See The WordPress use case.

Example Wordpress use case with 
existing or public networks and 
private or outbound networks

Provisioning fails because the network 
requires information from a network 
profile.

See above descriptions for a private 
network and an outbound network.

See The WordPress use case.

Example Wordpress use case with 
load balancer

Provisioning fails because a load 
balancer requires information from a 
network profile.

Provisioning can occur when existing 
load balancers are present.

A new load balancer is created based 
on the network profile configuration.

You can specify an existing load 
balancer that has been enabled in the 
network profile.

Provisioning fails if you request an 
existing load balancer, but none meet 
the constraints in the network profile.

See The WordPress use case.

Using security group settings in network profiles and blueprint 
designs in vRealize Automation Cloud Assembly

You can define and change security group settings in network profiles and in blueprint designs.

You can use security group capabilities in several ways:

n Existing security group specified in a network profile

You can add an existing security group to a network profile. When a blueprint design uses that 
network profile, its machines are grouped together as members of the security group. This 
method does not require that you add a security group resource to a blueprint design. You 
can also use a load balancer in this configuration, For related information, see Using a load 
balancer resource in a vRealize Automation blueprint.

n Security group component associated to machine resource in a blueprint design
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You can drag and drop a security group resource on to a blueprint design and bind the 
security group resource to a machine NIC by using constraint tags on the existing security 
group resource in the blueprint design and on the existing security group in the data-collected 
resource. You can also make this association by connecting the objects together with a 
connection line on the blueprint design canvas, similar to how you associate networks to 
machines on the design canvas.

When you drag and drop a security group resource onto the blueprint design canvas, it can be 
of type existing or new. If it’s an existing security group type, you should add a tag constraint 

value as prompted. If it's a new security group type, you can configure firewall rules.

n An existing security group allocated with tag constraints and associated with a machine NIC in 
the blueprint

For example, you can associate a security group resource with a machine NIC (in a machine 
resource)in the blueprint design by matching tags between the two resources.

As an example for NSX-T when tags are specified in the source endpoint, you can use 
NSX-T tags specified in your NSX-T application. You can then use an NSX-T tag, specified 
as a constraint on a network resource in a blueprint design, where the network resource is 
connected to a machine NIC in the blueprint design. NSX-T tags enable you to dynamically 
group machines by using a pre-defined NSX-T tag that is data-collected from the NSX-T 
source endpoint. Use a logical port when you create the NSX-T tag in NSX-T.

n Firewall rules in an on-demand security group resource in a blueprint design

You can add firewall rules to an on-demand security group in the blueprint design.

For information about available firewall rules, see Using a security group resource in a vRealize 
Automation blueprint.

Learn more

For information about defining security groups in network profiles, see Learn more about network 
profiles in vRealize Automation.

For information about viewing and changing security groups settings in infrastructure resource 
pages, see Security resources.

For information about defining security groups in blueprint designs, see Using a security group 
resource in a vRealize Automation blueprint.

For examples of security group resources in blueprint designs, see Network, security, and load 
balancer design samples in vRealize Automation blueprints.

Using load balancer settings in network profiles in vRealize 
Automation Cloud Assembly

You can configure load balancer settings in your network profile configuration.

You can add an existing load balancer to a network profile by using the Load Balancer tab.
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You can add a load balancer to a blueprint design by associating it to a network profile that 
contains one or more load balancers or directly by using a load balancer resource in the design 
canvas or code.

Examples for including a load balancer VIP based on security group use in a 
network profile

There are two types of security groups that you can use in a network profile – an existing security 
group that you select from the Security Groups tab and an on-demand security group that you 
create by using an isolation policy on the Network Policies tab.

When a load balancer VIP is associated to a security group based on network profile settings, the 
security group configuration is supplied by the network profile.

The following table illustrates some sample scenarios.

Blueprint design topology - 
associated resources Network profile configuration Security group membership

One-armed load balancer with VIP on 
private network, and a machine on 
the same private network.

The selected network profile uses 
isolation policy defined as an on-
demand security group.

The machine NIC and the load 
balancer VIP are added to the 
isolation security group.

One-armed load balancer with VIP on 
private network, and a machine on 
the same private network.

The selected network profile uses 
an existing security group and uses 
isolation policy defined as an on-
demand security group.

The machine NIC and the load 
balancer VIP are added to the 
isolation security group and the 
existing security group.

Two-armed load balancer with VIP on 
a public network and machine on a 
private network.

The selected network profile uses 
an existing security group and uses 
isolation policy defined as an on-
demand security group.

The machine NIC and the load 
balancer VIP are added to the 
isolation security group and the 
existing security group.

Two-armed load balancer with VIP on 
a public network and a machine on a 
private network.

The selected network profile uses an 
existing security group.

The machine NIC and the load 
balancer VIP are added to the existing 
security group.

Two-armed load balancer, VIP is on 
network 1 and the machine is on 
network 2.

Two network profiles:

n Network profile 1: Uses an existing 
security group 1.

n Network profile 2: Uses an 
existing security group 2.

The load balancer lands on network 
profile 1 and the machine lands on 
network profile 2.

The load balancer VIP is added to 
security group 1 and the machine NIC 
is added to security group 2.

Learn more

For information about adding load balancer resources to a blueprint design, see Using a load 
balancer resource in a vRealize Automation blueprint.

For examples of blueprint designs that include load balancers, see Network, security, and load 
balancer design samples in vRealize Automation blueprints.
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How do I configure a network profile to support an on-demand 
network for an external IPAM integration in vRealize Automation

You can configure a network profile to support blocks of IP addresses for an on-demand network 
when that network profile is used in a vRealize Automation blueprint that uses external IPAM 
integration.

Using an existing integration for a particular external IPAM provider, you can provision on-
demand network to create of a new network in the external IPAM system.

Using this process, you configure a block of IP addresses instead of supplying a parent CIDR (as 
is done when usingvRealize Automation's internal IPAM). The IP address block is used during 
on-demand network provisioning to segment the new network. The IP blocks are data-collected 
from the external IPAM provider, provided the integration supports on-demand networking. 
For example, when using an Infoblox IPAM integration, IP blocks represent Infoblox network 
containers.

When you use an on-demand network profile and an external IPAM integration in a blueprint, the 
following events occur when the blueprint is deployed:

n A network is created in the external IPAM provider.

n A network is also created in vRealize Automation, reflecting the new network configuration 
from the IPAM provider, including settings such as CIDR and gateway properties.

n The IP address for the deployed virtual machine is fetched from the newly created network.

In this on-demand networking example, you configure a network profile to allow a blueprint 
deployment to provision a machine to an on-demand network in vSphere by using Infoblox as the 
external IPAM provider.

For related information, see How do I configure a network profile to support an existing network 
for an external IPAM integration in vRealize Automation. Both network configuration examples 
fit within the overall vendor-specific workflow for external IPAM integration at VMware Cloud on 
AWS use case .

Prerequisites

While the following prerequisites apply to the person who creates or edits the network profile, 
the network profile itself would be applicable when used by a blueprint deployment that contains 
an IPAM integration. To learn about vendor-specific IPAM integration points, see Configure an 
external IPAM integration point in vRealize Automation .

This sequence of steps is shown in the context of an IPAM provider integration workflow. See Use 
case: How do I configure a provider-specific external IPAM integration for vRealize Automation .

n Verify that you have cloud administrator credentials. See Credentials required for working with 
cloud accounts in vRealize Automation.

n Verify that you have the cloud administrator user role. See What are the vRealize Automation 
Cloud Assembly user roles.
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n Verify that you have an account with the external IPAM provider, for example Infoblox or 
Bluecat, and that you have the correct access credentials to your organization's account with 
the IPAM provider. In this example workflow, the IPAM provider is Infoblox.

n Verify that you have an IPAM integration point for the IPAM provider and that the IPAM 
package used to create the IPAM integration supports on-demand networks. See Add an 
external IPAM integration point in vRealize Automation .

While the Infoblox IPAM package supports on-demand networks, if you are using an external 
IPAM integration for a different provider, verify that their IPAM integration package supports 
on-demand networks.

Procedure

1 To configure a network profile, click Infrastructure > Configure > Network Profiles.

2 Click New Network Profile.

3 Click the Summary tab and specify the following sample settings:

n Specify a vSphere cloud account/region, for example vSphere-IPAM-OnDemandA/
Datacenter.

This example assumes use of a vSphere cloud account that is not associated with an NSX 
cloud account.

n Name the network profile, for example Infoblox-OnDemandNP.

n Add a capability tag for the network profile, for example infoblox_ondemandA.

Make note of the capability tag value, as you must also use it as a blueprint constraint 
tag to make the network profile association to be used when provisioning the blueprint. 

4 Click the Network Policies tab and specify the following sample settings:

n From the Isolation policy drop-down menu, select On-demand network.

This option allows you to use external IPAM IP blocks. Depending on the cloud account, 
new options appear. For example, the following options appear when using a vSphere 
cloud account that is associated to an NSX cloud account:

n Transport zone

n Tier-0 logical router

n Edge cluster

For this example, the vSphere cloud account is not associated to NSX, so the Network 
domain menu option appears.

n Leave the Network domain option blank.

5 Click External as the address management Source.

6 Click Add IP Block, which opens the Add IPAM IP Block page.
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7 From the Provider menu on the Add IPAM IP Block page, select an existing external IPAM 
integration. For example, select the Infloblox_Integration integration point from Add an 
external IPAM integration point in vRealize Automation in the example workflow.

8 From the Address spaces menu, select one of the available and listed IP blocks, for example 
10.23.118.0/24 and add it.

If the IPAM provider supports address spaces, the Address spaces menu appears. For an 
Infoblox integration, address spaces are represented by Infoblox network views.

9 Select a Subnet size, such as /29 (-6 IP addresses).

10 Click Create.

Results

A network profile is created that can be used to provision an on-demand network using the 
specified external IPAM integration. The following sample blueprint shows a single machine to be 
deployed to a network that is defined by this new network profile.

            formatVersion: 1
            inputs: {}
            resources:
              Cloud_Machine_1:
                type: Cloud.Machine
                properties:
                  image: ubuntu
                  flavor: small
                  networks:
                    - network: '${resource.Cloud_Network_1.id}'
                      assignment: static
              Cloud_Network_1:
                type: Cloud.Network
                properties:
                  networkType: private
                  constraints:
                    - tag: infoblox_ondemandA

Note   When blueprint is deployed, the first available network in the specified IP block is fetched 
and considered to be the network CIDR. If you are using an NSX network in the blueprint, you 
can instead set the CIDR of the network manually by using the network property networkCidr, as 

shown below, to manually set a CIDR and override the settings for IP blocks and subnet size that 
are specified in the associated network profile.

Cloud_Network_1:
                type: Cloud.Network
                properties:
                  networkCidr: 10.10.0.0/16
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How do I configure a network profile to support an existing network 
for an external IPAM integration in vRealize Automation

You can configure a network profile to support IP address ranges for an existing network when 
that network profile is used in a vRealize Automation blueprint that uses external IPAM integration.

An example is provided within the context of a vendor-specific sample workflow at Configure a 
network and network profile to use external IPAM for an existing network in vRealize Automation . 
The overall vendor-specific workflow for external IPAM integration is at VMware Cloud on AWS 
use case .

For related information, see How do I configure a network profile to support an on-demand 
network for an external IPAM integration in vRealize Automation.

How to add vRealize Automation Cloud Assembly storage 
profiles that account for different requirements

A vRealize Automation Cloud Assembly storage profile describes the kind of storage to be 
deployed.

Storage is usually profiled according to characteristics such as service level or cost, performance, 
or purpose, such as backup.

Select Infrastructure > Configure > Storage Profiles and click New Storage Profile.

Learn more about vRealize Automation Cloud Assembly storage 
profiles

A cloud account region contains storage profiles that let the cloud administrator define storage for 
the region.

Storage profiles include disk customizations, and a means to identify the type of storage by 
capability tags. Tags are then matched against provisioning service request constraints to create 
the desired storage at deployment time.

Storage profiles are organized under cloud-specific regions. One cloud account might have 
multiple regions, with multiple storage profiles under each.

Vendor-independent placement is possible. For example, visualize three different vendor 
accounts and a region in each. Each region includes a storage profile that is capability tagged 
as fast. At provisioning time, a request containing a hard fast constraint tag looks for a matching 
fast capability, regardless of which vendor cloud is supplying the resources. A match then applies 
the settings from the associated storage profile during creation of the deployed storage item.

Note   Different cloud storage might have different performance characteristics but still be 
considered the fast offering by the administrator who tagged it.

Capability tags that you add to storage profiles should not identify actual resource targets. 
Instead, they describe types of storage. For more about actual resources, see Storage resources.
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How do I use tags to manage vRealize Automation Cloud 
Assembly resources and deployments

Tags are a critical component of vRealize Automation Cloud Assembly that drive the placement 
of deployments through matching of capabilities and constraints. You must understand and 
implement tags effectively to make optimal use of vRealize Automation Cloud Assembly.

Fundamentally, tags are labels that you add to vRealize Automation Cloud Assembly items. You 
can create any tags that are appropriate for your organization and implementation. Tags function 
as much more than labels though, because they control how and where vRealize Automation 
Cloud Assembly uses resources and infrastructure to build deployable services. Tags also support 
governance within Cloud Assembly.

Tag Structure

Structurally, tags must follow the name:value pair convention, but otherwise their construction is 

largely free form. Throughout vRealize Automation Cloud Assembly, all tags appear the same, and 
tag functionality is determined by context.

For example, tags on infrastructure resources function primarily as capability tags because 
vRealize Automation Cloud Assembly uses them to match resources with deployments. 
Secondarily, they also identify the resources.

Tag Function

The primary function of tags within vRealize Automation Cloud Assembly is to configure 
deployments using capabilities and constraints. Capability tags placed on cloud zones, network 
and storage profiles, and individual infrastructure resources define desired capabilities for 
deployments. Constraint tags that cloud administrators place on projects enable them to exercise 
a form of governance over those projects. These constraint tags are added to other constraints 
expressed in blueprints.

During provisioning, vRealize Automation Cloud Assembly matches these capabilities with 
constraints, also expressed as tags, in blueprints to define deployment configuration. This tag-
based capability and constraint functionality serves as the foundation for deployment configuration 
in vRealize Automation Cloud Assembly. For instance, you can use tags to make infrastructure 
available only on PCI resources in a particular region.
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On a secondary level, tags also facilitate search and identification of storage and network items 
and other infrastructure resources.

For example, assume that you are setting up cloud zones and you have many compute resources 
available. If you have tagged your compute resources appropriately, you can use the search 
function on the Compute tab of the Cloud Zone page to filter the resources that are associated 
with that particular cloud zone.

Also, the Manage Tags page and resource configuration pages contain search functions that 
enable you to locate items by tag names. Using logical and human readable tags for these items is 
key to facilitating this search and identification function.

External Tags

vRealize Automation Cloud Assembly might also contain external tags. These tags are imported 
automatically from cloud accounts that you associate with a vRealize Automation Cloud Assembly 
instance. These tags might be imported from vSphere, AWS, Azure or other external software 
products. When imported, these tags are available for use in the same manner as user created 
tags.
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Managing Tags

You can use the Manage Tags page in vRealize Automation Cloud Assembly to monitor and 
manage your tags library. You can also create tags on this page. In addition, the Manage Tags 
page is the only page on which you can view and identify external tags.

Tag Strategy

To minimize confusion, before creating tags in vRealize Automation Cloud Assembly, devise an 
appropriate tag strategy and tagging conventions, so that all users who create and use tags 
understand what they mean and how they should be used. See Creating a Tagging Strategy.

Creating a Tagging Strategy

You must carefully plan and implement an appropriate tagging strategy based on your 
organization's IT structure and goals to maximize Cloud Assembly functionality and minimize 
potential confusion.

While tagging serves several common purposes, your tagging strategy must be tailored to your 
organizations needs, structure, and goals.

Best Practices for Tagging

Some general characteristics of an effective tag strategy:

n Design and implement a coherent plan for tagging that relates to the structure of your 
business and communicate this plan to all applicable users. A plan must support your 
deployment needs, use clear human readable language, and be understandable to all 
applicable users.
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n Use simple, clear, and meaningful names and values for tags. For instance, tag names for 
storage and network items should be clear and coherent so that users can readily understand 
what they are selecting or reviewing tag assignments for a deployed resource.

n Though you can create tags using a name with no value, as a best practice, it is more 
appropriate to create an applicable value for each tag name, as this makes the tag usage 
clear to other users.

Tagging Implementation

Map out your primary considerations for a basic tagging strategy. The following list shows typical 
considerations to consider when mapping your strategy. Be aware that these considerations are 
representative rather than definitive. You might have other considerations that are highly relevant 
to your use cases. Your specific strategy must be appropriate for your specific use cases.

n How many different environments do you deploy to. Typically, you will create tags that 
represent each environment.

n How are your compute resources structured and used to support deployments.

n How many different regions or locations do you deploy to. Typically, you will create tags, at 
the profile level, that represents each of these different regions or locations.

n How many different storage options are available for deployments, and how do you want to 
characterize them. These options should be represented by tags.

n Categorize your networking options and create tags to accommodate all applicable options.

n Typical deployment variables. For example, how many different environments do you deploy 
to. Typically, many organizations have Test, Dev, and Production environments at a minimum. 
You will want to create and coordinate blueprint constraint tags and cloud zone capability tags 
that match so that you can easily set up deployments to one or more of these environments.

n Coordinate tags on network and storage resources so that they make logical sense in context 
of the network and storage profiles in which they are used. The resource tags can serve as a 
finer level of control over the resource deployment.

n Coordinate cloud zone and network profile capability tags, and other capability tags, with 
blueprint constraint tags. In general, your administrator will create capability tags for cloud 
zones and network profiles first, and then other users can design blueprints with constraints 
that match these capability tags.

After you understand the important considerations for your organization, you can plan appropriate 
tag names that address these considerations in a logical manner. Then, create an outline of your 
strategy and make it available to all users with privileges to create or edit tags.

As a useful implementation approach, you can begin by tagging all of your compute infrastructure 
resources individually. As noted, use logical categories for tag names that relate to the specific 
resource. For instance, you might tag storage resources as tier1, tier2, etc. Also, you might tag 
compute resources based on their operating system, such as Windows, Linux, etc.
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After you tag resources, you can then consider the approach to creating tags for cloud zone and 
storage and network profiles that best suits your needs.

Using capability tags in vRealize Automation Cloud Assembly

In vRealize Automation Cloud Assembly, capability tags enable you to define placement logic for 
deployment of infrastructure components. They are a more powerful and succinct option to hard 
coding such placements.

You can create capability tags on compute resources, cloud zones, images and image maps, 
and networks and network profiles. The pages for creating these resources contain options 
for creating capability tags. Alternatively, you can use the Manage Tags page in vRealize 
Automation Cloud Assembly to create capability tags. Capability tags on cloud zones and network 
profiles affect all resources within those zones or profiles. Capability tags on storage or network 
components affect only the components on which they are applied.

Typically, capability tags might define things like location for a compute resource, adapter type for 
a network, or tier level for a storage resource. They can also define environment location or type 
and any other business considerations. As with your overall tagging strategy, you should organize 
your capability tags in a logical manner.

vRealize Automation Cloud Assembly matches capability tags with constraints from cloud zones 
and on blueprints at deployment time. So, when creating and using capability tags, you must 
understand and plan to create appropriate blueprint constraints so that matching will occur as 
expected.

For example, in the Add Cloud Zones topic in the Wordpress example, you created dev and 
test tags for the OurCo-AWS-US-East and OurCo AWS-US-West zones. This indicates that the 
OurCo-AWS-US-East zone is a development environment, and the OurCo-AWS-US_West zone is 
a test environment. Paired with the appropriate constraint tags, these capability tags enable you 
to direct deployments to the desired environments.

Using constraint tags in vRealize Automation Cloud Assembly

You add constraint tags to blueprints and various other components within vRealize Automation 
Cloud Assembly to match capabilities defined on resources, cloud zones, and profiles to generate 
appropriate deployments.

There are two main areas in vRealize Automation Cloud Assembly where constraint tags are 
applicable. The first is on the configuration side in projects and images. The second is on the 
deployment side in blueprints. Constraints applied in both areas are merged in blueprints to form 
a set of deployment requirements.

How Constraint Tags Work on Projects

When configuring cloud assembly, cloud administrators can apply constraint tags on projects and 
image maps. In this way, cloud administrators can apply governance constraints directly at the 
project level. All constraints added at this level are applied to every blueprint requested for the 
applicable project.
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If tags on the project conflict with tags on the blueprint, the project tags take precedence, 
thus allowing the cloud administrator to enforce governance rules. For example, if the cloud 
administrators creates a location:london tag on the project, but a developer places a 

location:boston tag on the blueprint, the former will take precedence and the resource is 

deployed to infrastructure containing the location:london tag.

You can apply up to three constraints on projects. Project constraints can be hard or soft. By 
default they are hard. Hard constraints allow you to rigidly enforce deployment restrictions. If 
one or more hard constraints are not met, the deployment will fail. Soft constraints offer a way 
to express preferences that will be selected if available, but the deployment won't fail if soft 
constraints are not met.

How Constraint Tags Work in Blueprints

In blueprints, you add constraint tags to resources as YAML code to match the appropriate 
capability tags that your cloud administrator created on resources, cloud zones and storage and 
network profiles. In addition, there are other more complex options for implementing constraint 
tags. For example, you can use a variable to populate one or more tags on a request. This enables 
you to specify one or more of the tags at request time.

Create constraint tags by using the tag label in the blueprint YAML code. Constraint tags from 

projects are added to the constraint tags created in blueprints.

vRealize Automation Cloud Assembly supports a simple string formatting to make using 
constraints easier in YAML files:

[!]tag_key[:tag_value][:hard|:soft]

By default vRealize Automation Cloud Assembly creates a positive constraint with hard 
enforcement. The tag value is optional, though recommended, as in the rest of the application.

The following WordPress with MySQL example shows YAML constraint tags that specific location 
information for compute resources.

name: "wordPressWithMySql"
components:
  mysql:
    type: "Compute"
    data:
      name: "mysql"
      # ... skipped lines ...
  wordpress:
    type: "Compute"
    data:
      name: "wordpress"
      instanceType: small
      imageType: "ubuntu-server-1604"
      constraints:
        - tag: "!location:eu:hard"
        - tag: "location:us:soft"
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        - tag: "!pci"
      # ... skipped lines ...

For more information about how to work with blueprints, see WordPress use case: create and 
expand a blueprint.

How hard and soft constraints work in projects and blueprints

Constraints in both projects and blueprints can be hard or soft. The preceding code snippet shows 
examples of hard and soft constraints. By default all constraints are hard. Hard constraints allow 
you to rigidly enforce deployment restrictions. If one or more hard constraints are not met, the 
deployment will fail. Soft constraints express preferences that apply if available, but they won't fail 
if not met.

If you have a series of hard and soft constraints on a specific resource type, the soft constraints 
can also serve as tie breakers. That is, if multiple resources meet a hard constraint, the soft 
constraints are used to select the actual resource used in the deployment.

For example you can specify up to three constraints on a project in any combination of network, 
storage and extensibility items. Also, you can select whether each constraint is hard or soft. Let's 
say that you create a hard storage constraint with a tag of location:boston. If no storage in the 

project matches this constraint, any related deployment will fail.

Note   In projects and blueprints, the failOnConstraintMergeConflict flag modifies the behavior 

of constraints. When this flag is set to true, if there is a conflict between project constraints and 
blueprint constraints, the request will fail. If the flag is not present or set to false, the project 
constraints take precedence over the blueprint constraints.

Standard tags

vRealize Automation Cloud Assembly applies standard tags to some deployments to support 
analysis, monitoring, and grouping of deployed resources.

Standard tags are unique within vRealize Automation Cloud Assembly. Unlike other tags, users 
do not work with them during deployment configuration, and no constraints are applied. These 
tags are applied automatically during provisioning on AWS, Azure, and vSphere deployments. 
These tags are stored as system custom properties, and they are added to deployments after 
provisioning.

The list of standard tags appears below.

Table 4-1. Standard tags

Description Tag

Organization org:orgID

Project project:projectID

Requester requester:username

Deployment deployment:deploymentID
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Table 4-1. Standard tags (continued)

Description Tag

Blueprint reference (if applicable) blueprint:blueprintID

Component name in blueprint blueprintResourceName:CloudMachine_1

Placement Constraints: applied in blueprint, request 
parameters, or via IT policy

constraints:key:value:soft

Cloud Account cloudAccount:accountID

Zone or profile, if applicable zone:zoneID, networkProfile:profileID, 

storageProfile:profileID

How vRealize Automation Cloud Assembly Processes Tags

In vRealize Automation Cloud Assembly, tags express capabilities and constraints that determine 
how and where resources are allocated to provisioned deployments during the provisioning 
process.

vRealize Automation Cloud Assembly uses a specific order and hierarchy in resolving tags to 
create provisioned deployments. Understanding the basics of this process will help you to 
implement tags efficiently to create predictable deployments.

The following list summarizes the high level operations and sequence of capability and constraint 
tag processing:

n Cloud zones are filtered by several criteria, including availability and profiles; tags in profiles 
for the region the zone belongs to are matched at this point.

n Zone and compute capability tags are used to filter the remaining cloud zones by hard 
constraints.

n Out of the filtered zones, priority is used to select a cloud zone. If there are several cloud zones 
with the same priority, they are sorted by matching soft constraints, using a combination of the 
cloud zone and compute capabilities.

n After a cloud zone is selected, a host is selected by matching a series of filters, including hard 
& soft constraints as expressed in blueprints.

How do I set up a simple tagging structure

This topic describes a basic approach and options for a logical vRealize Automation Cloud 
Assembly tagging strategy. You can use these examples as a starting point for an actual 
deployment, or you can devise a different strategy that better suits your needs.

Typically, the cloud administrator is the primary individual responsible for creating and maintaining 
tags.
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This topic refers to the WordPress use case described elsewhere in the vRealize Automation Cloud 
Assembly documentation to illustrate how tags can be added to some key items. It also describes 
possible alternatives and extensions to the tagging examples that appear in the WordPress use 
case.

See The WordPress use case for more information about the WordPress use case.

The WordPress use case describes how to place tags on cloud zones and storage and network 
profiles. These profiles are like organized packages of resources. Tags placed on profiles apply to 
all items within the profile. You can also create and place tags on storage resources and individual 
network items as well as on compute resources, but these tags apply only to the specific resources 
on which they are placed. When setting up tags, it is usually best to begin by tagging compute 
resources, and then you can add tags to profiles and cloud zones later. Also, you use these tags to 
filter the list of compute resources for a cloud zone.

For example, while you can place tags on storage profiles as shown in this use case, you can 
also place tags on individual storage policies, data stores, and storage accounts. Tags on these 
resources enable you to exercise finer control over how storage resources are deployed. During 
processing in preparation for deployment, these tags are resolved as a next level of processing 
after the profile tags.

As an example of how you might configure a typical customer scenario, you could place a tag of 
region: eastern on a network profile. This tag would apply to all resources within that profile. 

Then you could place a tag of networktype:pci on a pci network resource within the profile. A 

blueprint with constraints of eastern and pci would create deployments that use this pci network 
for the eastern region.

Procedure

1 Tag your compute infrastructure resources in a logical and appropriate manner.

It is particularly important that you tag compute resources in a logical manner so that you can 
find them using the search function on the Compute tab of the Create Cloud Zone page. Using 
this search function, you can quickly filter the compute resources associated with a cloud 
zone. If you tag Storage and Networks at the profile level, you may not need to tag individual 
storage and network resources.

a Select Resources > Compute to view the compute resources that have been imported for 
your vRealize Automation Cloud Assembly instance.

b Select each compute resource as appropriate and click Tags to add a tag to the resource. 
You can add more than one tag to each resource if appropriate.

c Repeat the previous step for storage and network resources as appropriate.

2 Create cloud zone and network profile capability tags.

You can use the same tags for both cloud zones and network profiles, or you can create 
unique tags for each item if that makes more sense for your implementation.
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In network profiles, you can place tags on the entire profile as well as on subnets within the 
profile. Tags applied at the profile level apply to all components, such as subnets, within that 
profile. Tags on subnets apply only to the specific subnet on which they are placed. During tag 
processing, the profile level tags take precedence over the subnet level tags.

See WordPress use case: add cloud zonesWordPress use case: add network profiles for 
information about adding tags to cloud zones or network profiles.

In this example we create three simple tags that appear throughout the use case 
documentation for vRealize Automation Cloud Assembly cloud zone and network profile tags. 
These tags identify the environment for the profile components.

n zone:test

n zone:dev

n zone:prod 

3 Create storage profile tags for your storage components.

Typically, storage tags identify the performance level of storage items, such as tier1 or tier2, or 
they identify the nature of storage items, such as pci.

See WordPress use case: add storage profiles for information about adding tags to storage 
profiles.

n usage:general

n usage:fast

Results

After you create a basic tagging structure, you can begin working with it and add or edit tags as 
appropriate to refine and extend your tagging capabilities.

How to work with resources in vRealize Automation Cloud 
Assembly

A cloud administrator can review vRealize Automation Cloud Assembly resources that are exposed 
through data collection. The cloud administrator can label resources with capability tags to affect 
where vRealize Automation Cloud Assembly blueprints are deployed.

Compute resources

A cloud administrator can review compute resources that are exposed through data collection. 
The cloud administrator might choose to apply tags directly to the resources, to label capabilities 
for matching purposes in vRealize Automation Cloud Assembly provisioning.
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Network resources

In vRealize Automation Cloud Assembly, cloud administrators can view and edit the network 
resources that have been data-collected from the cloud accounts and integrations that are 
mapped to your project.

After you add a cloud account to your vRealize Automation Cloud Assembly infrastructure, for 
example by using the Infrastructure > Connections > Cloud Accounts menu sequence, data 
collection discovers the cloud account's network and security information. That information is then 
available for to use in networks, network profiles, and other definitions.

Networks are the IP-specific components of an available network domain or transport zone. If 
you're an Amazon Web Services or Microsoft Azure user, think of networks as subnets.

You can display information about the networks in your project by using the Infrastructure > 
Resources > Networks page.

The vRealize Automation Cloud Assembly Networks page contains information such as:

n Networks and load balancers that are defined externally in the network domain of your cloud 
account, for example in vCenter, NSX-V, or Amazon Web Services.

n Networks and load balancers that have been deployed by the cloud administrator.

n IP ranges and other network characteristics that have been defined or modified by your cloud 
administrator.

n External IPAM provider IP ranges for a particular address space in an provider-specific 
external IPAM integration.

For more information about networks, see the following information, signpost help for various 
settings on the Networks page, and Learn more about network profiles in vRealize Automation.

Networks

You can view and edit networks and their characteristics, for example to add tags or remove 
support for public IP access. You can also manage network settings such as DNS, CIDR, gateway, 
and tag values. You can also define new, and manage existing, IP ranges within a network.

For existing networks you can change the IP range and tag settings by selecting the network's 
checkbox and selecting either Manage IP Ranges or Tags. Otherwise you can select the network 
itself to edit its information.

Tags provide a means for matching appropriate networks, and optionally network profiles, to 
network components in blueprints. Network tags are applied to every instance of that network, 
regardless of any network profiles in which the network may reside. Networks can be instanced 
into any number of network profiles. Regardless of network profile residency, a network tag is 
associated with that network wherever the network is used. Network tag matching occurs with 
other components in the blueprint after the blueprint has been matched with one or more network 
profiles.
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IP Ranges

Use an IP range to define or make changes to the start and end IP address for a particular network 
in your organization. You can display and manage IP ranges for listed networks. If the network 
is managed by an external IPAM provider, you can manage IP ranges in connection with the 
associated IPAM integration point.

Click New IP Range to add an additional IP range to the network. You can specify an internal IP 
range, or if there is a valid IPAM integration available you can specify an External IP range.

You cannot include the default gateway in an IP range. The subnet IP range cannot include the 
subnet gateway value.

If you are using an external IPAM integration for a particular IPAM provider, you can use the 
External IP range to select an IP range from an available external IPAM integration point. This 
process is described within the context of an overall external IPAM integration workflow at 
Configure a network and network profile to use external IPAM for an existing network in vRealize 
Automation .

IP Addresses

You can see the IP addresses that are currently used by your organization and display their 
status, for example available or allocated. The IP addresses that are displayed are either IP 

addresses that are managed internally by vRealize Automation or IP addresses that are designated 
for deployments that contain an external IPAM provider integration. External IPAM providers 
manage their own IP address allocation.

If the network is managed internally by vRealize Automation, and not by an external IPAM 
provider, you can also release IP addresses.

When using internal IPAM and releasing IP addresses, for example after deleting a machine that 
had been using the IP addresses, there is a 30 minute wait period between when the addresses 
are released and when you can reuse them, for example to provision a machine with the same IP 
addresses as the previously deleted machine. The wait period allows for the DNS cache to clear. 
The IP addresses can then be allocated to a new machine.

Load Balancers

You can manage information about available load balancers for the account/region cloud accounts 
in your organization. You can open and display the configured settings for each available load 
balancer. You can also add and remove tags for a load balancer.

Network Domains

Network domains list related and non-overlapping networks.

Security resources

After you add a cloud account in vRealize Automation Cloud Assembly, data collection discovers 
the cloud account's network and security information and makes that information available for use 
in network profiles and other options.
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Security groups and firewall rules support network isolation. Security groups are data-collected. 
Firewall rules are not data-collected.

Security groups

Using the Infrastructure > Resources > Security menu sequence, you can view on-demand 
security groups that have been created in vRealize Automation Cloud Assembly blueprint designs 
and existing security groups that were created in source applications, such as NSX-T and Amazon 
Web Services. Available security groups are exposed by the data collection process.

You can view the available security groups and add or remove tags for selected security groups. A 
blueprint author can assign one or more security groups to a machine NIC to control security for 
the deployment.

In the blueprint design the securityGroupType parameter in the security group resource is 

specified as existing for an existing security group or new for an on-demand security group.

Existing security groups from the underlying cloud account endpoint, such as NSX-V, NSX-T, 
or Amazon Web Services applications, are available for use. On-demand security groups that 
were created in your organization's blueprint designs are also data-collected. On-demand security 
groups are currently available for NSX-V and NSX-T only.

Existing security groups are displayed and classified in the Origin column as Discovered. On-

demand security groups that you create in vRealize Automation Cloud Assembly, either in a 
blueprint or in a network profile, are displayed and classified in the Origin column as Managed by 
Cloud Assembly. On-demand security groups that you create as part of a network profile are 

internally classified as an isolation security group with pre-configured firewall rules and are not 
added to a blueprint design as a security group resource. On-demand security groups that you 
create in a blueprint design, and that can contain express firewall rules, are added as part of a 
security group resource that is classified as new.

If you edit an existing security group directly in the source application, such an in the source 
NSX application rather than in vRealize Automation Cloud Assembly, the updates are not visible 
in vRealize Automation Cloud Assembly until you data collection runs and data collects the 
associated cloud account or integration point from within vRealize Automation Cloud Assembly. 
Data collection runs automatically ever 10 minutes.

A cloud administrator can assign one or more tags to an existing security group to allow it to be 
used in a blueprint. A blueprint author can use a Cloud.SecurityGroup resource in a blueprint 

design to allocate an existing security group by using tag constraints. An existing security group 
requires at least one constraint tag be specified in the security resource in the blueprint design.

Using firewall rules in security groups

You can create firewall rules for on-demand security groups for NSX-V and NSX-T directly in a 
security group resource in blueprint design code.
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The Applied To column does not contain security groups that are classified or managed by an 
NSX Distributed Firewall (DFW). Firewall rules that apply to applications are for east/west DFW 
traffic.

Some firewall rules can only be managed in the source application and cannot be edited in 
vRealize Automation Cloud Assembly. For example, ethernet, emergency, infrastructure, and 
environment rules are managed in NSX-T.

Learn more

For more information about using security groups in network profiles, see Learn more about 
network profiles in vRealize Automation.

For information about defining firewall rules, see Using security group settings in network 
profiles and blueprint designs in vRealize Automation Cloud Assembly and Using a security group 
resource in a vRealize Automation blueprint.

For blueprint design code samples that contain security groups, see Network, security, and load 
balancer design samples in vRealize Automation blueprints.

Storage resources

A cloud administrator can work with storage resources and their capabilities, which are discovered 
through vRealize Automation Cloud Assembly data collection from associated cloud accounts.

Storage resource capabilities are exposed through tags that typically originate at the source cloud 
account. A cloud administrator can choose to apply additional tags directly to storage resources 
though, using vRealize Automation Cloud Assembly. The additional tags might label a specific 
capability for matching purposes at provisioning time.

Capabilities on storage resources become visible as part of the definition of a vRealize Automation 
Cloud Assembly storage profile. See Learn more about vRealize Automation Cloud Assembly 
storage profiles .

Machine resources

In vRealize Automation, all users can review machine resources that are exposed through data 
collection.

All the machines in your projects are listed. You can list only your machines or specify filters to 
control the display of listed machines.

Unmanaged machines that are associated to cloud accounts in your projects appear in this list, as 
do managed machines. The Origin column indicates the machine status.

n Discovered - machines that have not yet been onboarded.

n Deployed - machines that have been onboarded or provisioned from vRealize Automation and 
are considered to be managed machines.

You can use a workload onboarding plan to bring unmanaged machines into vRealize Automation 
management.
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Disconnected machine NICs are not listed because vRealize Automation requires the presence of 
the network switch or subnet information to enumerate the ethernet card. For example, if you 
have removed a machine NIC from a deployment, the NIC is not listed.

For information about using onboarding plans to bring unmanaged machines into vRealize 
Automation management, see What are onboarding plans in vRealize Automation Cloud 
Assembly.

Volume resources

In vRealize Automation Cloud Assembly, all users can review volume resources.

vRealize Automation Cloud Assembly displays volumes or logical drives that originate from two 
sources:

n Volumes discovered through data collection of source cloud accounts

n Volumes associated with workloads provisioned by vRealize Automation Cloud Assembly

You can review capacity and capabilities according to volume or logical drive. The list also exposes 
capability tags that originated at the source cloud account or were added in vRealize Automation 
Cloud Assembly itself.

Learn more about resources in vRealize Automation Cloud Assembly

vRealize Automation Cloud Assembly can expose additional information around data-collected 
resources, such as pricing cards.

How does data collection work in vRealize AutomationvRealize Automation 
Cloud Assembly

After initial data collection, resource data collection occurs automatically every 10 minutes. The 
data collection interval is not configurable and you cannot manually initiate data collection.

You can discover information about resource data collection and image synchronization for an 
existing cloud account in the Status section of its page. Do so by selecting Infrastructure > 
Connections > Cloud Accounts and then clicking Open on the existing cloud account of your 
choice.

You can open an existing cloud account and see its associated endpoint version in the Status 
section of its page. If the associated endpoint has been upgraded, the new endpoint version is 
discovered during data collection and reflected in the Status section on the cloud account's page.

Resource data collection

Data collection occurs every 10 minutes. Each cloud account displays when its data collection last 
completed.
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Image data collection

Image synchronization occurs every 24 hours. You can initiate image synchronization for some 
cloud account types. To initiate image synchronization, open the cloud account (Infrastructure 
> Cloud Accounts then select and open the existing cloud account) and click the Sync Images 
button. There is no image synchronization option for NSX cloud accounts.

Note   Images are internally classified as either public or private. Public images are shared and are 
not specific to a particular cloud subscription or organization. Private images are not shared and 
are specific to a specific subscription. Public and private images are automatically synchronized 
every 24 hours. An option on the cloud account page allows you to trigger synchronization for 
private images.

The cloud account page displays when image synchronization was last completed.

To facilitate fault tolerance and high availability in deployments, each NSX-T data center endpoint 
represents a cluster of three NSX managers. For related information, see Create an NSX-T cloud 
account in vRealize Automation Cloud Assembly.

Cloud accounts and onboarding plans

When you create a cloud account, all machines that are associated to it are data-collected 
and then displayed on the Infrastructure > Resources > Machines page. If the cloud account 
has machines that were deployed outside of vRealize Automation Cloud Assembly, you can 
use an onboarding plan to allow vRealize Automation Cloud Assembly to manage the machine 
deployments.

For information about adding cloud accounts, see Adding cloud accounts to vRealize Automation 
Cloud Assembly.

For information about onboarding unmanaged machines, see What are onboarding plans in 
vRealize Automation Cloud Assembly.

Persistent disks in vRealize Automation Cloud Assembly

Persistent disks preserve valuable data from accidental deletion.
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In a blueprint, under a volume, you can add the persistent: true property to have the disk 

survive vRealize Automation Cloud Assembly or vRealize Automation Service Broker deletions. 
Persistent disks aren't removed during deployment deletion nor Day 2 delete or remove disk 
operations.

Because of that, persistent disks can remain in your infrastructure even after a deployment 
deletion or disk deletion. To remove them, you can use the following techniques.

n Explicitly pass the purge flag as a query parameter using the DELETE API.

n Delete them directly from your cloud endpoint.

Note that there is no vRealize Automation Cloud Assembly or vRealize Automation Service Broker 
user interface for removing them.

What are Pricing Cards

vRealize Automation Cloud Assembly pricing cards help cloud administrators define and assign 
the pricing policy for the monetary impact of your individual deployments to help you manage 
resources.

Before you can create or assign pricing cards, you must configure and enable pricing in 
vRealize Operations to work with vRealize Automation . When configuring vRealize Operations 
with vRealize Automation , ensure that both applications are set to the same timezone. 
To configure the timezone in vRealize Operations, enable SSH and log in to each vRealize 
Operations node, edit the $ALIVE_Base/user/conf/analytics/advanced.properties file, 

and add timeZoneUseInMeteringCalculation = <time zone>.

Pricing cards define the rates for a pricing policy. The pricing policy can then be assigned 
to specific projects to define a total price. After creating a vRealize Operations endpoint, 
a predefined Default Rate Card is available with a cost equal to price configuration on the 
Infrastructure > Pricing Cards tab. You can create pricing cards that apply to projects only or 
cloud zones. By default, all new pricing cards are applied to projects.

Note   If you change the All pricing cards are applied to setting, all existing pricing card 
assignments are deleted. Also, if the vRealize Operations endpoint is deleted from Cloud 
Assembly, all pricing cards and assignments are also deleted.

The price of a deployment over time appears on the deployment card as the month-to-date 
price, which resets to zero at the beginning of each month. The component cost breakdowns are 
available in the deployment details. Providing this information at the deployment level informs the 
cloud administrator, but it also helps the members understand the impact their work might have 
on budgets and long-term development.

How is price calculated

The initial price that you see at the deployment level for your compute and storage resources are 
based on industry standard benchmark rates, and then calculated over time. The rate is applied 
to hosts and the service calculates the CPU and memory rates. The server recalculates the price 
every 24-hours.
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New policies, assignments, and upfront pricing are priced during the next occurring vROPs data 
collection cycle. By default, the data collection cycle is run every 5 minutes. It can take up to 
24-hours for new policies or changes to be updated in projects and deployments.

You can also manually refresh the price server at any time on the vROPs Endpoint page, 
Infrastructure > Integrations > vROPs Endpoint > . In the vCenter servers section, click Sync. 
When manually refreshing the price server using the Sync option, the price is recalculated for all 
projects in the organization. Depending on how many projects your organization has this process 
might be intensive and take time.

For a list of supported resources, see List of costed component types in vRealize Automation 
Cloud Assembly.

List of costed component types in vRealize Automation Cloud Assembly

vRealize Automation Cloud Assembly provides benchmark cost information for the following 
blueprint component types.

Table 4-2. Costed Component Types

Blueprint Component Type Service Name/Object Type Blueprint Resource Type Comments

Cloud Agnostic Machine Cloud.Machine If an agnostic machine is 
configured with vSphere, 
you can view deployment 
cost.

Disk Cloud.Volume If an agnostic disk is 
attached to a virtual 
machine that is configured 
with vSphere, you can view 
deployment cost.

vSphere vSphere machine Cloud.vSphere.Machine Deployed using a cloud 
specific blueprint.

vSphere disk Cloud.vSphere.Disk Deployed using a cloud 
specific blueprint attached 
to a virtual machine.

How to create a pricing card in Cloud Assembly

You can create and assign a pricing card to projects or cloud zones, depending on the pricing 
strategy determined by the cloud administrator.

Pricing cards are customizable based on user-selected parameters. After configuring a pricing 
card, you can assign it to one or more projects and cloud zones determined by the pricing 
strategy.
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Prerequisites

Before you can create or assign pricing cards, you must configure and enable pricing 
and configure currency in vRealize Operations to work with vRealize Automation . When 
configuring vRealize Operations with vRealize Automation , ensure that both applications are 
set to the same timezone. To configure the timezone in vRealize Operations, enable SSH 
and log in to each vRealize Operations node, edit the $ALIVE_Base/user/conf/analytics/
advanced.properties file, and add timeZoneUseInMeteringCalculation = <time zone>.

You must configure a vRealize Operations endpoint before you can configure pricing cards. 
To configure the vRealize Operations endpoint navigate to Infrastructure > Connections > 
Integrations > Add Integration.

Note   When multiple vRealize Operations endpoints are added they must not monitor the same 
vCenter.

Procedure

1 Navigate to Infrastructure > Pricing Cards > New Pricing Card.

2 On the Summary tab, enter a name and description for the pricing card. Once the policy is 
defined on the pricing tab, the Overview table is populated with pricing card rates.

Note   The currency unit is determined by the valued selected in vRealize Operations.

3 Optional. Select the Default for unassigned projects? check box to assign this pricing card to 
all unassigned projects by default.
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4 Click Pricing, and configure the details of your pricing policy.

Table 4-3. Pricing Policy Configuration

Parameter Description

Basic Charges Enter a name and description for your policy. Select cost 
or rate based.

n Cost - The cost is defined in vRealize Operations. 
If selected, a mulitplication factor is required. For 
example, if you select 1.1 as a factor, the cost is 
multiplied by 1.1 resulting in a 10% increase to the 
calculated cost. The price equation using cost is: 
<cost> x <multiplication factor> = Price

n Rate - If selected, you must use absolute values to 
determine the cost. The price equation using rate is: 
<Rate> = Price. Select a rate interval from the drop 
down list to specify how this rate is charged.

In the basic charges section, you define the cost or rate 
for CPU, memory, storage, and additional miscellaneous 
costs.

Guest OSes You can define a Guest OS charge by clicking Add 
Charge.

Enter the guest OS name and define the charging 
method and base rate.

n Recurring - enter a base rate and define recurring 
interval as the charge period. The absolute rate 
value is required and it is added to the overall price.

n One time - define the one-time base rate charge. 
The absolute value is required and it is added as a 
one time price.

n Rate Factor - A multiplication factor is required 
that is applied to the select charge category. For 
example, if you select CPU Charge and a rate factor 
of 2. The Guest OS CPU is charged as 2 times the 
standard cost value.

You can add multiple Guest Oses with different rates 
by clicking Add Charge and configuring an additional 
charge policy.

Note   Upfront charges for Guest Oses are not shown 
on the summary page, even though they are part of the 
policy.
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Table 4-3. Pricing Policy Configuration (continued)

Parameter Description

Tags You can define a Tag charge by clicking Add Charge.

Select the Tag name and define the charging method 
and base rate.

n Recurring - enter a base rate and define recurring 
interval as the charge period. The absolute rate 
value is required and it is added to the overall price.

n One time - define the one-time base rate charge. 
The absolute value is required and it is added as a 
one time price.

n Rate Factor - A multiplication factor is required that 
is applied to the select charge category.

Select how to charge the Tag based on powered on 
state.

You can add multiple Tags with different rates by 
clicking Add Charge and configuring an additional 
charge policy.

Note   Additional charges in the calculated final price 
include on tags on VMs and does not include tags on 
disks and networks.

Custom Properties You can define a Custom Property charge by clicking 
Add Charge.

Enter the property name and value, and define the 
charging method and base rate.

n Recurring - enter a base rate and define recurring 
interval as the charge period. The absolute rate 
value is required and it is added to the overall price.

n One time - define the one-time base rate charge. 
The absolute value is required and it is added as a 
one time price.

n Rate Factor - A multiplication factor is required that 
is applied to the select charge category.

Select how to charge the custom property based on 
powered on state.

You can add multiple custom properties with different 
rates by clicking Add Charge and configuring an 
additional charge policy.

Overall Charges Define any additional charge you would like to add 
to the pricing policy. You can add both one time and 
recurring charges.

Note   One time charges are not shown in the price estimate of a catalog item or on the 
summary tab. Only the daily price estimate for a given catalog item is shown.
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5 Click the Assignments tab and click Assign Projects. Select one or more projects to assign the 
pricing card to.

Note   By default pricing cards are applied to projects. On the Infrastructure > Pricing Cards 
tab, you can select to apply pricing cards to cloud zones. If cloud zones were selected, you 
would click Assign Cloud Zones on the Assignments tab.

6 Click Create to save and create your pricing policy.

Results

Your new pricing policy appears on the Pricing Cards page. To view or edit the policy details and 
configuration click Open.

How do I estimate the price of a deployment

Before deploying a catalog item, you can use the upfront price as a price estimate for your 
deployment.

For an upfront price estimation, the size of boot disk per VM is always 8 GB.

The upfront price of a deployment is a daily price estimate, based on the allocation of a 
resource, for a given catalog item before it is deployed. After a catalog item is deployed, you 
can view the month-to-date price as an aggregate of the upfront price on the Deployment and 
Infrastructure > Projects tabs. Upfront pricing is supported for private cloud resources such as 
vSphere Machine and vSphere Disk, Cloud Assembly catalog items, and cloud agnostic items with 
vCenter configured for private cloud.

Note   Upfront pricing is not supported for public cloud resources, or non-vSphere Machine or 
Disk private cloud resources.
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Prerequisites

To view the price in vRealize Automation Cloud Assembly, you must have a vRealize Operations 
integration endpoint configured with pricing enabled and currency preset.

Procedure

1 From the Catalog, select a catalog item and click Request.

2 Enter the details for your catalog item request and click Calculate.

3 (Optional) Click Details to view the price breakdown in the Daily price Estimate window.

What to do next

If the daily price estimate is acceptable, click Submit to continue the deployment request.

How do I estimate the price of all my projects

As a cloud administrator you might want to estimate the total price of all your projects.

For showback purposes, you can use project pricing cards to estimate the total price of all your 
projects.

Procedure

1 On the Infrastructure > Pricing Card page, next to All pricing cards are applied to: click Edit 
and select Projects.

Note   If you change the All pricing cards are applied to setting, all existing pricing card 
assignments are deleted.

2 Create pricing cards and assignments using a cost-based approach. See How to create a 
pricing card in Cloud Assembly.

How do I view the price history of my deployment

After defining and assigning a pricing card to a project, you can view the price history of an 
individual deployment over time.
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To view the price history, navigate to your deployment and click Price. The price analysis provides 
an overview and detailed view of the deployment price along with the price month-to-date value. 
You can change the graphical representation to display the deployment price as daily, weekly, or 
monthly values. Also, you can specify an exact date range or month for the price history.

To view the price breakdown by cost component, click Details.
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Adding and managing vRealize 
Automation Cloud Assembly 
projects

5
Projects control who has access to vRealize Automation Cloud Assembly blueprints and where the 
blueprints are deployed. You use projects to organize and govern what your users can do and to 
what cloud zones they can deploy blueprints in your cloud infrastructure.

Cloud administrators set up the projects, to which they can add users and cloud zones. Anyone 
who creates and deploys blueprints must be a member of at least one project.

Policies

Project

Blueprints

Project Administrator 

Members

Users and Roles

Cloud Zones

AWS region 1

AWS region 2

Azure region 1

vSphere datastore 1

Infrastructure

Access

Leases

Approvals

Other

Governance

This chapter includes the following topics:

n How do I add a project for my vRealize Automation Cloud Assembly development team

n Learn more about vRealize Automation Cloud Assembly projects

How do I add a project for my vRealize Automation Cloud 
Assembly development team

You create a project to which you add members and cloud zones so that the project members 
can deploy their blueprints to the associated zones. As the vRealize Automation Cloud Assembly 
administrator, you create a project for a development team. You can then assign a project 
administrator or you can operate as the project administrator.

When you create a blueprint, you first select the project to associate it with. The project must exist 
before you can create the blueprint.

Ensure that your projects support the business needs of the development team.

n Does the project provide the resources that support the team's goals. For an example of how 
the infrastructure resources and a project support a blueprint, see The WordPress use case.
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n Do your project members require or expect their deployments to be shared or private. Shared 
deployments are available to all the project members on the Deployments tab, not only the 
deploying member. You can change the deployment sharing state at anytime.

When you share the deployment with project members, the members can run the same 
day 2 action. To manage the ability of members to run day 2 actions, you can create day 
2 policies in vRealize Automation Service Broker. The policies apply to vRealize Automation 
Cloud Assembly and vRealize Automation Service Broker deployments.

To learn more about the day 2 policies, see How do I entitle deployment users to day 2 actions 
using policies .

This procedure is based on creating an initial project that includes only the basic configurations. As 
your development team creates and deploys their blueprints, you might modify to the project. You 
can add constraints, custom properties, and other options to improve deployment efficiencies. See 
the articles available in Learn more about vRealize Automation Cloud Assembly projects.

Prerequisites

n Verify that you configured the cloud zones. See Chapter 4 Building your vRealize Automation 
Cloud Assembly resource infrastructure.

n Verify that you configured the mappings and profiles for the regions that include as cloud 
zones for this project. See Chapter 4 Building your vRealize Automation Cloud Assembly 
resource infrastructure.

n Verify that you have the necessary permissions to perform this task. See What are the vRealize 
Automation Cloud Assembly user roles.

n Determine who you are designating as the project administrator. To understand what the 
project administrator can do in vRealize Automation Cloud Assembly, see What are the 
vRealize Automation Cloud Assembly user roles.

n If you are adding Active Directory groups to projects, verify that you configured Active 
Directory groups for your organization. See Edit group role assignments in vRealize 
Automation in Administering vRealize Automation. If the groups are not synchronized, they 
are not available when you try to add them to a project.

Procedure

1 Select Infrastructure > Configure > Projects, and click New Project.

2 Enter the project name.

3 Click the User tab.

a To make deployments by project members accessible only to the owner, turn off 
Deployment sharing.

b Add users with assigned roles.

4 Click the Provisioning tab and add one or more cloud zones.

The cloud zones must contain the resources that support the blueprints deployed by the users.
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For each cloud zone, you can limit the amount of resources that the project can utilize. The 
possible limits include the number of instances, memory, and CPUs. For vSphere cloud zones 
only, your can configure storage limits.

As you add each cloud zone and apply limits, don't limit the project resources so much that the 
members cannot deploy their blueprints.

5 Click Create.

6 To test your project with the project cloud zones, click Test Configuration on the Projects 
page.

The simulation runs a standardized hypothetical deployment test against the project cloud 
zone resources. If it fails, you can review the details and correct your resource configuration.

What to do next

Get started with blueprints. See Chapter 6 Designing your vRealize Automation Cloud Assembly 
deployments.

Learn more about vRealize Automation Cloud Assembly 
projects

Projects are the connector between blueprints and resources. The more you understand about 
how they work and how you can make them work for you, the more effective your vRealize 
Automation Cloud Assembly development and deployment process will be.

Using vRealize Automation Cloud Assembly project tags and custom 
properties

As an administrator, you can add project-level governance constraints or custom properties when 
the requirements of the project are different from the vRealize Automation Cloud Assembly 
blueprints. In addition to constraint tags, you can add resource tags that are added to deployed 
resources during the provisioning process so that you can manage the resources.

What are project resource tags

A project resource tag operates as an standardized identifying tag that you can use to manage the 
deployed resources and ensure compliance.

The resource tags defined in a project are added to all component resources deployed as part 
of that project. You can then use the standard tagging to manage the resources using other 
applications.

For example, as a cloud administrator, you want to use an application like CloudHealth to manage 
costs. You add the costCenter:eu-cc-1234 tag to a project dedicated to developing a European 

Union human resources tool. When the project team deploys from this project, the tag is added to 
the deployed resources. You then configure the costing tool to identify and manage the resources 
that include this tag. Other projects with other cost centers would have alternative values to go 
with the key.
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What are project constraint tags

A project constraint operates as a governance definition. It is a key:value tag that defines what 

resources the deployment request consumes or avoids in the project cloud zones.

The deployment process looks for tags for the networks and storage that match the project 
constraints, and deploys based on matching tags.

The extensibility constraint is used to specify which vRealize Orchestrator integrated instance to 
use for extensibility workflows.

Consider the following formats when you configure project constraints.

n key:value and key:value:hard. Use this tag, in either format, when the blueprint must be 
provisioned on resources with the matching capability tag. The deployment process fails when 
no matching tag is found. For example, a blueprint deployed by the members of a project 
must be provisioned on a PCI-compliant network. You use security:pci. If no networks are 

found in the project cloud zones, the deployment fails, ensuring no insecure deployments.

n key:value:soft. Use this tag when you prefer a matching resource, but you want the 
deployment process to proceed without failing and can accept resources where the tag does 
not match. For example, you prefer that the project members deploy their blueprints to a less 
expensive storage, but you do not want storage availability to interfere with their ability to 
deploy. You use tier:silver:soft. If there is no storage tagged tier:silver in the project cloud 

zones, the blueprint still deploys on other storage resources.

n !key:value. Use this tag, with hard or soft, when you want to avoid deploying to resources with 
a matching tag.

Importantly, the project constraint tags have a higher priority than the blueprint constraint tags 
and override them at deployment time. If you have a blueprint where this must never happen, you 
can use the failOnConstraintMergeConflict:true in the blueprint. For example, if your project 

has a network loc:london constraint, but the blueprint is loc:mumbai, but rather than the project 

location taking precedence, you want the deployment to fail with a constraint conflict message, 
you add a property similar to the following sample.

constraints:
    - tag: 'loc:mumbai'
failOnConstraintMergeConflict:true

How might I use project custom properties

You can use a project custom property for reporting, to trigger and populate extensibility actions 
and workflow, and to override blueprint level properties.

Adding a custom property to a deployment allows you to use the value in the user interface or to 
retrieve it using the API so that you can generate reports.

Extensibility can also use a custom property for an extensibility subscription.
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A blueprint might have a particular property value that you want to change for a project. You can 
provide an alternative name and value as a custom property.

How do vRealize Automation Cloud Assembly projects work at 
deployment time

Projects control user access to the cloud zones and user ownership of the provisioned resources. 
Whether your are a cloud administrator or a blueprint developer, you must understand how the 
projects work at deployment time so that you can manage your deployments and troubleshoot any 
problems.

As a cloud administrator who is setting up projects for various teams, you must understand how 
projects determine where blueprint components are deployed. This understanding helps you 
create projects that support blueprint developers and to troubleshoot failed deployments.

When you create a blueprint, you first associate it with a project. At deployment time, the 
blueprint requirements are evaluated against the project cloud zones to find the best deployment 
location.

The following workflow illustrates the process.

1 You submit a blueprint deployment request.

2 The project evaluates the blueprint and project requirements, for example, flavor, image, and 
constraint tags. The requirements are compared to the project cloud zones to locate a zone 
that supports the requirements.

3 These zones did not have the resources to support the request.

4 This cloud zone supports the request requirements and the blueprint is deployed to this cloud 
zone account region.
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Designing your vRealize 
Automation Cloud Assembly 
deployments

6
Deployments begin with blueprints, the specifications that define the machines, applications, and 
services that you create on cloud resources by way of vRealize Automation Cloud Assembly.

As a blueprint developer, you can design blueprints that target specific cloud vendors, or make 
them cloud agnostic. The cloud zones that are assigned to your project determine which approach 
you might take. Check with your cloud administrator to make sure that you understand what kind 
of resources make up your cloud zones.

Be aware that vRealize Automation Cloud Assembly blueprint creation is an infrastructure-as-code 
process. You add and connect resources in the design canvas to get started. Then, you complete 
the details using the code editor to the right of the canvas. The code editor allows you to type 
code directly or enter property values into a form.

This chapter includes the following topics:

n Before you create a blueprint

n Ways to create blueprints

n How to create a simple vRealize Automation Cloud Assembly blueprint from scratch

n How to enhance a simple vRealize Automation Cloud Assembly blueprint 

n How to add advanced features to vRealize Automation Cloud Assembly designs
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n What are the vRealize Automation resource properties 

n What are some vRealize Automation Cloud Assembly code examples

n How to use the vRealize Automation Cloud Assembly Marketplace 

Before you create a blueprint

You can create a vRealize Automation Cloud Assembly blueprint at any time, but to deploy it you 
first need to define your cloud resource infrastructure.

n Chapter 4 Building your vRealize Automation Cloud Assembly resource infrastructure

In addition, you must create a vRealize Automation Cloud Assembly project that includes those 
infrastructure resources as cloud zones.

n Using vRealize Automation Cloud Assembly project tags and custom properties 

Ways to create blueprints

vRealize Automation Cloud Assembly creates and saves blueprints as code, which allows you to 
easily design and reuse blueprints.

You can build a blueprint from a blank canvas or take advantage of existing code.

The vRealize Automation Cloud Assembly blueprint design page

To create a blueprint from scratch, go to Design and click New. Drag resources to the canvas, 
connect them, and finish configuring them in the code editor.

The code editor allows you to type, cut, copy, and paste code directly. If you're uncomfortable 
editing code, you can select a resource in the design canvas, click the code editor Properties tab, 
and enter values there. Property values that you enter appear in the code as if you had typed them 
directly.
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Note that you can copy and paste code from one blueprint to another.

Blueprint cloning

To clone a blueprint, go to Design, select a source, and click Clone. You clone a blueprint to 
create a copy based on the source, then assign the clone to a new project or use it as starter code 
for a new application.

Uploading and downloading

The vRealize Automation Cloud Assembly Marketplace offers finished blueprints to jumpstart your 
effort. See How to use the vRealize Automation Cloud Assembly Marketplace .
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In addition, you can upload, download, and share blueprint YAML code in any way that makes 
sense for your site. You can even modify blueprint code using external editors and development 
environments.

Note   A good way to validate shared blueprint code is to inspect it in the vRealize Automation 
Cloud Assembly code editor on the blueprint design page.

How to create a simple vRealize Automation Cloud 
Assembly blueprint from scratch

You use the design page to create vRealize Automation Cloud Assembly blueprint specifications 
for the machines or applications that you want to provision.

1 Locate resources.

2 Drag resources to the canvas.

3 Connect resources.

4 Configure resources by editing the blueprint code.
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From the design page, you can also change the blueprint name, version or revert to versions, 
clone, or deploy a blueprint.

How to select and add vRealize Automation Cloud Assembly 
resources to a blueprint

vRealize Automation Cloud Assembly resources are your blueprint building blocks. The design 
page lets you use cloud agnostic resources, or resources specific to a cloud vendor.

Resources appear for selection on the left side of the design page.

Cloud agnostic resources

You can deploy cloud agnostic resources to any cloud vendor. At provisioning time, the 
deployment uses cloud specific resources that match. For example, if you expect a blueprint to 
deploy to both AWS and vSphere cloud zones, use cloud agnostic resources.

Cloud vendor resources

Vendor resources, such as those specific to Amazon Web Services, Microsoft Azure, Google Cloud 
Platform, or VMware vSphere, can only be deployed to matching AWS, Azure, GCP, or vSphere 
cloud zones.

You can add cloud agnostic resources to a blueprint that contains cloud specific resources for a 
particular vendor. Just be aware of what the project cloud zones support in terms of vendor.

Configuration management resources

Configuration management resources depend on your integrated applications. For example, a 
Puppet resource can monitor and enforce the configuration of the other resources.

How to connect blueprint resources in vRealize Automation Cloud 
Assembly

Use the graphical design canvas to connect vRealize Automation Cloud Assembly blueprint 
resources.

You can connect resources when they are compatible for a connection. For example:

n Connecting a load balancer to a cluster of machines.

n Connecting a machine to a network.

n Connecting external storage to a machine.

To connect, hover over the edge of a resource to reveal the connection bubble. Then, click and 
drag the bubble to the target resource and release.

In the code editor, additional code for the source resource appears in the target resource code.
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A solid line between resources indicates that the resources must end up in the same place. 
Even though you can add a connection on the canvas, deployment fails if conflicting placement 
constraint tags are present. For example, deployment fails if you connect resources where one 
is hard-constrained to a test us-west-1 cloud zone, and the other to a production us-east-1 cloud 
zone.

How to create valid vRealize Automation Cloud Assembly blueprint 
code

Adding vRealize Automation Cloud Assembly resources and connecting them in the canvas only 
creates starter code. To fully configure them, edit the code.

The code editor allows you to type code directly or enter property values into a form. To help with 
direct code creation, the vRealize Automation Cloud Assembly editor includes syntax completion 
and error checking features.
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Editor 
Hints Example

Available 
values

Allowed 
properties

Child 
properties

Syntax 
errors

Ctrl+F to 
search
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Editor 
Hints Example

Optional 
parameter
s

Schema 
help

For all of the custom properties, you can also refer to the consolidated resource schema on the VMware 
{code} site.

How to save different versions using vRealize Automation Cloud 
Assembly

As a blueprint developer, you can safely capture a snapshot of a working design before risking 
further changes.

At deployment time, you can select any of your versions to deploy.

How to capture a blueprint version

From the design page, click Version, and provide a name.

The name must be alphanumeric, with no spaces, and only periods, hyphens, and underscores 
allowed as special characters.

How to restore an older version

From the design page, click Version History.
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On the left, select an older version to inspect it in the canvas and code editor. When you find the 
version that you want, click Restore. Restoring overwrites the current draft without removing any 
named versions.

How to release a version to users of vRealize Automation Service Broker

From the design page, click Version History.

On the left, select a version and click Release. You cannot release the current draft until you 
version it.

When more than one version of a blueprint is released, vRealize Automation Service Broker uses 
the most recent one.

How to compare blueprint versions

When changes and versions accumulate, you might want to identify differences among them.

From the Version History view, select a version, and click Diff. Then, from the Diff against drop-
down, select another version to compare to.

Note that you can toggle between reviewing code differences or visual topology differences.
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Figure 6-1. Code Differences

Figure 6-2. Visual Topology Differences

How to clone a blueprint

Although it's not the same as saving a version, from the design page, Actions > Clone makes a 
copy of the current blueprint for alternative development.

How to enhance a simple vRealize Automation Cloud 
Assembly blueprint

There are vRealize Automation Cloud Assembly blueprint code possibilities that can take a simple 
blueprint to the next level.
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The techniques described here require some comfort with infrastructure code. Fortunately, 
vRealize Automation Cloud Assembly code is human readable and fairly easy to follow.

How user input can customize a vRealize Automation Cloud 
Assembly blueprint

As a blueprint developer, you use input parameters so that users can make custom selections at 
request time.

When users supply inputs, you no longer need to save multiple copies of blueprints that are only 
slightly different. In addition, inputs can prepare a blueprint for day 2 operations. See How to use 
vRealize Automation Cloud Assembly blueprint inputs for day 2 updates .

The following inputs show how you might create one blueprint for a MySQL database server, 
where users can deploy that one blueprint to different cloud resource environments and apply 
different capacity and credentials each time.

How to define blueprint input parameters

Add an inputs section to your blueprint code, where you set the selectable values.

In the following example, machine size, operating system, and number of clustered servers are 
selectable.

inputs:
  wp-size:
    type: string
    enum:
      - small
      - medium
    description: Size of Nodes
    title: Node Size
  wp-image:
    type: string
    enum:
      - coreos
      - ubuntu
    title: Select Image/OS
  wp-count:
    type: integer
    default: 2

Using and Managing vRealize Automation Cloud Assembly

VMware, Inc. 230



    maximum: 5
    minimum: 2
    title: Wordpress Cluster Size
    description: Wordpress Cluster Size (Number of nodes)

If you're uncomfortable editing code, you can click the code editor Inputs tab, and enter settings 
there. The following example shows some inputs for the MySQL database mentioned earlier.

How to reference blueprint input parameters

Next, in the resources section, you reference an input parameter using ${input.property-name} 
syntax.

If a property name includes a space, delimit with square brackets and double quotes instead of 
using dot notation: ${input["property name"]}

Important   In blueprint code, you cannot use the word input except to indicate an input 

parameter.

resources:
  WebTier:
    type: Cloud.Machine
    properties:
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      name: wordpress
      flavor: '${input.wp-size}'
      image: '${input.wp-image}'
      count: '${input.wp-count}'

List of input properties

Property Description

const Used with oneOf. The real value associated with the 
friendly title.

default Prepopulated value for the input.

The default must be of the correct type. Do not enter a 
word as the default for an integer.

description User help text for the input.

encrypted Whether to encrypt the input that the user enters, true or 
false.

Passwords are usually encrypted.

enum A drop-down menu of allowed values.

Use the following example as a format guide.

enum:
      - value 1
      - value 2

format Sets the expected format for the input. For example, 
(25/04/19) supports date-time.

Allows the use of the date picker in vRealize Automation 
Service Broker custom forms.

items Declares items within an array. Supports number, integer, 
string, Boolean, or object.

maxItems Maximum number of selectable items within an array.

maxLength Maximum number of characters allowed for a string.

For example, to limit a field to 25 characters, enter 
maxLength: 25.

maximum Largest allowed value for a number or integer.

minItems Minimum number of selectable items within an array.

minLength Minimum number of characters allowed for a string.

minimum Smallest allowed value for a number or integer.

oneOf Allows the user input form to display a friendly name (title) 
for a less friendly value (const). If setting a default value, 
set the const, not the title.

Valid for use with types string, integer, and number.
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Property Description

pattern Allowable characters for string inputs, in regular 
expression syntax.

For example, '[a-z]+' or '[a-z0-9A-Z@#$]+'

properties Declares the key:value properties block for objects.

readOnly Used to provide a form label only.

title Used with oneOf. The friendly name for a const value. The 
title appears on the user input form at deployment time.

type Data type of number, integer, string, Boolean, or object.

writeOnly Hides keystrokes behind asterisks in the form. Cannot be 
used with enum. Appears as a password field in vRealize 
Automation Service Broker custom forms.

Additional examples

String with enumeration

  image:
    type: string
    title: Operating System
    description: The operating system version to use.
    enum:
      - ubuntu 16.04
      - ubuntu 18.04
    default: ubuntu 16.04

  shell:
    type: string
    title: Default shell
    Description: The default shell that will be configured for the created user.
    enum:
      - /bin/bash
      - /bin/sh

Integer with minimum and maximum

  count:
    type: integer
    title: Machine Count
    description: The number of machines that you want to deploy.
    maximum: 5
    minimum: 1
    default: 1
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Array of objects

  tags:
    type: array
    title: Tags
    description: Tags that you want applied to the machines.
    items:
      type: object
      properties:
        key:
          type: string
          title: Key
        value:
          type: string
          title: Value

String with friendly names

  platform:
    type: string
    oneOf:
      - title: AWS
        const: platform:aws
      - title: Azure
        const: platform:azure
      - title: vSphere
        const: platform:vsphere
    default: platform:aws

String with pattern validation

  username:
    type: string
    title: Username
    description: The name for the user that will be created when the machine is provisioned.
    pattern: ^[a-zA-Z]+$

String as password

  password:
    type: string
    title: Password
    description: The initial password that will be required to logon to the machine. 
Configured to reset on first login.
    writeOnly: true
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String as text area

  ssh_public_key:
    type: string
    title: SSH public key
    maxLength: 256

Boolean

  public_ip:
    type: boolean
    title: Assign public IP address
    description: Choose whether your machine should be internet facing.
    default: false

How to set the resource deployment sequence in vRealize 
Automation Cloud Assembly

When you deploy a vRealize Automation Cloud Assembly blueprint, one resource might need 
another resource to be available first.

How to create an explicit dependency

Sometimes, a resource needs another to be deployed first. For example, a database server might 
need to exist first, before an application server can be created and configured to access it.

An explicit dependency sets the build order at deployment time, or for scale in or scale out 
actions. You can add an explicit dependency using the graphical design canvas or the code editor.

n Design canvas option—draw a connection starting at the dependent resource and ending at 
the resource to be deployed first.

n Code editor option—add a dependsOn property to the dependent resource, and identify the 

resource to be deployed first.

An explicit dependency creates a solid arrow in the canvas.
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How to create an implicit dependency or property binding

Sometimes, a resource property needs a value found in a property of another resource. For 
example, a backup server might need the operating system image of the database server that is 
being backed up, so the database server must exist first.

Also called a property binding, an implicit dependency controls build order by waiting until the 
needed property is available before deploying the dependent resource. You add an implicit 
dependency using the code editor.

n Edit the dependent resource, adding a property that identifies the resource and property that 
must exist first.

An implicit dependency or property binding creates a dashed arrow in the canvas.

How to use expressions to make vRealize Automation Cloud 
Assembly blueprint code more versatile

For increased flexibility, you can add expressions to vRealize Automation Cloud Assembly 
blueprint code.

Expressions use the ${expression} construct, as shown in the following examples.

The examples are pruned to show only the important lines. The entire, unedited blueprint appears 
at the end.

Examples

At deployment time, allow the user to paste in the encrypted key needed for remote access:

inputs:
  sshKey:
    type: string
    maxLength: 500
resources:
  frontend:
    type: Cloud.Machine
    properties:
      remoteAccess:
        authentication: publicPrivateKey
        sshKey: '${input.sshKey}'
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For deploying to VMware Cloud on AWS, set the folder name to the required name of Workload:

inputs:
  environment:
    type: string
    enum:
      - AWS
      - vSphere
      - Azure
      - VMC
      - GCP
    default: vSphere
resources:
  frontend:
    type: Cloud.Machine
    properties:
      folderName: '${input.environment == "VMC" ? "Workload" : ""}'

At deployment time, tag the machine with an all-lowercase env tag that matches the selected 
environment:

inputs:
  environment:
    type: string
    enum:
      - AWS
      - vSphere
      - Azure
      - VMC
      - GCP
    default: vSphere
resources:
  frontend:
    type: Cloud.Machine
    properties:
      constraints:
        - tag: '${"env:" + to_lower(input.environment)}'

Set the number of machines in the front-end cluster to one (small) or two (large). Note that the 
large cluster is set by process of elimination:

inputs:
  envsize:
    type: string
    enum:
      - Small
      - Large
resources:
  frontend:
    type: Cloud.Machine
    properties:
      count: '${input.envsize == "Small" ? 1 : 2}'
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Attach machines to the same Default network by binding to the property found in the network 
resource:

resources:
  frontend:
    type: Cloud.Machine
    properties:
      networks:
        - name: '${resource.Cloud_Network_1.name}'
  apitier:
    type: Cloud.Machine
    properties:
      networks:
        - name: '${resource.Cloud_Network_1.name}'
  Cloud_Network_1:
    type: Cloud.Network
    properties:
      name: Default
      networkType: existing

Encrypt access credentials submitted to the API:

resources:
  apitier:
    type: Cloud.Machine
    properties:
      cloudConfig: |
        #cloud-config
        runcmd:
          - export apikey=${base64_encode(input.username:input.password)}
          - curl -i -H 'Accept:application/json' -H 'Authorization:Basic :$apikey' http://
example.com

Discover the address of the API machine:

resources:
  frontend:
    type: Cloud.Machine
    properties:
      cloudConfig: |
        runcmd:
          - echo ${resource.apitier.networks[0].address}
  apitier:
    type: Cloud.Machine
    properties:
      networks:
        - name: '${resource.Cloud_Network_1.name}'
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Complete Blueprint

inputs:
  environment:
    type: string
    enum:
      - AWS
      - vSphere
      - Azure
      - VMC
      - GCP
    default: vSphere
  sshKey:
    type: string
    maxLength: 500
  envsize:
    type: string
    enum:
      - Small
      - Large
resources:
  frontend:
    type: Cloud.Machine
    properties:
      folderName: '${input.environment == "VMC" ? "Workload" : ""}'
      image: ubuntu
      flavor: medium
      count: '${input.envsize == "Small" ? 1 : 2}'
      remoteAccess:
        authentication: publicPrivateKey
        sshKey: '${input.sshKey}'
      cloudConfig: |
        packages:
          - nginx
        runcmd:
          - echo ${resource.apitier.networks[0].address}
      constraints:
        - tag: '${"env:" + to_lower(input.environment)}'
      networks:
        - name: '${resource.Cloud_Network_1.name}'
  apitier:
    type: Cloud.Machine
    properties:
      folderName: '${input.environment == "VMC" ? "Workload" : ""}'
      image: ubuntu
      flavor: small
      cloudConfig: |
        #cloud-config
        runcmd:
          - export apikey=${base64_encode(input.username:input.password)}
          - curl -i -H 'Accept:application/json' -H 'Authorization:Basic :$apikey' http://
example.com
      remoteAccess:
        authentication: publicPrivateKey
        sshKey: '${input.sshKey}'
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      constraints:
        - tag: '${"env:" + to_lower(input.environment)}'
      networks:
        - name: '${resource.Cloud_Network_1.name}'
  Cloud_Network_1:
    type: Cloud.Network
    properties:
      name: Default
      networkType: existing
      constraints:
        - tag: '${"env:" + to_lower(input.environment)}'

vRealize Automation Cloud Assembly blueprint expression syntax

The vRealize Automation Cloud Assembly blueprint expression syntax exposes all of the 
capabilities of expressions.

The syntax is only partly represented in the examples shown in How to use expressions to make 
vRealize Automation Cloud Assembly blueprint code more versatile.

Literals

The following literals are supported:

n Boolean (true or false)

n Integer

n Floating point

n String

Backslash escapes double quote, single quote, and backslash itself:

" is escaped as \"

' is escaped as \'

\ is escaped as \\

Quotes only need to be escaped inside a string enclosed with the same type of quote, as 
shown in the following example.

"I am a \"double quoted\" string inside \"double quotes\"."

n Null

Environment variables

Environment names:

n orgId

n projectId

n projectName
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n deploymentId

n deploymentName

n blueprintId

n blueprintVersion

n blueprintName

n requestedBy (user)

n requestedAt (time)

Syntax:

env.ENV_NAME

Example:

${env.blueprintId}

Resource variables

Resource variables let you bind to resource properties from other resources.

Syntax:

resource.RESOURCE_NAME.PROPERTY_NAME

Examples:

n ${resource.db.id}

n ${resource.db.networks[0].address}

n ${resource.app.id} (Return the string for non-clustered resources, where count isn't 

specified. Return the array for clustered resources.)

n ${resource.app[0].id} (Return the first entry for clustered resources.)

Resource self variables

Resource self variables are allowed only for resources supporting the allocation phase. Resource 
self variables are only available (or only have a value set) after the allocation phase is complete.

Syntax:

self.property_name

Example:

${self.address} (Return the address assigned during the allocation phase.)

Note that for a resource named resource_x, self.property_name and 

resource.resource_x.property_name are the same and are both considered self-references.

Cluster count index

Syntax:
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count.index

Example:

${count.index == 0 ? "primary" : "secondary"} (Return the node type for clustered 

resources.)

Limitations:

Use of count.index for resource allocation is not supported. For example, the following capacity 

expression fails when it references the position within an array of disks created at input time.

inputs:
  disks:
    type: array
    minItems: 0
    maxItems: 12
    items:
      type: object
      properties:
        size:
          type: integer
          title: Size (GB)
          minSize: 1
          maxSize: 2048
resources:
  Cloud_vSphere_Disk_1:
    type: Cloud.vSphere.Disk
    properties:
      capacityGb: '${input.disks[count.index].size}'
      count: '${length(input.disks)}'

Conditions

Syntax:

n Equality operators are == and !=.

n Relational operators are < > <= and >=.

n Logical operators are && || and !.

n Conditionals use the pattern:

condition-expression ? true-expression : false-expression

Examples:

${input.count < 5 && input.size == 'small'}

${input.count < 2 ? "small" : "large"}

Arithmetic operators

Syntax:

Operators are + – / * and %.
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Example:

${(input.count + 5) * 2}

String concatenation

Syntax:

${'ABC' + 'DEF'} evaluates to ABCDEF.

Operators [ ] and .

The expression follows ECMAScript in unifying the treatment of the [ ] and . operators.

So, expr.identifier is equivalent to expr["identifier"]. The identifier is used to construct a 

literal whose value is the identifier, and then the [ ] operator is used with that value.

Example:

${resource.app.networks[0].address}

In addition, when a property includes a space, delimit with square brackets and double quotes 
instead of using dot notation.

Incorrect:

input.operating system

Correct:

input["operating system"]

Construction of map

Syntax:

${{'key1':'value1', 'key2':input.key2}}

Construction of array

Syntax:

${['key1','key2']}

Example:

${[1,2,3]}

Functions

Syntax:

${function(arguments...)}

Example:

${to_lower(resource.app.name)}
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Table 6-1. Functions

Function Description

abs(number) Absolute number value

floor(number) Returns the largest (closest to positive infinity) value that 
is less than or equal to the argument and is equal to a 
mathematical integer

ceil(number) Returns the smallest (closest to negative infinity) value that 
is greater than or equal to the argument and is equal to a 
mathematical integer

to_lower(str) Convert string to lower case

to_upper(str) Convert string to upper case

contains(array, value) Check if array contains a value

contains(string, value) Check if string contains a value

join(array, delim) Join array of strings with a delimiter and return a string

split(string, delim) Split string with a delimiter and return array of strings

slice(array, begin, end) Return slice of array from begin index to end index

reverse(array) Reverse entries of array

starts_with(subject, prefix) Check if subject string starts with prefix string

ends_with(subject, suffix) Check if subject string ends with suffix string

replace(string, target, replacement) Replace string containing target string with target string

substring(string, begin, end) Return substring of string from begin index until end index

format(format, values...) Return a formatted string using Java Class Formatter 
format and values.

keys(map) Return keys of map

values(map) Return values of map

merge(map, map) Return a merged map

length(string) Return string length

length(array) Return array length

max(array) Return maximum value from array of numbers

min(array) Return minimum value from array of numbers

sum(array) Return sum of all values from array of numbers

avg(array) Return average of all values from array of numbers
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Table 6-1. Functions (continued)

Function Description

digest(value, type) Return digest of value using supported type (md5, sha1, 
sha256, sha384, sha512)

to_string(value) Return string representation of the value

to_number(string) Parse string as number

not_null(array) Return the first entry which is not null

base64_encode(string) Return base64 encoded value

base64_decode(string) Return decoded base64 value

now() Return current time in ISO-8601 format

uuid() Return randomly generated UUID

from_json(string) Parse json string

to_json(value) Serialize value as json string

json_path(value, path) Evaluate path against value using XPath for JSON.

matches(string, regex) Check if string matches a regex expression

url_encode(string) Encode string using url encoding specification

trim(string) Remove leading and trailing spaces

How to enable remote access in vRealize Automation Cloud 
Assembly blueprints

To remotely access a machine that vRealize Automation Cloud Assembly has deployed, you add 
properties, before deployment, to the blueprint for that machine.

For remote access, you can configure one of the following authentication options.

Note   In cases where keys need to be copied, you might also create a cloudConfig section in 
the blueprint, to automatically copy the keys upon provisioning. The specifics aren't documented 
here, but How to automatically initialize a machine in a vRealize Automation Cloud Assembly 
blueprint provides general information about cloudConfig.

Generate a key pair at vRealize Automation Cloud Assembly provisioning time

If you don't have your own public-private key pair for remote access authentication, you can have 
vRealize Automation Cloud Assembly generate a key pair.
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Use the following code as a guideline.

1 In vRealize Automation Cloud Assembly, before provisioning, add remoteAccess properties to 

the blueprint as shown in the example.

The username is optional. If you omit it, the system generates a random ID as the username.

Example:

type: Cloud.Machine
properties:
  name: our-vm2
  image: Linux18
  flavor: small
  remoteAccess:
    authentication: generatedPublicPrivatekey
    username: testuser

2 In vRealize Automation Cloud Assembly, provision the machine from its blueprint, and bring it 
to a started-up state.

The provisioning process generates the keys.

3 Locate the key name in the Deployments > Topology properties.

4 Use the cloud provider interface, such as the vSphere client, to access the provisioned 
machine command line.

5 Grant read permission to the private key.

chmod 600 key-name

6 Go to the vRealize Automation Cloud Assembly deployment, select the machine, and click 
Actions > Get Private Key.

7 Copy the private key file to your local machine.

A typical local file path is /home/username/.ssh/key-name.

8 Open a remote SSH session, and connect to the provisioned machine.

ssh -i key-name user-name@machine-ip

Supply your own public-private key pair to vRealize Automation Cloud Assembly

Many enterprises create and distribute their own public-private key pairs for authentication.

Use the following code as a guideline.

1 In your local environment, obtain or generate your public-private key pair.

For now, just generate and save the keys locally.

2 In vRealize Automation Cloud Assembly, before provisioning, add remoteAccess properties to 

the blueprint as shown in the example.

The sshKey includes the long alphanumeric found within the public key file key-name.pub.
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The username is optional and gets created for you to log in with. If you omit it, the system 
generates a random ID as the username.

Example:

type: Cloud.Machine
properties:
  name: our-vm1
  image: Linux18
  flavor: small
  remoteAccess:
    authentication: publicPrivateKey
    sshKey: ssh-rsa Iq+5aQgBP3ZNT4o1baP5Ii+dstIcowRRkyobbfpA1mj9tslf
qGxvU66PX9IeZax5hZvNWFgjw6ag+ZlzndOLhVdVoW49f274/mIRild7UUW... 
    username: testuser

3 In vRealize Automation Cloud Assembly, provision the machine from its blueprint, and bring it 
to a started-up state.

4 Using the cloud vendor client, access the provisioned machine.

5 Add the public key file to the home folder on the machine. Use the key that you specified in 
remoteAccess.sshKey.

6 Verify that the private key file counterpart is present on your local machine.

The key is typically /home/username/.ssh/key-name with no .pub extension.

7 Open a remote SSH session, and connect to the provisioned machine.

ssh -i key-name user-name@machine-ip

Supply an AWS key pair to vRealize Automation Cloud Assembly

By adding an AWS key pair name to the blueprint, you can remotely access a machine that 
vRealize Automation Cloud Assembly deploys to AWS.

Be aware that AWS key pairs are region specific. If you provision workloads into us-east-1, the key 
pair must exist in us-east-1.

Use the following code as a guideline. This option works for AWS cloud zones only.

type: Cloud.Machine
properties:
  image: Ubuntu
  flavor: small
  remoteAccess:
    authentication: keyPairName
    keyPair: cas-test
constraints:
  - tag: 'cloud:aws'
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Supply a username and password to vRealize Automation Cloud Assembly

By adding a username and password to the blueprint, you can have simple remote access to a 
machine that vRealize Automation Cloud Assembly deploys.

Although it is less secure, logging in remotely with a username and password might be all that 
your situation requires. Be aware that some cloud vendors or configurations might not support 
this less secure option.

1 In vRealize Automation Cloud Assembly, before provisioning, add remoteAccess properties to 

the blueprint as shown in the example.

Set the username and password to the account that you expect to log in with.

Example:

type: Cloud.Machine
properties:
  name: our-vm3
  image: Linux18
  flavor: small
  remoteAccess:
    authentication: usernamePassword
    username: testuser
    password: admin123

2 In vRealize Automation Cloud Assembly, provision the machine from its blueprint, and bring it 
to a started-up state.

3 Go to your cloud vendor's interface, and access the provisioned machine.

4 On the provisioned machine, create or enable the account.

5 From your local machine, open a remote session to the provisioned machine IP address or 
FQDN, and log in with the username and password as usual.

How to add advanced features to vRealize Automation 
Cloud Assembly designs

There are advanced infrastructure-as-code techniques and vRealize Automation Cloud Assembly 
features that increase the enterprise readiness of your designs.

Some features described here expand the design capabilities of vRealize Automation Cloud 
Assembly while others apply directly to blueprint coding practices.

How to customize the names of deployed resources using vRealize 
Automation Cloud Assembly

As a cloud or project administrator, you have a prescribed naming convention for resources in 
your environment, and you want the deployed resource to follow those conventions without user 
interaction. You can create a naming template for all deployments from a vRealize Automation 
Cloud Assembly project.
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For example, your host naming convention is to prefix a resource as projectname-sitecode-
costcenter-whereDeployed-identifier. You configure the custom naming template for the 
machines for each project. Some of the template variables are pulled from the system as it is 
deployed, other are based on project custom properties. The custom naming template for the 
above prefix looks similar to the following example.

${project.name}-${resource.siteCode}-${resource.costCenter}-${endpoint.name}-${######} 

The identifier, provided in the template as ${######}, shows a six digit identifier. The identifier is 

a counter that ensures uniqueness. The counter increments across all projects in the organization, 
not only the current project. When you have multiple projects, do not expect a sequence from 
000123 to 000124 for deployments in you current project. You can expect an increment from 
000123 to 000127.

All resource names must be unique. Use the incremental number property to ensure uniqueness. 
The numbers increment for all deployments, including those that are named by vRealize 
Automation Cloud Assembly. As your system becomes more robust, the numbering might appear 
random, but they still ensure uniqueness.

In addition to the examples provided here, you can also add the user name, the image that 
is used, other built-in options, and simple strings. As you build the template, hints regarding 
possible options are provided.

Remember that some of the values you see are only use case examples. You won't be able to 
use them letter-by-letter in your environment. Think about where you would make your own 
substitutions, or extrapolate from the example values, in order to fit your own cloud infrastructure 
and deployment management needs.

Prerequisites

n Verify that you know the naming convention that you want to use for deployments from a 
project.

n This procedure assumes you have or can create a simple blueprint that you use to test your 
custom host prefix naming.

Procedure

1 Select Infrastructure > Projects.

2 Select an existing project or create a new one.

3 On the Provisioning tab, locate the Custom Properties section and create the properties for 
the site code and cost center values.

This is where you replace the values you see here with ones pertinent to your environment.
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a Create a custom property with the name siteCode and the value BGL.

b Add another custom property with the name costCenter and the value IT-research.

4 Locate the Custom Naming section and add the following template.

${project.name}-${resource.siteCode}-${resource.costCenter}-${endpoint.name}-${######} 

You can copy in the string, but if this is your first naming template, consider using the hint text 
and quick select as you build the template.

5 Deploy a blueprint associated with the project to verify that the custom name is applied to the 
resource.

a Click the Design tab, and then click a blueprint associated with the project.

b Deploy the blueprint.

The Deployments tab opens, showing your deployment in process.

c When deployment is completed, click the deployment name.

d On the Topology tab, notice that your custom name is the resource name in the right 
pane.

6 If you deployed a test blueprint to verify the naming convention, you can delete the 
deployment.
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What to do next

Create custom naming templates for your other projects.

How to automatically initialize a machine in a vRealize Automation 
Cloud Assembly blueprint

You can apply machine initialization in vRealize Automation Cloud Assembly through vSphere 
customization specifications, or by running commands directly.

A property in your blueprint code can reference a vSphere customization specification by name. 
Alternatively, you can add a cloudConfig section to the blueprint, in which you embed specific 
commands.

Caution   Proceed carefully if you attempt to combine embedded commands and customization 
specification initialization. They aren't formally compatible and might produce inconsistent or 
unwanted results when used together. 

For an example of how a customization specification interferes with commands in a cloudConfig 
section, see How to deploy a Linux machine with a static IP address.

vSphere customization specifications in vRealize Automation Cloud Assembly 
blueprints

Customization specifications let you apply guest operating system settings at deployment time, 
when deploying to vSphere based cloud zones.

The customization specification must exist in vSphere, at the target that you deploy to.

Edit the blueprint code directly. The following example points to a cloud-assembly-linux 
customization specification for a WordPress host on vSphere.

resources:
  WebTier:
    type: Cloud.vSphere.Machine    
    properties:     
        name: wordpress      
        cpuCount: 2
        totalMemoryMB: 1024
        imageRef: 'Template: ubuntu-18.04'      
        customizationSpec: 'cloud-assembly-linux'      
        resourceGroupName: '/Datacenters/Datacenter/vm/deployments'

Customization specifications versus initialization commands

If you want the provisioning experience to match what you are currently doing in vSphere, 
continuing to use customization specifications might be the best approach. However, to expand 
to hybrid or multiple cloud provisioning, a more neutral approach is to embed initialization 
commands in a cloudConfig section of a blueprint.
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For more about cloudConfig sections in blueprints, see Configuration commands in vRealize 
Automation Cloud Assembly blueprints.

Configuration commands in vRealize Automation Cloud Assembly blueprints

You can add a cloudConfig section to vRealize Automation Cloud Assembly blueprint code, in 
which you add machine initialization commands that run at deployment time.

n Linux—initialization commands follow the open cloud-init standard.

n Windows—initialization commands use Cloudbase-init.

Note   Linux cloud-init and Windows Cloudbase-init don't share the same syntax. A cloudConfig 
section for one operating system won't work in a machine image of the other operating system.

You use initialization commands to automate the application of data or settings at instance 
creation time, which can customize users, permissions, installations, or any other command-based 
operations. Examples include:

n Setting a hostname

n Generating and setting up SSH private keys

n Installing packages

In vRealize Automation Cloud Assembly, you can also add initialization commands up front, to a 
machine image, when configuring infrastructure. All blueprints that reference the source image 
get the same initialization.

Important   You might have an image map and a blueprint where both contain initialization 
commands. At deployment time, the commands merge, and vRealize Automation Cloud Assembly 
runs the consolidated commands.

When the same command appears in both places but includes different parameters, only the 
image map command is run.

See Learn more about image mappings in vRealize Automation for additional details.

The following example cloudConfig section is taken from WordPress use case: create a basic 
blueprint blueprint code for the Linux-based MySQL server.

To ensure correct interpretation of commands, always include the pipe character cloudConfig: | 
as shown.
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If a cloud-init script behaves unexpectedly, check the captured console output in /var/log/
cloud-init-output.log when troubleshooting. For more about cloud-init, see the cloud-init 

documentation.

      cloudConfig: |
        #cloud-config
        repo_update: true
        repo_upgrade: all
        packages:
         - apache2
         - php
         - php-mysql
         - libapache2-mod-php
         - php-mcrypt
         - mysql-client
        runcmd:
         - mkdir -p /var/www/html/mywordpresssite && cd /var/www/html && wget 
https://wordpress.org/latest.tar.gz && tar -xzf /var/www/html/latest.tar.gz -C /var/www/html/
mywordpresssite --strip-components 1
         - i=0; while [ $i -le 5 ]; do mysql --connect-timeout=3 -h $
{DBTier.networks[0].address} -u root -pmysqlpassword -e "SHOW STATUS;" && break || sleep 15; 
i=$((i+1)); done
         - mysql -u root -pmysqlpassword -h ${DBTier.networks[0].address} -e "create database 
wordpress_blog;"
         - mv /var/www/html/mywordpresssite/wp-config-sample.php /var/www/html/
mywordpresssite/wp-config.php
         - sed -i -e s/"define( 'DB_NAME', 'database_name_here' );"/"define( 'DB_NAME', 
'wordpress_blog' );"/ /var/www/html/mywordpresssite/wp-config.php && sed 
-i -e s/"define( 'DB_USER', 'username_here' );"/"define( 'DB_USER', 
'root' );"/ /var/www/html/mywordpresssite/wp-config.php && sed -i 
-e s/"define( 'DB_PASSWORD', 'password_here' );"/"define( 'DB_PASSWORD', 
'mysqlpassword' );"/ /var/www/html/mywordpresssite/wp-config.php && sed 
-i -e s/"define( 'DB_HOST', 'localhost' );"/"define( 'DB_HOST', '$
{DBTier.networks[0].address}' );"/ /var/www/html/mywordpresssite/wp-config.php
         - service apache2 reload

How to deploy a Linux machine with a static IP address

When deploying to vSphere, a static IP address requires that vRealize Automation Cloud 
Assembly generate a vSphere customization specification, which can interfere with cloud-init 
commands.

Problem

n A vRealize Automation Cloud Assembly blueprint includes assignment: static to apply a 

static IP address to a vSphere virtual machine.

n The blueprint also contains a cloudConfig section, which includes initialization commands that 
are run using cloud-init.

n To give the virtual machine a static IP, vRealize Automation Cloud Assembly dynamically 
generates a vSphere customization specification to apply.
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n Whenever a customization specification is applied, the last operation restarts the virtual 
machine.

n The customization specification doesn't know that cloud-init commands are running, so the 
restart interrupts them.

n The cloud-init commands only run upon first boot and don't automatically recover when 
interrupted.

n The resulting virtual machine remains only partially configured.

Workaround

Create a machine template that includes a timed disabling of cloud-init. Then, deploy machines 
based on the template so that the customization specification and restart can occur before cloud-
init.

Example procedure—Ubuntu 18.04

The following steps apply to Ubuntu 18.04. You might need to make adjustments and adapt the 
ideas presented here for other Linux versions or offerings.

1 Create the virtual machine, and bring it up to date with version updates and packages that you 
want.

Be aware that other Linux offerings might not have cloud-init pre-installed, but Ubuntu 18.04 
does.

2 Reconfigure cloud-init, setting the datasource to OVF.

sudo dpkg-reconfigure cloud-init

3 Edit the following file.

/etc/cloud/cloud.cfg

a Enable traditional guest operating system customization (GOSC) by adding the following 
line.

disable_vmware_customization: true

b Make sure that network configuration is enabled. Delete or comment out the disable 
setting, if it exists.

network:
  # config: disabled

Alternatively, inspect all configuration files in the following directory.

/etc/cloud/cloud.cfg.d/*

Delete any files that contain a network: {config: disabled} setting.

4 Edit the following file.
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/usr/lib/tmpfiles.d/tmp.conf

n Prevent the temporary directory from clearing by commenting out the setting.

# D /tmp 1777 root root –

5 Edit the following file.

/lib/systemd/system/open-vmtools.service

n Configure open-vmtools to start after dbus.service by adding the following line under the 
[Unit] section.

After=dbus.service

6 Create the new, empty file that disables cloud-init.

sudo touch /etc/cloud/cloud-init.disabled

7 Create a re_init.sh script. After a cron job delay that pauses for the customization 
specification, the script re-enables and initializes cloud-init.

sudo rm -rf /etc/cloud/cloud-init.disabled
sudo cloud-init init
sleep 20
sudo cloud-init modules --mode config
sleep 20
sudo cloud-init modules --mode final

8 Add run permission for the script.

sudo chmod +x re_init.sh

9 Create the cron job that will run after 90 seconds of sleep at startup. Type crontab -e and 

enter the following:

@reboot ( sleep 90 ; sh /script_path/delay_init.sh )

You can apply more then 90 seconds if customization specifications and restarts are taking 
longer to finish.

10 Create a cleaner.sh script, which cleans the template. Replace cloudadmin with your own user 

that you set up during operating system installation.

The sample script is specific to Ubuntu. To create a script for other Linux offerings, make sure 
to include the highlighted, mandatory sections.

#!/bin/bash

# Add usernames to add to /etc/sudoers for passwordless sudo
users=("ubuntu" "cloudadmin")

for user in "${users[@]}"
do
cat /etc/sudoers | grep ^$user
RC=$?
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if [ $RC != 0 ]; then
bash -c "echo \"$user ALL=(ALL) NOPASSWD:ALL\" >> /etc/sudoers"
fi
done

#grab Ubuntu Codename
codename="$(lsb_release -c | awk {'print $2}')"

#Stop services for cleanup
service rsyslog stop

#clear audit logs
if [ -f /var/log/audit/audit.log ]; then
cat /dev/null > /var/log/audit/audit.log
fi
if [ -f /var/log/wtmp ]; then
cat /dev/null > /var/log/wtmp
fi
if [ -f /var/log/lastlog ]; then
cat /dev/null > /var/log/lastlog
fi

#cleanup persistent udev rules
if [ -f /etc/udev/rules.d/70-persistent-net.rules ]; then
rm /etc/udev/rules.d/70-persistent-net.rules
fi

#cleanup /tmp directories
rm -rf /tmp/*
rm -rf /var/tmp/*

#cleanup current ssh keys
#rm -f /etc/ssh/ssh_host_*

#cat /dev/null > /etc/hostname

#cleanup apt
apt-get clean

#Clean Machine ID

truncate -s 0 /etc/machine-id
rm /var/lib/dbus/machine-id
ln -s /etc/machine-id /var/lib/dbus/machine-id

#Clean Cloud-init
cloud-init clean --logs --seed

#cleanup shell history
history -w
history -c

11 Add run permission for the template cleaning script.
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sudo chmod +x cleaner.sh

12 In Ubuntu 18.04, the cleanup script needs root privileges. Edit the following file.

/etc/ssh/sshd_config

a Make sure that you can switch to root user.

PermitRootLogin yes

b Set a password for root.

sudo passwd root

13 Run the cleanup script.

sudo ./script_path/cleaner.sh

14 (Optional) For security, revert step 12 to prevent further root logins.

15 Shut down the virtual machine, and use vSphere to turn it into a template.

Template updates

The cron job runs whenever you update the template. If your update takes longer than the delay 
(such as 90 seconds) you need to re-add the /etc/cloud/cloug-init.disabled file and re-run 

the cleanup script before shutting down the template. Otherwise, cloud-init won't be disabled 
at first boot, and the customization specification restart goes back to interrupting the cloud-init 
commands.

Troubleshooting

If you suspect that the vSphere customization specification is preventing cloud-init completion, 
temporarily disable the customization specification, and determine whether cloud-init can finish 
as expected. To temporarily disable the customization specification, use the customizeGuestOS: 
false property.

    properties:
      image: ubuntu
      cpuCount: 1
      totalMemoryMB: 8192
      customizeGuestOS: false

How to make a vRealize Automation Cloud Assembly deployment wait for 
initialization

Sometimes, a virtual machine needs to be fully started before proceeding with vRealize 
Automation Cloud Assembly deployment.

For example, deploying a machine that is still installing packages and starting a web server might 
lead to conditions where a fast user tries to reach the application before it's available.
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Be aware of the following considerations when using this feature.

n The feature uses the cloud-init phone_home module and is available when deploying Linux 
machines.

n Phone home isn't available for Windows because of Cloudbase-init limitations.

n Phone home can affect deployment order like an explicit dependency, but has more flexibility 
around timing and processing options.

See How to set the resource deployment sequence in vRealize Automation Cloud Assembly.

n Phone home requires a cloudConfig section in the blueprint.

n Your creativity is a factor. Initialization commands might include embedded wait time between 
operations, which can be used in concert with phone home.

n Blueprint-based phone home won't work if the machine template already contains 
phone_home module settings.

n The machine must have outbound communication access back to vRealize Automation Cloud 
Assembly.

To wait for machine initialization by using phone home in vRealize Automation Cloud Assembly, 
add a cloudConfigSettings section to the blueprint:

cloudConfigSettings:
  phoneHomeShouldWait: true
  phoneHomeTimeoutSeconds: 600
  phoneHomeFailOnTimeout: true

Property Description

phoneHomeShouldWait Whether to wait for initialization, true or false.

phoneHomeTimeoutSeconds When to decide whether to proceed with deployment 
even though initialization is still running. Default is 10 
minutes.

phoneHomeFailOnTimeout Whether to proceed with deployment after timing out, true 
or false. Note that even when proceeding, deployment 
might still fail for separate reasons.

How to perform Windows guest customization

To have vRealize Automation Cloud Assembly automatically initialize a Windows machine at 
deployment, prepare an image that supports Cloudbase-Init, then a blueprint that contains the 
appropriate commands.

The image creation process varies depending on cloud vendor. The example shown here is for 
vSphere.
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How to create an initializable Windows image for vSphere

For vRealize Automation Cloud Assembly to initialize a Windows machine deployed to vSphere, it 
needs to be based on a template with Cloudbase-Init installed and configured.

1 Use vSphere to make and power on a Windows virtual machine.

2 On the virtual machine, log in to Windows.

3 Download Cloudbase-Init.

https://cloudbase.it/cloudbase-init/#download

4 Start the Cloudbase-Init setup .msi file.

During installation, enter Administrator as the username, and select the option to run as 
LocalSystem.

Other setup selections can remain as default values.

5 Allow the installation to run, but do not close the final Completed page of the setup wizard.

Important   Do not close the final page of the setup wizard.

6 With the Completed page of the setup wizard still open, use Windows to navigate to the 
Cloudbase-Init installation path, and open the following file in a text editor.

conf\cloudbase-init-unattend.conf

7 Set metadata_services to OvfService as shown.

metadata_services=cloudbaseinit.metadata.services.ovfservice.OvfService

8 Save and close cloudbase-init-unattend.conf.

9 In the same folder, open the following file in a text editor.

conf\cloudbase-init.conf
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10 Set first_logon_behaviour, metadata_services, and plugins as shown.

first_logon_behaviour=always
. . .
metadata_services=cloudbaseinit.metadata.services.ovfservice.OvfService
. . . 
plugins=cloudbaseinit.plugins.windows.createuser.CreateUserPlugin,cloudbaseinit.plugins.win
dows.setuserpassword.SetUserPasswordPlugin,cloudbaseinit.plugins.common.sshpublickeys.SetUs
erSSHPublicKeysPlugin,cloudbaseinit.plugins.common.userdata.UserDataPlugin
. . .

11 Save and close cloudbase-init.conf.

12 On the Completed page of the setup wizard, select the options to run Sysprep and to shut 
down after Sysprep, then click Finish.

Note   VMware has seen cases where running Sysprep prevents deployments of the image 
from working.

When deploying, vRealize Automation Cloud Assembly applies a dynamically generated 
customization specification, which disconnects the network interface. The pending Sysprep 
state in the image might cause the customization specification to fail and leave the deployment 
disconnected.
If you suspect that this is happening in your environment, try leaving the Sysprep options 
deactivated when creating the image.

13 After the virtual machine shuts down, use vSphere to turn it into a template.

Additional details

The following table expands upon the configuration entries made during setup.
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Configuration Setting Purpose

Username, CreateUserPlugin, and SetUserPasswordPlugin After Sysprep, first boot uses CreateUserPlugin to 
create the username Administrator account with a blank 
password. SetUserPasswordPlugin allows Cloudbase-Init 
to change the blank password to the remote access 
password that will be included in the blueprint.

First Logon Behavior This setting prompts the user to change the password 
upon first login.

Metadata services By listing only OvfService, Cloudbase-Init won’t try to find 
other metadata services that aren't supported in vCenter. 
This results in cleaner log files, because the logs would 
otherwise fill with entries about failing to find those other 
services.

Plugins By listing only plugins with capabilities supported by 
OvfService, logs are again cleaner. Cloudbase-Init runs 
plugins in the order specified.

Run as LocalSystem This setting supports any advanced initialization 
commands that might require Cloudbase-Init to run under 
a dedicated administrator account.

How to include Cloudbase-Init commands in a blueprint

To initialize a Windows machine, create infrastructure and blueprints in vRealize Automation Cloud 
Assembly so that the initializable Windows image runs the commands that you want.

The example shown here is based on vSphere, but other cloud vendors should be similar.

Prerequisites

n Create infrastructure. In vRealize Automation Cloud Assembly, add your vSphere cloud 
account and an associated cloud zone.

n Add flavor and image mappings, and add network and storage profiles.

In your infrastructure, an image mapping must point to the Windows template you created to 
support Cloudbase-Init. See How to create an initializable Windows image for vSphere .

If the template isn't listed, go to Cloud Accounts, and synchronize images. Otherwise, 
automatic synchronization runs every 24 hours.

n Add a project, add users, and make sure the users can provision to your cloud zone.

For more about creating infrastructure and projects, see the examples in the The WordPress use 
case.

Procedure

1 In vRealize Automation Cloud Assembly, go to the Design tab, and create a new blueprint.

2 Add a cloudConfig section with the Cloudbase-init commands that you want.
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The following command examples create a new file at the Windows C: drive and set the host 

name.

resources:
  Cloud_Machine_1:
    type: Cloud.Machine
    properties:
      image: cloudbase-init-win-2016
      flavor: small
      remoteAccess:
        authentication: usernamePassword
        username: Administrator
        password: Password1234@$
      cloudConfig: |
        #cloud-config
        write_files:
          content: Cloudbase-Init test
          path: C:\test.txt
        set_hostname: testname

For more information, see the Cloudbase-init documentation.

3 Add remoteAccess properties so that you configure the machine for initial login to Windows.

As mentioned when you created the template, the metadata service picks up the login 
credentials and exposes them to CreateUserPlugin and SetUserPasswordPlugin. Note that the 
password must meet Windows password requirements.

4 From vRealize Automation Cloud Assembly, test and deploy the blueprint.

5 After deploying, use Windows RDP and the credentials in the blueprint to log in to the new 
Windows machine and verify the customization.

In the example above, you would look for the C:\test.txt file, and check the system 

properties for the host name.

How to create custom resource types to use in vRealize Automation 
Cloud Assembly blueprints

When you create a blueprint in vRealize Automation Cloud Assembly, the design canvas includes 
resource types for the supported cloud account and integration endpoints. You might have use 
cases where you want to create blueprints based on an expanded list of resource type. You can 
create custom resources, add them to the design canvas, and create blueprints that support your 
design and deployment needs.
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Use vRealize Orchestrator to create custom resources

Each custom resource is based on a vRealize Orchestrator SDK inventory type and is created by a 
vRealize Orchestrator workflow that has an output which is an instance of your desired SDK type. 
Primitive types, such as Properties, Date, string, and number are not supported for the creation 

of custom resources.

Note   SDK object types can be differentiated from other property types by the colon (":") used 
to separate the plug-in name and the type name. For example, AD:UserGroup is a SDK object type 

used to manage Active Directory user groups.

You can use the built-in workflows in vRealize Orchestrator, or you can create your own. Using 
vRealize Orchestrator to create anything-as-a-service/XaaS workflows means that you can create 
a blueprint that adds an Active Directory user to machines at deployment time, or add a custom 
F5 load balancer to a deployment.

Custom resource name and resource type

The custom resource name identifies your custom resource inside the blueprint resource type 
palette.

The resource type of a custom resource must begin with Custom. and each resource type must be 

unique. For example, you might set Custom.ADUser as a resource type for a custom resource that 

adds Active Directory users. Although the inclusion of Custom. is not validated in the text box, the 

string is automatically added if you remove it.

External type constraints

External types define the type of custom resource in vRealize Orchestrator. For example, 
VC:VirtualMachine or AD:UserGroup.

When you set an external type, verify that the external type matches the output type of the 
vRealize Orchestrator workflow. For example, if your output type in vRealize Orchestrator is 
AD:User, you must also add AD:User as the external type of your custom resource. Also, the added 

external type value must not be an array type.

Note   For dynamic types, the selected variable must be created by using the 

DynamicTypesManager.getObject() method.

When you define your custom resources, you also define the scope of the availability of the select 
external type. The selected external type can be:

n Shared across projects.

n Available only for the selected project.

You can only have one external type per defined scope. For example, if you create a custom 
resource in your project, that uses VC:VirtualMachine as an external type, you cannot create 

another custom resource for the same project that uses the same external type. You also cannot 
create two shared custom resources that use the same external type.
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How do I create a blueprint in vRealize Automation Cloud Assembly that adds 
users to Active Directory

In addition to the vRealize Automation Cloud Assembly blueprint resources that you use when you 
create blueprints, you can also create your own custom resources.

Custom resources are vRealize Orchestrator objects that you manage through vRealize 
Automation with the defined main resource operation workflows. The blueprint service 
automatically call up the appropriate vRealize Orchestrator workflows when a create or delete 
operation is triggered. You can extend the functionality of the resource type by also selecting 
vRealize Orchestrator workflows that can be used as day 2 operations.

This use case uses built-in workflows provided in the vRealize Orchestrator library. It includes 
prescriptive values or strings to demonstrate how to perform the process. You can modify them to 
suit your environment.

For reference purposes, this use case uses a project named DevOpsTesting. You can replace the 
project with one that you already have.

Prerequisites

n Verify that you configured a vRealize Orchestrator integration. See Configure vRealize 
Orchestrator integration in Cloud Assembly.

n Verify that the workflows that you are using for the create, update, destroy, and day 2 actions 
exist in vRealize Orchestrator and run successfully from there.

n In vRealize Orchestrator, locate the resource type used by the workflows. The workflows 
included in this custom resource must all use the same resource type. In this use case, the 
resource type is AD:User.

n By using the built-in Active Directory workflows in your vRealize Orchestrator integration, 
configure an Active Directory server.

n Verify that you know how to configure and deploy a machine blueprint.

Using and Managing vRealize Automation Cloud Assembly

VMware, Inc. 264



Procedure

1 Create an Active Directory custom resource for adding a user in a group.

This step adds the custom resource to the blueprint design canvas as a resources type.

a In vRealize Automation Cloud Assembly, select Design > Custom Resources, and click 
New Custom Resource.

b Provide the following values.

Remember, except for the workflow names, these are sample values.

Setting Sample Value

Name AD user
This is the name that appears in the blueprint 
resource type palette.

Resource Type Custom.ADUser
The resource type must begin Custom. and each 

custom resource type should be unique.

Although the inclusion of Custom. is not validated in 

the text box, the string is automatically added if you 
inadvertently remove it.

This resource type is added to the resource type 
palette so that you can use it in the blueprint.

External Type AD:User
This resource type must match the variable type 
defined in the vRealize Orchestrator workflow.

An external source type can be used only once 
if shared and once per project. In this use case, 
you are providing the custom resource for only the 
DevOpsTesting project. If you had other workflows 
that use AD:User, you can create a custom resource 

that is shared and one for other projects.

In this use case, the workflows are Create a user with 
a password in an organizational unit and Destroy a 
user. For the create workflow, the type is an output 
parameter. For the Destroy a user workflow, the type 
is an input parameter.

c To enable this resource type in the blueprint resource type list, verify that Activate option 
is toggled on.

d Select the Scope setting that makes the resource type available to any project.
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e Select the workflows that define the resource and the day 2 actions.

Note   The selected day 2 workflows must have an input parameter that is of the same type 
as the external type.

Setting Sample Value

Lifecycle Actions - Create Select the Create a user with a password in an 
organizational unit workflow.

If you have multiple vRealize Orchestrator 
integrations, select the workflow on the integration 
instance you use to run these custom resources.

Lifecycle Actions - Destroy Select the Destroy a user workflow.

Additional Actions Select the Change a user password workflow.

To modify the action request form that the user 
responds to when they request the action, click the 
icon in the Request Parameters column.

Note   For additional action workflows, verify that the 
workflow has an input parameter that is of the same 
type as the external type.

In this example, there is no appropriate application of an update workflow. A common 
example of an update workflow, which makes changes to the provisioned custom 
resource, is scaling in or scaling out a deployment.

f Review the schema key and type values in the right pane so that you understand the 
workflow inputs so that you can configure in the blueprint.

The schema lists the required and optional input values defined in the workflow. The 
required input values are included in the blueprint YAML.

In the Create a user workflow, accountName, displayName, and ouContainer are required 

input values. The other schema properties are not required. You can also use the schema 
to determine where you want to create bindings to other field values, workflows, or 
actions. Bindings are not included in this use case.

The generated keys are text in the workflows. There is no need to consider these inputs 
when you create the blueprint.

2 Create a blueprint that adds the user to a machine when you deploy it.

a Select Design > Blueprints, and click New.

b Name the blueprint Machine with an AD user.

c Select the DevOpsTesting project, and click Create.

d Add and configure a vSphere machine.
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e From the resource type list on the left of the blueprint design page, drag the AD user 
resource type onto the canvas.

Note   You can select the custom resource by either scrolling down and selecting it from 
the left pane, or searching for it in the Search Resource Types text box. If the custom 
resource does not appear, click the refresh button next to the Search Resource Types text 
box.
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f On the right, edit the YAML code to add the mandatory input values and the password.

Add an inputs section in the code so that users can provide the name of the users that 

they are adding. In the following example, some of these values are sample data. Your 
values might be different.

inputs:
  accountName:
    type: string
    title: Account name
    encrypted: true   
  displayName:
    type: string
    title: Display name   
  password:
    type: string
    title: Password
    encrypted: true 
  confirmPassword:
    type: string
    title: Password
    encrypted: true   
  ouContainer: 
    type: object
    title: AD OU container
    $data: 'vro/data/inventory/AD:OrganizationalUnit'
    properties:
        id:
            type: string
        type:
            type: string    

g In the resources section, add ${input.input-name} code to prompt for the user selection.

resources:
  Custom_ADUser_1:
    type: Custom.ADUser
    properties:
        accountName: '${input.accountName}'
        displayName: '${input.displayName}'
        ouContainer: '${input.ouContainer}'
        password: '${input.password}'
        confirmPassword: '${input.confirmPassword}'       
        

3 Deploy the blueprint.

a On the blueprint designer page, click Deploy.

b Enter the Deployment Name AD User Scott.

c Select the Blueprint Version and click Next.
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d Complete the deployment inputs.

e Click Deploy.

4 Monitor the provisioning process to ensure that the user is added to Active Directory.

a Click Deployments and locate your AD User Scott deployment.

b Monitor the status of the request and verify success.

c Verify that the change password action is available and working.

What to do next

When your tested blueprint is working, you can then begin using the AD user custom resource 

with other blueprints.

How do I create a blueprint in Cloud Assembly that includes SSH

You can create custom resources that you can use to build blueprints using vRealize Orchestrator 
workflows. In this use case, you add a custom resource that adds an SSH host. You can then 
include the resource in blueprints. This procedure also adds an update workflow so that users 
can make changes to the SSH configuration after deployment rather than perform individual day 2 
actions.

Custom resources are vRealize Orchestrator objects that you manage through vRealize 
Automation with the defined main resource operation workflows. The blueprint service 
automatically call up the appropriate vRealize Orchestrator workflows when a create or delete 
operation is triggered. You can extend the functionality of the resource type by also selecting 
vRealize Orchestrator workflows that can be used as day 2 operations.

This use case uses built-in workflows provided in the vRealize Orchestrator library. It includes 
prescriptive values or strings to demonstrate how to perform the process. You can modify them to 
suit your environment.

For reference purposes, this use case uses a project named DevOpsTesting. You can replace the 
project with one that you already have.

Prerequisites

n Verify that you configured a vRealize Orchestrator integration. See Configure vRealize 
Orchestrator integration in Cloud Assembly.

n Verify that the workflows that you are using for the create, update, destroy, and day 2 actions 
exist in vRealize Orchestrator and run successfully from there.

n In vRealize Orchestrator, locate the resource type used by the workflows. The workflows 
included in this custom resource must all use the same resource type. In this use case, the 
resource type is SSH:Host.

n Verify that you know how to configure and deploy a machine blueprint.
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Procedure

1 Create an SSH Host custom resource for adding SSH to a blueprint.

This step adds the custom resource to the blueprint design canvas as a resource type.

a In vRealize Automation Cloud Assembly, select Design > Custom Resources, and click 
New Custom Resource.

b Provide the following values.

Remember, except for the workflow names, these are sample values.

Setting Sample Value

Name SSH Host - DevOpsTesting Project
This is the name that appears in the blueprint 
resource type palette.

Resource Type Custom.SSHHost
The resource type must begin Custom. and each 

custom resource type should be unique.

Although the inclusion of Custom. is not validated in 

the text box, the string is automatically added if you 
inadvertently remove it.

This resource type is added to the resource type 
palette so that you can use it in the blueprint.

External Type SSH:Host
This resource type must match the variable type 
defined in the vRealize Orchestrator workflow.

An external source type can be used only once 
if shared and once per project. In this use case, 
you are providing the custom resource for only the 
DevOpsTesting project. If you had other workflows 
that use SSH:Host, you can create a custom resource 

that is shared and one for other projects.

In this use case, the workflows are Add SSH Host, 
Update SSH Host, and Remove SSH Host. For the 
Add SSH Host workflow, the type is an output 
parameter. For the Update SSH Host workflow, the 
type is an input and an output parameter. For the 
Remove SSH Host workflow, the type is an input.

c To enable this resource type in the blueprint resource type list, verify that Activate option 
is toggled on.

d Select the Scope setting that makes the resource type available to the DevOpsTesting 
project.
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e Select the workflows that define the resource.

Table 6-2. 

Setting Setting

Lifecycle Actions - Create Select the Add SSH Host workflow.

If you have multiple vRealize Orchestrator 
integrations, select the workflow on the integration 
instance you use to run these custom resources.

Lifecycle Actions - Update Select the Update SSH Host workflow.

Lifecycle Actions - Destroy Select the Remove SSH Host workflow.

f Review the schema key and type values in the right pane so that you understand the 
workflow inputs that apply when configure in the blueprint.

The schema lists the required and optional input values defined in the workflow. The 
required input values are included in the blueprint YAML.

In the Add SSH Host workflow, hostname, port, and username are required input values. 

The other schema properties are not required. You can also use the schema to determine 
where you want to create bindings to other field values, workflows, or actions. Bindings 
are not included in this use case.

2 Create a blueprint that adds the SSH host when you deploy it.

a Select Design > Blueprints, and click New.

b Name the blueprint Machine with SSH Host.

c Select the DevOpsTesting project, and click Create.

d Add and configure a vSphere machine.

e From the custom resource list on the left of the blueprint design page, drag the SSH Host - 
DevOpsTesting Project resource type onto the canvas.

Note   You can select the custom resource by either scrolling down and selecting it from 
the left pane, or searching for it in the Search Resource Types text box. If the custom 
resource does not appear, click the refresh button next to the Search Resource Types text 
box.
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f On the right, edit the YAML code to add the mandatory input values.

Add an inputs section in the code so that users can provide the user name and the host 

name at deployment time. In this example, the port default is 22. In the following example, 
some of these values are sample data. Your values might be different.

inputs: 
  hostname:
    type: string
    title: The hostname of the SSH Host
  username:
    type: string
    title: Username

g In the resources section, add ${input.input-name} code to prompt for the user selection.

resources:
  Custom_SSHHost_1:
    type: Custom.SSHHost
    properties:
      port: 22
      hostname: '${input.hostname}'
      username: '${input.username}'

3 Deploy the blueprint.

a On the blueprint designer page, click Deploy.

b Enter the Deployment Name SSH Host Test.

c Select the Blueprint Version and click Next.

d Complete the deployment inputs.

e Click Deploy.

4 Monitor the provisioning process to ensure that the SSH Host is included in the deployment.

a Click Deployments and locate your SSH Host Test deployment.

b Monitor the status of the request and verify success.

What to do next

When your tested blueprint is working, you can then begin using the SSH Host custom resource 

with other blueprints.

How to design in vRealize Automation Cloud Assembly to prepare for 
day 2 changes

In addition to the day 2 actions already associated with vRealize Automation Cloud Assembly 
resource types, you have design options that let you prepare in advance for custom updates that 
users might need to make.
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Day 2 preparation can involve the vRealize Automation Cloud Assembly design interface or make 
direct use of blueprint code, or both.

n You can add inputs to blueprint code. Then, any update action to a deployment or deployed 
resource asks for fresh input values.

n You can use vRealize Automation Cloud Assembly to design a custom action based on 
a vRealize Orchestrator workflow or action. Running the custom action results in vRealize 
Orchestrator making changes to the deployment or deployed resource.

How to use vRealize Automation Cloud Assembly blueprint inputs for day 2 
updates

When designing vRealize Automation Cloud Assembly blueprints, input parameters allow day 2 
users to re-enter selections from the initial deployment request.

Caution   Some property changes cause a resource to be re-created. For example, changing the 
connection_string.name under a Cloud.Service.Azure.App.Service deletes the existing resource 

and creates a new one.

When designing inputs to support day 2 changes, decide whether to allow inputs that delete and 
re-create resources. To learn which properties re-create a resource, follow the schema link at 
What are the vRealize Automation resource properties .

For information on how to create inputs, see How user input can customize a vRealize Automation 
Cloud Assembly blueprint.

For a specific day 2 example, see the following section.

How to move a deployed machine to another network

While maintaining deployments and networks, you might need the ability to relocate machines 
that you deployed with vRealize Automation Cloud Assembly.

For example, you might deploy to a test network first, then move to a production network. The 
technique described here lets you design a blueprint in advance to prepare for such day 2 actions. 
Note that the machine is moved. It isn't deleted and redeployed.

This procedure only applies to Cloud.vSphere.Machine resources. It won't work for cloud 

agnostic machines deployed to vSphere.

Prerequisites

n The vRealize Automation Cloud Assembly network profile must include all subnets that the 
machine will connect to. In vRealize Automation Cloud Assembly, you can check networks by 
going to Infrastructure > Configure > Network Profiles.

The network profile must be in an account and region that are part of the appropriate vRealize 
Automation Cloud Assembly project for your users.

n Tag the two subnets with different tags. The example that follows assumes that test and prod 
are the tag names.
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n The deployed machine must keep the same IP assignment type. It can't change from static to 
DHCP, or vice versa, while moving to another network.

Procedure

1 In vRealize Automation Cloud Assembly, go to Design, and create a blueprint for the 
deployment.

2 In the inputs section of the blueprint code, add an entry that lets the user select a network.

inputs:
  net-tagging:
    type: string
    enum:
      - test
      - prod
    title: Select a network

3 In the resources section of the blueprint code, add the Cloud.Network and connect the 

vSphere machine to it.

4 Under the Cloud.Network, create a constraint that references the selection from the inputs.

resources:
  ABCServer:    
    type: Cloud.vSphere.Machine
    properties:
      name: abc-server
      . . . 
      networks:
       - network: '${resource["ABCNet"].id}'
  ABCNet:
    type: Cloud.Network
    properties:
      name: abc-network
      . . .
      constraints:
       - tag: '${input.net-tagging}'

5 Continue with your blueprint design, and deploy it as you normally would. At deployment, the 
interface prompts you to select the test or prod network.

6 When you need to make a day 2 change, go to Deployments, and locate the deployment 
associated with the blueprint.

7 To the right of the deployment, click Actions > Update.

8 In the Update panel, the interface prompts you the same way, to select the test or prod 
network.

9 To change networks, make your selection, click Next, and click Submit.
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How to create a vRealize Automation Cloud Assembly custom action to vMotion 
a virtual machine

After you deploy a blueprint, you can run day 2 actions that make changes to the 
deployment.vRealize Automation Cloud Assembly includes many day 2 actions, but you might 
want to provide others. You can create custom resource actions and make them available to users 
as day 2 actions.

The custom resource actions are based on vRealize Orchestrator workflows.

This example of a custom day 2 action is meant to introduce you to the creation process. To use 
custom actions effectively, you must be able to create vRealize Orchestrator workflows and actions 
that run the tasks you need.

Prerequisites

n Verify that you configured a vRealize Orchestrator integration. See Configure vRealize 
Orchestrator integration in Cloud Assembly.

n Verify that the workflow that you are using for the day 2 action exists in vRealize Orchestrator 
and runs successfully there.

Procedure

1 Create a custom resource action that uses vMotion to move a vSphere virtual machine from 
one host to another.

a In vRealize Automation Cloud Assembly, select Design > Resource Actions, and click New 
Resource Action.

b Provide the following values.

Remember, except for the workflow names, these are sample values.

Setting Sample Value

Name vSphere VM vMotion
This is the name that appears in the resource actions 
list.

Display name Move VM
This is the name that users see in the deployment 
actions menu.
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c Click the Activate option to enable this action in the day 2 actions menu for resources that 
matches the resource type.

d Select the resource type and workflow that define the day 2 action.

Setting Sample Value

Resource Type Select the Cloud.vSphere.Machine resource type.

This is the resource type that is deployed as a 
blueprint component, not necessarily what is in the 
blueprint. For example, you might have a cloud 
agnostic machine in your blueprint, but when it 
is deployed on a vCenter Server, the machine is 
Cloud.vSphere.Machine. Because the action applies 
to the deployed type, do not use cloud agnostic types 
when you define your custom actions.

In this example, vMotion only works for vSphere 
machines, but you might have other actions that you 
want to run on multiple resource types. You must 
create an action for each resource type.

Workflow Select the Migrate virtual machine with vMotion 
workflow.

If you have multiple vRealize Orchestrator 
integrations, select the workflow on the integration 
instance you use to run these custom resource 
actions.

2 Create a binding for the vRealize Orchestrator properties to the vRealize Automation Cloud 
Assembly schema properties.

In this use case, the binding is a vRealize Orchestrator action that makes the connection 
between vRealize Orchestrator VC:VirtualMachine input type used in the workflow and the 
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vRealize Automation Cloud Assembly Cloud.vSphere.Machine resource type. By setting up the 
binding, you make the day 2 action seamless for the user requesting the vMotion action on a 
vSphere VM machine. The system provides the name in the workflow so that the user does not 
have to do it.

a Verify that you have a vRealize Orchestrator action that retrieves virtual machine names.

If you do not have an action, you can create one in vRealize Orchestrator. In this example, 
getVMByName might look something like this.

A sample script.

var allVms = VcPlugin.getAllVirtualMachines();
for (var I in allVms) {
    if (allVms[I].name === name) {
        return allVms[I];
    }
}
return null;

The Property Return type is VC:VirtualMachine, and the Inputs is name and a string.

b In vRealize Automation Cloud Assembly, in the action page Property Binding pane, select 
the Workflow input vm.

c Click in the Binding action search and select your getVMByName action.

d Enter the binding action value for the vSphere Compute Schema property resourceName.

The correct format for this example is ${properties.resourceName}

Binding Action Input Input Type Value

name string ${properties.resourceName}

Note   You must use the complete properties definition. For example, you must use $
{properties.resourceName}. You cannot use ${properties}.
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3 To account for the other input parameters in the workflow, you can customize the request form 
that users see when they request the action.

a Click Edit Request Parameters.

You can customize how the request page is presented to users.

Default Field Name Appearance Values Constraints

Destination resource pool 
for the virtual machine. 
Default is the current 
resource pool.

n Label = Target 
resource pool

n Display type = Value 
Picker

Destination host to which 
to migrate the virtual 
machine

n Label = Target host

n Display type = Value 
Picker

Required = Yes

Priority of the migration 
task

Label = Priority of the 
task

Value options

n Value source = 
Constant

In the text box, enter 
a comma-separated 
list.

lowPriority|
Low,defaultPri
ority|
Default,highPr
iority|High

Required = Yes

(Optional) Only migrate 
the virtual machine if its 
power on state matches 
the specified state

Delete this field.

vMotion can move 
machines in any power 
state.

4 To limit when the action is available, you can configure the conditions.

For example, you only want the vMotion action to be available when the machine has four or 
fewer CPUs.

a Click Requires condition.

b Enter the condition.

Table 6-3. 

Key Operator Value

${properties.cpuCount} lessThan 4

c Click Create.
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5 Verify that the Move VM action is available for deployed machines that match the criteria.

a Click Deployments.

b Locate a deployment that includes a deployed machine that matches the defined criteria.

c Open the deployment and select the machine.

d Click actions in the right pane and verity that the Move VM action exists.

e Run the action.

How to extend and automate application life cycles with extensibility

You can extend your application life cycles by using either extensibility actions or vRealize 
Orchestrator workflows with extensibility subscriptions.

With vRealize Automation Cloud Assembly Extensibility, you can assign an extensibility action 
or vRealize Orchestrator workflow to an event by using subscriptions. When the specified event 
occurs, the subscription initiates the action or workflow to run, and all subscribers are notified.

Extensibility Actions

Extensibility actions are small, lightweight scripts of code used to specify an action and how that 
action is to perform. You can import extensibility actions from pre-defined vRealize Automation 
Cloud Assembly action templates or from a ZIP file. You can also use the action editor to create 
custom scripts for your extensibility actions. When multiple action scripts are linked together in 
one script, you create an action flow. By using action flows, you can create a sequence of actions. 
For information on using action flows, see What is an action flow.

vRealize Orchestrator Workflows

By integrating vRealize Automation Cloud Assembly with your existing vRealize Orchestrator 
environment, you can use workflows in your extensibility subscriptions.

Using and Managing vRealize Automation Cloud Assembly

VMware, Inc. 279



Extensibility action subscriptions

You can assign an extensibility action to a vRealize Automation Cloud Assembly subscription to 
extend your application life cycle.

Note   The following subscriptions are use case examples and do not cover all extensibility action 
functionality.

How do I integrate Cloud Assembly with ServiceNow using extensibility actions

Using extensibility actions you can integrate vRealize Automation Cloud Assembly with an 
Enterprise ITSM, like ServiceNow.

Enterprise users commonly integrate their Cloud Management Platform with an IT Service 
Management (ITSM) and Configuration Management Database (CMDB) platform for compliance. 
Following this example, you can integrate vRealize Automation Cloud Assembly with ServiceNow 
for CMDB and ITSM by using extensibility action scripts.

Note   You can also integrate ServiceNow with vRealize Automation Cloud Assembly by 
using vRealize Orchestrator workflows. For information about integrating ServiceNow by using 
workflows, see How do I integrate Cloud Assembly for ITSM with ServiceNow using vRealize 
Orchestrator workflows.

To create this integration, you use four extensibility action scripts. The first three scripts are 
initiated in sequence during provisioning, at the compute provision post event. The fourth script 
triggers at the compute removal post event.

For more information on event topics, refer to Event topics provided with vRealize Automation 
Cloud Assembly.
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Get VM Details

The Get VM details script acquires additional payload details required for CI creation and an 
identity token that is stored in Amazon Web Services Systems Manager Parameter Store (SSM). 
Also, this script updates customProperties with additional properties for later use.

Create ServiceNow CMDB CI 

The Create ServiceNow CMDB CI script passes the ServiceNow instance URL as an input and 
stores the instance in SSM to meet security requirements. This script also reads the ServiceNow 
CMDB unique record identifier response (sys_id). It passes it as an output and writes the custom 
property serviceNowSysId during creation. This value is used to mark the CI as retired when the 

instance is destroyed.

Note   Additional permissions might need to be allocated to your vRealize Automation services 
Amazon Web Services role to allow Lambda to access the SSM Parameter Store.

Create ServiceNow Change

This script finishes the ITSM integration by passing the ServiceNow instance URL as an input and 
storing the ServiceNow credentials as SSM to meet security requirements.

Create ServiceNow Change

The retire ServiceNow CMDB CI script prompts the ServiceNow to stop and marks the CI as retired 
based on the custom property serviceNowSysId that was created in the creation script.

Prerequisites

n Before configuring this integration, filter all event subscriptions with the conditional blueprint 
property: event.data["customProperties"]["enable_servicenow"] === "true"

Note   This property exists on blueprints that require a ServiceNow integration.

n Installed Python application.

For more information on filtering subscriptions, see .Create an extensibility subscription.

Procedure

1 Open a command-line prompt from your Virtual Machine.
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2 Run the Get VM details script.

from botocore.vendored import requests
import json
import boto3
client = boto3.client('ssm','ap-southeast-2')

def handler(context, inputs):
    baseUri = inputs['url']
    casToken = client.get_parameter(Name="casToken",WithDecryption=True)
    
    url = baseUri + "/iaas/login"
    headers = {"Accept":"application/json","Content-Type":"application/json"}
    payload = {"refreshToken":casToken['Parameter']['Value']}
    
    results = requests.post(url,json=payload,headers=headers)
    
    bearer = "Bearer "
    bearer = bearer + results.json()["token"]
    
    deploymentId = inputs['deploymentId']
    resourceId = inputs['resourceIds'][0]
    
    print("deploymentId: "+ deploymentId)
    print("resourceId:" + resourceId)
    
    machineUri = baseUri + "/iaas/machines/" + resourceId
    headers = {"Accept":"application/json","Content-Type":"application/json", 
"Authorization":bearer }
    resultMachine = requests.get(machineUri,headers=headers)
    print("machine: " + resultMachine.text)
    
    print( "serviceNowCPUCount: "+ json.loads(resultMachine.text)["customProperties"]
["cpuCount"] )
    print( "serviceNowMemoryInMB: "+ json.loads(resultMachine.text)["customProperties"]
["memoryInMB"] )
    
    #update customProperties
    outputs = {}
    outputs['customProperties'] = inputs['customProperties']
    outputs['customProperties']['serviceNowCPUCount'] = int(json.loads(resultMachine.text)
["customProperties"]["cpuCount"])
    outputs['customProperties']['serviceNowMemoryInMB'] = json.loads(resultMachine.text)
["customProperties"]["memoryInMB"]
    return outputs

3 Run the CMDB configuration item creation action.

from botocore.vendored import requests
import json
import boto3
client = boto3.client('ssm','ap-southeast-2')

def handler(context, inputs):
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    snowUser = client.get_parameter(Name="serviceNowUserName",WithDecryption=False)
    snowPass = client.get_parameter(Name="serviceNowPassword",WithDecryption=True)
    table_name = "cmdb_ci_vmware_instance"
    url = "https://" + inputs['instanceUrl'] + "/api/now/table/{0}".format(table_name)
    headers = {'Content-type': 'application/json', 'Accept': 'application/json'}
    payload = {
        'name': inputs['customProperties']['serviceNowHostname'],
        'cpus': int(inputs['customProperties']['serviceNowCPUCount']),
        'memory': inputs['customProperties']['serviceNowMemoryInMB'],
        'correlation_id': inputs['deploymentId'],
        'disks_size': int(inputs['customProperties']['provisionGB']),
        'location': "Sydney",
        'vcenter_uuid': inputs['customProperties']['vcUuid'],
        'state': 'On',
        'sys_created_by': inputs['__metadata']['userName'],
        'owned_by': inputs['__metadata']['userName']
        }
    results = requests.post(
        url,
        json=payload,
        headers=headers,
        auth=(snowUser['Parameter']['Value'], snowPass['Parameter']['Value'])
    )
    print(results.text)

    #parse response for the sys_id of CMDB CI reference
    if json.loads(results.text)['result']:
        serviceNowResponse = json.loads(results.text)['result']
        serviceNowSysId = serviceNowResponse['sys_id']
        print(serviceNowSysId)

        #update the serviceNowSysId customProperty
        outputs = {}
        outputs['customProperties'] = inputs['customProperties']
        outputs['customProperties']['serviceNowSysId'] = serviceNowSysId;
        return outputs

4 Run the Creation action script.

from botocore.vendored import requests
import json
import boto3
client = boto3.client('ssm','ap-southeast-2')

def handler(context, inputs):
    snowUser = client.get_parameter(Name="serviceNowUserName",WithDecryption=False)
    snowPass = client.get_parameter(Name="serviceNowPassword",WithDecryption=True)
    table_name = "change_request"
    url = "https://" + inputs['instanceUrl'] + "/api/now/table/{0}".format(table_name)
    headers = {'Content-type': 'application/json', 'Accept': 'application/json'}
    payload = {
        'short_description': 'Provision CAS VM Instance'      
              }
    results = requests.post(
        url,
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        json=payload,
        headers=headers,
        auth=(snowUser['Parameter']['Value'], snowPass['Parameter']['Value'])
    )
    print(results.text)

Results

vRealize Automation Cloud Assembly is successfully integrated with ITSM ServiceNow.

What to do next

When desired, you can retire your CI by using the CMDB configuration item retire action:

from botocore.vendored import requests
import json
import boto3
client = boto3.client('ssm','ap-southeast-2')

def handler(context, inputs):
    snowUser = client.get_parameter(Name="serviceNowUserName",WithDecryption=False)
    snowPass = client.get_parameter(Name="serviceNowPassword",WithDecryption=True)
    tableName = "cmdb_ci_vmware_instance"
    sys_id =inputs['customProperties']['serviceNowSysId']
    url = "https://" + inputs['instanceUrl'] + "/api/now/"+tableName+"/{0}".format(sys_id)
    headers = {'Content-type': 'application/json', 'Accept': 'application/json'}
    payload = {
        'state': 'Retired'
        }

    results = requests.put(
        url,
        json=payload,
        headers=headers,
        auth=(inputs['username'], inputs['password'])
    )
    print(results.text)

For more information on how you can use extensibility actions to integrate ServiceNow in vRealize 
Automation Cloud Assembly, see Extending Cloud Assembly with Action Based Extensibility for 
ServiceNow Integration.

How do I tag virtual machines during provisioning by using extensibility actions

You can use extensibility actions along with subscriptions to automate and simplify tagging VMs.

As a cloud administrator, you can create deployments that are automatically tagged with specified 
inputs and outputs by using extensibility actions and extensibility subscriptions. When a new 
deployment is created against the project containing the tag VM subscription, the deployment 
event triggers the Tag VM script to run and the tags are automatically applied. This saves time and 
promotes efficiency while allowing for easier deployment management.
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Prerequisites

n Access to cloud administrator credentials.

n Amazon Web Services role for Lambda functions.

Procedure

1 Navigate to Extensibility > Library > Actions > New Action and create an action with the 
following parameters.

Parameter Description

Action Name Extensibility action name, preferably with 'TagVM' as a 
prefix or suffix.

Project Project to test the extensibility action against.

Action Template Tag VM

Runtime Python

Script Source Write Script

2 Enter Handler as the Main function.

3 Add tagging inputs for testing the extensibility action.

For example, resourceNames = ["DB_VM"] and target = world.

4 To save your action, click Save.

5 To test your action, click Test.

6 To exit the action editor, click Close.

7 Navigate to Extensibility > Subscriptions.

8 Click New Subscription.

9 Enter the following subscription details.

Detail Setting

Event Topic Select an event topic related to the tagging phase of the 
VM. For example, Compute Allocation.

Note   Tags must be part of the subscription schema.

Blocking Set the timeout for the subscription to 1 minute.

Runnable Item Type Select an extensibility action runnable type.

Runnable id Select your custom extensibility action.

10 To save your custom extensibility action subscription, click Create.
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11 Create a New Blueprint containing two virtual machines: Application VM and DB VM.

12 To deploy the VMs, click Deploy.

13 During deployment, verify that the event is initiated and the extensibility action is run.

14 To verify that the tags were applied correctly, navigate to Infrastructure > Resources > 
Machines.

Learn more about extensibility actions

Action-based extensibility uses streamlined scripts of code within vRealize Automation Cloud 
Assembly to automate extensibility actions.

Action-based extensibility provides a lightweight and flexible run-time engine interface where 
you can define small scriptable actions and configure them to initiate when events specified in 
extensibility subscriptions occur.

You can create these extensibility action scripts of code within vRealize Automation Cloud 
Assembly, or on your local environment, and assign them to subscriptions. Extensibility action 
scripts are used for more lightweight and simple automation of tasks and steps. For more 
information on integrating vRealize Automation Cloud Assembly with a vRealize Orchestrator 
server, see Configure vRealize Orchestrator integration in Cloud Assembly.

Action-based extensibility provides:

n An alternative to vRealize Orchestrator workflows, using small and reusable scriptable actions, 
for lightweight integrations and customizations.

n A way to reuse action templates, which contain reusable parameterized actions.
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You can create extensibility actions by either writing a user-defined action script code or importing 
a predefined script code as a .ZIP package. Action-based extensibility supports Node.js, Python, 
and PowerShell run-time environments. The Node.js and Python run-times rely on Amazon Web 
Services Lambda. Therefore, you must have an active subscription with Amazon Web Services 
Identity and Access Management (IAM), and configure Amazon Web Services as an endpoint 
in vRealize Automation Cloud Assembly. For information on getting started with Amazon Web 
Services Lambda, see ABX: Serverless Extensibility of Cloud Assembly Services.

Note   Extensibility actions are project-specific.

How do I create extensibility actions
With vRealize Automation Cloud Assembly, you can create extensibility actions for use in 
extensibility subscriptions.

Extensibility actions are highly customizable, lightweight, and flexible ways to extend application 
life cycles by using user-defined script code and action templates. Action templates contain 
predefined parameters that help set up the foundation of your extensibility action.

There are two methods of creating an extensibility action:

n Writing user-defined code for an extensibility action script.

Note   Writing user-defined code in the extensibility action editor might require an active 
Internet connection.

n Importing a deployment package as a ZIP package for an extensibility action. For information 
on creating a ZIP package for extensibility actions, see Create a ZIP package for Python 
runtime extensibility actions, Create a ZIP package for Node.js runtime extensibility actions, or 
Create a ZIP package for PowerShell runtime extensibility actions.

The following steps describe the procedure for creating an extensibility action that uses Amazon 
Web Services as a FaaS provider.

Prerequisites

n Membership in an active and valid project.

n Configured Amazon Web Services role for Lambda functions. For example, 
AWSLambdaBasicExecutionRole.

n Cloud administrator role or iam:PassRole permissions enabled.

Procedure

1 Select Extensibility > Library > Actions.

2 Click New Action.

3 Enter a name for your action and select a project.

4 Click Next.
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5 Search and select an action template.

Note   To create a custom action without using an action template, select Custom Script.

New configurable parameters appear.

6 Select Write script or Import package.

7 Select the action runtime.

8 Enter an Main function name for the action's entry point.

Note   For actions imported from a ZIP package, the main function must also include the name 
of the script file that contains the entry point. For example, if your main script file is titled 
main.py and your entry point is handler (context, inputs), the name of the main function 

must be main.handler.

9 Define the Input and Output parameters of the action.

10 (Optional) Add application dependencies to the action.

Note   For PowerShell scripts, you can define your application dependencies so they are 
resolved against the PowerShell Gallery repository. To define your application dependencies 
so, they are resolvable from the public repository use the following format:

@{
                Name = 'Version'
 }
 
 e.g.
 
@{
    Pester = '4.3.1'
}

Note   For actions imported from a ZIP package, application dependencies are added 
automatically.

11 To define timeout and memory limits, enable the Set custom timeout and limits option.

12 To test your action, click Save and then Test.

What to do next

After your extensibility action is created and verified, you can assign it to a subscription.

Note   Extensibility subscriptions use the latest released version of an extensibility action. After 
creating a new version of an action, click Versions on the top-right of the editor window. To 
release the version of the action you want to use in your subscription, click Release.

Create a ZIP package for Python runtime extensibility actions
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You can create a ZIP package that contains the Python script and dependencies used by your 
vRealize Automation Cloud Assembly extensibility actions.

There are two methods of building the script for your extensibility actions:

n Writing your script directly in the extensibility action editor in vRealize Automation Cloud 
Assembly.

n Creating your script on your local environment and adding it, with any relevant dependencies, 
to a ZIP package.

By using a ZIP package, you can create a custom preconfigured template of action scripts and 
dependencies that you can import to vRealize Automation Cloud Assembly for use in extensibility 
actions.

Furthermore, you can use a ZIP package in scenarios where modules associated with 
dependencies in your action script cannot be resolved by the vRealize Automation Cloud 
Assembly service, such as when your environment lacks Internet access.

You can also use a ZIP package to create extensibility actions that contain multiple Python script 
files. Using multiple script files can be useful for organizing the structure of your extensibility action 
code.

Prerequisites

If you are using Python 3.3 or earlier, download and configure the PIP package installer. See 
Python Package Index.

Procedure

1 On your local machine, create a folder for your action script and dependencies.

For example, /home/user1/zip-action.

2 Add your main Python action script or scripts to the folder.

For example, /home/user1/zip-action/main.py.

3 (Optional) Add any dependencies for your Python script to the folder.

a Create a requirements.txt file that contains your dependencies. See Requirements 

Files.

b Open a Linux shell.

Note   The runtime of action-based extensibility in vRealize Automation Cloud Assembly 
is Linux-based. Therefore, any Python dependencies compiled in a Windows environment 
might make the generated ZIP package unusable for the creation of extensibility actions. 
Therefore, you must use a Linux shell.

c Install your requirements.txt file in the script folder by running the following command:

pip install -r requirements.txt --target=home/user1/zip-action
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4 In the assigned folder, select your script elements and, if applicable, your requirements.txt 
file and compress them to a ZIP package.

Note   Both your script and dependency elements must be stored at the root level of the 
ZIP package. When creating the ZIP package in a Linux environment, you might encounter 
a problem where the package content is not stored at the root level. If you encounter this 
problem, create the package by running the zip -r command in your command-line shell.

cd your_script_and_dependencies_folder
zip -r ../your_action_ZIP.zip *

What to do next

Use the ZIP package to create an extensibility action script. See How do I create extensibility 
actions.

Create a ZIP package for Node.js runtime extensibility actions
You can create a ZIP package that contains the Node.js script and dependencies used by your 
vRealize Automation Cloud Assembly extensibility actions.

There are two methods of building the script for your extensibility actions:

n Writing your script directly in the extensibility action editor in vRealize Automation Cloud 
Assembly.

n Creating your script in your local environment and adding it, with any relevant dependencies, 
to a ZIP package.

By using a ZIP package, you can create a custom preconfigured template of action scripts and 
dependencies that you can import to vRealize Automation Cloud Assembly for use in extensibility 
actions.

Furthermore, you can use a ZIP package in scenarios where modules associated with 
dependencies in your action script cannot be resolved by the vRealize Automation Cloud 
Assembly service, such as when your environment lacks Internet access.

Also, you can use packages to create extensibility actions that contain multiple Node.js script files. 
Using multiple script files can be useful for organizing the structure of your extensibility action 
code.

Procedure

1 On your local machine, create a folder for your action script and dependencies.

For example, /home/user1/zip-action.

2 Add your main Node.js action script or scripts to the folder.

For example, /home/user1/zip-action/main.js.
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3 (Optional) Add any dependencies for your Node.js script to the folder.

a Create a package.json file with dependencies in your script folder. See Creating a 

package.json file and Specifying dependencies and devDependencies in a package.json 
file.

b Open a command-line shell.

c Navigate to the folder that you created for the action script and dependencies.

cd /home/user1/zip-action

d Install your package.json file in the script folder by running the following command:

npm install --production

Note   This command creates a node_modules directory in your folder.

4 In the assigned folder, select your script elements and, if applicable, your node_modules 
directory and compress them to a ZIP package.

Note   Both your script and dependency elements must be stored at the root level of the 
ZIP package. When creating the ZIP package in a Linux environment, you might encounter 
a problem where the package content is not stored at the root level. If you encounter this 
problem, create the package by running the zip -r command in your command-line shell.

cd your_script_and_dependencies_folder
zip -r ../your_action_ZIP.zip *

What to do next

Use the ZIP package to create an extensibility action script. See How do I create extensibility 
actions.

Create a ZIP package for PowerShell runtime extensibility actions
You can create a ZIP package that contains your PowerShell script and dependency modules for 
use in extensibility actions.

There are two methods of building the script for your extensibility actions:

n Writing your script directly in the extensibility action editor in vRealize Automation Cloud 
Assembly.

n Creating your script on your local environment and adding it, with any relevant dependencies, 
to a ZIP package.
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By using a ZIP package, you can create a custom preconfigured template of action scripts and 
dependencies that you can import to vRealize Automation Cloud Assembly for use in extensibility 
actions.

Note   You do not need to define PowerCLI cmdlets as dependencies or bundle them into a ZIP 
package. PowerCLI cmdlets come preconfigured with the PowerShell runtime of your vRealize 
Automation Cloud Assembly service.

Furthermore, you can use a ZIP package in scenarios where modules associated with 
dependencies in your action script cannot be resolved by the vRealize Automation Cloud 
Assembly service, such as when your environment lacks Internet access.

You can also use a ZIP package to create extensibility actions that contain multiple PowerShell 
script files. Using multiple script files can be useful for organizing the structure of your extensibility 
action code.

Prerequisites

Verify that you are familiar with PowerShell and PowerCLI. You can find a Docker image with 
PowerShell Core, PowerCLI 10, PowerNSX, and several community modules and script examples 
at Docker Hub .

Procedure

1 On your local machine, create a folder for your action script and dependencies.

For example, /home/user1/zip-action.

2 Add your main PowerShell script with a .psm1 extension to the folder.

The following script presents a simple PowerShell function called main.psm1:

function handler($context, $payload) {

  Write-Host "Hello " $payload.target

 

  return $payload

Note   The output of a PowerShell extensibility action is based on the last variable displayed in 
the body of the function. All other variables in the included function are discarded.

3 (Optional) Add a proxy configuration to your main PowerShell script by using context 
parameters. See Using context parameters to add a proxy configuration in your PowerShell 
script.
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4 (Optional) Add any dependencies for your PowerShell script.

Note   Your PowerShell dependency script must use the .psm1 extension. Use the same name 

for the script and the subfolder where the script is saved.

a Log in to a Linux PowerShell shell.

Note   The runtime of action-based extensibility in vRealize Automation Cloud Assembly 
is Linux-based. Any PowerShell dependencies compiled in a Windows environment might 
make the generated ZIP package unusable. Any installed third-party dependencies must 
be compatible with the VMware Photon OS as PowerShell scripts run on Photon OS.

b Navigate to the /home/user1/zip-action folder.

c Download and save the PowerShell module containing your dependencies, by running the 
Save-Module cmdlet.

Save-Module -Name <module name> -Path ./

d Repeat the previous substep for any additional dependency modules.

Important   Verify that each dependency module is located in a separate subfolder. For 
more information on writing and managing PowerShell modules, see How to Write a 
PowerShell Script Module.

5 In the assigned folder, select your script elements and, if applicable, your dependency module 
subfolders and compress them to a ZIP package.

Note   Both your script and dependency module subfolders must be stored at the root level of 
the ZIP package. When creating the ZIP package in a Linux environment, you might encounter 
a problem where the package content is not stored at the root level. If you encounter this 
problem, create the package by running the zip -r command in your command-line shell.

cd your_script_and_dependencies_folder
zip -r ../your_action_ZIP.zip *

What to do next

Use the ZIP package to create an extensibility action script. See How do I create extensibility 
actions.

Using context parameters to add a proxy configuration in your PowerShell script
You can enable network proxy communication in your PowerShell script by using context 
parameters.

Certain PowerShell cmdlets might require that you set a network proxy as an environment variable 
in your PowerShell function. Proxy configurations are provided to the PowerShell function with the 
$context.proxy.host and $context.proxy.host parameters.
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You can add these context parameters in the beginning of your PowerShell script.

$proxyString = "http://" + $context.proxy.host + ":" + $context.proxy.port
$Env:HTTP_PROXY = $proxyString
$Env:HTTPS_PROXY = $proxyString

If the cmdlets support the -Proxy parameter, you can also pass the proxy value directly to the 

specific PowerShell cmdlets.
Configure cloud-specific extensibility actions
You can configure extensibility actions to work with your cloud accounts.

When creating an extensibility action, you can configure and link it to various cloud-based 
accounts:

n Microsoft Azure

n Amazon Web Services

Prerequisites

A valid cloud account is required.

Procedure

1 Select Extensiblity > Library > Action.

2 Click New Action.

3 Enter the action parameters as necessary.

4 In the FaaS provider drop-down menu, select your cloud account provider or select Auto.

Note   If you select Auto, the action automatically defines the FaaS provider.

5 Click Save.

Results

Your extensibility action is linked for use with the configured cloud account.
Configure on-premises extensibility actions
You can configure your extensibility actions to use an on-premises FaaS provider instead of an 
Amazon Web Services or Microsoft Azure cloud account.

By using an on-premises FaaS provider for your extensibility actions, you can use on-premises 
services like LDAP, CMDB, or vCenter data centers in your vRealize Automation Cloud Assembly 
extensibility subscriptions.

Procedure

1 Select Extensibility > Library > Actions.

2 Click New Action.

3 Enter a name and project for the extensibility action.
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4 (Optional) Enter a description for the extensibility action.

5 Click Next.

6 Create or import your extensibility action script.

7 Click the FaaS provider drop-down menu and select On Prem.

8 To save the new extensibility action, click Save.

What to do next

Use the created extensibility action in your vRealize Automation Cloud Assembly extensibility 
subscriptions.

Export and import extensibility actions
With vRealize Automation Cloud Assembly, you can export and import extensibility actions for use 
in different projects.

Prerequisites

An existing extensibility action.

Procedure

1 Export an extensibility action.

a Navigate to Extensibility > Library > Actions.

b Select an extensibility action and click Export.

The action script and its dependencies are saved on your local environment as a ZIP file.

2 Import an extensibility action.

a Navigate to Extensibility > Library > Actions.

b Click Import.

c Select the exported extensibility action and assign it to a project.

d Click Import.

Note   If the imported extensibility action is already assigned to the specified project, you 
are prompted to select a conflict resolution policy.

Alternate   You can also import action scripts by selecting the Import package option 
directly from the action editor.

What is an action flow
Action flows are a set of extensibility action scripts that are used to extend life cycles and 
automation further.

All action flows begin with flow_start and end with flow_end. You can link several extensibility 

action scripts together, by using the following action flow elements:

n Sequential action flows - Multiple extensibility action scripts running sequentially.
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n Fork action flows - Multiple extensibility action scripts or flows that split pathways to contribute 
to the same output.

n Join action flows - Multiple extensibility action scripts or flows that join together and contribute 
to the same output.

n Conditional action flows - Multiple extensibility action scripts or flows that run after a condition 
is satisfied.

Sequential action flows
Multiple extensibility action scripts running sequentially.

version: "1"
flow:  
 flow_start: 
  next: action1  
action1:  
  action: <action_name>   
  next: action2  
action2:  
  action: <action_name>  
  next: flow_end

Note   You can loop back to a previous action by 
assigning it as the next: action. For instance, in this 

example, instead of next: flow_end, you can enter 

next: action1 to rerun action1 and restart the sequence 

of actions.

Fork action flows
Multiple extensibility action scripts or flows that split pathways to contribute to the same output.
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version: "1"
flow: 
 flow_start:  
  next: forkAction  
forkAction:  
  fork:    
   next: [action1, action2]  
action1:   
 action: <action_name>  
 next: action3  
action3:  
  action: <action_name>    
  next: action4  
action4:  
  action: <action_name>  
   next: action7  
action7:  
  action: <action_name>                
action2:  
  action: <action_name>      

Note   You can loop back to a previous action by assigning 
it as the next: action. For example, instead of next: 
flow_end to end your action flow, you can enter next: 
action1 to rerun action1 and restart the sequence of 

actions.

 Fork Element

Join action flows
Multiple extensibility action scripts or flows that join pathways together and contribute to the same 
output.
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version: "1"
action7:   
 action: <action_name>   
 next: joinElement     
action8:    
 action: <action_name>   
 next: joinElement                      
joinElement:
 join: 
   type: all 
   next: action10   
action10:   
 action: <action_name>   
 next: flow_end      

Note   You can loop back to a previous action by 
assigning it as the next: action. For instance, in this 

example, instead of next: flow_end, you can enter 

next: action1 to rerun action1 and restart the sequence 

of actions.

 Join Element

Conditional action flows
Multiple extensibility action scripts or flows that run when a condition is satisfied using a switch 
element.

In some cases, the condition must be equal to true in order for the action to run. Other cases, as 

seen in this example, require parameter values to be met before an action can run. If none of the 
conditions are met the action flow fails.
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version: 1
id: 1234
name: Test
inputs: ...
outputs: ...
flow: 
 flow_start:   
  next: forkAction 
forkAction:  
  fork:   
   next: [action1, action2] 
action1:    
   action: <action_name>
   next: action3
action3:  
   action: <action_name> 
   next: action4  
action4: 
   action: <action_name> 
   next: action7  
action7:  
   action: <action_name>
   next: joinElement              
action2:  
  action: <action_name>
  next: switchAction      
switchAction:  
  switch:      
  "${1 == 1}": action5    
  "${1 != 1}": action6
action5:   
  action: <action_name> 
  next: action8  
action6: 
  action: <action_name> 
  next: action8  
action8:  
 action: <action_name>

Note   You can loop back to a previous action by assigning 
it as the next: action. For example, instead of next: 
flow_end to end your action flow, you can enter next: 
action1 to rerun action1 and restart the sequence of 

actions.

 Switch element

How do I use an error handler with action flows
You can configure your action flow to issue an error at specified stages of the flow by using an 
error handler element.

An error handler element requires two inputs:

n Specified error message of the failed action.

n Action flow inputs.
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If an action in your flow fails and the action flow contains an error handler element, an error 
message is issued alerting you of the action failure. The error handler is an action on its own. The 
following script is an example of an error handler that can be used in an action flow.

def handler(context, inputs): 
       
            errorMsg = inputs["errorMsg"]    
            flowInputs = inputs["flowInputs"]        

            print("Flow execution failed with error {0}".format(errorMsg))    
            print("Flow inputs were: {0}".format(flowInputs))        

        outputs = {       
                 "errorMsg": errorMsg,       
                 "flowInputs": flowInputs   
 }        

        return outputs

You can view the successful and failed runs on the Action Runs window.

In this example, the flow-with-handler action flow, which contains an error handler element, was 
run successfully. However, one of the actions in the flow failed, which then initiated the error 
handler to issue an error.
How do I track action runs
The action runs tab shows you a log of subscription triggered extensibility actions and their status.
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You can view the log of action runs using Extensibility > Activity > Action Runs. Also, you can 
filter the list of action runs by one or more properties at once. To view additional details of an 
individual action run, click the Run ID.
Troubleshooting failed extensibility action runs
If your extensibility action run fails, you can perform troubleshooting steps to correct it.

When an action run fails you might receive an error message, a failed status, and a failed log. If 
your action run fails, it is either due to a deployment or code failure.

Problem Solution

Deployment Failure These failures are a result of problems related to the 
cloud account configuration, action deployment, or other 
dependencies that can prevent the action from deploying. 
Ensure that the project you used is defined within the 
configured cloud account and granted permissions to run 
functions. Before initiating the action again, you can test 
the action against a specific project within the action's 
details page.

Code Failure These failures are a result of invalid scripts or code. Use 
the Action run logs to troubleshoot and correct the invalid 
scripts.

Extensibility workflow subscriptions

You can use your vRealize Orchestrator hosted workflows with vRealize Automation Cloud 
Assembly to extend application lifecycle.

How do I modify virtual machine properties using a vRealize Orchestrator workflow subscription

You can use an existing vRealize Orchestrator workflow to modify virtual machine properties and 
add virtual machines to the active directory.

The subscription schema defines the format of the payload for Event Broker Service (EBS) 
messages. In order to receive and use EBS message payload inside a workflow, you must define 
the "inputProperties" workflow input parameters.

Prerequisites

n Cloud administrator user role

n Existing vRealize Orchestrator on-premises workflows.

n Successful integration and connection to the vRealize Orchestrator client server.

Procedure

1 Select Extensiblity > Subscriptions.

2 Click New Subscription.
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3 Create a subscription with the following parameters:

Parameter Value

Name RenameVM

Event topic Select an event topic suitable for the desired vRealize 
Orchestrator integration. For example, compute 
allocation.

Blocking/Non-blocking Non-blocking

Runnable item Select a vRealize Orchestrator runnable type.

Runnable ID Select the desired workflow. For example, Set VM 
name.

4 To save your subscription, click Create.

5 Assign and activate your subscription by creating a blueprint or deploying an existing 
blueprint.

What to do next

Verify that the workflow initiated successfully by one of the following methods:

n Verify the workflow runs log, Extensibility > Activity > Workflow Runs.

n Open the vRealize Orchestrator client and check workflow status by navigating to the workflow 
and verifying the status or by opening the specific logs tab.

How do I integrate Cloud Assembly for ITSM with ServiceNow using vRealize Orchestrator 
workflows

Using vRealize Orchestrator hosted workflows, you can integrate vRealize Automation Cloud 
Assembly with ServiceNow for ITSM compliance.
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Enterprise users commonly integrate their Cloud Management Platform with an IT Service 
Management (ITSM) and Configuration Management Database (CMDB) platform for compliance. 
Following this example, you can integrate vRealize Automation Cloud Assembly with ServiceNow 
for CMDB and ITSM using vRealize Orchestrator hosted workflows. When using vRealize 
Orchestrator integrations and workflows, capability tags are especially useful if you have multiple 
instances for different environments. For more information on capability tags, See Using capability 
tags in vRealize Automation Cloud Assembly.

Note   You can also integrate ServiceNow with vRealize Automation Cloud Assembly using 
extensibility action scripts. For information about integrating ServiceNow using extensibility action 
scripts, see How do I integrate Cloud Assembly with ServiceNow using extensibility actions.

In this example, the ServiceNow integration is composed of three top-level workflows. Each 
workflow has their own subscriptions so that you can update and iterate each component 
individually.

n Event subscription entry point - Basic logging, identifies the requesting user and vCenter VM, 
if applicable.

n Integration workflow - Separates objects and feeds inputs into the technical workflow, handles 
logging, property, and output updates.

n Technical workflow - Downstream system integration for ServiceNow API to create the CMDB 
CI, CR, and CAS IaaS API with additional virtual machine properties outside of the payload.

Prerequisites

n A standalone or clustered vRealize Orchestrator environment.

n A vRealize Orchestrator integration in vRealize Automation Cloud Assembly. For information 
on integrating a standalone vRealize Orchestrator with vRealize Automation Cloud Assembly, 
see Configure vRealize Orchestrator integration in Cloud Assembly.

Procedure

1 Create and save a configuration file in vRealize Orchestrator that contains common 
configuration used in multiple workflows.

2 Save your CAS API token in the same location, as the configuration file from Step 1.

Note   The CAS API token has an expiration.

3 Create a workflow in vRealize Orchestrator with the provided script element. This script 
references and locates a REST Host. It also standardizes REST actions that use an optional 
parameter of a token, which is added as an extra authorization header.

var configPath = "CS"
var configName = "environmentConfig"
var attributeName = "CASRestHost"

//get REST Host from configuration element
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var restHost = 
System.getModule("au.com.cs.example").getRestHostFromConfig(configPath,configName,attribute
Name)

var ConfigurationElement = 
System.getModule("au.com.cs.example").getConfigurationElementByName(configName,configPath);
System.debug("ConfigurationElement:" + ConfigurationElement);
var casToken = ConfigurationElement.getAttributeWithKey("CASToken")["value"]
if(!casToken){
    throw "no CAS Token";
}
//REST Template
var opName = "casLogin";
var opTemplate = "/iaas/login";
var opMethod = "POST";

// create the REST operation:
var opLogin = 
System.getModule("au.com.cs.example").createOp(restHost,opName,opMethod,opTemplate);

//cas API Token
var contentObject = {"refreshToken":casToken}
postContent = JSON.stringify(contentObject);

var loginResponse = 
System.getModule("au.com.cs.example").executeOp(opLogin,null,postContent,null) ;

try{
    var tokenResponse = JSON.parse(loginResponse)['token']
    System.debug("token: " + tokenResponse);
} catch (ex) {
    throw ex + " No valid token";
}

//REST Template  Machine Details
var opName = "machineDetails";
var opTemplate = "/iaas/machines/" + resourceId;
var opMethod = "GET";

var bearer = "Bearer " + tokenResponse;

var opMachine = 
System.getModule("au.com.cs.example").createOp(restHost,opName,opMethod,opTemplate);

// (Rest Operation, Params, Content, Auth Token)
var vmResponse = 
System.getModule("au.com.cs.example").executeOp(opMachine,null,"",bearer) ;

try{
    var vm = JSON.parse(vmResponse);
} catch (ex) {
    throw ex + " failed to parse vm details"
}

System.log("cpuCount: " + vm["customProperties"]["cpuCount"]);
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System.log("memoryInMB: " + vm["customProperties"]["memoryInMB"]);

cpuCount =  vm["customProperties"]["cpuCount"];
memoryMB = vm["customProperties"]["memoryInMB"];

This script sends the output cpuCount and memoryMB to the parent workflow and updates the 

existing customProperties properties. These values can be used in subsequent workflows 

when creating the CMDB.

4 Add the ServiceNow CMDB Create CI script element to your workflow. This element locates 
the ServiceNow REST Host using the configuration item, creates a REST operation for the 
cmdb_ci_vmware_instance table, creates a string of content object based on workflow 

inputs for post data, and outputs the returned sys_id.

var configPath = "CS"
var configName = "environmentConfig"
var attributeName = "serviceNowRestHost"
var tableName = "cmdb_ci_vmware_instance"

//get REST Host from configuration element
var restHost = 
System.getModule("au.com.cs.example").getRestHostFromConfig(configPath,configName,attribute
Name)

//REST Template
var opName = "serviceNowCreatCI";
var opTemplate = "/api/now/table/" + tableName;
var opMethod = "POST";

// create the REST operation:
var opCI = 
System.getModule("au.com.cs.example").createOp(restHost,opName,opMethod,opTemplate);

//cmdb_ci_vm_vmware table content to post;
var contentObject = {};
contentObject["name"] = hostname;
contentObject["cpus"] = cpuTotalCount;
contentObject["memory"] = MemoryInMB;
contentObject["correlation_id"]=  deploymentId
contentObject["disks_size"]=  diskProvisionGB

Using and Managing vRealize Automation Cloud Assembly

VMware, Inc. 305



contentObject["location"] = "Sydney";
contentObject["vcenter_uuid"] = vcUuid;
contentObject["state"] = "On";
contentObject["owned_by"] = owner;

postContent = JSON.stringify(contentObject);
System.log("JSON: " + postContent);

// (Rest Operation, Params, Content, Auth Token)
var ciResponse = 
System.getModule("au.com.cs.example").executeOp(opCI,null,postContent,null) ;

try{
    var cmdbCI = JSON.parse(ciResponse);
} catch (ex) {
    throw ex + " failed to parse ServiceNow CMDB response";
}

serviceNowSysId = cmdbCI['result']['sys_id'];

5 Using the output from the child workflow, create a properties object using the existing 
customProperties and overwrite the serviceNowSysId property with the value from 

ServiceNow. This unique id is used in the CMDB to mark an instance as retired on destroy.

Results

vRealize Automation Cloud Assembly is successfully integrated with ITSM ServiceNow. For more 
information on how you can use workflows to integrate ServiceNow in vRealize Automation Cloud 
Assembly, see Extending Cloud Assembly with vRealize Orchestrator for ServiceNow Integration.

Learn more about workflow subscriptions

By using an vRealize Orchestrator integration with vRealize Automation Cloud Assembly, you can 
extend the life cycles of applications with workflows.

vRealize Automation includes an embedded vRealize Orchestrator deployment. You can use the 
workflow library of the embedded vRealize Orchestrator deployment in your subscriptions. You 
can create, modify, and delete workflows by using the vRealize Orchestrator client.
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You can also integrate an external vRealize Orchestrator deployment in vRealize Automation 
Cloud Assembly. See How do I integrate an external vRealize Orchestrator Client in Using the 
Embedded vRealize Orchestrator Client.
Best practices for creating vRealize Orchestrator workflows
A workflow subscription is based on a specific topic schema. To ensure that the subscriptions 
initiate the vRealize Orchestrator workflows, you must configure them with the correct input 
parameters so that they work with the event data.

Workflow Input Parameters

Your custom workflow can include all the parameters or a single parameter that consumes all the 
data in the payload.

To use a single parameter, configure one parameter with a type of Properties and name 

inputProperties.

Workflow Output Parameters

Your custom workflow can include output parameters that are relevant to subsequent events 
necessary for a reply event topic type.

If an event topic expects a reply, the workflow output parameters must match the reply schema.
How do I track workflow runs
The Workflow Runs window displays the logs of the subscription triggered workflows and their 
status.

You can view the logs of your workflow runs by navigating to Extensibility > Activity > Workflow 
Runs.
Troubleshooting failed workflow subscriptions
If your workflow subscription fails, you can perform troubleshooting steps to correct it.

Failed workflow runs can cause your workflow subscription not to start or complete successfully. 
Workflow run failure can result from several common problems.
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Problem Cause Solution

Your vRealize Orchestrator 
workflow subscription did not 
start or complete successfully.

You configured a workflow subscription to run 
a custom workflow when the event message 
is received, but the workflow does not run or 
complete successfully.

1 Verify that the workflow 
subscription is saved 
correctly.

2 Verify that the workflow 
subscription conditions are 
configured correctly.

3 Verify that vRealize 
Orchestrator contains the 
specified workflow.

4 Verify that the workflow is 
configured correctly within 
vRealize Orchestrator.

Your approval request 
vRealize Orchestrator workflow 
subscription did not run.

You configured a pre-approval or post-approval 
workflow subscription to run a vRealize 
Orchestrator workflow. The workflow does not 
run when a machine that matches the defined 
criteria is requested in the service catalog.

To successfully run an approval 
workflow subscription, you must 
verify that all the components 
are configured correctly.

1 Verify that the approval 
policy is active and correctly 
applied.

2 Verify that your workflow 
subscription is correctly 
configured and saved.

3 Review the event logs 
for messages related to 
approvals.

Your approval request 
vRealize Orchestrator workflow 
subscription was rejected.

You configured a pre-approval or post-approval 
workflow subscription that runs a specified 
vRealize Orchestrator workflow, but the request 
is rejected on the external approval level.

One possible cause is an internal workflow run 
error in vRealize Orchestrator. For example, the 
workflow is missing or the vRealize Orchestrator 
server is not running.

1 Review the logs for 
messages related to 
approvals.

2 Verify that the vRealize 
Orchestrator server is 
running.

3 Verify that vRealize 
Orchestrator contains the 
specified workflow.

Learn more about extensibility subscriptions

You can extend your application life cycles by using either extensibility actions or vRealize 
Orchestrator hosted workflows with extensibility subscriptions.

When a triggering event occurs in your environment, the subscription is initiated and the specified 
workflow or extensibility action is run. You can view system events on the event log, workflow 
runs in the workflow runs window, and action runs in the action run window. Subscriptions are 
project-specific, meaning they are linked to blueprint and deployments through the specified 
project.
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Extensibility terminology

As you work with extensibility subscriptions within vRealize Automation Cloud Assembly, you 
might encounter some terminology that is specific to the subscriptions and event broker service.

Table 6-4. Extensibility Terminology

Term Description

Event Topic Describes a set of events that have the same logical intent 
and the same structure. Every event is an instance of an 
event topic.

You can assign blocking parameters to certain event 
topics. For more information, see Blocking event topics.

Event Indicates a change in the state in the producer or any of 
the entities managed by it. The event is the entity that 
records information about the event occurrence.

Event Broker Service The service that dispatches messages published by a 
producer to the subscribed consumers.

Payload The event data that contains all the relevant properties 
related to that Event Topic.

Subscription Indicates that a subscriber is interested in being notified 
about an event by subscribing to an event topic 
and defining the criteria that triggers the notification. 
Subscriptions link either extensibility actions or workflows 
to triggering events used to automate parts of the 
applications life cycle.

Subscriber The users notified by the events published to the event 
broker service based on the subscription definition. The 
subscriber can also be called a consumer.

System Administrator A user with privileges to create, read, update, and 
delete tenant workflow subscriptions and system workflow 
subscriptions using vRealize Automation Cloud Assembly.

Workflow Subscription Specifies the event topic and conditions that trigger a 
vRealize Orchestrator workflow.

Action Subscription Specifies the event topic and conditions that trigger an 
extensibility action to run.

Workflow A vRealize Orchestrator workflow that is integrated within 
vRealize Automation Cloud Assembly. You can link these 
workflows to events within subscriptions.

Extensibility Action A streamlined script of code that can run after an event is 
triggered in a subscription. Extensibility actions are similar 
to workflows, but are more lightweight. Extensibility 
actions can customized from within vRealize Automation 
Cloud Assembly.

Action Runs Accessible through the Action Runs tab. An action run 
is a detailed log of extensibility actions that have run in 
response to triggering events.
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Blocking event topics
Some event topics support blocking events. The behavior of an extensibility subscription depends 
on whether the topic supports these event types and how you configure the subscription.

vRealize Automation Cloud Assembly extensibility subscriptions can use two broad types of event 
topics: non-blocking and blocking event topics. The event topic type defines the behavior of the 
extensibility subscription.

Non-Blocking Event Topics

Non-blocking event topics only allow you to create non-blocking subscriptions. Non-blocking 
subscriptions are triggered asynchronously and you cannot rely on the order that the 
subscriptions are triggered in.

Blocking Event Topics

Some event topics support blocking. If a subscription is marked as blocking, all messages that 
meet the set conditions are not received by any other subscriptions with matching conditions until 
the runnable item of the blocking subscription is run.

Blocking subscriptions run in priority order. The highest priority value is 0 (zero). If you have 
more than one blocking subscription for the same event topic with the same priority level, the 
subscriptions run in a reverse alphabetical order based on the name of the subscription. After all 
blocking subscriptions are processed, the message is sent to all the non-blocking subscriptions at 
the same time. Because the blocking subscriptions run synchronously, the changed event payload 
includes the updated event when the subsequent subscriptions are notified.

You can use blocking event topics to manage multiple subscriptions that are dependent on each 
other.

For example, you can have two provisioning workflow subscriptions where the second 
subscription depends on the results of the first subscription. The first subscription changes a 
property during provisioning, and the second subscription records the new property, such as 
a machine name, in a file system. The ChangeProperty subscription is prioritized as 0 and the 
RecordProperty is prioritized as 1 because the second subscription uses the results of the first 
subscription. When a machine is provisioned, the ChangeProperty subscription begins running. 
Because the RecordProperty subscription conditions are based on a post-provisioning condition, 
an event triggers the RecordProperty subscription. However, because the ChangeProperty 
workflow is a blocking workflow, the event is not received until it is finished. When the machine 
name is changed and the first workflow subscription is finished, the second workflow subscription 
runs and records the machine name in the file system.

Recovery Runnable Item

For blocking event topics, you can add a recovery runnable item to the subscription. The recovery 
runnable item in a subscription runs if the primary runnable item fails. For example, you can create 
a workflow subscription where the primary runnable item is a workflow that creates records in a 
CMDB system such as ServiceNow. Even if the workflow subscription fails, some records might be 
created in the CMDB system. In this scenario, a recovery runnable item can be used to clean up 
the records left in the CMDB system by the failed runnable item.
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For use cases that include multiple subscriptions that are dependent on each other, you can add 
a ebs.recover.continuation property to the recovery runnable item. With this property, you 

can direct if the Extensibility service must continue with the next subscription in your chain, if the 
current subscription fails.

Event topics provided with vRealize Automation Cloud Assembly

vRealize Automation Cloud Assembly includes predefined event topics.

Event Topics

Event topics are the categories that group similar events together. When assigned to a 
subscription, event topics define which event triggers the subscription. The following event topics 
are provided by default with vRealize Automation Cloud Assembly. All topics can be used to 
add or update custom properties or tags of the resource. If a vRealize Orchestrator workflow or 
extensibility action fails, the corresponding task fails as well.

Table 6-5. Cloud Assembly Event Topics

Event Topic Blockable Description

Blueprint.configuration No Issued when a blueprint configuration 
event, such as the creation or deletion 
of a blueprint, occurs. This event topic 
can be useful for notifying external 
systems of such events.

Blueprint.version.configuratio
n

No Issued when a new blueprint 
versioning event occurs, such as 
the creation, release, de-release, or 
restoration of a version. This event 
topic can be useful with integrations 
of third-party version control systems.

Compute allocation Yes Issued before the allocation 
of resourcenames and 

hostselections. Both of these 

properties can be modified at this 
stage.

Compute post provision Yes Issued after a resource was 
provisioned successfully.

Compute post removal Yes issued after a compute resource was 
removed.

Compute provision Yes Issued before the resource is 
provisioned at the hypervisor.

Note   You can change the allocated 
IP address.

Compute removal Yes Issued before the resource is 
removed.
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Table 6-5. Cloud Assembly Event Topics (continued)

Event Topic Blockable Description

Compute reservation Yes Issued at the time of reservation.

Note   You can change the placement 
order.

Deployment action completed Yes Issued after a deployment action is 
finished.

Deployment action requested Yes Issued before a deployment action is 
finished.

Deployment completed Yes Issued after the deployment of a 
blueprint or catalog request.

Deployment onboarded No Issued when a new deployment is on-
boarded.

Deployment requested Yes Issued before the deployment of a 
blueprint or catalog request.

Deployment resource action 
completed

Yes Issued after the deployment of a 
resource action.

Deployment resource action 
requested

Yes Issued before the deployment of a 
resource action.

Deployment resource completed Yes Issued after the provisioning of a 
deployment resource.

Deployment resource requested Yes Issued before the provisioning of a 
deployment resource.

Disk allocation Yes Issued for the preallocation of disk 
resources.

Disk post removal Yes Issued after a disk resource is deleted.

Disk post resize Yes Issued after a disk resource is resized.

EventLog Yes Logging related events.

Kubernetes cluster allocation Yes Issued for the preallocation of 
resources for a Kubernetes cluster.

Kubernetes cluster post 
provision

Yes Issued after a Kubernetes cluster is 
provisioned.

Kubernetes cluster post 
removal

Yes Issued after a Kubernetes cluster is 
deleted.

Kubernetes cluster provision Yes Issued before a Kubernetes cluster is 
provisioned.

Kubernetes cluster removal Yes Issued before the process of deleting 
a Kubernetes cluster is initiated.

Load balancer post provision Yes Issued after the provisioning of a load 
balancer.
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Table 6-5. Cloud Assembly Event Topics (continued)

Event Topic Blockable Description

Load balancer post removal Yes Issued after the removal of a load 
balancer.

Load balancer provision Yes Issued before provisioning a load 
balancer

Load balancer removal Yes Issued before removing a load 
balancer.

Network Configure Yes Issued when the network is 
configured during compute allocation.

Note   The Network Configure topic 
supports multiple IP addresses/NICs.

Network post provisioning Yes Issued after a network resource is 
provisioned.

Network post removal Yes Issued after a network resource is 
removed.

Network provisioning Yes Issued before a network resource is 
provisioned.

Network removal Yes Issued before a network resource is 
removed.

Security group post 
provisioning

Yes Issued after a security group is 
provisioned.

Security group post removal Yes Issued after a security group is 
removed.

Security group provisioning Yes Issued before a security group is 
provisioned.

Security group removal Yes Issued before a security group is 
removed.

Project Lifecycle No Events issued when a project is 
created, updated, or deleted.

Event Schema

After you add an event topic, you can view the event schema. This schema defines the structure of 
the event's payload, or inputProperties.

Extensibility event log

The extensibility events page displays a list of all events that have occurred within your 
environment.

You can view the extensibility event logs by navigating to Extensibility > Events. You can also 
filter the list of events by one or more properties. To view additional details of an individual event, 
select the event's ID.
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Create an extensibility subscription

By using a vRealize Orchestrator integration, or extensibility actions with vRealize Automation 
Cloud Assembly, you can create subscriptions to extend your applications.

Extensibility subscriptions allow you to extend your applications by triggering workflows or actions 
at specific life-cycle events. You can also apply filters to your subscriptions to set boolean 
conditions for the specified event. For example, the event and workflow or action only triggers 
if the boolean expression is 'true'. This is helpful for scenarios where you want to control when 

events, actions, or workflows are triggered.

Tip   In the filter events in topic text box, use the "Alt + Space" keys on Windows or "Option + 
Space" keys on Mac to display filter options.

Prerequisites

n Cloud administrator user role

n If you are using vRealize Orchestrator workflows:

n The library of the embedded vRealize Orchestrator Client or the library of any integrated 
external vRealize Orchestrator instance.

n If you are using extensibility actions:

n Existing extensibility action scripts. For more information, see How do I create extensibility 
actions.

Procedure

1 Select Extensibility > Subscriptions.

2 Click New Integration.

3 Enter the details of your subscription.

4 Select an Event Topic.

5 (Optional) Set conditions for the event topic.

6 (Optional) If applicable, configure the blocking behavior for the event topic.

7 Click Runnable item and select vRO Workflow or ABX Action from the drop-down menu.
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8 Select a workflow or extensibility action that you want to run in your subscription.

9 (Optional) To define the project scope of the extensibility subscription, disable Any Project, 
and click Add Projects.

10 Click Create save your subscription.

Results

Your subscription is created. When an event, categorized by the selected event topic, occurs the 
linked vRealize Orchestrator workflow or extensibility action is initiated and all subscribers are 
notified.

What to do next

After creating your subscription, you can create or deploy a blueprint to link and use the 
subscription. You can also verify the status of the workflow run in the Extensibility tab 
within vRealize Automation Cloud Assembly. For subscriptions containing vRealize Orchestrator 
workflows, you can also monitor runs and workflow status from the vRealize Orchestrator client.

Troubleshooting an extensibility subscription

Troubleshoot extensibility subscription failures.

When your subscription fails, it is commonly a result of errors with your workflow or extensibility 
action script.
View topic parameters and payload
You can use a dump subscription topic parameters script to view the specific parameters and 
payload of your virtual machine at any given event stage.

Primarily, this script is useful for debugging and verifying available inputs for your vRealize 
Orchestrator workflow. To view all parameters of your virtual machine, use the following script 
with your workflow:

function dumpProperties(props,lvl){
         var keys = props.keys;
         var prefix = ""
     for (var i=0; i<lvl; i++){
                   prefix = prefix + "";
          }
          for (k in keys){
                 var key = keys[k];
                 var value = props.get(keys[k])
                 if ("Properties" == System.getObjectType(value)){
                  System.log(prefix + key + "[")
                  dumpProperties(value,(lvl+2));
                  System.log(prefix+ "]")
                 } else{
                   System.log( prefix + key + ":" + value)
                 }
                 }
   }
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   dumpProperties(inputProperties, 0)

   customProps = inputProperties.get("customProperties")

Subscription version history
If your subscription fails, you can view the version history.

Viewing Subscription Version History

The version history tab can show you the change history of your subscription with the user and 
date of the change. If your subscription fails or is running incorrectly, the version history can help 
identify the cause.

Open your subscription from the Subscriptions tab.

To view the version history, click Version History.

You can click each change entry to view the corresponding subscription code associated with 
the change.
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What are the vRealize Automation resource properties

The vRealize Automation infrastructure-as-code editor lets you click or hover for syntax and code 
completion help. To view the complete set of blueprint resource properties though, sometimes 
called custom properties, refer to the consolidated resource schema.

The schema is available from the VMware {code} site. Follow the link, and click Models to list the 
resource objects that are available for blueprints.

n vRealize Automation Resource Type Schema on VMware {code}

What are some vRealize Automation Cloud Assembly code 
examples

Blueprint code in vRealize Automation Cloud Assembly can be almost limitless in combination and 
application.

Often, an example of successful code is your best starting point for further development. When 
following an example, make substitutions in order to apply your site settings in terms of resource 
names, values, and so on.

vSphere machine examples in vRealize Automation Cloud Assembly 
blueprints

These basic examples define vSphere resources within vRealize Automation Cloud Assembly 
blueprints.

Resource Example Blueprint

vSphere virtual machine with 
CPU, memory, and operating 
system

resources:
  demo-machine:
    type: Cloud.vSphere.Machine
    properties:
      name: demo-machine
      cpuCount: 1
      totalMemoryMB: 1024
      image: ubuntu

vSphere machine with a 
datastore resource

resources:
  demo-vsphere-disk-001:
    type: Cloud.vSphere.Disk
    properties:
        name: DISK_001
        type: 'HDD'
        capacityGb: 10
        dataStore: 'datastore-01'
        provisioningType: thick
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Resource Example Blueprint

vSphere machine with an 
attached disk

resources:
  demo-vsphere-disk-001:
    type: Cloud.vSphere.Disk
    properties:
      name: DISK_001
      type: HDD
      capacityGb: 10
      dataStore: 'datastore-01'
      provisioningType: thin
  demo-machine:
    type: Cloud.vSphere.Machine
    properties:
      name: demo-machine
      cpuCount: 2
      totalMemoryMB: 2048
      imageRef: >-
        https://bintray.com/vmware/photon/
download_file?file_path=2.0%2FRC%2Fova%2Fphoton-
custom-hw11-2.0-31bb961.ova
      attachedDisks:
        - source: '${demo-vsphere-disk-001.id}'

vSphere machine from a 
snapshot image. Append 
a forward slash and the 
snapshot name. The snapshot 
image can be a linked clone.

resources:
  demo-machine:
    type: Cloud.vSphere.Machine
    properties:
      imageRef: 'demo-machine/snapshot-01'
      cpuCount: 1
      totalMemoryMB: 1024

vSphere machine in a specific 
folder in vCenter

resources:
  demo-machine:
    type: Cloud.vSphere.Machine
    properties:
      name: demo-machine
      cpuCount: 2
      totalMemoryMB: 1024
      imageRef: ubuntu
      resourceGroupName: 'myFolder'
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Resource Example Blueprint

vSphere machine with multiple 
NICs

resources:
  demo-machine:
    type: Cloud.Machine
    properties:
      image: ubuntu
      flavor: small
      networks:
        - name: '${network-01.name}'
          deviceIndex: 0
        - name: '${network-02.name}'
          deviceIndex: 1
  network-01:
    type: Cloud.vSphere.Network
    properties:
      name: network-01
  network-02:
    type: Cloud.vSphere.Network
    properties:
      name: network-02

vSphere machine with an 
attached tag in vCenter

resources:
  demo-machine:
    type: Cloud.Machine
    properties:
      flavor: small
      image: ubuntu
      tags:
        - key: env
          value: demo

vSphere machine with a 
customization spec

resources:
  demo-machine:
      type: Cloud.vSphere.Machine
      properties:
        name: demo-machine
        image: ubuntu
        flavor: small
        customizationSpec: Linux
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Resource Example Blueprint

vSphere machine with a 
vSphere network resource 
and static IP address

resources:
  demo-network:
    type: Cloud.vSphere.Network
    properties:
      name: demo-network
  demo-machine:
    type: Cloud.vSphere.Machine
    properties:
      image: ubuntu
      flavor: small
      networks:
        - name: demo-network
          assignment: static

vSphere machine with remote 
access

inputs:
  username:
    type: string
    title: Username
    description: Username
    default: testUser
  password:
    type: string
    title: Password
    default: VMware@123
    encrypted: true
    description: Password for the given username
resources:
  demo-machine:
    type: Cloud.vSphere.Machine
    properties:
      flavor: small
      imageRef: >-
        
https://cloud-images.ubuntu.com/releases/16.04/
release-20170307/ubuntu-16.04-server-cloudimg-
amd64.ova
      cloudConfig: |
        ssh_pwauth: yes
        chpasswd:
          list: |
            ${input.username}:${input.password}
          expire: false
        users:
          - default
          - name: ${input.username}
            lock_passwd: false
            sudo: ['ALL=(ALL) NOPASSWD:ALL']
            groups: [wheel, sudo, admin]
            shell: '/bin/bash'
        runcmd:
          - echo "Defaults:${input.username}  !
requiretty" >> /etc/sudoers.d/${input.username}
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Documented vRealize Automation Cloud Assembly blueprint 
example

By including a thorough set of comments, this example lets you review the structure and purpose 
of the sections in a vRealize Automation Cloud Assembly blueprint.

# *************************************************************************
# 
# This WordPress blueprint is enhanced with comments to explain its 
# parameters.
# 
# Try cloning it and experimenting with its YAML code. If you're new to 
# YAML, visit yaml.org for general information.
# 
# The blueprint deploys a minimum of 3 virtual machines and runs scripts 
# to install packages. 
# 
# *************************************************************************
# 
# ------------------------------------------------------------------------
# Blueprints need a descriptive name and version if
# source controlled in git.
# ------------------------------------------------------------------------
name: WordPress Blueprint with Comments
formatVersion: 1
version: 1
#
# ------------------------------------------------------------------------
# Inputs create user selections that appear at deployment time. Inputs 
# can set placement decisions and configurations, and are referenced 
# later, by the resources section.
# ------------------------------------------------------------------------
inputs:
# 
# ------------------------------------------------------------------------
# Choose a cloud endpoint. 'Title' is the visible 
# option text (oneOf allows for the friendly title). 'Const' is the 
# tag that identifies the endpoint, which was set up earlier, under the 
# Cloud Assembly Infrastructure tab.
# ------------------------------------------------------------------------
  platform:
    type: string
    title: Deploy to
    oneOf:
      - title: AWS
        const: aws
      - title: Azure
        const: azure
      - title: vSphere
        const: vsphere
    default: vsphere
# 
# ------------------------------------------------------------------------
# Choose the operating system. Note that the Cloud Assembly
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# Infrastructure must also have an AWS, Azure, and vSphere Ubuntu image 
# mapped. In this case, enum sets the option that you see, meaning there's
# no friendly title feature this time. Also, only Ubuntu is available 
# here, but having this input stubbed in lets you add more operating
# systems later. 
# ------------------------------------------------------------------------
  osimage:
    type: string
    title: Operating System
    description: Which OS to use
    enum:
      - Ubuntu
# 
# ------------------------------------------------------------------------
# Set the number of machines in the database cluster. Small and large 
# correspond to 1 or 2  machines, respectively, which you see later,
# down in the resources section. 
# ------------------------------------------------------------------------
  dbenvsize:
    type: string
    title: Database cluster size
    enum:
      - Small
      - Large
# 
# ------------------------------------------------------------------------
# Dynamically tag the machines that will be created. The 
# 'array' of objects means you can create as many key-value pairs as 
# needed. To see how array input looks when it's collected,
# open the blueprint and click TEST.
# ------------------------------------------------------------------------
  Mtags:
    type: array
    title: Tags
    description: Tags to apply to machines
    items:
      type: object
      properties:
        key:
          type: string
          title: Key
        value:
          type: string
          title: Value
# 
# ------------------------------------------------------------------------
# Create machine credentials. These credentials are needed in
# remote access configuration later, in the resources section.
# ------------------------------------------------------------------------
  username:
    type: string
    minLength: 4
    maxLength: 20
    pattern: '[a-z]+'
    title: Database Username
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    description: Database Username
  userpassword:
    type: string
    pattern: '[a-z0-9A-Z@#$]+'
    encrypted: true
    title: Database Password
    description: Database Password
# 
# ------------------------------------------------------------------------
# Set the database storage disk size.
# ------------------------------------------------------------------------
  databaseDiskSize:
    type: number
    default: 4
    maximum: 10
    title: MySQL Data Disk Size
    description: Size of database disk
# 
# ------------------------------------------------------------------------
# Set the number of machines in the web cluster. Small, medium, and large 
# correspond to 2, 3, and 4 machines, respectively, which you see later,
# in the WebTier part of the resources section.
# ------------------------------------------------------------------------
  clusterSize:
    type: string
    enum:
      - small
      - medium
      - large
    title: Wordpress Cluster Size
    description: Wordpress Cluster Size
# 
# ------------------------------------------------------------------------
# Set the archive storage disk size.
# ------------------------------------------------------------------------
  archiveDiskSize:
    type: number
    default: 4
    maximum: 10
    title: Wordpress Archive Disk Size
    description: Size of Wordpress archive disk
#
# ------------------------------------------------------------------------
# The resources section configures the deployment of machines, disks, 
# networks, and other objects. In several places, the code pulls from 
# the preceding interactive user inputs.
# ------------------------------------------------------------------------
resources:
# 
# ------------------------------------------------------------------------
# Create the database server. Choose a cloud agnostic machine 'type' so
# that it can deploy to AWS, Azure, or vSphere. Then enter its property 
# settings.
# ------------------------------------------------------------------------
  DBTier:
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    type: Cloud.Machine
    properties:
# 
# ------------------------------------------------------------------------
# Descriptive name for the virtual machine. Does not become the hostname 
# upon deployment. 
# ------------------------------------------------------------------------
      name: mysql
# 
# ------------------------------------------------------------------------
# Hard-coded operating system image to use. To pull from user input above,
# enter the following instead. 
# image: '${input.osimage}' 
# ------------------------------------------------------------------------
      image: Ubuntu
# 
# ------------------------------------------------------------------------
# Hard-coded capacity to use. Note that the Cloud Assembly 
# Infrastructure must also have AWS, Azure, and vSphere flavors 
# such as small, medium, and large mapped. 
# ------------------------------------------------------------------------
      flavor: small
# 
# ------------------------------------------------------------------------
# Tag the database machine to deploy to the cloud vendor chosen from the 
# user input. Tags are case-sensitive, so 'to_lower' forces the tag to 
# lowercase to ensure a match with a site's tagging convention. It's 
# important if platform input were to contain any upper case characters.
# ------------------------------------------------------------------------
      constraints:
        - tag: '${"env:" + to_lower(input.platform)}'
# 
# ------------------------------------------------------------------------
# Also tag the database machine with any free-form tags that were created 
# during user input. 
# ------------------------------------------------------------------------
      tags: '${input.Mtags}'
# 
# ------------------------------------------------------------------------
# Set the database cluster size by referencing the dbenvsize user 
# input. Small is one machine, and large defaults to two. 
# ------------------------------------------------------------------------
      count: '${input.dbenvsize == "Small" ? 1 : 2}' 
# 
# ------------------------------------------------------------------------
# Add a variable to connect the machine to a network resource based on 
# a property binding to another resource. In this case, it's the 
# 'WP_Network' network that gets defined further below.
# ------------------------------------------------------------------------
      networks:
        - name: '${resource.WP_Network.name}'
          network: '${resource.WP_Network.id}'
# 
# ------------------------------------------------------------------------
# Enable remote access to the database server. Reference the credentials 
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# from the user input. 
# ------------------------------------------------------------------------
      remoteAccess:
        authentication: usernamePassword
        username: '${input.username}'
        password: '${input.userpassword}'
# 
# ------------------------------------------------------------------------
# You are free to add custom properties, which might be used to initiate 
# an extensiblity subscription, for example. 
# ------------------------------------------------------------------------
      ABC-Company-ID: 9393 
# 
# ------------------------------------------------------------------------
# Run OS commands or scripts to further configure the database machine, 
# via operations such as setting a hostname, generating SSH private keys,
# or installing packages.
# ------------------------------------------------------------------------
      cloudConfig: |
        #cloud-config
        repo_update: true
        repo_upgrade: all
        packages:
         - mysql-server
        runcmd:
         - sed -e '/bind-address/ s/^#*/#/' -i /etc/mysql/mysql.conf.d/mysqld.cnf
         - service mysql restart
         - mysql -e "GRANT ALL PRIVILEGES ON *.* TO 'root'@'%' IDENTIFIED BY 'mysqlpassword';"
         - mysql -e "FLUSH PRIVILEGES;"
      attachedDisks: []
# 
# ------------------------------------------------------------------------
# Create the web server. Choose a cloud agnostic machine 'type' so that it
# can deploy to AWS, Azure, or vSphere. Then enter its property settings.
# ------------------------------------------------------------------------
  WebTier:
    type: Cloud.Machine
    properties:
# 
# ------------------------------------------------------------------------
# Descriptive name for the virtual machine. Does not become the hostname 
# upon deployment. 
# ------------------------------------------------------------------------
      name: wordpress
# 
# ------------------------------------------------------------------------
# Hard-coded operating system image to use. To pull from user input above,
# enter the following instead:
# image: '${input.osimage}' 
# ------------------------------------------------------------------------
      image: Ubuntu
# 
# ------------------------------------------------------------------------
# Hard-coded capacity to use. Note that the Cloud Assembly
# Infrastructure must also have AWS, Azure, and vSphere flavors 
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# such as small, medium, and large mapped.
# ------------------------------------------------------------------------
      flavor: small 
# 
# ------------------------------------------------------------------------
# Set the web server cluster size by referencing the clusterSize user 
# input. Small is 2 machines, medium is 3, and large defaults to 4. 
# ------------------------------------------------------------------------
      count: '${input.clusterSize== "small" ? 2 : (input.clusterSize == "medium" ? 3 : 4)}'
# 
# ------------------------------------------------------------------------
# Set an environment variable to display object information under the 
# Properties tab, post-deployment. Another example might be 
# {env.blueprintID} 
# ------------------------------------------------------------------------
      tags:
        - key: cas.requestedBy
          value: '${env.requestedBy}' 
# 
# ------------------------------------------------------------------------
# You are free to add custom properties, which might be used to initiate 
# an extensiblity subscription, for example. 
# ------------------------------------------------------------------------
      ABC-Company-ID: 9393 
# 
# ------------------------------------------------------------------------
# Tag the web server to deploy to the cloud vendor chosen from the 
# user input. Tags are case-sensitive, so 'to_lower' forces the tag to 
# lowercase to ensure a match with your site's tagging convention. It's 
# important if platform input were to contain any upper case characters.
# ------------------------------------------------------------------------
      constraints:
        - tag: '${"env:" + to_lower(input.platform)}' 
# 
# ------------------------------------------------------------------------
# Add a variable to connect the machine to a network resource based on 
# a property binding to another resource. In this case, it's the 
# 'WP_Network' network that gets defined further below.
# ------------------------------------------------------------------------
      networks:
        - name: '${resource.WP_Network.name}'
          network: '${resource.WP_Network.id}'
# 
# ------------------------------------------------------------------------
# Run OS commands or scripts to further configure the web server, 
# with operations such as setting a hostname, generating SSH private keys,
# or installing packages.
# ------------------------------------------------------------------------
      cloudConfig: |
        #cloud-config
        repo_update: true
        repo_upgrade: all
        packages:
          - apache2
          - php
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          - php-mysql
          - libapache2-mod-php
          - php-mcrypt
          - mysql-client
        runcmd:
          - mkdir -p /var/www/html/mywordpresssite && cd /var/www/html && wget 
https://wordpress.org/latest.tar.gz && tar -xzf /var/www/html/latest.tar.gz -C /var/www/html/
mywordpresssite --strip-components 1
          - i=0; while [ $i -le 5 ]; do mysql --connect-timeout=3 -h $
{DBTier.networks[0].address} -u root -pmysqlpassword -e "SHOW STATUS;" && break || sleep 15; 
i=$((i+1)); done
          - mysql -u root -pmysqlpassword -h ${resource.DBTier.networks[0].address} -e 
"create database wordpress_blog;"
          - mv /var/www/html/mywordpresssite/wp-config-sample.php /var/www/html/
mywordpresssite/wp-config.php
          - sed -i -e s/"define('DB_NAME', 'database_name_here');"/"define('DB_NAME', 
'wordpress_blog');"/ /var/www/html/mywordpresssite/wp-config.php && sed -i 
-e s/"define('DB_USER', 'username_here');"/"define('DB_USER', 'root');"/ /var/www/html/
mywordpresssite/wp-config.php && sed -i -e s/"define('DB_PASSWORD', 
'password_here');"/"define('DB_PASSWORD', 'mysqlpassword');"/ /var/www/html/mywordpresssite/
wp-config.php && sed -i -e s/"define('DB_HOST', 'localhost');"/"define('DB_HOST', '$
{resource.DBTier.networks[0].address}');"/ /var/www/html/mywordpresssite/wp-config.php
          - service apache2 reload
# 
# ------------------------------------------------------------------------
# Create the network that the database and web servers connect to. 
# Choose a cloud agnostic network 'type' so that it can deploy to AWS, 
# Azure, or vSphere. Then enter its property settings.
# ------------------------------------------------------------------------
  WP_Network:
    type: Cloud.Network
    properties:
# 
# ------------------------------------------------------------------------
# Descriptive name for the network. Does not become the network name 
# upon deployment. 
# ------------------------------------------------------------------------
      name: WP_Network
# 
# ------------------------------------------------------------------------
# Set the networkType to an existing network. You could also use a 
# constraint tag to target a specific, like-tagged network. 
# The other network types are private or public.
# ------------------------------------------------------------------------
      networkType: existing
# 
# ************************************************************************
# 
# VMware hopes that you found this commented blueprint useful. Note that 
# you can also access an API to create blueprints, or query for input 
# schema that you intend to request. See the following Swagger 
# documentation.
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# 
# www.mgmt.cloud.vmware.com/blueprint/api/swagger/swagger-ui.html
# 
# ************************************************************************

Network, security, and load balancer design samples in vRealize 
Automation blueprints

You can use networking, security, and load balancer resources and settings in blueprint designs 
and deployments.

For a summary of blueprint design code options, see vRealize Automation Resource Type 
Schema.

For related information, see:

n Using a network resource in a vRealize Automation blueprint

n Using a security group resource in a vRealize Automation blueprint

n Using a load balancer resource in a vRealize Automation blueprint

These examples illustrate sample network, security group, and load balancer resources within 
basic blueprint designs.

Resource scenario Example blueprint design code

vSphere machine with multiple 
NICs associated to an NSX 
network resource

resources:
  demo-machine:
    type: Cloud.vSphere.Machine
    properties:
      image: ubuntu
      flavor: small
      networks:
       - network: '$
{resource.Cloud_vSphere_Network_1.id}'  
  Cloud_vSphere_Network_1:
    type: Cloud.vSphere.Network
    properties:
      networkType: existing
  Cloud_vSphere_Network_2:
    type: Cloud.NSX.Network
    properties:
      networkType: existing
     

Public cloud machine to use 
an internal IP instead of a 
public IP. This example also 
uses a specific network ID.
Note: The - network: option 
is used in the networks: 
setting to specify a target 
network ID. The - name: 
option in the networks: 
setting has been deprecated 
and should not be used.

resources:
  wf_proxy:
    type: Cloud.Machine
    properties:
      image: ubuntu 16.04
      flavor: small
      constraints:
        - tag: 'platform:vsphere'
      networks:
        - network: '${resource.wf_net.id}'
          assignPublicIpAddress: false
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Resource scenario Example blueprint design code

Routed network for NSX-V or 
NSX-T using the NSX network 
resource type

Cloud_NSX_Network_1:
    type: Cloud.NSX.Network
    properties:
      networkType: routed

Tagging NSX-T logical 
switches for an outbound 
network
Tagging is supported for NSX-
T and VMware Cloud on AWS. 
Tagging is not supported for 
NSX-V.
For more information on this 
scenario, see community blog 
post Creating Tags in NSX 
with Cloud Assembly.

Cloud_NSX_Network_1:
    type: Cloud.NSX.Network
    properties:
      networkType: outbound
      tags: 
        - key: app
          value: opencart

Existing security group with 
a constraint tag applied to a 
machine NIC
To use an existing security 
group, enter existing for 
the securityGroupType 
property.
You can assign tags to 
a Cloud.SecurityGroup 
resource to allocate existing 
security groups by using tag 
constraints. Security groups 
that do not contain tags 
cannot be used in the 
blueprint design.
Constraint tags must be 
set for securityGroupType: 
existing security group 
resources. Those constraints 
must match the tags set on 
the existing security groups. 
Constraint tags cannot be 
set for securityGroupType: 
new security group resources.

formatVersion: 1
inputs: {}
resources:
  allowSsh_sg:
    type: Cloud.SecurityGroup
    properties:
      securityGroupType: existing
      constraints:
        - tag: allowSsh
  compute:
    type: Cloud.Machine
    properties:
      image: centos
      flavor: small
      networks:
        - network: '${resource.prod-net.id}'
          securityGroups:
            - '${resource.allowSsh_sg.id}'
  prod-net:
    type: Cloud.Network
    properties:
      networkType: existing
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Resource scenario Example blueprint design code

On-demand security group 
with two firewall rules 
illustrating the Allow and 
Deny access options

resources:
  Cloud_SecurityGroup_1:
    type: Cloud.SecurityGroup
    properties:
      securityGroupType: new
      rules:
        - ports: 5000
          source: 
'fc00:10:000:000:000:56ff:fe89:48b4'
          access: Allow
          direction: inbound
          name: allow_5000
          protocol: TCP
        - ports: 7000
          source: 
'fc00:10:000:000:000:56ff:fe89:48b4'
          access: Deny
          direction: inbound
          name: deny_7000
          protocol: TCP
  Cloud_vSphere_Machine_1:
    type: Cloud.vSphere.Machine
    properties:
      image: photon
      cpuCount: 1
      totalMemoryMB: 256
      networks:
        - network: '$
{resource.Cloud_Network_1.id}'
          assignIPv6Address: true
          assignment: static
          securityGroups:
            - '$
{resource.Cloud_SecurityGroup_1.id}'
  Cloud_Network_1:
    type: Cloud.Network
    properties:
      networkType: existing
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Resource scenario Example blueprint design code

Complex blueprint with 2 
security groups, including:
n 1 existing security group
n 1 on-demand security 

group with multiple firewall 
rule examples

n 1 vSphere machine
n 1 existing network
This code sample illustrates 
different combinations of 
protocols and ports, services, 
IP CIDR as source and 
destination, IP range as 
source or destination, and the 
options for any, IPv6, and 
(::/0).
For machine NICs, you 
can specify the connected 
network, and security 
group(s). You can also specify 
the NIC index, a possible IP 
address, and so on.

formatVersion: 1
inputs: {}
resources:
  DEMO_ESG : existing security group - security 
group 1)
    type: Cloud.SecurityGroup
    properties:
      constraints:
        - tag: BlockAll
      securityGroupType: existing (designation 
of existing for security group 1) 
  DEMO_ODSG: (on-demand security group - 
security group 2))
    type: Cloud.SecurityGroup
    properties:
      rules: (multiple firewall rules in this 
section)
        - name: IN-ANY (rule 1)
          source: any
          service: any
          direction: inbound
          access: Deny
        - name: IN-SSH (rule 2)
          source: any
          service: SSH
          direction: inbound
          access: Allow
        - name: IN-SSH-IP (rule 3)
          source: 33.33.33.1-33.33.33.250
          protocol: TCP
          ports: 223
          direction: inbound
          access: Allow
        - name: IPv-6-ANY-SOURCE (rule 4)
          source: '::/0'
          protocol: TCP
          ports: 223
          direction: inbound
          access: Allow
        - name: IN-SSH-IP (rule 5)
          source: 44.44.44.1/24
          protocol: UDP
          ports: 22-25
          direction: inbound
          access: Allow
        - name: IN-EXISTING-SG (rule 6)
          source: '${resource["DEMO_ESG"].id}'
          protocol: ICMPv6
          direction: inbound
          access: Allow
        - name: OUT-ANY (rule 7)
          destination: any
          service: any
          direction: outbound
          access: Deny
        - name: OUT-TCP-IPv6 (rule 8)
          destination: 
'2001:0db8:85a3::8a2e:0370:7334/64'
          protocol: TCP
          ports: 22
          direction: outbound
          access: Allow
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Resource scenario Example blueprint design code

        - name: IPv6-ANY-DESTINATION (rule 9)
          destination: '::/0'
          protocol: UDP
          ports: 23
          direction: outbound
          access: Allow
        - name: OUT-UDP-SERVICE (rule 10)
          destination: any
          service: NTP
          direction: outbound
          access: Allow
      securityGroupType: new (designation of on-
demand for security group 2)
  DEMO_VC_MACHINE: (machine resource)
    type: Cloud.vSphere.Machine 
    properties:
      image: PHOTON
      cpuCount: 1
      totalMemoryMB: 1024
      networks: (Machine network NICs)
        - network: '${resource.DEMO_NW.id}'
          securityGroups:
            - '${resource.DEMO_ODSG.id}'
            - '${resource.DEMO_ESG.id}'
  DEMO_NETWORK: (network resource)
    type: Cloud.vSphere.Network
    properties:
      networkType: existing
      constraints:
        - tag: nsx62
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Resource scenario Example blueprint design code

On-demand network with a 1 
arm load balancer

inputs: {}
resources:
  mp-existing:
    type: Cloud.Network
    properties:
      name: mp-existing
      networkType: existing
  mp-wordpress:
    type: Cloud.vSphere.Machine
    properties:
      name: wordpress
      count: 2
      flavor: small
      image: tiny
      customizationSpec: Linux
      networks:
        - network: '${resource["mp-
private"].id}'
  mp-private:
    type: Cloud.NSX.Network
    properties:
      name: mp-private
      networkType: private
      constraints:
        - tag: nsxt
  mp-wordpress-lb:
    type: Cloud.LoadBalancer
    properties:
      name: wordpress-lb
      internetFacing: false
      network: '${resource.mp-existing.id}'
      instances: '${resource["mp-
wordpress"].id}'
      routes:
        - protocol: HTTP
          port: '80'
          instanceProtocol: HTTP
          instancePort: '80'
          healthCheckConfiguration:
            protocol: HTTP
            port: '80'
            urlPath: /index.pl
            intervalSeconds: 60
            timeoutSeconds: 30
            unhealthyThreshold: 5
            healthyThreshold: 2

Existing network with a load 
balancer

formatVersion: 1
inputs:
  count:
    type: integer
    default: 1
resources:
  ubuntu-vm:
    type: Cloud.Machine
    properties:
      name: ubuntu
      flavor: small
      image: tiny
      count: '${input.count}'
      networks:
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Resource scenario Example blueprint design code

        - network: '$
{resource.Cloud_NSX_Network_1.id}'
  Provider_LoadBalancer_1:
    type: Cloud.LoadBalancer
    properties:
      name: OC-LB
      routes:
        - protocol: HTTP
          port: '80'
          instanceProtocol: HTTP
          instancePort: '80'
          healthCheckConfiguration:
            protocol: HTTP
            port: '80'
            urlPath: /index.html
            intervalSeconds: 60
            timeoutSeconds: 5
            unhealthyThreshold: 5
            healthyThreshold: 2
      network: '$
{resource.Cloud_NSX_Network_1.id}'
      internetFacing: false
      instances: '${resource["ubuntu-vm"].id}'
  Cloud_NSX_Network_1:
    type: Cloud.NSX.Network
    properties:
      networkType: existing
      constraints:
        - tag: nsxt24prod

Learn more

For network and security implementation scenarios, see VMware blogs such as these:

n vRealize Automation Cloud Assembly Load Balancer with NSX-T Deep Dive

n Network Automation with Cloud Assembly and NSX – Part 1 (includes use of NSX-T and 
vCenter cloud accounts and network CIDR)

n Network Automation with Cloud Assembly and NSX – Part 2 (includes use of existing and 
outbound network types)

n Network Automation with Cloud Assembly and NSX – Part 3 (includes use of existing and 
on-demand security groups)

n Network Automation with Cloud Assembly and NSX – Part 4 (includes use of existing and 
on-demand load balancers)

Using a network resource in a vRealize Automation blueprint

As you create or edit your vRealize Automation blueprint designs, use the most appropriate 
network resources for your objectives.

Select one of the available network resource types based on machine and related conditions in 
your vRealize Automation blueprint.
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Cloud agnostic network resource

You add a cloud agnostic network by using the Cloud Agnostic > Network resource on the 
blueprint Design page. The resource displays in the blueprint code as a Cloud.Network resource 

type. The default resource displays as:

  Cloud_Network_1: 
    type: Cloud.Network
    properties:
      networkType: existing

Use a cloud agnostic network when you want to specify networking characteristics for a target 
machine type that is not, or might not, be connected to an NSX network.

The cloud agnostic network resource is available for these resource types:

n Cloud agnostic machine

n vSphere

n Google Cloud Platform (GCP)

n Amazon Web Services (AWS)

n Microsoft Azure

n VMware Cloud on AWS (VMC)

The cloud agnostic network resource is available for these network type (networkType) settings:

n public

n private

n outbound

n existing

vSphere network resource

You add a vSphere network by using the vSphere > Network resource on the blueprint Design 
page. The resource displays in the blueprint code as a Cloud.vSphere.Network resource type. The 

default resource displays as:

  Cloud_vSphere_Network_1:
    type: Cloud.vSphere.Network
    properties:
      networkType: existing

Use a vSphere network when you want to specify networking characteristics for a vSphere 
machine type (Cloud.vSphere.Machine).

The vSphere network resource is only available for a Cloud.vSphere.Machine machine type.

The vSphere resource is available for these network type (networkType) settings:

n public
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n private

n existing

For more information about network types, see Using network settings in network profiles and 
blueprints in vRealize Automation.

NSX network resource

You add an NSX network by using the NSX > Network resource on the blueprint Design page. 
The resource displays in the blueprint code as a Cloud.NSX.Network resource type. The default 

resource displays as:

  Cloud_NSX_Network_1:
    type: Cloud.NSX.Network
    properties:
      networkType: existing

Use an NSX network when you want to attach a network resource to one or more machines that 
have been associated to an NSX-V or NSX-T cloud account. The NSX network resource allows you 
to specify NSX networking characteristics for a vSphere machine resource that is associated to an 
NSX-V or NSX-T cloud account.

The NSX network resource is available for these network type (networkType) settings:

n public

n private

n outbound

n existing

n routed - Routed networks are only available for NSX-T and NSX-V.

Each on-demand NSX-T network creates a new Tier-1 logical router. Each on-demand NSX-V 
network creates a new Edge.

Available day 2 operations

For a list of common day 2 operations that are available for blueprint and deployment resources, 
see What actions can I run on vRealize Automation Cloud Assembly deployments.

For an example of how to move from one network to another, see How to move a deployed 
machine to another network.

Learn more

For information about defining network resources, see Network resources.

For information about defining network profiles, see Learn more about network profiles in 
vRealize Automation.

For examples of blueprint designs that illustrate sample network resources and settings, see 
Network, security, and load balancer design samples in vRealize Automation blueprints.
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Using a security group resource in a vRealize Automation blueprint

As you create or edit your vRealize Automation blueprint, use the most appropriate security group 
resources for your objectives.

Cloud agnostic security group resource

There is currently only one type of security group resource. You add a security group resource by 
using the Cloud Agnostic > Security Group resource on the blueprint Design page. The resource 
displays in the blueprint code as a Cloud.SecurityGroup resource type. The default resource 

displays as:

  Cloud_SecurityGroup_1:
    type: Cloud.SecurityGroup
    properties:
      constraints: []
      securityGroupType: existing

You specify a security group resource in a blueprint design as either existing (securityGroupType: 
existing) or on-demand (securityGroupType: new).

You can add an existing security group directly to your blueprint design or you can use an existing 
security group that has been added to a network profile. Existing security groups are supported 
for various cloud account types.

For NSX-V and NSX-T, you can add an existing security group or define a new security group as 
you design or modify your blueprint. On-demand security groups are only supported for NSX-T 
and NSX-V.

For all cloud account types except Microsoft Azure, you can associate one or more security groups 
to a machine NIC. A Microsoft Azure virtual machine NIC (machineName) can only be associated 
to one security group.

By default, the security group property securityGroupType is set to existing. To create an on-

demand security group, enter new for the securityGroupType property. To specify firewall rules for 

an on-demand security group, use the rules property in the Cloud.SecurityGroup section of the 

security group resource.

Existing security groups

Existing security groups are created in a source cloud account resource such as NSX-T or Amazon 
Web Services. They are data collected by vRealize Automation from the source. You can select an 
existing security group from a list of available resources as part of a vRealize Automation network 
profile. In a blueprint design, you can specify an existing security group either inherently by its 
membership in a specified network profile or specifically by name using the securityGroupType: 
existing setting in a security group resource. If you add a security group to a network profile, add 

at least one capability tag to the network profile. On-demand security group resources require a 
constraint tag when used in a blueprint design.
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You can associate a security group resource in your blueprint design to one or more machine 
resources.

Note   If you intend to use a machine resource in your blueprint design to provision to a Microsoft 
Azure virtual machine NIC (machineName), you should only associate the machine resource to a 
single security group.

On-demand NSX-V and NSX-T security groups

You can define on-demand security groups as you define or modify a blueprint design by using 
the securityGroupType: new setting in the security group resource code.

You can use an on-demand NSX-V or NSX-T security group to apply a specific set of firewall rules 
to a networked machine resource or set of grouped resources. Each security group can contain 
multiple named firewall rules. You can use an on-demand security group to specify services or 
protocols and ports. Note that you can specify either a service or a protocol but not both. You can 
specify a port in addition to a protocol. You cannot specify a port if you specify a service. If the rule 
contains neither a service or a protocol, the default service value is Any.

You can also specify IP addresses and IP ranges in firewall rules. Some firewall rule examples are 
shown in Network, security, and load balancer design samples in vRealize Automation blueprints.

When you create firewall rules in an NSX-V or NSX-T on-demand security group, the default is to 
allow the specified network traffic but to also allow other network traffic. To control network traffic, 
you must specify an access type for each rule. The rule access types are:

n Allow (default) - Allows the network traffic that is specified in this firewall rule.

n Deny - Blocks the network traffic that is specified in this firewall rule. Actively tells the client 
that the connection is rejected.

n Drop - Rejects the network traffic that is specified in this firewall rule. Silently drops the packet 
as if the listener is not online.

For an example design that uses an access: Allow and an access: Deny firewall rule, see 

Network, security, and load balancer design samples in vRealize Automation blueprints.

Note   A cloud administrator can create a blueprint design that contains only an NSX on-demand 
security group and can deploy that design to create a reusable existing security group resource 
that members of the organization can add to network profiles and blueprint designs as an existing 
security group.

Firewall rules support either IPv4 or IPv6 format CIDR values for source and destination IP 
addresses. For an example design that uses IPv6 CIDR values in a firewall rule, see Network, 
security, and load balancer design samples in vRealize Automation blueprints.
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Using app isolation policies in on-demand security group firewall rules

You can use an app isolation policy to only allow internal traffic between the resources that are 
provisioned by the blueprint design. With app isolation, the machines provisioned by the blueprint 
can communicate with each other but cannot connect outside the firewall. You can create an app 
isolation policy in the network profile. You can also specify app isolation in a blueprint design by 
using an on-demand security group with a Deny firewall rule or a private or outbound network.

An app isolation policy is created with a lower precedence. If you apply multiple policies, the 
policies with the higher weight will take precedence.

For the same associated endpoint in a project, any deployment that requires an on-demand 
security group for app isolation can use the same app isolation policy. Once the policy is created, 
it is not deleted. When you specify an app isolation policy, vRealize Automation searches for the 
policy within the project and relative to the associated endpoint - If it finds the policy it reuses it, if 
it does not find the policy, it creates it. The app isolation policy name is only visible after its initial 
deployment in the project's custom properties listing.

Available day 2 operations

For a list of common day 2 operations that are available for blueprint and deployment resources, 
see What actions can I run on vRealize Automation Cloud Assembly deployments.

Learn more

For related information about using a security group for network isolation, see Security resources.

For information about using security group settings in a network profile, see Learn more about 
network profiles in vRealize Automation and Using security group settings in network profiles and 
blueprint designs in vRealize Automation Cloud Assembly.

For examples of blueprint designs that illustrate sample security resources and settings, see 
Network, security, and load balancer design samples in vRealize Automation blueprints.

Using a load balancer resource in a vRealize Automation blueprint

As you create or edit your vRealize Automation blueprints, use the most appropriate load balancer 
resources for your objectives.

Choose one of the available load balancer resource types based on conditions in your vRealize 
Automation blueprint.

You cannot connect a load balancer resource directly to a security group resource in the design 
canvas.

Cloud agnostic load balancer resource

Use a cloud agnostic load balancer when you want to specify networking characteristics for any 
type of target machine.
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You add a cloud agnostic load balancer by using the Cloud Agnostic > Load Balancer resource on 
the blueprint design page. The resource displays in the blueprint code as a Cloud.LoadBalancer 
resource type. The default resource displays as:

Cloud_LoadBalancer_1:
    type: Cloud.LoadBalancer
    properties:
      routes: []
      network: ''
      instances: []
      internetFacing: false

NSX load balancer resource

Use an NSX load balancer when you want to specify networking characteristics that are specific 
to NSX-V or NSX-T. To attach one or more load balancers to an NSX-V or NSX-T network or to 
machines that are associated to an NSX-V or NSX-T network.

You add an NSX load balancer by using the NSX > Load Balancer resource on the blueprint 
design page. The resource displays in the blueprint code as a Cloud.NSX.LoadBalancer resource 

type. The default resource displays as:

Cloud_NSX_LoadBalancer_1:
    type: Cloud.NSX.LoadBalancer
    properties:
      routes: []
      network: ''
      instances: []
      

Available day 2 operations

When you scale in or scale out a deployment that contains a load balancer, the load balancer is 
configured to include newly added machines or to stop load balancing machines that are targeted 
for tear down.

For a list of common day 2 operations that are available for designs and deployments, see What 
actions can I run on vRealize Automation Cloud Assembly deployments.

Learn more

For information about defining load balancer settings in a network profile, see Learn more about 
network profiles in vRealize Automation

For examples of blueprint designs that include load balancers, see Network, security, and load 
balancer design samples in vRealize Automation blueprints.

Puppet-enabled blueprint with username and password access

In this example, you add Puppet configuration management to a blueprint deployed on a vCenter 
compute resource with username and password access.
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This procedure shows an example of how you might create a Puppet enabled deployable resource 
that requires username and password authentication. Username and password access means that 
the user must manually log in from the compute resource to the Puppet primary machine in order 
to invoke Puppet configuration management.

Optionally, you can configure remote access authentication which sets up configuration 
management in a blueprint so that the compute resource handles authentication with the Puppet 
primary machine. With remote access enabled, the compute resource automatically generates a 
key to satisfy password authentication. A valid username is still required.

See AWS Puppet configuration management blueprint examples and vCenter Puppet 
configuration blueprint examples for more examples of how you can configure different Puppet 
scenarios in vRealize Automation Cloud Assembly blueprints.

Prerequisites

n Set up a Puppet Enterprise instance on a valid network.

n Add your Puppet Enterprise instance to vRealize Automation Cloud Assembly using the 
Integrations feature. See Configure Puppet Enterprise integration in vRealize Automation 
Cloud Assembly

n Set up a vSphere account and a vCenter compute resource.
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Procedure

1 Add a Puppet configuration management component to a vSphere compute resource on the 
canvas for the desired blueprint.

a Select Infrastructure > Manage > Integrations.

b Click Add Integration and select Puppet.

c Enter the appropriate information on the Puppet configuration page.

Confguration Description Example Value

Hostname Host name or IP address of the Puppet 
primary machine

Puppet-Ubuntu

SSH Port SSH port for communication between 
vRealize Automation Cloud Assembly 
and Puppet primary machine. (Optional)

NA

Autosign secret The shared secret configured on the 
Puppet primary machine that nodes 
should provide to support autosign 
certificate requests.

User specific

Location Indicate whether the Puppet primary 
machine is on a private or public cloud.

Note   Cross cloud deployment is 
supported only if there is connectivity 
between the deployment compute 
resource and the Puppet primary 
machine.

Cloud proxy Not required for public cloud accounts, 
such as Microsoft Azure or Amazon 
Web Services. If you are using a 
vCenter based cloud account, select 
the appropriate cloud proxy for your 
account.

NA

Username SSH and RBAC user name for Puppet 
primary machine.

User specific. YAML value is '$
{input.username}'

Password SSH and RBAC password for Puppet 
primary machine.

User specific YAML value is '$
{input.password}'

Use sudo commands 
for this user

Select to use sudo commands for the 
procidd.

true

Name Puppet primary machine name. PEMasterOnPrem

Description

2 Add the username and password properties to the Puppet YAML as shown in the following 
example.

3 Ensure that the value for the remoteAccess property to the Puppet YAML is set to 
authentication: username and password as shown in the example below.
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Example: vCenter username and password YAML code

The following example shows the representative YAML code for adding username and password 
authentication on a vCenter compute resource.

inputs:
  username:
    type: string
    title: Username
    description: Username to use to install Puppet agent
    default: puppet
  password:
    type: string
    title: Password
    default: VMware@123
    encrypted: true
    description: Password for the given username to install Puppet agent
resources:
  Puppet-Ubuntu:
    type: Cloud.vSphere.Machine
    properties:
      flavor: small
      imageRef: >-
        https://cloud-images.ubuntu.com/releases/16.04/release-20170307/ubuntu-16.04-server-
cloudimg-amd64.ova
      remoteAccess:
        authentication: usernamePassword
        username: '${input.username}'
        password: '${input.password}'
  Puppet_Agent:
    type: Cloud.Puppet
    properties:
      provider: PEMasterOnPrem
      environment: production
      role: 'role::linux_webserver'
      username: '${input.username}'
      password: '${input.password}'
      host: '${Puppet-Ubuntu.*}'
      useSudo: true
      agentConfiguration:
        certName: '${Puppet-Ubuntu.address}'

AWS Puppet configuration management blueprint examples

There are several options for configuring blueprints to support Puppet based configuration 
management on AWS compute resources.
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Puppet management on AWS with username and password

Example of... Sample Blueprint YAML

authentication of cloud 
configuration on any supported 
Amazon Machine Image.

inputs:
  username:
    type: string
    title: Username
    default: puppet
  password:
    type: string
    title: Password
    encrypted: true
    default: VMware@123
resources:
  Webserver:
    type: Cloud.AWS.EC2.Instance
    properties:
      flavor: small
      image: centos
      cloudConfig: |
        #cloud-config
        ssh_pwauth: yes
        chpasswd:
          list: |
            ${input.username}:${input.password}
          expire: false
        users:
          - default
          - name: ${input.username}
            lock_passwd: false
            sudo: ['ALL=(ALL) NOPASSWD:ALL']
            groups: [wheel, sudo, admin]
            shell: '/bin/bash'
            ssh-authorized-keys:
              - ssh-rsa 
AAAAB3NzaC1yc2EAAAADAQABAAABAQDytVL+Q6/+vGbmkXoRpX 
dmettem@dmettem-m01.vmware.com
        runcmd:
          - echo "Defaults:${input.username}  !requiretty" 
>> /etc/sudoers.d/${input.username}
  Puppet_Agent:
    type: Cloud.Puppet
    properties:
      provider: PEOnAWS
      environment: production
      role: 'role::linux_webserver'
      host: '${Webserver.*}'
      osType: linux
      username: '${input.username}'
      password: '${input.password}'
      useSudo: true

Authentication of cloud 
configuration on a custom 
Amazon Machine Image with an 
existing user.

inputs:
  username:
    type: string
    title: Username
    default: puppet
  password:
    type: string
    title: Password
    encrypted: true
    default: VMware@123
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Example of... Sample Blueprint YAML

resources:
  Webserver:
    type: Cloud.AWS.EC2.Instance
    properties:
      flavor: small
      image: centos
      cloudConfig: |
        #cloud-config
        runcmd:
          - sudo sed -e 's/.*PasswordAuthentication no.*/
PasswordAuthentication yes/' -i /etc/ssh/sshd_config
          - sudo service sshd restart
  Puppet_Agent:
    type: Cloud.Puppet
    properties:
      provider: PEOnAWS
      environment: production
      role: 'role::linux_webserver'
      host: '${Webserver.*}'
      osType: linux
      username: '${input.username}'
      password: '${input.password}'
      useSudo: true

Puppet management on AWS with generated PublicPrivateKey

Example of... Sample Blueprint YAML

remoteAccess.authentication 
authentication on AWS 
with generatedPublicPrivateKey 
acces.

inputs: {}
resources:
  Machine:
    type: Cloud.AWS.EC2.Instance
    properties:
      flavor: small
      imageRef: ami-a4dc46db
      remoteAccess:
        authentication: generatedPublicPrivateKey
  Puppet_Agent:
    type: Cloud.Puppet
    properties:
      provider: puppet-BlueprintProvisioningITSuite
      environment: production
      role: 'role::linux_webserver'
      host: '${Machine.*}’
      osType: linux
      username: ubuntu
      useSudo: true
      agentConfiguration:
        runInterval: 15m
        certName: ‘${Machine.address}'
      useSudo: true

vCenter Puppet configuration blueprint examples

There are several options for configuring blueprints to support Puppet based configuration 
management on vCenter compute resources.
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Puppet on vSphere with username and password authentication

The following example shows example YAML code for Puppet on a vSphere OVA with username 
and password authentication.
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Table 6-6. 

Example of... Sample Blueprint YAML

YAML code for Puppet on a vSphere 
OVA with username and password 
authentication.

inputs:
  username:
    type: string
    title: Username
    default: puppet
  password:
    type: string
    title: Password
    encrypted: true
    default: VMware@123
resources:
  Puppet_Agent:
    type: Cloud.Puppet
    properties:
      provider: PEonAWS
      environment: dev
      role: 'role::linux_webserver'
      username: '${input.username}'
      password: '${input.password}'
      useSudo: true
      host: '${Webserver.*}’
      osType: linux
      agentConfiguration:
        runInterval: 15m
        certName: ‘${Machine.address}'
  Webserver:
    type: Cloud.vSphere.Machine
    properties:
      cpuCount: 1
      totalMemoryMB: 1024
      imageRef: >-
https://cloud-images.ubuntu.com/releases/16.04/
release-20170307/ubuntu-16.04-server-cloudimg-amd64.ova
      cloudConfig: |
        #cloud-config
        ssh_pwauth: yes
        chpasswd:
          list: |
            ${input.username}:${input.password}
          expire: false
        users:
          - default
          - name: ${input.username}
            lock_passwd: false
            sudo: ['ALL=(ALL) NOPASSWD:ALL']
            groups: [wheel, sudo, admin]
            shell: '/bin/bash'
            ssh-authorized-keys:
              - ssh-rsa 
AAAAB3NzaC1yc2EAAAADAQABAAABAQDytVL+Q6+vGbmkXoRpX 
dmettem@dmettem-m01.vmware.com
        runcmd:
          - echo "Defaults:${input.username}

YAML code for Puppet on a vSphere 
OVA with username and password 
authentication on the compute 
resource.

inputs:
  username:
    type: string
    title: Username
    default: puppet
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Table 6-6. (continued)

Example of... Sample Blueprint YAML

  password:
    type: string
    title: Password
    encrypted: true
    default: VMware@123
resources:
  Puppet_Agent:
    type: Cloud.Puppet
    properties:
      provider: PEonAWS
      environment: dev
      role: 'role::linux_webserver'
      username: '${input.username}'
      password: '${input.password}'
      useSudo: true
      host: '${Webserver.*}’
      osType: linux
      agentConfiguration:
        runInterval: 15m
        certName: ‘${Machine.address}'
  Webserver:
    type: Cloud.vSphere.Machine
    properties:
      cpuCount: 1
      totalMemoryMB: 1024
      imageRef: >-
https://cloud-images.ubuntu.com/releases/16.04/
release-20170307/ubuntu-16.04-server-cloudimg-amd64.ova
      cloudConfig: |
        #cloud-config
        ssh_pwauth: yes
        chpasswd:
          list: |
            ${input.username}:${input.password}
          expire: false
        users:
          - default
          - name: ${input.username}
            lock_passwd: false
            sudo: ['ALL=(ALL) NOPASSWD:ALL']
            groups: [wheel, sudo, admin]
            shell: '/bin/bash'
            ssh-authorized-keys:
              - ssh-rsa 
AAAAB3NzaC1yc2EAAAADAQABAAABAQDytVL+Q6+vGbmkXoRpX 
dmettem@dmettem-m01.vmware.com
        runcmd:
          - echo "Defaults:${input.username}

YAML code for Puppet on a vCenter 
with remote access enabled password 
authentication on the compute 
resource.

inputs:
  username:
    type: string
    title: Username
    description: Username to use to install Puppet agent
    default: puppet
  password:
    type: string
    title: Password
    default: VMware@123
    encrypted: true
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Table 6-6. (continued)

Example of... Sample Blueprint YAML

    description: Password for the given username to install 
Puppet agent
resources:
  Puppet-Ubuntu:
    type: Cloud.vSphere.Machine
    properties:
      flavor: small
      imageRef: >-
        https://cloud-images.ubuntu.com/releases/16.04/
release-20170307/ubuntu-16.04-server-cloudimg-amd64.ova
      remoteAccess:
        authentication: usernamePassword
        username: '${input.username}'
        password: '${input.password}'
  Puppet_Agent:
    type: Cloud.Puppet
    properties:
      provider: PEMasterOnPrem
      environment: production
      role: 'role::linux_webserver'
      username: '${input.username}'
      password: '${input.password}'
      host: '${Puppet-Ubuntu.*}'
      useSudo: true
      agentConfiguration:
        certName: '${Puppet-Ubuntu.address}'

Puppet on vSphere with generated PublicPrivateKey authentication

Table 6-7. 

Example of... Sample Blueprint YAML

YAML code for Puppet on a vSphere 
OVA with generated PublicPrivateKey 
authentication on the compute resource.

inputs: {}
resources:
  Machine:
    type: Cloud.vSphere.Machine
    properties:
      flavor: small
      imageRef: >-
https://cloud-images.ubuntu.com/releases/16.04/
release-20170307/ubuntu-16.04-server-cloudimg-amd64.ova
      remoteAccess:
        authentication: generatedPublicPrivateKey
  Puppet_Agent:
    type: Cloud.Puppet
    properties:
      provider: puppet-BlueprintProvisioningITSuite
      environment: production
      role: 'role::linux_webserver'
      host: '${Machine.*}’
      osType: linux
      username: ubuntu
      useSudo: true
      agentConfiguration:
        runInterval: 15m
        certName: ‘${Machine.address}'
          - echo "Defaults:${input.username}

Using and Managing vRealize Automation Cloud Assembly

VMware, Inc. 349



How to use the vRealize Automation Cloud Assembly 
Marketplace

To jumpstart your resource library, download files from the vRealize Automation Cloud Assembly 
Marketplace.

The Marketplace provides finished blueprints and open virtualization images that are managed on 
the VMware Solution Exchange. Solution Exchange files that are tagged with cloud assembly 
appear under the vRealize Automation Cloud Assembly Marketplace tab.

How to access the Marketplace

In vRealize Automation Cloud Assembly, select Infrastructure > Connections > Integrations. Click 
Add Integration, click My VMware, and provide your My VMware account credentials.

How to download and use Marketplace blueprint files

In the Marketplace tab, click Get, and accept the blueprint EULA. Then, you can add the blueprint 
to a vRealize Automation Cloud Assembly project, or simply download it. You can upload a 
blueprint in the Design tab.

For a project-based example, imagine that you are a project administrator for a Big Data effort. 
To assist your team, you locate a Marketplace Hadoop blueprint that you add to the team project. 
You then customize the blueprint for your resource environment, and release it. Then, you import 
the blueprint into the vRealize Automation Service Broker catalog so that your team can deploy it.

How to download and use Marketplace image files

In the Marketplace tab, click Get, and accept the OVF or OVA image EULA. Afterward, you can 
download the OVF or OVA image and reference it in blueprint code.

Continuing with the previous example, your team might need access to a version of Hadoop itself. 
You download a Hadoop OVF and add it to cloud account resources such as a vCenter Server 
Content Library. You then update any blueprint code that needs to point to the OVF image.
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Managing vRealize Automation 
Cloud Assembly deployments 7
As a vRealize Automation Cloud Assembly blueprint developer, you use the Deployment tab to 
manage your deployments. You can troubleshoot failed provisioning processes, make changes, 
and destroy unused deployments.

Deployments are the provisioned instances of blueprints. The Deployments tab displays your 
successful and failed deployments. You use the page to manage your successful deployments or 
to begin troubleshooting any failed requests.

Working with deployment cards

You can locate and manage your deployments using the card list. You can filter or search for 
specific deployments, and then run actions on those deployments.

1 Filter your requests based on attributes.

2 Search for deployments based on keywords or requestor.

3 Sort the list to order by time or name.

4 Run deployment-level actions on the deployment, including deleting unused deployments to 
reclaim resources.

You can also see deployment costs, expiration dates, and status.
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This chapter includes the following topics:

n How do I monitor active deployments in vRealize Automation Cloud Assembly

n What can I do if a vRealize Automation Cloud Assembly deployment fails

n How do I manage the life cycle of a completed vRealize Automation Cloud Assembly 
deployment

n What actions can I run on vRealize Automation Cloud Assembly deployments

How do I monitor active deployments in vRealize 
Automation Cloud Assembly

After you deploy a vRealize Automation Cloud Assembly blueprint, you can monitor your request 
to ensure that the resources are provisioned and running. Beginning with the deployment card, 
you can verify the provisioning of your resources. Next, you can examine the deployment details.

Procedure

1 Click Deployments and locate your in-process deployment card using the filter and search, if 
needed.

2 Review the card status.

If the deployment is in progress, the process bar indicates the number of tasks remaining. 
If the deployment completed successfully, the card displays the basic details about the 

deployment. 
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3 To determine where your resources were deployed, click the deployment name and review the 
details on the Topology page.

You will likely need the IP address for the primary component. As you click on each 
component, notice the information provided that is specific to the component. In this example, 
the IP address is highlighted.

The availability of the external link depends on the cloud provider. Where it is available, you 
must have the credential on that provider to access the component.

What to do next

n You can make changes to your deployment. See How do I manage the life cycle of a 
completed vRealize Automation Cloud Assembly deployment.

n If your deployment fails, see What can I do if a vRealize Automation Cloud Assembly 
deployment fails.

What can I do if a vRealize Automation Cloud Assembly 
deployment fails

Your deployment request might fail for many reasons. It might be due to network traffic, a 
lack of resources on the target cloud provider, or a flawed deployment specification. Or, the 
deployment succeeded, but it does not appear to be working. You can use vRealize Automation 
Cloud Assembly to examine your deployment, review any error messages, and determine whether 
the problem is the environment, the requested workload specification, or something else.

You use this workflow to begin your investigation. The process might reveal that the failure was 
due to a transient environmental problem. Redeploying the request after verifying the conditions 
have improved resolves this type of problem. In other cases, your investigation might require you 
to examine other areas in detail.

As a project member, you can review the request details in vRealize Automation Cloud Assembly.
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Procedure

1 To determine if a request failed, click the Deployments tab and locate the deployment card.

Failed deployments are indicated on the card.

a Review the error message.

b For more information, click the deployment name for the deployment details.

2 On the deployment details page, click the History tab.

a Review the event tree to see where the provisioning process failed. This tree is useful when 
you modify a deployment, but the change fails.

The tree also shows when you run deployment actions. You can use the tree troubleshoot 
failed changes.

b The Details provides a more verbose version of the error message.

c If the requested item was a vRealize Automation Cloud Assembly blueprint, the link to the 
right of the message opens vRealize Automation Cloud Assembly so that you can see the 
Request Details.
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3 The Request Details provides the provisioning workflow for failed components so that you can 
research the problem.

a Review the error message.

b You can turn on the Dev mode to switch between the simple provisioning workflow and a 
more detailed flowchart.

c Click the card to review the deployment script.

4 Resolve the errors and redeploy the blueprint.

The errors might be in the blueprint construction or they might be related to how your 
infrastructure is configured.

What to do next

When the errors are resolved and the blueprint is deployed, you can see information similar to 
the following example in the Request Details. To see the request details, select Infrastructure > 
Activity > Requests.
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How do I manage the life cycle of a completed vRealize 
Automation Cloud Assembly deployment

After a deployment is provisioned and running, you have several actions that you can run to 
manage the deployment. The life cycle management can include powering on or off, resizing, and 
deleting a deployment. You can also run various actions on individual components to manage 
them.
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Procedure

1 Click Deployments and locate your deployment.

2 To access the deployment details, click the deployment name.

You can use the Topology tab to visualize the deployment structure and resources.

The History tab includes all the provisioning events and any events related to actions that 
you run after the requested item is deployed. If there are any problems with the provisioning 
process, the History tab events will help you with troubleshooting the failures.

The Cost tab provides the current cost of some components since they were deployed.

3 If you determine that a deployment is too costly in its current configuration and you want to 
resize a component, select the component on the topology page and then select Actions > 
Resize on the component page.

The available actions depend on the component, the cloud account, and your permissions.
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4 As part of your development life cycle, one of your deployments is no longer needed. To 
remove the deployment and reclaim resources, select Actions > Delete.

The available actions depend on the state of the deployment.

What to do next

To learn more about possible actions, see What actions can I run on vRealize Automation Cloud 
Assembly deployments.
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What actions can I run on vRealize Automation Cloud 
Assembly deployments

After you deploy blueprints, you can run actions in vRealize Automation Cloud Assembly to 
manage the resources. The available actions depend on the resource type and whether the actions 
are supported on a particular cloud account or integration platform. 

The available actions also depend on what your administrator entitled you to run.

As an administrator or project administrator, you can set up Day 2 Actions policies in vRealize 
Automation Service Broker. See How do I entitle consumers to Service Broker day 2 action 
policies

You might also see actions that are not included in the list. These are likely custom actions added 
by your administrator. For example, a How to create a vRealize Automation Cloud Assembly 
custom action to vMotion a virtual machine.

Table 7-1. List of possible actions

Action

Applies to 
these 
resource 
types

For these cloud accounts or 
integrations Description

Add Disk Machines n Amazon Web Service

n Google Cloud Platform

n Microsoft Azure

n VMware vSphere

Add additional disks to existing virtual machines.

Change 
Lease

Deployments n Amazon Web Service

n Microsoft Azure

n VMware vSphere

Change the lease expiration date and time.

When a lease expires, the deployment is destroyed and 
the resources are reclaimed.

Lease policies are set in vRealize Automation Service 
Broker.

Connect 
to 
Remote 
Console

Machines n VMware vSphere Open a remote session on the selected machine.

Review the following requirements for a successful 
connection.

n As a deployment consumer, verify that the provisioned 
machine is powered on.

Create 
Snapshot

Machines n Google Cloud Platform

n VMware vSphere

Create a snapshot of the virtual machine.

If you are allowed only two snapshots in vSphere and you 
already have them, this command is not available until you 
delete a snapshot.
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Table 7-1. List of possible actions (continued)

Action

Applies to 
these 
resource 
types

For these cloud accounts or 
integrations Description

Delete Deployments n Amazon Web Service

n Google Cloud Platform

n Microsoft Azure

n VMware vSphere

Destroy a deployment.

All the resources are deleted and the reclaimed.

If a delete fails, you can run the delete action on a 
deployment a second time. During the second attempt, 
you can select Ignore Delete Failures. If you select this 
option, the deployment is deleted, but the resources 
might not be reclaimed. You should check the systems on 
which the deployment was provisioned to ensure that all 
resources are removed. If they are not, you must manually 
delete the residual resources on those systems.

Machines 
and load 
balancers

n Amazon Web Service

n Microsoft Azure

n VMware vSphere

Delete a machine or load balancer from a deployment. This 
action might result in an unusable deployment.

Delete 
Snapshot

Machines n VMware vSphere

n Google Cloud Platform

Delete a snapshot of the virtual machine.

Edit Tags Deployments n Amazon Web Service

n Microsoft Azure

n VMware vSphere

Add or modify resource tags that are applied to individual 
deployment resources.

Power 
Off

Deployments n Amazon Web Service

n Microsoft Azure

n VMware vSphere

Power off the deployment without shutting down the guest 
operating systems.

Machines n Amazon Web Service

n Google Cloud Platform

n Microsoft Azure

n VMware vSphere

Power off the machine without shutting down the guest 
operating systems.

Power 
On

Deployments n Amazon Web Service

n Microsoft Azure

n VMware vSphere

Power on the deployment. If the resources were 
suspended, normal operation resumes from the point at 
which they were suspended.

Machines n Amazon Web Service

n Google Cloud Platform

n Microsoft Azure

n VMware vSphere

Power on the machine. If the machine was suspended, 
normal operation resumes from the point at which the 
machine was suspended.

Reboot Machines n Amazon Web Service

n VMware vSphere

Reboot the guest operating system on a virtual machine.

For a vSphere machine, VMware Tools must be installed 
on the machine to use this action.

Reconfig
ure

Load 
Balancers

n Amazon Web Service

n Microsoft Azure

n Google Cloud Platform

n VMware vSphere

Change the load balancer protocol, port, health 
configuration, and member pool settings.
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Table 7-1. List of possible actions (continued)

Action

Applies to 
these 
resource 
types

For these cloud accounts or 
integrations Description

Remove 
Disk

Machines n Amazon Web Service

n Google Cloud Platform

n Microsoft Azure

n VMware vSphere

Remove disks from existing virtual machines.

Reset Machines n Amazon Web Service

n Google Cloud Platform

n VMware vSphere

Force a virtual machine restart without shutting down the 
guest operating system.

Resize Machines n Amazon Web Service

n Microsoft Azure

n Google Cloud Platform

n VMware vSphere

Increase or decrease the CPU and memory of a virtual 
machine.

Resize 
Boot 
Disk

Machines n Amazon Web Service

n Google Cloud Platform

n Microsoft Azure

n VMware vSphere

Increase or decrease the size of your boot disk medium.

Resize 
Disk

Storage disk n Amazon Web Service

n Google Cloud Platform

Increase the capacity of a storage disk.

Restart Machines n Microsoft Azure Shut down and restart a running machine.

Revert to 
Snapshot

Machines n Google Cloud Platform

n VMware vSphere

Revert to a previous snapshot of the machine.

You must have an existing snapshot to use this action.

Run 
Puppet 
Task

Managed 
resources

n Puppet Enterprise Run the selected task on machines in your deployment.

The tasks are defined in your Puppet instance. You 
must be able to identify the task and provide the input 
parameters.

Shutdow
n

Machines n VMware vSphere Shut down the guest operating system and power off the 
machine. VMware Tools must be installed on the machine 
to use this action.

Suspend Machines n Microsoft Azure

n VMware vSphere

Pause the machine so that it cannot be used and does not 
consume any system resources other than the storage it is 
using.

Update Deployments n Amazon Web Service

n Microsoft Azure

n VMware vSphere

Change the deployment based on the input parameters.

For an example, see How to move a deployed machine to 
another network.

Update 
Tags

Machines 
and disks

n Amazon Web Service

n Microsoft Azure

n VMware vSphere

Add, modify, or delete a tag that is applied to an individual 
resource.
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